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Preface
 Congratulations! You have just purchased a lavishly equipped and easy-to-use video studio including
video functions for recording, editing, subtitling, dubbing, mixing, transitioning, effects editing, optimizing,
reverse transferring, and burning CD-ROMs, (S) Video CDs, and DVDs / Blu-ray DiscsTM

. 
The possibilities are endless: from quickly editing your holiday videos to composing elaborate multimedia
masterpieces. For example: 

 DVD movie memories of vacations, parties, sports, or special family events
 Video web pages
 CD or DVD movies and slideshows
 Web movies, email greetings, or streaming movies
 Enhanced presentations, instructional courses
 Ad spots or TV trailers
 Music videos, karaoke shows, animation, fun clips

The printed manual only contains the basic functions of both program versions MAGIX Movie Edit Pro
16 and MAGIX Movie Edit Pro 16 Plus. Additional features of the Plus version are marked
accordingly. 
In addition to the printed manual, there is also a more detailed documentation which is copied to your
hard drive during installation. This electronic PDF manual describes all program functions and even gives
you an overview of everything that is relevant for the different disc formats such as CDs, VCDs, SVCDs
and DVDs. 
This information will get you started on your way to making your first movie masterpiece. The reference
chapter that follows and the index can also be used to help quickly when you need it. 
Enjoy! 
The MAGIX Team 
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Support
 If you experience any problems with your software
, please contact our support team: 
Support website: http://support.magix.net/contact/us
 This website takes you to the MAGIX user service page; the following free offers are also featured
there: 

 FAQs (frequently asked questions) and general tricks and tips. In most cases, you'll find the
solution to your problem here. If not, use the email support form.

 Email support form: Use the special form to inform our support staff about your system. This
information is used to solve your problems quickly and competently. Simply fill it out and send it
with a mouse click!

 Support forum: You are not alone. Perhaps other users had a similar problem and can help you
solve yours. Our support staff are also regular contributors.

 Download section: Updates, improvements, and patches are likewise offered free of charge via
download. Many problems you may experience are already familiar to us, and they can often be
solved by downloading the latest patch. Besides patches, there are also wizards for checking and
optimizing your system.

 Links: The links list contains the contact addresses for all of the most important hardware
manufacturers.

Please note:
 To be able to use the support, you have to register your product using the serial number provided. This
number can be found on the CD case of your installation CD or on the inside of the DVD box. 
You can also reach our support team by telephone:
UK: 0203 3183666 (Mon. - Fri., 09:00-16:00

GMT) 
USA/Canada: 1-775-562-0527 (Mon.?Fri. 9 am to 5 pm

EST) 
Denmark: 699 18763 (Mon.- Fri. 10:00 - 17:00) 
Finland (Suomi): 09 42419023 (Mon.- Fri. 11:00 - 18:00) 
Norway: 210 35843 (Mon.- Fri. 10:00 - 17:00) 
Sweden: 0852500713 (Mon.- Fri. 10:00 - 17:00) 
You can request a free access code to the phone support hotline by using this link: 
http://support.magix.net/phone
. There you'll also get additional information and explanations about phone support. 
Please have the following information at hand:

  Program version
 Configuration details (operating system, processor, memory, hard drive, etc.), sound card

configuration (type, driver)
 Information regarding other audio software installed

You can also contact our support team by mail:
 UK/Scandinavia: MAGIX Development Support, P.O. Box 20 09 14, 01194 Dresden, Germany 
US/Canada: MAGIX Customer Service, 1105 Terminal Way #302, Reno, NV 89502, USA 
Customer service & upgrades (US only)
 Periodically, MAGIX offers users who purchased their software an upgrade from a previous product to
the current version. For details about an upgrade, please call us using the following number: 
Sales Department 1-305-722-5810 
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Serial number
 A serial number is included with each product, and although it is not required for the installation of the 
software
, it does enable access to additional bonus services. Please store this number in a safe place. 
What can a serial number do?
 A serial number ensures that your copy of MAGIX Movie
 Edit Pro 16 is clearly assigned to you and only you, and it makes improved and more targeted customer
service possible. Abuse of the software can be prevented with a serial number, since it ensures that the
optimum price/performance ratio continues to be offered by MAGIX. 
Where can the serial number be found?
 The serial number can be found on the reverse side of your CD/DVD case. If your product, for
example, is packed in a DVD box, then you'll find the serial number on the inside. 
For versions that have been especially optimized for the Internet (download versions), you'll receive your
serial number for activating the software directly after purchasing the product via email. 
When will you need the serial number?
 The serial number is required when you start or register MAGIX Movie Edit Pro 16 for the first time. 
Note: We explicitly recommend registering your product, since only then are you entitled to get program
updates and contact MAGIX Support. Entering the serial number is also required for activating codecs
. 
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System requirements
 For Microsoft® Windows® XPTM / VistaTM / 7TM

  Intel® Pentium® IV or AMD® AthlonTM, 2 GHz or higher
 1 GB RAM
 1 GB free hard disk memory and a DVD drive for program installation
 Graphics card with a screen resolution of at least 1024 x 768
 Sound card (multi-channel sound card recommended for surround sound editing)

Minimum requirements for HD editing
  Intel® PentiumTM IV 3 GHz with hyperthreading, or dual core with at least 1.3 GHz
 2 GB RAM
 DirectX® 9.0c compatible graphics card, min. 128 MB graphics card memory, and Pixelshader

2.0, ATI X300 or higher, NVIDIA GeForce 6600 or better
Recommended configuration for AVCHD editing

  Intel® CoreTM 2 Quad with 2.83 GHz
 3 GB RAM
 ATI Radeon HD 3000 series or higher with 512 MB VRAM
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MAGIX Online World
 MAGIX Online World from MAGIX offers you a range of new services for your photos, videos, and
music that are accessible directly from the "Online" menu in MAGIX Movie
 Edit Pro 16: 
In this chapter
MAGIX Online Album
MAGIX Blog Service
MAGIX Website Maker
MAGIX Online Print Service
Catooh – the Online Content Library

MAGIX Online Album
 MAGIX Online Album is your personal multimedia album on the Internet. If you want to present
slideshows or videos online, then MAGIX Online Album is the perfect service. 

MAGIX Blog Service
 With MAGIX Blog Service, YOU make the news! Share your thoughts, experiences, and news with a
worldwide audience in no time using your own interactive online multimedia journal. Invite family, friends,
and acquaintances to join in and enter their comments! A free MAGIX Online Album belongs to the
MAGIX Blog Service so that you always have full control over your contributions. 
You can also read the FAQ (frequently asked questions) on the Internet.

 MAGIX Website Maker
 MAGIX Website Maker helps you create a personal Internet showcase with a professional design in
just a few mouse clicks ? without prior knowledge, including your own chosen domain
 and email address. Publish slideshows and videos and accessorize your site with music and various
effects ? anything from a simple business card to a fireworks display of effects, professional or private ?
show your best side! 
More about this topic can be found under MAGIX Website Maker.

 MAGIX Online Print Service
 MAGIX Online Print Service is perfect for getting your pictures processed online or printed as photo
gifts on mugs, t-shirts, or calendars. 

Catooh – the Online Content Library
 If your project
 is missing pictures, videos, DVD menus, sounds, or samples, then you should have a look at the huge
selection available at Catooh. There you'll be able to buy media in excellent quality for low prices: DVD
menus, Slideshow Maker styles, decorative elements, 3D power effects, 3D transition series, MAGIX
Soundpools, songs, ringtones... Perfectly suited to all MAGIX photo, video, and music projects. 
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Introduction
In this chapter
What is MAGIX Movie Edit Pro 16?
What is MAGIX Movie Edit Pro 16?
What’s new in MAGIX Movie Edit Pro 16?
Features
Extra in the Plus version
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What is MAGIX Movie Edit Pro 16?
 MAGIX Movie Edit Pro 16 is a complete movie studio for your PC. MAGIX Movie Edit Pro 16 lets
you easily transmit your recordings to your computer and then, once you have improved and enriched
them, onto DVD and Blu-ray DiscTM

. It's great for theater-quality presentations on TV, screen, or monitor. 
MAGIX Movie Edit Pro 16 is a production studio for the PC for editing videos, movies, photos, and 
audio
 from a wide range of sources. Long movies can be automatically separated into different chapters or
scenes, or do the opposite by automatically incorporating short takes into a single movie. 
Add music, theater-quality transitions, text, and selected effects to your own movies with a mouse click.
The easy-to-use interface, advanced technology and handy assistants guarantee perfect results at lightning
speed! 
Once your movie is finished, you can use it again in a number of ways: Transfer it back onto tape or to
your camcorder, burn it onto DVD or Blu-ray DiscTM

 and enjoy it on TV, or put it online for your friends and family in your personal MAGIX Online Album. 
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What’s new in MAGIX Movie Edit Pro 16?
 Improved file import
 MAGIX Movie Edit Pro 16's support of video formats
 has been improved, and new formats have been added. 

 For DVD videos, multiple audio tracks, or the corresponding audio track may be selected.
 OGG and MP3 are now read directly; conversion to the WAV format is omitted. To import

DVDs with multiple audio tracks (e.g. multi-lingual videos), the corresponding audio track can be
selected via the context menu for the respective audio object.
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Creating backgrounds
 The Media Pool
 features useful templates for various applications. For example, there are professional backgrounds for
measurements, but there are also special templates with more creative freedom and adjustable color
schemes. 

Performance test for your PC during AVCHD import
 A performance test has been integrated into MAGIX Movie Edit Pro 16 for loading AVCHD videos.
This tests whether your computer is powerful enough to edit AVCHD
 material directly. 
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Revised MAGIX Slideshow Maker 
MAGIX Slideshow Maker
 has been completely revised. Effects and fades can now be set and adjusted in detail. This program is
accessible via "Edit -> Wizards -> Slideshow Maker". 

Secondary color correction
 Secondary color correction allows the colors in an area of an image
 to be edited independently from the rest of the image. To do this, the image is separated into fore and
background segments. For each layer, a color range can be selected and edited with the eyedropper
tool. Color correction can be found in the Media Pool under "Video effects -> Color correction". 

Object zoom
 Activate this mode and click on an object to zoom in for detailed editing. This allows individual drum hits
in a loop to be edited in a very detailed way or cut. Select the object and then you will see a button with
four arrows pointing outwards on it in the lower right section of the Arranger. Click this button
 again to reset the view to the original settings. 

Scrubbing
 Scrubbing originates from the time of tape machines and provides quicker monitoring of passages of a
film or piece of music. This was technically implemented in these devices by keeping the tape head on the
tape itself, but the motor doesn't drive the tape rolls in this case. Instead the tape is "manually" set to the
desired position. Scrubbing in MAGIX Movie
 Edit Pro 16 is available beneath the transport controls via a large wheel, which may be used to move the
playback marker. 

Audio effects animation in the Media Pool
 Audio effects can also be animated in the Media Pool in the same way as video effects. Automation
curves that were normally difficult to draw can now be set and changes be made with just few keyframes.
Because these curves are object-related, the entire arrangement remains clearly laid-out even with
complex automations. The button
 for animations is located in the Media Pool (like video effects). 

Improved video upload
 Video uploads to video portals and communities
 can now even be done in HD quality, and in most cases, without recalculation on the video portal or
community website. Upload functions are accessible via "File -> Internet". 

Revised DVD menu design
 The DVD menu design function has been generally revised. You can access this option directly via the
"Burn" button
. 

New Title Editor
 Titles, text, opening and end credits are now written directly in the preview monitor so that you can see
exactly where your titles will be positioned right away. Click the "Title" button in the Media Pool, select a
template and place it onto the track via drag & drop
. You may now edit your titles in the preview window. 
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Additional innovations in the PLUS and Premium versions
 Additional innovations in the PLUS and Premium versions versus the classic version: 

 Secondary color correction for impressive color effects
 Level display for audio file import
 Extended jump markers for improved project navigation
 Creation of colored surfaces/color scroll generator
 Upload videos to Vimeo
 Travel route animation
 MAGIX Music Editor with optimized user guidance
 Advanced support for Blu-ray and AVCHD discs
 More functions for DVD menu design
 Timeline zoom for individual objects
 Internal PC performance benchmarking for optimized presets

 Additional innovations in the Premium version
  proDAD Mercalli Expert: The ultimate solution for stabilizing video clips retroactively
 proDAD Adorage HD SE: Video effects and transitions in HD quality
 XXL sound pack: Features over 500 sounds and complete songs 
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Features
 Recording
 MAGIX Movie
 Edit Pro 16 provides the following recording options: 

 DV cameras: Mini DV camcorders or DV video recorders
 HDV cameras: HDV1 and HDV2 camcorders
 Video: Analog TV, video input, VHS recorders, webcams
 Single frame: Single images and series of images from webcams, video recorders, video

cameras, or TV cards
 Audio: Microphones, cassette recorders, MiniDisc players, turntables
 Screen (Plus version only): PC monitor.

Analog capture requires capture cards compatible
 with DirectShow. DV capture can be performed through an OHCI-compatible IEEE 1394 host adapter
(Firewire or iLink). A TV card can be used to record programs from TV or from your video recorder. 

Import/Export formats
 Video files: Videos for Windows and DV-AVI type 1/2 (*.avi), MPEG-1 and 2
(*.mpg,*.mp2,*.MPEG), QuickTime (*.mov), MAGIX Video (*.mxv), Windows Media, VOB streams
from DVD (unencrypted), AVCHD
 (import only, only in the Plus version), MPEG-4 (*.mp4) (after fee-based activation). Activation is free
in the Plus version. 
Note: To import and export AVC and MPEG-4 files, the MEPG-4 codec must first be activated. A
dialog will open if the codec is required. Files with a horizontal resolution of more than 768 pixels can
only be loaded in MAGIX Movie
 Edit Pro 16 Plus. 
Audio files: The following formats are supported for soundtracks. Wave, MP3 (Windows Media Player
10 is required for export), WMA, OGG Vorbis, MIDI
 files, and audio CD tracks. 
Graphics files (for slideshows or as a still behind a scrolling title): Windows bitmaps (BMP),
JPEG, GIF, Animated GIF, ZSoft Paintbrush (PCX), PNG, Portable Pixmap (PPM), Portable Greymap
(PGM), Adobe Photoshop (PSD), Sun Rasterfile, Targa (TGA), Tagged Image
 File Format (TIFF), Photo CD (PCD). 
Text files in RTF format
: You may conveniently enter text like closing credits into any text editor and then save it in the universal
text format (.rtf). Loading such text into MAGIX Movie Edit Pro 16 creates a title object. 
Note
: 
AVI video files in DivX™ format can only be imported with the corresponding codec installed! The
DivX codec can be downloaded from www
.divx.com. 
The QuickTime Library has to be installed to import QuickTime files (*.mov). 
Additional export formats: In addition to the above-mentioned audio and video formats, the following
formats can also be exported: RealMedia™, BMP, Snapshot function (export any film motif as a bitmap
or JPEG file). In addition, MAGIX Online Album can be used to create a Flash video. The video to be
uploaded to the MAGIX Online Album will be exported in Windows Media format, and from there it
can be exported as a Flash video. 
You can read more information about importing and exporting files in the "Media Pool
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" chapter. 

AVCHD standard support
 Files from AVCHD cameras can be either read directly or imported. Newer computers are capable of
decoding and playing this format in real-time.
MAGIX Movie Edit Pro 16 does a performance check in order to make sure that the computer has
enough computing capacity. If the check indicates that the computer is insufficient, AVCHD material is
transformed into a MPEG
-2 file to allow older systems to edit it, too. 
Note: To import AVCHD video, the camera drive must be installed even if you are working with
portable media (8 cm DVDs, SD memory card, etc.). Reason: AVCHD
 cameras use an improved UDF file system which Windows can't handle without the driver. 

AVCHD Lite
 MAGIX Movie Edit Pro 16 now also supports the AVCHD
 Lite standard, which is used by digital cameras for recording video (among other things). 

AVCHD activation details
 Attention: For AVCHD support, Dolby Digital Stereo and the MPEG-4 codec must be activated. To
convert AVCHD videos to MPEG
-2, the MPEG-2 codec must be activated. 

Burnable disc formats
  1:1 copies of DVDs & (S)VCDs
 Double-layer DVDs
 VCDs (MPEG-1 on CD-R)
 S-VCDs (MPEG-2 on CD-R)
 DVD (MPEG-2 on DVD)
 miniDVDs (MPEG-2 on CD-R)
 Blu-ray Discs
 AVCHD disc to DVD and Blu-ray
 Project backups and backup copies

 Automatic scene recognition 
Long films are automatically divided into shorter scenes upon import or even retroactively. 
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 MAGIX Movie
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 Single frame: Single images and series of images from webcams, video recorders, video

cameras, or TV cards
 Audio: Microphones, cassette recorders, MiniDisc players, turntables
 Screen (Plus version only): PC monitor.

Analog capture requires capture cards compatible
 with DirectShow. DV capture can be performed through an OHCI-compatible IEEE 1394 host adapter
(Firewire or iLink). A TV card can be used to record programs from TV or from your video recorder. 

Import/Export formats
 Video files: Videos for Windows and DV-AVI type 1/2 (*.avi), MPEG-1 and 2
(*.mpg,*.mp2,*.MPEG), QuickTime (*.mov), MAGIX Video (*.mxv), Windows Media, VOB streams
from DVD (unencrypted), AVCHD
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in the Plus version. 
Note: To import and export AVC and MPEG-4 files, the MEPG-4 codec must first be activated. A
dialog will open if the codec is required. Files with a horizontal resolution of more than 768 pixels can
only be loaded in MAGIX Movie
 Edit Pro 16 Plus. 
Audio files: The following formats are supported for soundtracks. Wave, MP3 (Windows Media Player
10 is required for export), WMA, OGG Vorbis, MIDI
 files, and audio CD tracks. 
Graphics files (for slideshows or as a still behind a scrolling title): Windows bitmaps (BMP),
JPEG, GIF, Animated GIF, ZSoft Paintbrush (PCX), PNG, Portable Pixmap (PPM), Portable Greymap
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Text files in RTF format
: You may conveniently enter text like closing credits into any text editor and then save it in the universal
text format (.rtf). Loading such text into MAGIX Movie Edit Pro 16 creates a title object. 
Note
: 
AVI video files in DivX™ format can only be imported with the corresponding codec installed! The
DivX codec can be downloaded from www
.divx.com. 
The QuickTime Library has to be installed to import QuickTime files (*.mov). 
Additional export formats: In addition to the above-mentioned audio and video formats, the following
formats can also be exported: RealMedia™, BMP, Snapshot function (export any film motif as a bitmap
or JPEG file). In addition, MAGIX Online Album can be used to create a Flash video. The video to be
uploaded to the MAGIX Online Album will be exported in Windows Media format, and from there it
can be exported as a Flash video. 
You can read more information about importing and exporting files in the "Media Pool
" chapter. 
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AVCHD standard support
 Files from AVCHD cameras can be either read directly or imported. Newer computers are capable of
decoding and playing this format in real-time.
MAGIX Movie Edit Pro 16 does a performance check in order to make sure that the computer has
enough computing capacity. If the check indicates that the computer is insufficient, AVCHD material is
transformed into a MPEG
-2 file to allow older systems to edit it, too. 
Note: To import AVCHD video, the camera drive must be installed even if you are working with
portable media (8 cm DVDs, SD memory card, etc.). Reason: AVCHD
 cameras use an improved UDF file system which Windows can't handle without the driver. 

AVCHD Lite
 MAGIX Movie Edit Pro 16 now also supports the AVCHD
 Lite standard, which is used by digital cameras for recording video (among other things). 

AVCHD activation details
 Attention: For AVCHD support, Dolby Digital Stereo and the MPEG-4 codec must be activated. To
convert AVCHD videos to MPEG
-2, the MPEG-2 codec must be activated. 

Burnable disc formats
  1:1 copies of DVDs & (S)VCDs
 Double-layer DVDs
 VCDs (MPEG-1 on CD-R)
 S-VCDs (MPEG-2 on CD-R)
 DVD (MPEG-2 on DVD)
 miniDVDs (MPEG-2 on CD-R)
 Blu-ray Discs
 AVCHD disc to DVD and Blu-ray
 Project backups and backup copies

 Automatic scene recognition 
Long films are automatically divided into shorter scenes upon import or even retroactively. 
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Import/Export formats
 Video files: Videos for Windows and DV-AVI type 1/2 (*.avi), MPEG-1 and 2
(*.mpg,*.mp2,*.MPEG), QuickTime (*.mov), MAGIX Video (*.mxv), Windows Media, VOB streams
from DVD (unencrypted), AVCHD
 (import only, only in the Plus version), MPEG-4 (*.mp4) (after fee-based activation). Activation is free
in the Plus version. 
Note: To import and export AVC and MPEG-4 files, the MEPG-4 codec must first be activated. A
dialog will open if the codec is required. Files with a horizontal resolution of more than 768 pixels can
only be loaded in MAGIX Movie
 Edit Pro 16 Plus. 
Audio files: The following formats are supported for soundtracks. Wave, MP3 (Windows Media Player
10 is required for export), WMA, OGG Vorbis, MIDI
 files, and audio CD tracks. 
Graphics files (for slideshows or as a still behind a scrolling title): Windows bitmaps (BMP),
JPEG, GIF, Animated GIF, ZSoft Paintbrush (PCX), PNG, Portable Pixmap (PPM), Portable Greymap
(PGM), Adobe Photoshop (PSD), Sun Rasterfile, Targa (TGA), Tagged Image
 File Format (TIFF), Photo CD (PCD). 
Text files in RTF format
: You may conveniently enter text like closing credits into any text editor and then save it in the universal
text format (.rtf). Loading such text into MAGIX Movie Edit Pro 16 creates a title object. 
Note
: 
AVI video files in DivX™ format can only be imported with the corresponding codec installed! The
DivX codec can be downloaded from www
.divx.com. 
The QuickTime Library has to be installed to import QuickTime files (*.mov). 
Additional export formats: In addition to the above-mentioned audio and video formats, the following
formats can also be exported: RealMedia™, BMP, Snapshot function (export any film motif as a bitmap
or JPEG file). In addition, MAGIX Online Album can be used to create a Flash video. The video to be
uploaded to the MAGIX Online Album will be exported in Windows Media format, and from there it
can be exported as a Flash video. 
You can read more information about importing and exporting files in the "Media Pool
" chapter. 

AVCHD standard support
 Files from AVCHD cameras can be either read directly or imported. Newer computers are capable of
decoding and playing this format in real-time.
MAGIX Movie Edit Pro 16 does a performance check in order to make sure that the computer has
enough computing capacity. If the check indicates that the computer is insufficient, AVCHD material is
transformed into a MPEG
-2 file to allow older systems to edit it, too. 
Note: To import AVCHD video, the camera drive must be installed even if you are working with
portable media (8 cm DVDs, SD memory card, etc.). Reason: AVCHD
 cameras use an improved UDF file system which Windows can't handle without the driver. 

AVCHD Lite
 MAGIX Movie Edit Pro 16 now also supports the AVCHD
 Lite standard, which is used by digital cameras for recording video (among other things). 
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AVCHD activation details
 Attention: For AVCHD support, Dolby Digital Stereo and the MPEG-4 codec must be activated. To
convert AVCHD videos to MPEG
-2, the MPEG-2 codec must be activated. 

Burnable disc formats
  1:1 copies of DVDs & (S)VCDs
 Double-layer DVDs
 VCDs (MPEG-1 on CD-R)
 S-VCDs (MPEG-2 on CD-R)
 DVD (MPEG-2 on DVD)
 miniDVDs (MPEG-2 on CD-R)
 Blu-ray Discs
 AVCHD disc to DVD and Blu-ray
 Project backups and backup copies

 Automatic scene recognition 
Long films are automatically divided into shorter scenes upon import or even retroactively. 
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Automatic scene recognition 
Long films are automatically divided into shorter scenes upon import or even retroactively. 
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Timeline mode / Storyboard mode / Overview mode
 MAGIX Movie
 Edit Pro 16 provides three specialized views for especially easy editing: 

 All scenes from your film are listed sequentially in Storyboard mode. Every scene is displayed
with a preview picture in the storyboard. 

 Timeline mode chronologically displays your photos with text and sound elements over four
tracks: The longer the representative object remains in the track, the longer the corresponding
photo will be displayed during playback. In total you have four tracks to arrange your scenes
with titles, movie sequences, or music.

 Overview mode displays all scenes in multiple rows. The zoom function makes sure that the
number of scenes you want to view can be viewed at the same time. 

 The Plus version also features Multicam mode, which can be switched on in Timeline mode. This
mode allows you to edit together two camera perspectives comfortably.
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Optimize Video/Audio
 Every film and every video can be optimized for image quality, color improvement (RGB, saturation),
sharpness (sharp and soft filters), brightness control (brightness, contrast) and pushed through an
anti-flicker filter (Deinterlace). The sound quality of every movie and every video can also be optimized.
The equalizer allows you to manipulate the frequency spectrum ? perfect for cleaning up muffled dialog
. The compressor is a dynamic volume control that can lend the overall sound a deeper, richer quality.
The stereo effects processor justifies the position of the sound in the stereo panorama, while the
DeNoiser and DeHisser are professional noise reduction tools which perform the function indicated by
their names. 

Effects
 MAGIX Movie
 Edit Pro 16 offers numerous effects and effects settings options as described in detail in the chapter
"Effects and titles". A short overview: 

 Every object (every video, every single scene, every photo, and every audio recording) can be
provided with its own individual effects combination. Every effects combination can be saved
separately so that you can use it later on different objects. Right click the object and choose the
"Save video effects" option in the context menu.

 Video effects are selected and set up in the "Effects" folder in the Media Pool. Most effects allow
"keyframes" to control their behavior. The current settings only become effective beginning with
the first selected keyframe. The next keyframe activates the settings present at that keyframe. The
area between two keyframes approximates the corresponding effects settings ("tweening").

 Video effects can be controlled using effects curves. A curve is shown in the video's object
display which controls the application of the effect; the higher the curve, the more intense the
effect. Keyframes are indicated by curve handles, and these can be manipulated as desired. For
every curve handle, Bezier handles can be generated to create harmonic curves and effects
automations.

 Effects presets are standardized effects configurations for the most important cases. They can be
used via drag & drop; just hold down the mouse button and drag the selected effect from the
Media Pool to the desired object - finished.

 The effects mixer ("Slide FX") combines or interweaves an assortment of recordings to create a
complex visual arrangement. To execute this effect, simply drag the transitions to the space
between two videos.

 Slideshow Maker
 Slideshow Maker turns drab photo collages into spectacular multimedia shows. With just one click, your
footage is professionally optimized and enhanced with suitable music, authentic noises, smart transitions,
text templates that can be edited, animations, effects and video clips. Just try it out! 
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"keyframes" to control their behavior. The current settings only become effective beginning with
the first selected keyframe. The next keyframe activates the settings present at that keyframe. The
area between two keyframes approximates the corresponding effects settings ("tweening").

 Video effects can be controlled using effects curves. A curve is shown in the video's object
display which controls the application of the effect; the higher the curve, the more intense the
effect. Keyframes are indicated by curve handles, and these can be manipulated as desired. For
every curve handle, Bezier handles can be generated to create harmonic curves and effects
automations.

 Effects presets are standardized effects configurations for the most important cases. They can be
used via drag & drop; just hold down the mouse button and drag the selected effect from the
Media Pool to the desired object - finished.

 The effects mixer ("Slide FX") combines or interweaves an assortment of recordings to create a
complex visual arrangement. To execute this effect, simply drag the transitions to the space
between two videos.

 Slideshow Maker
 Slideshow Maker turns drab photo collages into spectacular multimedia shows. With just one click, your
footage is professionally optimized and enhanced with suitable music, authentic noises, smart transitions,
text templates that can be edited, animations, effects and video clips. Just try it out! 
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MAGIX Soundtrack Maker
 If you need a soundtrack, MAGIX Soundtrack Maker offers a massive selection of suitable sounds for
background music in different variations, from "funky" to "easy listening" ? simply add music to your 
movie project. The result is real movie
 background music with changing moods to perfectly match your images. 

Multimedia editable DVD menus
 The program includes many DVD menu
 templates (for chapter selection, etc.) for projects intended for TV, and some are also in 16:9
widescreen format. They can be easily inserted during the burning process to give the DVD a
professional look. 
Every menu template can be customized with your own photos, thematic animations, 3D titles, sound, 
intro videos, etc. Write with flowers if your video takes place on a meadow, or with clouds if you've
flown somewhere. A lovingly created menu
 always makes a great impression. It's your video's calling card. 

Time-saving VHS copying technique
 Use your analog PC video card to quickly transfer old videos to high-quality MPEG-2 format directly
from your VHS recorder. The movie and its interactive menu
 can be automatically burned directly to disc after capture/transfer. 

MAGIX Videorecorder
 MAGIX Videorecorder's design is especially suited for viewing and navigating videos, photos, audio
, and TV by remote control. MAGIX Videorecorder includes: 

 TV/Video recorder for analog TV and DVB-T/S for easily recording TV on your PC. You
can easily select and record analog TV and DVB programs with your PC-compatible remote
control.

 Improved PC-remote control compatible MAGIX Online TV Guide (EPG): With the DVB
program guide, you can access all available information related to the selected program, record it
directly, or earmark it for fully automatic recording. You can also open an illustrated Internet
program guide with plenty of detailed information.

MAGIX Videorecorder can be opened separately via the "Start" menu or activated in MAGIX Movie
Edit Pro 16's recording dialog, which can be accessed via the red button
 below the preview monitor. 
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Task assistant + Video tooltips
 The "Tasks" menu
 option provides all of the important functions as well as tips & tricks for your movies. With the
applicable tool tip you receive valuable information. Just a simple click immediately opens the desired
function or a wizard video for the task. 
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Extra in the Plus version
 Additional disc formats 

 WMVHD (Windows Media High Definition Disc): WMVHD is a type of disc optimized for
movie playback on PCs. The movies are converted into high-resolution Windows Media 9
format and a menu is added, like with DVDs. Windows Media Player 9, or higher is required for
successful playback. Video encoding will be preset for HDTV resolution (1280 x 720, also
known as "720p")

 JPEG disc (for displaying photos on TV): With the "JPEG disc" option, every photo in the
disc project is individually exported and burned to a CD or DVD in JPEG format. The disc can
be played back later using photo disc-compatible DVD players. If a project contains several
slideshows, a subfolder will be created for each one, and the corresponding images will be
placed into each one. On a JPEG disc there are no menus, sounds, animated effects or
transitions. However, it does offer the best possible quality available for TV playback. 

 AVCHD disc: Burn a disc in the AVCHD format here. This high-resolution format makes it
possible to add 30 minutes of film to a DVD or 160 minutes of film to a Blu-ray Disc.

 MultiDisc: Conventional video DVD, high-resolution HD discs, and complete backup projects
are burned onto the disc.

 Download media directly from the Internet
 Videos, pictures, texts, and sounds which are freely available on the Internet can be found and copied
into the Media Pool at the click of a button via the newly integrated web browser. Audio files can be
recorded using the analog input on the sound card, and video recorded directly from the screen. The
media files are then immediately available for use in your own project
. You can find this function in the Media Pool under "Tasks -> Import -> Online media". 

Support for AVCHD camcorders
 MAGIX Movie Edit Pro 16 Plus also supports camcorders that use the AVCHD format. AVCHD is
currently used by video cameras that record directly to DVDs, SD cards, memory sticks, or hard disk.
Files from AVCHD cameras can be either read directly or imported. During import the files can be
converted to MPEG
-2 format. Import requires approximately three times the playback time. 
Hint:For AVCHD support Dolby® Digital Stereo import must be activated. For AVCHD import,
MPEG2 codec must be activated. Read the hints for using AVCHD in the chapter "Import and export"
 or the PDF tutorial "Working with AVCHD material"! 
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Synthesizer
 The Ambient Synth is a well-developed tool for easily producing realistic natural noises, from rain and
thunderstorms to animal sounds and traffic
 noise. The Drum&Bass machine includes throbbing bass lines and powerful beats in one device, allowing
you to create great modern mood music, even if you don't have previous experience. 

DV logging
 MAGIX Movie Edit Pro 16 Plus also features a DV logging option. You no longer need to save large
DV-AVI and audio
 files, since MAGIX Movie Edit Pro 16 saves the position of this material on the DV tape and imports
missing files automatically when reloading the DV tape. 

Custom multi-channel Surround 5.1 sound
 Create custom multi-channel Surround 5.1 sound for your videos. With Dolby Digital® audio
 (5.1 Surround) you can burn your videos for any DVD player (requires a fee-based Dolby Digital®
codec activation). 

Customize keyboard shortcuts
 Keyboard shortcuts are very useful for working more quickly and professionally. For this reason,
MAGIX Movie
 Edit Pro 16 Plus offers an editor for individual adjustment of keyboard shortcuts for almost all important
commands. 

Create a disc project as an ISO image
 MAGIX Movie Edit Pro 16 Plus now allows you to save your disc project as an ISO image file as well.
"ISO" image is the technical term for the exact memory map of the content of a disc. An ISO image file
can work directly with all standard burning programs and makes multiple burnings especially easily.
Select the "Image
" option under "Burner" to do so. 
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MAGIX Xtreme Print Center
 MAGIX Xtreme Print Center is a printing suite for CD, DVD, and VHS label printing. You can
conveniently print perfect stickers, covers, inlays, and booklets for your projects. 

MAGIX Xtreme Photo Designer
 MAGIX Xtreme Photo Designer offers you high-quality image editing software for any situation. The
newly integrated Task Assistant explains frequently used tasks in an easy-to-understand manner. The
program interface is now even more intuitive due to an entirely new program interface look and improved
user navigation. MAGIX Xtreme Photo Designer can be accessed via the "Effects" button for each scene
or the context menu for image
 files. 

MAGIX Music Editor
 MAGIX Music Editor is a full WAV editor with all necessary cutting, editing & effect functions as well
as numerous import/export functions. You can open audio objects from MAGIX Movie Edit Pro 16 with
a mouse click in the MAGIX Music Editor. There you'll be able to take advantage of lots of additional
powerful tools, for example, a function for freehand drawing of waveforms. This can be used to fix the
most stubborn distortions that cannot be eliminated completely using the MAGIX Movie
 Edit Pro 16 DeClicker. 

More extras
  TV ad killer (removes TV commercial blocks automatically)
 99 stereo tracks for more flexible arranging
 Professional reference track (according to TV and movie standard)
 VirtualDub plug-in interface for external video effects or removing TV channel logos
 BPM recognition for music videos with precise rhythmic editing options
 Import/export of Bitmap and TIF series (e.g. from 3D applications)
 Legal backup copies of protected video DVDs via analog recording from your DVD player
 Freely definable motion paths for dynamic camera movements and zooms
 3D design for perspective picture-in-picture alignment, 3D outros, and more
 Transition export: Create individual transition effects from your favorite scene
 Audio Mastering Suite 2.0 for professional sound on soundtracks
 Menu background design options
 Seamless integration of effect plug-in proDAD Vitascene
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Work areas
In this chapter
"Record" screen
"Edit" screen
Video monitor
Media Pool
Toolbars
Arranger
Adjusting the workspace
The "Burn" screen
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"Record" screen

1 Menubar: The different menus give you access to MAGIX
Movie
 Edit Pro 16's different functions. 

2 Toolbar: 
Here you will find a number of buttons for quick access to
important functions. 

3 Screens: 
Here you will find the switches for the "Record", "Edit", and
"Burn CD" screens. 

4 Preview monitor:
 In the preview monitor you can view your recorded or
imported video. 

5 Transport control:
 The transport control resembles the playback controls of a
DVD player. You can use these buttons to control the preview
in the preview monitor. 

6 Record functions:
 The "Record", "Import file", "Copy CD/DVD" (PLUS version
only), and "TV & Media Center" buttons can be used to start
the main functions of these screens. 

7 Filmbox:
 Movies and their preview images will be added to the
filmboxes during importing. 
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"Edit" screen

1 Upper button bar
: Here are the buttons for quick access to important commands. 

2 Menu bar: Most functions in MAGIX Movie Edit Pro 16 can be
accessed via the menu
 bar. 

3 Program monitor: Video and image
 objects are displayed and files from the Media Pool can be
previewed here. 

4 Templates
: Here you can find the directories for fades, transitions, titles,
effects and movements. To preview a template, simply click on it
to see a preview. With "Catooh" you will be directly connected
to the Internet to open the Online Media Library. 

5 Media Pool
: In the Media Pool you can load your photos and other media
files. Using the generic navigation icons you can access any drive
or folder on your PC. 

6 Modes
: 

 Storyboard mode displays all scenes in the current video
in a panel so that they can be easily manipulated and
arranged. 

 Timeline mode is for more involved arrangement and
effects work. 

 Overview mode displays all the objects on the first
track and enables quick sorting of the scenes. 

 The right button activates Multicam mode in the Plus
version.

7 Lower toolbar
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: Here you can select the Timeline or different mouse modes for
various editing functions. 

8 Timeline with range markers
: Defines the range that will be played. In Timeline mode, this is
done using time intervals. 

9 Arranger 
: Drag & drop files from the Media Pool, then arrange and edit
files in detail here. 

10 Scroll bars
: The lower scroll bars can be dragged apart and pushed
together for zooming with the mouse. The right scroll bar
vertically zooms into the tracks. The right scroll bar zooms
vertically into the tracks. Click on the edge of the scroll bars
with the mouse button held down to change the visible window
in the arranger. 
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Video monitor
 All selection processes are conducted on the video monitor. Here you can view and edit material before
importing. There is a preview function for all of the files in the Media Pool. 

 Use the playback button to start the preview of video or image objects in Media Pool. For
special objects like titles or fades a preview is given.

 Audio files and synthesizer objects from the Media Pool can also be listened to using the
playback button. 

Tip: Useful presets for the arranger and video monitor can be found in the tab Display presets
 in the program settings. 

Full screen view
 The option "full screen" in the context menu
 maximizes the preview monitor. Alternatively, a double click on the monitor or "A+Enter" also maximizes
the window. The fullscreen view is especially recommended for working with two screens; one screen for
the film preview, and the other for the arranger. 
You can also shift the monitor into full screen mode and access it via the context menu (right mouse
button
). There, you can also hide and display the basic transport controls. 
With "Esc" you will go back to the normal view (or click on "smaller" button
 to the right in the fullscreen mode). 

Show movie overview
 The option "Film overview" in the "Window" menu
 enables an overview of teh entire arranger. All objects in the arranger will be displayed in the program
monitor. The overview display is especially recommended for work with long movies because the
reduced overview in the program monitor and the zoomed detailed view in the arranger present a good
combination. 
The film overview can be used for moving around in the movie
 and for editing certain parts: 

 When you click on a certain object in the video monitor, the arranger will zoom on that object. 
 Using the mouse, you can draw a frame in the video monitor ? and the corresponding range will

be zoomed in the arranger.
 When you move the playback marker in the video monitor, the arranger playback marker will

also move correspondingly.
Tip:
 If you use this option very often, you can use the keyboard shortcut (Shift + A). 

Transport control
 The transport controls in the program monitor enable you to play back video and photo material in the
arranger or as a preview in the Media Pool. 

Transport control buttons
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Range
: Above the playback functions,
the range between the in and out
points can be changed by
clicking. 

Playback marker: This marker indicates the location of
the image
 currently displayed on-screen. 
Media Pool/Arranger: This button
 allows you to switch between the Arranger's transport
control and the selected files in the Media Pool (preview
function). 
Set in/out points
: Defines the start and end of the playback range. 
To the start: This button
 sets the playback marker to the start of the current
area. 
Jump to start of film: Sets the playback marker to the
start of the movie
. 
Play/Stop (pause)
: The playback button in the middle starts playback. A
second click ends playback. 

Tip: In the menu
 "File -> Settings -> Program -> Playback", you can set whether the
playback marker will go back to the start position (stop) after the
second click or following the appropriate shortcut (space bar), or if it
should stay at the current position (pause function). 

Area playback
: This button plays back the current range. 
To the end
: This button sets the playback marker to the end of the
current range. 
Audio or video recording
: Quickly jumps to the Recording selection dialog. 
Film overview

Jog wheel
: Using this wheel, you can move by single
frames within the video and position the
playback marker exactly at high
magnifications. 
Shuttle control: The further the slider
 control is moved to the side, the quicker
the arrangement is played in the
corresponding direction. This way a
certain position can be reached quickly. 
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Full screen view
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To the start: This button
 sets the playback marker to the start of the current
area. 
Jump to start of film: Sets the playback marker to the
start of the movie
. 
Play/Stop (pause)
: The playback button in the middle starts playback. A
second click ends playback. 

Tip: In the menu
 "File -> Settings -> Program -> Playback", you can set whether the
playback marker will go back to the start position (stop) after the
second click or following the appropriate shortcut (space bar), or if it
should stay at the current position (pause function). 

Area playback
: This button plays back the current range. 
To the end
: This button sets the playback marker to the end of the
current range. 
Audio or video recording
: Quickly jumps to the Recording selection dialog. 
Film overview

Jog wheel
: Using this wheel, you can move by single
frames within the video and position the
playback marker exactly at high
magnifications. 
Shuttle control: The further the slider
 control is moved to the side, the quicker
the arrangement is played in the
corresponding direction. This way a
certain position can be reached quickly. 
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Show movie overview
 The option "Film overview" in the "Window" menu
 enables an overview of teh entire arranger. All objects in the arranger will be displayed in the program
monitor. The overview display is especially recommended for work with long movies because the
reduced overview in the program monitor and the zoomed detailed view in the arranger present a good
combination. 
The film overview can be used for moving around in the movie
 and for editing certain parts: 

 When you click on a certain object in the video monitor, the arranger will zoom on that object. 
 Using the mouse, you can draw a frame in the video monitor ? and the corresponding range will

be zoomed in the arranger.
 When you move the playback marker in the video monitor, the arranger playback marker will

also move correspondingly.
Tip:
 If you use this option very often, you can use the keyboard shortcut (Shift + A). 

Transport control
 The transport controls in the program monitor enable you to play back video and photo material in the
arranger or as a preview in the Media Pool. 

Transport control buttons

Range
: Above the playback functions,
the range between the in and out
points can be changed by
clicking. 

Playback marker: This marker indicates the location of
the image
 currently displayed on-screen. 
Media Pool/Arranger: This button
 allows you to switch between the Arranger's transport
control and the selected files in the Media Pool (preview
function). 
Set in/out points
: Defines the start and end of the playback range. 
To the start: This button
 sets the playback marker to the start of the current
area. 
Jump to start of film: Sets the playback marker to the
start of the movie
. 
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Play/Stop (pause)
: The playback button in the middle starts playback. A
second click ends playback. 

Tip: In the menu
 "File -> Settings -> Program -> Playback", you can set whether the
playback marker will go back to the start position (stop) after the
second click or following the appropriate shortcut (space bar), or if it
should stay at the current position (pause function). 

Area playback
: This button plays back the current range. 
To the end
: This button sets the playback marker to the end of the
current range. 
Audio or video recording
: Quickly jumps to the Recording selection dialog. 
Film overview

Jog wheel
: Using this wheel, you can move by single
frames within the video and position the
playback marker exactly at high
magnifications. 
Shuttle control: The further the slider
 control is moved to the side, the quicker
the arrangement is played in the
corresponding direction. This way a
certain position can be reached quickly. 
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Transport control
 The transport controls in the program monitor enable you to play back video and photo material in the
arranger or as a preview in the Media Pool. 

Transport control buttons

Range
: Above the playback functions,
the range between the in and out
points can be changed by
clicking. 

Playback marker: This marker indicates the location of
the image
 currently displayed on-screen. 
Media Pool/Arranger: This button
 allows you to switch between the Arranger's transport
control and the selected files in the Media Pool (preview
function). 
Set in/out points
: Defines the start and end of the playback range. 
To the start: This button
 sets the playback marker to the start of the current
area. 
Jump to start of film: Sets the playback marker to the
start of the movie
. 
Play/Stop (pause)
: The playback button in the middle starts playback. A
second click ends playback. 

Tip: In the menu
 "File -> Settings -> Program -> Playback", you can set whether the
playback marker will go back to the start position (stop) after the
second click or following the appropriate shortcut (space bar), or if it
should stay at the current position (pause function). 

Area playback
: This button plays back the current range. 
To the end
: This button sets the playback marker to the end of the
current range. 
Audio or video recording
: Quickly jumps to the Recording selection dialog. 
Film overview
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Jog wheel
: Using this wheel, you can move by single
frames within the video and position the
playback marker exactly at high
magnifications. 
Shuttle control: The further the slider
 control is moved to the side, the quicker
the arrangement is played in the
corresponding direction. This way a
certain position can be reached quickly. 
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Media Pool
 The design and operation of the Media Pool is very similar to Windows Explorer. It serves to control
and load multimedia files of all kinds: video files, audio
 files, fades, effects, and even entire projects. At the same time, it is used as a window for editing
different tasks. 

Importing

 Navigation buttons
 The navigation buttons let you navigate through your computer's drives and folders. 

Forwards/Back The "Back" button
 always returns you to the folder
you last used. 

Up The "Up" button
 brings you to the next highest folder level. 

Folder tree Here you can activate a folder tree to
navigate through your computer system. 

Search To quickly find specific files, use the
search function. You can also specify
file type, data and certain folders that
should be searched. 

Browse history
list and path
details

The current folder's path is
displayed in the top center. Use the
arrow button to open the menu
 to find the folders you previously
visited. 

Options All functions of the context
menu
 (switch views, rename, or
delete files, etc.) can also be
accessed via the options
button. 

Display options Settings for how detailed the entries
should be listed can be made here. 

Computer
 The link button
 "Computer" displays the drives in the Media Pool. All drives will be listed along with their drive letters
and can be opened with a double click. 

User directory 
The second button
 featuring the user's name opens their personal folder in the Media Pool. 

My media
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 The "My media" button
 lets you select "Projects", "My videos", "My music", "My images", and "Recordings". 

Projects
 Switches to the folder where your projects and videos are usually stored. 

My videos
 Displays all usable files found in "My documents\My videos." 

My music
 Displays the contents of the "My Documents\My Music" folder. MAGIX Music Manager also suggests
this folder for importing your music collection into the database. 

My pictures
 Switches to the "My documents\My pictures" folder. This folder is often used by digital cameras and
scanners to store transferred images by default. The included MAGIX Photo Manager program also uses
this folder (e.g. during image
 import). 

Recordings
 Recordings: MAGIX Movie
 Edit Pro 16 stores all recordings here to access all recordings as quickly as possible. 

MAGIX tools
 The "MAGIX tools" link selects links to "Downloads", "Database", "Online Album", and "Internet
Media". 
Downloads: Use this button
 to access the media files that you downloaded with Catooh. 
Database: Use this button
 to open the database view. Right-clicking opens the database search. The database first has to be
created using the supplied additional programs MAGIX Photo Manager or MAGIX Music Manager. 
Online Album
: This buttons opens MAGIX Online Album. This provides a shortcut to uploading and deleting data. To
do this, you must first register on MAGIX Online Album. 
There are many ways to upload data: 

1. While holding "Ctrl" down, select the data to be uploaded in the Media Pool, and select "Copy"
in the context menu (opened by right-clicking). Switch to the MAGIX Online Album screen,
open the desired folder, and select "Paste" in the context menu.

2. In the Media Pool, click on "Online Album", and go to the desired directory. Open the Windows
Explorer, select the desired data with "Ctrl" held down, and drag it into the Media Pool.

Both options will result in your desired data being uploaded to your MAGIX Online Album. 
Hint
: This function requires an Internet connection. To gain access, make sure you have your login information
(email address and password) ready. 
Internet media: This opens MAGIX Movie Edit Pro 16's integrated browser. It offers you the
possibility to collect media from the Internet to use in the current project
. 
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Importing

 Navigation buttons
 The navigation buttons let you navigate through your computer's drives and folders. 

Forwards/Back The "Back" button
 always returns you to the folder
you last used. 

Up The "Up" button
 brings you to the next highest folder level. 

Folder tree Here you can activate a folder tree to
navigate through your computer system. 

Search To quickly find specific files, use the
search function. You can also specify
file type, data and certain folders that
should be searched. 

Browse history
list and path
details

The current folder's path is
displayed in the top center. Use the
arrow button to open the menu
 to find the folders you previously
visited. 

Options All functions of the context
menu
 (switch views, rename, or
delete files, etc.) can also be
accessed via the options
button. 

Display options Settings for how detailed the entries
should be listed can be made here. 

Computer
 The link button
 "Computer" displays the drives in the Media Pool. All drives will be listed along with their drive letters
and can be opened with a double click. 

User directory 
The second button
 featuring the user's name opens their personal folder in the Media Pool. 

My media
 The "My media" button
 lets you select "Projects", "My videos", "My music", "My images", and "Recordings". 

Projects
 Switches to the folder where your projects and videos are usually stored. 

My videos
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 Displays all usable files found in "My documents\My videos." 

My music
 Displays the contents of the "My Documents\My Music" folder. MAGIX Music Manager also suggests
this folder for importing your music collection into the database. 

My pictures
 Switches to the "My documents\My pictures" folder. This folder is often used by digital cameras and
scanners to store transferred images by default. The included MAGIX Photo Manager program also uses
this folder (e.g. during image
 import). 

Recordings
 Recordings: MAGIX Movie
 Edit Pro 16 stores all recordings here to access all recordings as quickly as possible. 

MAGIX tools
 The "MAGIX tools" link selects links to "Downloads", "Database", "Online Album", and "Internet
Media". 
Downloads: Use this button
 to access the media files that you downloaded with Catooh. 
Database: Use this button
 to open the database view. Right-clicking opens the database search. The database first has to be
created using the supplied additional programs MAGIX Photo Manager or MAGIX Music Manager. 
Online Album
: This buttons opens MAGIX Online Album. This provides a shortcut to uploading and deleting data. To
do this, you must first register on MAGIX Online Album. 
There are many ways to upload data: 

1. While holding "Ctrl" down, select the data to be uploaded in the Media Pool, and select "Copy"
in the context menu (opened by right-clicking). Switch to the MAGIX Online Album screen,
open the desired folder, and select "Paste" in the context menu.

2. In the Media Pool, click on "Online Album", and go to the desired directory. Open the Windows
Explorer, select the desired data with "Ctrl" held down, and drag it into the Media Pool.

Both options will result in your desired data being uploaded to your MAGIX Online Album. 
Hint
: This function requires an Internet connection. To gain access, make sure you have your login information
(email address and password) ready. 
Internet media: This opens MAGIX Movie Edit Pro 16's integrated browser. It offers you the
possibility to collect media from the Internet to use in the current project
. 
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Fades
 This provides a list of all fades sorted into categories. Clicking on a category shows all of the fades
contained therein. 
To load a fade, click on it and drag it onto a scene
 which you would like to blend into. Alternatively, you can select the scene into which you would like to
blend into before and double click on the fade in the Media Pool later. 
Tip: All fades will appear in the menu
 between two scenes, and they can also be selected there. 
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Title
 Title presets and the Title Editor
 are located here. They are sorted into various categories and can be loaded via a double-click or drag
& drop. You will also find templates for 3D titles here. The text of title objects can be changed in the
program monitor by double-clicking on it. 
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Effects
 Access the effects presets via "Video effects", "Movement effects", "Audio
 effects", and "Design elements". 

Video effects
 These are the various effects which can be applied to videos and stills. The effects can be set after an
object is selected in the respective effects dialog which appears. For more information, see the "Video
effects in the Media Pool
" chapter. 

Movement effects
 These are movement effects you can use to animate the frame by using zoom or camera movements. For
more information, go to the "Effects and titles" chapter in "Movement effects in Media Pool
". 

Audio effects
 In addition to many different audio
 effects presets (echo, reverb, equalizer, compressor, etc.), you can also use the included synthesizer. A
synthesizer can be dragged onto the arranger like a multimedia file. It will be displayed as a synth object.
Use the corresponding control console to edit the synth sounds and melodies. The control console opens
automatically when the synthesizer is dragged onto the arrangement for the first time. A synth object can
be opened for further editing later by double clicking. 

Design elements
 Multi picture-in-picture: These are various effects presets for image
 stacking. 
Collages
: These work similarly to normal picture-in-picture effects, but more objects are used. Depending on the
collage, arrange the selected objects one after the other and drag the collage onto the first object. 
Portrait effects
: Select individual effects which are especially suited to vertically formatted photos. 
Image objects
: These are various image objects like black bars, thought bubbles for cartoons, etc. 
Intros/Outros
: These are beginning and end scenes for films with various themes. 
Visuals
: Graphical displays of any played sounds which can be combined with other video material. 
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Various file list view modes
 In the file list, all of the supported multimedia files and subfolders of the currently selected folder are
displayed. Three different views (list, detail, large symbols) can be set by right clicking on the Media
Pool context menu
. 

List:
 Only file
names are
listed. This
view mode
displays the
most files
simultaneou
sly. 
Details:
 In the
details
section the
type, size,
and date of
modificatio
n are
shown for
every
media file
beside its
name. The
list can be
sorted by
clicking on
any of
these
details. 

Large icons can be quite useful
because they show a preview frame
for each movie
 and picture file. This allows you to
sort through the material quicker.
One disadvantage is that it takes
longer for the file list to be
displayed. 
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Preview function
 This is a preview function for all files in the Media Pool which can be started by dragging & dropping
onto the video monitor or by pressing the play button
. 
There are also previews for effects that illustrate their functionality. 
The "Extras" button
 or the enhanced transport control function provides a selection of sections from a longer video file in the
Media Pool. Please refer to the Inserting objects into the project chapter. 
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Toolbars
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Upper button bar

 The upper button
 bar can be found in the monitor to the top left. It has the following functions: 
In this section:
New project
Load project
Save project
Program settings
Context help
MAGIX News Center
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New project
Creates a new MAGIX Movie Edit Pro 16 project. A dialog
with settings for a new disc project or a new film
 opens to get started. 

Keyboard shortcut: Shift + N 
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Load project
Use this option to load a movie into your disc project
. Please note that all media files associated with it must be
accessible. MAGIX Movie Edit Pro 16 will search for all used
sounds and video files in the folders in which they were located
when the movie was saved. 

Keyboard shortcut: Ctrl + O 
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Save project
The current movie is saved with the name displayed in the
project window. If you have not yet specified a name for your
project, a dialog
 will open wherein MAGIX Movie Edit Pro 16 asks you to do
so. 

Please note
: In the project file (*.MVP), all information about the used media files, cuts, effects, and titles are saved,
but not the picture and sound material itself. This is found in the recorded or imported media files that
remain unchanged during the entire MAGIX Movie Edit Pro 16 editing process. To save the full movie
into a dedicated directory, for instance to continue editing on a different PC, please use the command
"Copy movie and media into directory". 
Keyboard shortcut: Ctrl + S 
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Program settings
Opens the program settings
. 

Keyboard shortcut: Y 
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Context help
By choosing the context help entry from the "Help" menu, or by
clicking on the button in the top toolbar
, the mouse cursor will turn into an arrow with a question mark. 

Then, when you click on any button
 of the main screen, program help describing the control element in question will open. 
Shortcut key: Alt + F1 
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MAGIX News Center
MAGIX can supply you with all of the latest information about
your software
. In the MAGIX News Center, you will find all of the links to
current online tutorials as well as tips & tricks on individual
topics or software application examples. 

You will also be informed of the availability of brand new updates and patches for your program as well
as special offers, contests, and surveys. 
The news is split into three color-coded sections: 

 Green for practical tips & tricks for your software
 Yellow reports the availability of new patches and updates for your product
 Red for special offers, contests, and surveys
 And if there are no new messages, then the button will be grey

All available information is shown as soon as you click on MAGIX News Center. If you click on one of
the news items you will be forwarded to the corresponding website. 
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Lower toolbar

 The following buttons are available in "Overview" and "Timeline" modes: 
In this section:
Select a movie to edit
Undo
Restore
Delete objects
Title editor
Mute button
Mixer
Cut button
Paste modes
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Select a movie to edit
Using the dropdown menu, you can control various movies
within a project
. 
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Undo
 During project
 editing, you can undo the last changes you made. This way it's no problem if you want to experiment
with critical operations. If you don't like the results, then you can always revert to the previous state by
using "Undo". 
Keyboard shortcut: Ctrl + Z 
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Restore
 The "Redo" function undoes the previous "Undo" function. 
Keyboard shortcut: Ctrl + Y 
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Delete objects
This function deletes the selected scene
 (or the selected object in "Timeline" mode). 

Keyboard shortcut: Del 
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Title editor
Opens the title editor
 for the selected photo, video, or title object. 

Keyboard shortcut: Ctrl + T 
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Mute button
This button
 mutes the sound output. 
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Mixer
This option allows you to display or conceal the real-time
mixer. You will find further information, especially with regard
to the integration of effects plug-ins, in the chapter "Mixer". 

Keyboard shortcut: M 
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Cut button
 You can access the individual options using the dropdown menu
. 

Split
This command cuts a scene
 at the point where the playback marker is positioned. This
way, two free-standing objects are created. 
Keyboard shortcut: T 

Remove start
This command cuts a scene
 at the point where the playback marker is positioned and
removes the material before the playback marker. 
Keyboard shortcut: K 

Remove end
This command cuts a scene
 at the point where the playback marker is positioned and
removes the material behind the back marker. 
Keyboard shortcut: U 

Hint:
 If the commands "Split" and "Remove beginning/end" are applied without a selection, all objects at the
position of the playback marker are cut. 

Remove scene
This command allows you to completely remove selected
scenes. The scenes that follow will be automatically moved to
the end of the scene
 in front of the scene to be removed. 

Keyboard shortcut: Ctrl + Del 

Split movie
Splits the movie at the playback marker position into two
sections within one project. These can be individually controlled
using the "Window" menu or the button
 "Select movie for editing" (see above). 

Keyboard shortcut: Alt + W 
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Paste modes
 MAGIX Movie Edit Pro 16 provides various options for how an object selected in the Media Pool will
be pasted into the project
. 
In this section:
Apply automatically
Intelligent ripple
Single-track ripple
Multitrack ripple
Replace
Overwrite
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Apply automatically
Pastes the file selected in the Media Pool into the arranger.
Video and image objects will always be placed behind the last
object into the first track; audio
 and text objects are separated into different tracks. 
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Intelligent ripple
Inserts an object from the Media Pool at the position of the
playback marker and simultaneously moves the objects
following it. 

 In contrast to automatic insertion, all objects will be inserted at the position of the playback
marker. 

 Videos and images are placed on the first track. If another object is found at the playback
marker position, then it will be cut continued at the end of the inserted object (so that the inserted
object can start exactly at the point of insertion).

 The objects lying further along on the track will be moved further down. 
 Objects on other linked tracks (all objects up to the first completely empty track) will also be

moved further down. This includes sound tracks, fades, and titles, all of which will be moved
together so that nothing gets mixed up. All objects will be moved which start at the same position
as or behind the playback marker.

Note
: The prerequisite for a good ripple effect is that the soundtrack, most importantly, is cut at the position of
the playback marker. Otherwise, the elements located further down would move down even more, while
the soundtrack would stay at its old position, causing picture and sound to separate from each other. If
you would like to create an intelligent ripple, make sure that the starting points of all objects that are to be
moved are positioned at or behind the playback marker. If this is not the case, click on the screen to cut
the corresponding object at the playback marker position. 
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Single-track ripple
Inserts an object from the Media Pool at the position of the
playback marker and simultaneously moves the objects on the
track following it. 

 The one-track ripple behaves similarly to the intelligent ripple, the difference is that only the
objects on the target track are moved. Bordering tracks are unchanged.

 In contrast to automatic insertion, all objects will be inserted at the position of the playback
marker. 

 Videos and images are placed on the first track. If another object is found at the playback
marker position, then it will be cut continued at the end of the inserted object (so that the inserted
object can start exactly at the point of insertion).

 The objects lying further along on the track will be moved further down. 
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Multitrack ripple
The object selected in the Media Pool will be inserted on the
target track at the position of the playback marker. All objects
found at the playback marker position will be split and moved
down the length of the inserted object. All objects on the track
located further on will also be moved. 

 The multitrack ripple behaves similarly to the intelligent ripple, but the difference is that all objects
on all tracks following the playback marker's position will be moved.

 In contrast to automatic insertion, all objects will be inserted at the position of the playback
marker.

 Videos and images are placed on the first track. If another object is found at the playback
marker position, then it will be cut continued at the end of the inserted object (so that the inserted
object can start exactly at the point of insertion).

 If other objects are located at the playback marker position, these will also be separated and
moved further along the track.

 Objects lying further along on all tracks will be moved further down.
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Replace
Replaces the selected object with an object selected in the
Media Pool. 

Page 84



Overwrite
Overwrites the object in the target track at the position of the
start marker with the object selected in the Media Pool. 

Hint:
 In contrast to "Replace", no length adjustment takes place. With "Replace", any downstream objects are
moved, while "Overwrite" overwrites downstream objects as well (sometimes only partially), depending
on the length of the object being inserted in comparison to the object being overwritten. 
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Additional buttons in Timeline mode

 The following buttons are only available in "Timeline" mode: 
In this section:
Set chapter marker
Object grid
Form group
Ungroup objects
Mouse modes
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Set chapter marker
Sets a chapter marker at the position of the playback marker.
This creates a chapter entry in the disc menu, in case you are
planning to burn the movie
 to CD/DVD. 

You can rename your chapter markers by right clicking and selecting "Rename". The name then appears
in the chapter menu
. 
Shortcut: Shift + Enter 
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Object grid
Use this button
 to switch the object grid on and off. When the object grid is
switched on, the objects snap into place beside one another so
that everything fits in seamlessly. 
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Form group
Orders all selected objects into groups. As soon as an object
from the group is selected, all other objects in the group will be
highlighted as well so that you can work on them collectively. 

Keyboard shortcut: Ctrl + L 
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Ungroup objects
This turns all selected objects into free-standing objects
again. 

Keyboard shortcut: Ctrl + M 
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Mouse modes
MAGIX Movie Edit Pro 16 offers special mouse modes for
different kinds of editing. They can be selected using the small
arrow next to the button
. 

In this section:
Intelligent mouse mode
Mouse mode for individual objects
Curve mouse mode
Stretch mouse mode
Preview audio mouse mode
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Intelligent mouse mode
In principle, this mouse mode behaves like the "Single object
mouse" mode. 

However, all objects that border the object on the same or on adjacent tracks are also moved, starting
from the mouse position. This means that all objects overlapping adjacent tracks (fades, fade effects) and
those directly connecting to the next one (hard cuts) are pushed together up to the next empty space in
the arrangement (the technical term for this action is "Ripple until black"). 
This is useful for preventing destruction of fades you have already set and want to move an object
included therein. To move individual object, switch to "Single object mouse" mode. You can also drag an
object vertically onto a free track, thereby breaking the connection with the following objects. You will
then be able to move it freely without having to move other objects with it. 
Keyboard shortcut: Alt + 2 
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Mouse mode for individual objects
This is the preset mouse mode which performs most of the
work. 

Select objects with a left click. You can move an object by dragging it to the desired position. 
Keyboard shortcut: Alt + 1 
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Curve mouse mode
This mouse mode is used especially for drawing effects curves. 

The effects curve controls the intensity of the effect: The higher the curve point, the more intense the
respective effects parameter at this location. The curves can be used for video and image objects on the
image tracks and also for audio
 objects on the audio tracks. 
More information about this can be found in the chapter "Animate objects", section "Editing object effects
curves". 
Keyboard shortcut: Alt + 3 
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Stretch mouse mode
This special mode is for customizing the length of objects. 

With timestretching, audio objects can be expanded or compressed using the handles
 at the bottom. The duration of the audio material is therefore lengthened without changing the pitch.
Playback of the video objects is accelerated/decelerated with the help of the handles at the bottom. 
Attention! If the object to be stretched or compressed is going to be animated with an effects curve,
then the option "Connect curve length with object length
" should be set for the effects curve. 
Keyboard shortcut: Alt + 4 
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Preview audio mouse mode
This mode allows you to preview audio objects (as long as the
mouse button
 is held down). 

In this mode, objects cannot be moved or changed. 
Keyboard shortcut: Alt + 8 
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Arranger

 MAGIX Movie Edit Pro 16 offers an editing interface for advanced editing: audio
 dubbing, professional editing, plus precise transitions and effects editing. 

There are corresponding views for different
applications: "Scene
 overview", "Storyboard" mode, and "Timeline"
mode. 
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Tracks
 The arranger offers tracks for multimedia material positioning and editing. The number of tracks
displayed can be specified in the file menu under "Movie
 settings". 
In principle, any object type may be placed on any of the tracks. You can also combine video and
bitmaps objects with MIDI and audio
 objects on any of these tracks. The maximum length of a movie is restricted to 6 hours. 

At the beginning of each track is a track box
where you can mute a single audio track with the 
Mute button or play them S
olo. 

Clicking the lock symbol protects all objects in a track against unwanted editing. The track name can be
changed by double clicking the text above the buttons. 
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Zooming
 The vertical zoom function sets the number of visible tracks in the window. For a lot of tracks, enlarging
the view (zooming) is sensible for editing a single track or object. 
Use the horizontal zoom function to increase the visible section of the arrangement on the timeline. 

Enlarge objects
: Vertical and horizontal zoom stages are enlarged so that all of
the selected objects are able to be displayed at maximum
size. 

If the function is switched off, the zoom stage will be restored. 
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Adjusting the workspace
 The program monitor, the Arranger, and the Media Pool can be shut off completely or freely
repositioned. Personal settings are automatically saved when MAGIX Movie
 Edit Pro 16 is closed and remain unchanged when the program is reopened. 
Program settings -> Display presets provide a collection of useful configurations for display on the
monitor. On systems with only a single connected monitor, only the first two are practical. The presets
are explained on the right side of the dialog
. All window properties of the Arranger, video monitor, etc. can be changed after the application of a
preset. 
For larger arrangements, the program monitor can be used to show an overview of the Arranger
("Window -> Movie overview
"). 
Note
: If you've lost your overview, then you can use "Window -> Reset window arrangement" or the
keyboard shortcut "F9" to reset the basic settings. 
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The "Burn" screen

1 Preview menu: This is a preview of the selection menu. Read
more in the "Menu
" chapter 

2 Switch views:
 Here you can switch between the Preview and Edit views. 

3 Remote control: Check how your disc reacts when you press
a button
 on your remote control. 

4 Output: Choose between burning a project
, a show optimized for PC, or a web show. 

5 Play preview:
 Here you can playback the menu preview, which you can test
with the remote control. 

6 Template category:
 Switch between different templates for designing your menus. 

7 Menu templates:
 Switch between different templates for designing your menus. 

8 Apply templates:
 Here you can select whether a template should be assigned to
the page, menu or all disc menus. 

Page 101



Functionality
Switch to the "Burn" screen first by pressing the 
button
 indicated. 

You can burn your movies (including a selection menu
) onto CD, DVD, Blu-ray Disc, or upload them to MAGIX Online Album. 
All movies loaded into the project are taken into account. If you want to take out some of the movies that
are loaded, then you will have to switch back to the "Edit" screen and delete some of them from the
project. To do so, switch to the corresponding movie, open the "File" menu and select "Manage movies
-> Remove movie
" 
Note
: At a screen resolution of 1280 x 1024, the program display changes. This makes the program more
manageable and easier to use. The work steps remain the same despite the different display. 
For more information about the "Burn" screen, please read the chapter "Burning discs
". It is assumed that you are working in the "Advanced mode". 
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Create new video project
In this chapter
Movie settings
New project disc settings or new movie
Load project
Save project
Save project as...
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Movie settings

 Settings
 Name: Here you can enter the name of the current movie
. 
Path:
 This is where you determine the folder on your hard drive in which your movie is saved. 
Play movie back in loop mode:
 The movie is then played over and over again; that is, once the movie reaches the end marker, it is
started again from the beginning. 
Automatically save: 
The movie is automatically saved in regular intervals. You can set the interval in the system settings (Y
key). 
Number of tracks:
 Here you can change the track number. 
Audio sample rate: 
The preset sample rate is 48 kHz. This sample rate is used for all recordings and is also a prerequisite for
DVDs. With this setting, optimum sound quality is guaranteed. Audio material at different sample rates
(e.g. CD Audio with 44 kHz) is automatically adapted when loaded (resampling). Only change this value
if you want to use sound material with a different sample rate or if your sound card does not support this
sample rate. 
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Video resolution: This is where you set the standard settings for the picture format and frame rate for
PAL or NTSC TV pictures or for your own format. Please note that MPEG
 encoding requires a width/height ratio divisible by 8. 
Use as presets for new projects: Use the same settings from the dialog
 as standard settings for new projects. 
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Settings
 Name: Here you can enter the name of the current movie
. 
Path:
 This is where you determine the folder on your hard drive in which your movie is saved. 
Play movie back in loop mode:
 The movie is then played over and over again; that is, once the movie reaches the end marker, it is
started again from the beginning. 
Automatically save: 
The movie is automatically saved in regular intervals. You can set the interval in the system settings (Y
key). 
Number of tracks:
 Here you can change the track number. 
Audio sample rate: 
The preset sample rate is 48 kHz. This sample rate is used for all recordings and is also a prerequisite for
DVDs. With this setting, optimum sound quality is guaranteed. Audio material at different sample rates
(e.g. CD Audio with 44 kHz) is automatically adapted when loaded (resampling). Only change this value
if you want to use sound material with a different sample rate or if your sound card does not support this
sample rate. 
Video resolution: This is where you set the standard settings for the picture format and frame rate for
PAL or NTSC TV pictures or for your own format. Please note that MPEG
 encoding requires a width/height ratio divisible by 8. 
Use as presets for new projects: Use the same settings from the dialog
 as standard settings for new projects. 
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Movie information
 This option opens an information window: 

Name: Enter the name of the current movie
. 
Path
: The path for the folder on your hard drive where your movie is saved. 
Created on
: Displays the time the movie was created. 
Last changed
: Displays the time of the last save. 
Number of objects used
: Displays the number of all objects in the movie. 
Number of objects used
: All files used in the movie are listed here. 
Keyboard shortcut:
 E 
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Project settings
In this dialog
, you can view
and change the
settings for the
current film. 

Automatically select preview image
 MAGIX Movie Edit Pro 16 uses an automatically selected preview image
. 

Use image file
 Clicking the folder button opens a dialog to load image files. In this dialog, you can navigate to the
directory where the image
 file is found and select it by double clicking. 

Use preview image from movie
 Use the controller to select a frame
 from the corresponding directory. 
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New project disc settings or new movie
 When you start MAGIX Movie Edit Pro 16 the following dialog
 will open: 
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We're still at the very beginning, so let's stick with keeping an overview of everything. Click "OK" to end
the dialog
 and continue. 
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Load project
Use this option to load a movie into your disc project
. Please note that all media files associated with it must be
accessible. MAGIX Movie Edit Pro 16 will search for all used
sounds and video files in the folders in which they were located
when the movie was saved. 

Keyboard shortcut: Ctrl + O 
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Save project
The current disc project is saved with the name displayed in the
project window. If you have not yet specified a name for your
project, a dialog
 will open asking you to do so. 

Keyboard shortcut: Shift + S 
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Save project as...
 A dialog
 opens where you can specify the path and name of the video for saving. 
Keyboard shortcut: Shift + O 
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Video recording
In this chapter
Connect camera
Select the recording method
DV cameras
DV as MPEG
HDV camera
Batch recording
Logging
Record dialog analog video recording
Single frame
Record screen contents (Plus version)
Edit after recording
Audio
AVCHD recording (Plus version)
Import a non-copy-protected DVD
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Connect camera
In this section:
Connect AVCHD camera (Plus version)
Connect a DV or HDV camera
Connect analogue video source

Connect AVCHD camera (Plus version)
 AVCHD
 cameras are available in basically three types: 

 Cameras with removable storage: The camera includes a slot for a memory card. Your
computer should feature a card reader for the associated medium so that you can simply insert
the card from the camera and import the desired material. Different camera models can be
connected via USB.

 Cameras which burn DVDs directly (usually 80 mm diameter instead of the regular 120 mm):
The DVD can simply be taken out of the camera and inserted into the computer. For so-called
"Slot in DVD" drives, look beforehand in the operational manual whether or not 80 mm DVDs
(also called 3" DVDs or MiniDVDs) are acceptable.

Note
: These variants require a special UDF driver (normally included with the camera) to be installed before
the DVDs or removable storage can be imported into Windows. 

 Cameras with built-in hard drives: The camera is preset as a drive as soon as the USB cable
is connected to the PC. This additional drive is then visible in the Media Pool. A separate UDF
driver doesn't usually need to be installed.

Note
: The variants listed here and their procedures are explained according to our experience. We also
recommend reading the camera's manual for more detailed instructions and contacting the manufacturer in
case of problems. 

Connect a DV or HDV camera
 MAGIX Movie
 Edit Pro 16 supports continuous editing of DV (digital video) files. You will require a DV recorder or
DV camera with an IEEE-1394 interface (also known as FireWire or iLink) as well as an
OHCI-standard IEEE-1394 host adapter for your PC. You must also have Microsoft's DirectX8.a (or
higher) installed. 

 Connect the digital output of the switched-off camera with the computer's DV interface (also
called FireWire or iLink).

 Insert a DV cassette or the storage device into the camera.
 Switch your camera's operating mode to "Video recorder" or "Playback".

The camera is now ready to transfer the video to the computer. 
Note: You may also use a HDV camera in DV mode to, for example, transfer recordings in the old DV
format. We have noted problems with this mode in many cameras, and therefore recommend that the 
Record mode
 of the camera is also switched to DV, switching the camera off and then on again. 

Connect analogue video source
 Connect the video out of your camcorder, or DVD/VHS recorder to the video in (TV, video, or video
graphics card) of your computer, and the audio
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 out to the line in of your sound card. 
Due to the variety of device configurations, it is difficult to say which cable will function best with your
setup. If you're not sure, check the manual of your VCR or your TV, video, or graphics cards. 
Example
: 
Europe
: Many VCRs and DVD players have a SCART, 3 RCA (2 for stereo sound, 1 for video), or
S-Video/optical audio line out. In such case, you will need a SCART to RCA adapter, a cable with 3
RCA jacks, or an S-Video cable. 
North America
: Many VCRs and DVD players have a 3 RCA (2 for stereo sound, 1 for video), or S-Video/optical
audio line out. In such case, you will need a cable with 3 RCA jacks, or an S-Video cable. 

SCART/Cinch adapter SCART/Cinch adapter
with 3 RCA jacks

Stereo RCA/mini phone
jack adapter

 Most sound card inputs are 3.5 mini stereo jacks. To connect the VCR audio out to the sound card
audio in you will need a stereo RCA/ mini phono plug adapter. 
You will most likely have to buy a cable with 3 RCA plugs and a stereo cinch/mini jack adapter from
your local supplier. 
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Connect AVCHD camera (Plus version)
 AVCHD
 cameras are available in basically three types: 

 Cameras with removable storage: The camera includes a slot for a memory card. Your
computer should feature a card reader for the associated medium so that you can simply insert
the card from the camera and import the desired material. Different camera models can be
connected via USB.

 Cameras which burn DVDs directly (usually 80 mm diameter instead of the regular 120 mm):
The DVD can simply be taken out of the camera and inserted into the computer. For so-called
"Slot in DVD" drives, look beforehand in the operational manual whether or not 80 mm DVDs
(also called 3" DVDs or MiniDVDs) are acceptable.

Note
: These variants require a special UDF driver (normally included with the camera) to be installed before
the DVDs or removable storage can be imported into Windows. 

 Cameras with built-in hard drives: The camera is preset as a drive as soon as the USB cable
is connected to the PC. This additional drive is then visible in the Media Pool. A separate UDF
driver doesn't usually need to be installed.

Note
: The variants listed here and their procedures are explained according to our experience. We also
recommend reading the camera's manual for more detailed instructions and contacting the manufacturer in
case of problems. 

Connect a DV or HDV camera
 MAGIX Movie
 Edit Pro 16 supports continuous editing of DV (digital video) files. You will require a DV recorder or
DV camera with an IEEE-1394 interface (also known as FireWire or iLink) as well as an
OHCI-standard IEEE-1394 host adapter for your PC. You must also have Microsoft's DirectX8.a (or
higher) installed. 

 Connect the digital output of the switched-off camera with the computer's DV interface (also
called FireWire or iLink).

 Insert a DV cassette or the storage device into the camera.
 Switch your camera's operating mode to "Video recorder" or "Playback".

The camera is now ready to transfer the video to the computer. 
Note: You may also use a HDV camera in DV mode to, for example, transfer recordings in the old DV
format. We have noted problems with this mode in many cameras, and therefore recommend that the 
Record mode
 of the camera is also switched to DV, switching the camera off and then on again. 

Connect analogue video source
 Connect the video out of your camcorder, or DVD/VHS recorder to the video in (TV, video, or video
graphics card) of your computer, and the audio
 out to the line in of your sound card. 
Due to the variety of device configurations, it is difficult to say which cable will function best with your
setup. If you're not sure, check the manual of your VCR or your TV, video, or graphics cards. 
Example
: 
Europe
: Many VCRs and DVD players have a SCART, 3 RCA (2 for stereo sound, 1 for video), or
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S-Video/optical audio line out. In such case, you will need a SCART to RCA adapter, a cable with 3
RCA jacks, or an S-Video cable. 
North America
: Many VCRs and DVD players have a 3 RCA (2 for stereo sound, 1 for video), or S-Video/optical
audio line out. In such case, you will need a cable with 3 RCA jacks, or an S-Video cable. 

SCART/Cinch adapter SCART/Cinch adapter
with 3 RCA jacks

Stereo RCA/mini phone
jack adapter

 Most sound card inputs are 3.5 mini stereo jacks. To connect the VCR audio out to the sound card
audio in you will need a stereo RCA/ mini phono plug adapter. 
You will most likely have to buy a cable with 3 RCA plugs and a stereo cinch/mini jack adapter from
your local supplier. 
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Connect a DV or HDV camera
 MAGIX Movie
 Edit Pro 16 supports continuous editing of DV (digital video) files. You will require a DV recorder or
DV camera with an IEEE-1394 interface (also known as FireWire or iLink) as well as an
OHCI-standard IEEE-1394 host adapter for your PC. You must also have Microsoft's DirectX8.a (or
higher) installed. 

 Connect the digital output of the switched-off camera with the computer's DV interface (also
called FireWire or iLink).

 Insert a DV cassette or the storage device into the camera.
 Switch your camera's operating mode to "Video recorder" or "Playback".

The camera is now ready to transfer the video to the computer. 
Note: You may also use a HDV camera in DV mode to, for example, transfer recordings in the old DV
format. We have noted problems with this mode in many cameras, and therefore recommend that the 
Record mode
 of the camera is also switched to DV, switching the camera off and then on again. 

Connect analogue video source
 Connect the video out of your camcorder, or DVD/VHS recorder to the video in (TV, video, or video
graphics card) of your computer, and the audio
 out to the line in of your sound card. 
Due to the variety of device configurations, it is difficult to say which cable will function best with your
setup. If you're not sure, check the manual of your VCR or your TV, video, or graphics cards. 
Example
: 
Europe
: Many VCRs and DVD players have a SCART, 3 RCA (2 for stereo sound, 1 for video), or
S-Video/optical audio line out. In such case, you will need a SCART to RCA adapter, a cable with 3
RCA jacks, or an S-Video cable. 
North America
: Many VCRs and DVD players have a 3 RCA (2 for stereo sound, 1 for video), or S-Video/optical
audio line out. In such case, you will need a cable with 3 RCA jacks, or an S-Video cable. 

SCART/Cinch adapter SCART/Cinch adapter
with 3 RCA jacks

Stereo RCA/mini phone
jack adapter

 Most sound card inputs are 3.5 mini stereo jacks. To connect the VCR audio out to the sound card
audio in you will need a stereo RCA/ mini phono plug adapter. 
You will most likely have to buy a cable with 3 RCA plugs and a stereo cinch/mini jack adapter from
your local supplier. 
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Connect analogue video source
 Connect the video out of your camcorder, or DVD/VHS recorder to the video in (TV, video, or video
graphics card) of your computer, and the audio
 out to the line in of your sound card. 
Due to the variety of device configurations, it is difficult to say which cable will function best with your
setup. If you're not sure, check the manual of your VCR or your TV, video, or graphics cards. 
Example
: 
Europe
: Many VCRs and DVD players have a SCART, 3 RCA (2 for stereo sound, 1 for video), or
S-Video/optical audio line out. In such case, you will need a SCART to RCA adapter, a cable with 3
RCA jacks, or an S-Video cable. 
North America
: Many VCRs and DVD players have a 3 RCA (2 for stereo sound, 1 for video), or S-Video/optical
audio line out. In such case, you will need a cable with 3 RCA jacks, or an S-Video cable. 

SCART/Cinch adapter SCART/Cinch adapter
with 3 RCA jacks

Stereo RCA/mini phone
jack adapter

 Most sound card inputs are 3.5 mini stereo jacks. To connect the VCR audio out to the sound card
audio in you will need a stereo RCA/ mini phono plug adapter. 
You will most likely have to buy a cable with 3 RCA plugs and a stereo cinch/mini jack adapter from
your local supplier. 
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Select the recording method
 First, you should find out the correct recording method for your camera. The following options are
basically available: 

 Analog transfer: Transformation of the analog signal into a digital data current, whereby the actual
video file is then created using the settings (Super 8, Hi8, (S)VHS, video recorder, and other
analog sources).

 Digital transfer (DV camera, HDV camera)
 Copy the finished video files from a storage medium or directly from the connected camera to the

local hard drive for AVCHD cameras, DVDs (without copy protection), DVD cameras with
built-in hard drive or removable storage. Next, import the copied file into the project.

To start recording, click on the "Record" button
 under the source monitor. 

 The following selections are possible: 
 DV

camer
as: For
mini
DV
camera
s and
DV
video
record
ers

 HDV
camer
a: For
HDV1
and
HDV2
camera
s

 Video:
For
analog
video
camera
s TV,
analog
TV,
VHS
record
ers
(video
input),
webca
ms

 Single frame: For single and series images from analog cameras, analog TV, or VHS recorders,
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webcams, etc.
 Audio: For microphones, cassette recorders, MiniDisc players, turntables, etc.
 Screenshots: Records directly from the computer monitor.
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DV cameras
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DV devices
 MAGIX Movie
 Edit Pro 16 supports continuous editing of DV (digital video) files. You will require a DV camcorder or
DV recorder with an IEEE 1394 interface (also known as FireWire or iLink) as well as an OHCI
conforming IEEE 1394 host adapter for your PC. 
To record digitally, the digital output of the Mini DV camcorder or DV video recorder must be
connected to the DV interface of the PC, but remain switched off. You must also have Microsoft's
"DirectX8.a" (or higher) installed. Now switch your camcorder to "video recorder" or "playback"
(according to your particular device) and open the DV capturing dialog
. 
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Capturing DV recorders or cameras
To start recording, click the "Record" button
 under the source monitor. 

 Select "DV camera" from the recording dialog. Uncompressed DV capture requires approx. 220
MB per minute of video. If you would instead like to record using the more space-saving MPEG
format, then you should first activate the "Record DV as MPEG" option.

 This opens the actual recording dialog. Check to see if a DV camera driver has been selected.
 Name your recording. It's worth choosing a logical name which will allow you to find it easily

again on the hard drive.
 You can access the appropriate place on the camcorder tape by using the remote control

buttons: shuttle forwards, backwards, and start/stop playback. To start recording, click on the
"Record" button. Keep an eye on the remaining hard-drive space.

 Cease capturing with the "Stop" button and exit the record dialog. You can see the recording in
the film-strip in the lower third of the screen.

Tip: In the DV recording dialog, you can set clips from the DV video which will then be recorded one
after the other (batch capturing). Read more on this in the chapter "Batch processing"
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"DV capturing" dialog

 Note
: Keep an eye on the available hard drive space before each recording. DV capture requires approx. 220
MB per minute of video! 
Select DV device driver: The device driver for your DV device should be listed here. If "Audio
 recording" is deactivated, then only video without sound is recorded. "Audio preview" activates the
audio output of the recording. 
Note: The audio
 preview is deactivated at first, since DV cameras usually include built-in speakers. 
Save video file as/save in following folder: Enter the name of the movie to be recorded. You can also
select the folder where you wish to store your video file. The default recording directory is set by default,
but you can change the Path settings settings under menu
 item "File -> Program settings -> Path settings". 
Edit after recording
: This provides access to the automatic editing options. 
Start device automatically: Starts the DV recorder or DV camera automatically when the "Record"
button
 is pressed. This does not function with all digital cards/video devices. 
Movie preview: On the preview monitor you can see a preview of your movie
. 
Original size: This option allows you to preview the video in the original size. To return to the dialog
 use the "Esc" key. 
Automatic capturing: Here the start and end points can be set for the capturing. This allows you to
search the entire video for all captures to be used and list them for planned batch capture. This is then
processed in sequence when the recording starts (via the red button). That way you don't need to record
each scene individually. You simply determine recording time points, and the computer takes care of the
rest. To set the start and end points precisely, click "Enter start/end point
" 
Recording list: Use this button
 to view the available list of already recorded videos and scheduled recordings. All entries from the list
can be selected and deleted. 
Record
: Starts the recording process. Also contains the list of scheduled recordings. These are processed
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step-by-step (batch capturing). 
Stop
: Stops the recording process. 
Snapshot! With the Snapshot! button, you can create a frozen image directly from the preview monitor.
Start the camcorder and watch the preview window. When the image you want appears, click
"Snapshot". Or you can navigate using the remote control to the position you want, and stop there in 
Pause mode. Stopped playback on the DV camera will not deliver an image
! The images are saved in the record directory as graphics files in the set resolution. 
Remote control: Digital camcorders can be controlled remotely. This does not function with all digital
cards/video devices. If your hardware
 does not support the remote control function the buttons will not be usable. 
The transport buttons required for this are in the DV or HDV recording dialog
. 

Tape name: Enter a name for your tape here. MAGIX Movie
 Edit Pro 16 requires this name for the DV logging feature. 
Recording information
: Displays various information about your recordings. 
Enter start/end point
: 
Enter the exact start and end point
or the recording length for a scene
. 
Both values can be entered as ATN
(absolute track number) or as a
timecode in
hours:minutes:seconds:frames
. 
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DV as MPEG
 The "Recording selection" dialog option allows you to transfer DV recordings directly into the
space-saving MPEG format on the hard disk
. 

The "Enhance" button
 presents the MPEG encoder settings options. 
 You can also burn your DV material directly to
disc without taking any intermediate steps. 
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HDV camera
 Use this option to open the "HDV camcorder recording" dialog
. To do this, you have to connect an HDV 1 or HDV 2 camcorder. 

The options in this dialog
 can also be found above in DV recording. 
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Batch recording
 Set the start and end points for the capture here. This allows you to search the entire video for all
captures to be used and then list them for planned batch capture. This is then processed in sequence
when the recording starts (via the red button). That way, you don't need to record each scene
individually. You simply determine recording time points, and the computer takes care of the rest. To set
the start and end points precisely, click "Enter start/end point
". 
Recording list: Use this button
 to view the available list of already recorded videos and scheduled recordings. All entries from the list
can be selected and deleted. 

The basis for batch recording is the
recording list in the DV recording, DV to 
MPEG recording, or HDV recording's
recording dialog. All recordings listed there
are "logged". Recordings for which the
corresponding video material is no longer
on the hard disk
 will appear as "planned recordings". Click
the red record button to move all video files
back to the hard disk. 

Logging
 Logging means that MAGIX Movie Edit Pro 16 also saves the original position and additional
information (metadata, e.g. scene, take, rating, comments, etc.) about DV video and audio
 files. 
If does not find the corresponding DV and WAV
 files during the loading of a video, it will ask that the corresponding DV tape is inserted into the
connected camcorder again for automatic scene import. 
You no longer have to save DV AVI and audio files (which can be very large). If at a later time you
would like to work on a film again, but do not have the space to keep the material for it on your hard
disk
, then you can simply delete the bulky DV AVI and audio files. 
The basis for the log is the recording list in the DV recording, DV to MPEG recording, or HDV
recording's recording dialog. All recordings listed there are "logged". Recordings for which the
corresponding video material is no longer on the hard disk will appear as "planned recordings". Click the
record button to move all video files back to the hard disk
. 

Record dialog analog video recording
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 Video/Audio driver: Here you can set up the video card or sound card for recording. In practically
every case, the driver software supplied with the hardware
 must be installed. 
Hint: Under "video driver", you will find a "screen capture" entry in the Plus version. Read more about
how it functions in the chapter Screen (Plus version)
. 
Input/Tuner settings:
 If your video capture card supports multiple sources, i.e. your card also has a TV tuner or multiple
inputs (SVHS, composite, etc.), then you can select the proper recording source and the TV channel to
be recorded here. 
Save video file as / Save in following folder: Enter the name of the movie to be recorded here. You
can also select the folder where you wish to store your video file. The standard record folder is set as
default. The location of this folder can be changed in Path settings
 by going to "File -> Program settings -> Path settings". 
Edit after recording:
 Use this to access the automatic editing options. 
Recording quality: You can select from a variety of predefined quality levels from the list box. They are
listed according to picture quality. Using Configuration
 you can fine tune the quality for the selected preset. 
Presets displayed with "MPEG
" record directly in MPEG format. 
Tip:
 Use the presets marked MPEG if you want to burn your recordings straight away, since smart encoding
can omit laborious encoding after recording. 
Advanced...: Opens the video driver settings dialog
. 
Capture control:
 Here you'll find the "Red" record and "Stop" buttons. These start and stop recording. 
Timer recordings active/time limit:
 Specify a recording start time and length here to transform your PC into a fully functioning VCR. 
Snapshot!: Use the "Snapshot" button to create a still image
 directly from the preview monitor. The images are saved in the record directory as graphics files in the
set resolution. 
Recording information: 
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This shows statistical information such as the recording time, available space on the hard drive, the
recorded frames, and the "dropped" frames. Dropped frames are frames that have been left out because
the computer processor is too slow for the selected image format and cannot accept all incoming frames. 
Preview: Some graphics adapters allow you to reduce the system lead by deactivating the video
preview. If you hear an "echo", deactivate the audio
 preview. 
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Logging
 Logging means that MAGIX Movie Edit Pro 16 also saves the original position and additional
information (metadata, e.g. scene, take, rating, comments, etc.) about DV video and audio
 files. 
If does not find the corresponding DV and WAV
 files during the loading of a video, it will ask that the corresponding DV tape is inserted into the
connected camcorder again for automatic scene import. 
You no longer have to save DV AVI and audio files (which can be very large). If at a later time you
would like to work on a film again, but do not have the space to keep the material for it on your hard
disk
, then you can simply delete the bulky DV AVI and audio files. 
The basis for the log is the recording list in the DV recording, DV to MPEG recording, or HDV
recording's recording dialog. All recordings listed there are "logged". Recordings for which the
corresponding video material is no longer on the hard disk will appear as "planned recordings". Click the
record button to move all video files back to the hard disk
. 

Record dialog analog video recording

 Video/Audio driver: Here you can set up the video card or sound card for recording. In practically
every case, the driver software supplied with the hardware
 must be installed. 
Hint: Under "video driver", you will find a "screen capture" entry in the Plus version. Read more about
how it functions in the chapter Screen (Plus version)
. 
Input/Tuner settings:
 If your video capture card supports multiple sources, i.e. your card also has a TV tuner or multiple
inputs (SVHS, composite, etc.), then you can select the proper recording source and the TV channel to
be recorded here. 
Save video file as / Save in following folder: Enter the name of the movie to be recorded here. You
can also select the folder where you wish to store your video file. The standard record folder is set as
default. The location of this folder can be changed in Path settings
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 by going to "File -> Program settings -> Path settings". 
Edit after recording:
 Use this to access the automatic editing options. 
Recording quality: You can select from a variety of predefined quality levels from the list box. They are
listed according to picture quality. Using Configuration
 you can fine tune the quality for the selected preset. 
Presets displayed with "MPEG
" record directly in MPEG format. 
Tip:
 Use the presets marked MPEG if you want to burn your recordings straight away, since smart encoding
can omit laborious encoding after recording. 
Advanced...: Opens the video driver settings dialog
. 
Capture control:
 Here you'll find the "Red" record and "Stop" buttons. These start and stop recording. 
Timer recordings active/time limit:
 Specify a recording start time and length here to transform your PC into a fully functioning VCR. 
Snapshot!: Use the "Snapshot" button to create a still image
 directly from the preview monitor. The images are saved in the record directory as graphics files in the
set resolution. 
Recording information: 
This shows statistical information such as the recording time, available space on the hard drive, the
recorded frames, and the "dropped" frames. Dropped frames are frames that have been left out because
the computer processor is too slow for the selected image format and cannot accept all incoming frames. 
Preview: Some graphics adapters allow you to reduce the system lead by deactivating the video
preview. If you hear an "echo", deactivate the audio
 preview. 
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Record dialog analog video recording

 Video/Audio driver: Here you can set up the video card or sound card for recording. In practically
every case, the driver software supplied with the hardware
 must be installed. 
Hint: Under "video driver", you will find a "screen capture" entry in the Plus version. Read more about
how it functions in the chapter Screen (Plus version)
. 
Input/Tuner settings:
 If your video capture card supports multiple sources, i.e. your card also has a TV tuner or multiple
inputs (SVHS, composite, etc.), then you can select the proper recording source and the TV channel to
be recorded here. 
Save video file as / Save in following folder: Enter the name of the movie to be recorded here. You
can also select the folder where you wish to store your video file. The standard record folder is set as
default. The location of this folder can be changed in Path settings
 by going to "File -> Program settings -> Path settings". 
Edit after recording:
 Use this to access the automatic editing options. 
Recording quality: You can select from a variety of predefined quality levels from the list box. They are
listed according to picture quality. Using Configuration
 you can fine tune the quality for the selected preset. 
Presets displayed with "MPEG
" record directly in MPEG format. 
Tip:
 Use the presets marked MPEG if you want to burn your recordings straight away, since smart encoding
can omit laborious encoding after recording. 
Advanced...: Opens the video driver settings dialog
. 
Capture control:
 Here you'll find the "Red" record and "Stop" buttons. These start and stop recording. 
Timer recordings active/time limit:
 Specify a recording start time and length here to transform your PC into a fully functioning VCR. 
Snapshot!: Use the "Snapshot" button to create a still image
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 directly from the preview monitor. The images are saved in the record directory as graphics files in the
set resolution. 
Recording information: 
This shows statistical information such as the recording time, available space on the hard drive, the
recorded frames, and the "dropped" frames. Dropped frames are frames that have been left out because
the computer processor is too slow for the selected image format and cannot accept all incoming frames. 
Preview: Some graphics adapters allow you to reduce the system lead by deactivating the video
preview. If you hear an "echo", deactivate the audio
 preview. 
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Advanced configurations in the video capturing dialog
 Here you can adjust certain settings for the video recording driver. 
These dialog
 boxes, so-called "property sheets," come with the video card drivers. These driver-specific performance
properties may deviate depending on the cards. We also have a very limited influence on the behavior of
these drivers. If you encounter any difficulties, please contact the video card manufacturer for the latest
driver updates. 
Input
: Sets the crossbar of the video card. 
The crossbar determines which video and audio input signal will be recorded. The crossbars are
connected in series to the video recording chip itself. In the output field, the video output (for the
crossbars) is the input for the recording chip (video or audio decoder-in) of the video card. In the
"Input" field, select the signal source that will be used by the video card to capture for this input. Many
video cards have separate crossbars for audio and video. If you have a problem, try out the different
configurations until the right sound matches the right image
. 
Composite-in = the normal video input (typically a cinch jack) 
S-video = S-video input (mini-din jack) 
SVHS-in = SVHS input (special cable) 
Tuner-in = TV signal of the integrated tuner 
Imagesetting
 Video decoder: If the picture only appears in black & white or it flickers, the video standard may be set
incorrectly. In mainland Europe, PAL_B
 is used. 
VideoProcAmp
: Fine-adjustment of colors, brightness, contrast etc. We recommend against changing any of the
manufacturer's settings. 
Format
: Please do not change anything here. The capturing format is set in the "Recording quality" option in the
video recording dialog. 
Station selection
 This option is only available if a TV tuner is integrated into your video card. 
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Single frame
 The single-frame recording function lets you record snapshots directly from the connected video source.
This requires either a video clip compatible
 with DirectShow, a TV card, or a USB device such as a webcam. 
The time control function allows you to automatically take snapshots. Here are just a few examples of
where it might be used: 

 for creating photo stories from videos
 for animated films (stop-motion animation)
 for video surveillance
 or for time-lapse photography

The recorded images are added to the current arrangement. 

Video source:
 Sets the video card to be used to take pictures. 
How would you like to name the recorded JPEG file?: 
Enter the title of snapshots you are about to record. They are saved under this name and numbered
consecutively. You can also select the file path for storage. 
Resolution: The resolution of the recording is defined here. It corresponds to the resolution options
offered on the camera. The slider lets you set the image
 quality. Using higher resolutions results in larger file sizes for each recording; moving the slider in the
opposite direction sets the image quality back to the preset value. 
Advanced…: Opens the video driver settings dialog
. 
Camera noise during recording:
 You can make the program play a clicking sound each time a snapshot is taken. 
Recording: The red "Record" button
 triggers a snapshot or alternatively a series of recordings when using the time control function. 
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Time control
 Photo length in frames
: Specifies how long the photos appear in the slideshow. 
Interval
: When this function is activated, a series of images is made once the recording has started. Snapshots are
automatically saved and numbered consecutively at a preset time interval. 
For example, if you specify a two-second interval between shots and that each shot be added at a length
of 5 frames to the slideshow, then the end result is a time-lapse recording at 10x normal speed. 
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Enhanced single-frame recording dialog settings
 You can adjust certain settings for the video recording driver. 
These dialog
 boxes, so-called "property sheets", come with the video card drivers. The driver-specific features may
slightly vary from driver to driver. The MAGIX team has little direct influence on the performance of the
various drivers. If you encounter any difficulties, then please contact the video card manufacturer for the
latest driver updates. 
Input: Sets the crossbar switch of the video card. This lets you define what video and audio
 signal is used in the recording. The crossbars are connected in series to the video recording chip itself. 
Output: In the "Output" field
, the video output (for the crossbars) is the input for the recording chip (video or audio decoder in) of the
video card. In the "Input" field, you select the signal source to be used for this input by the video card
during recording. 
Composite in = the normal video input (typically a cinch jack) 
S-VHS in = S-VHS input (special cable) 
Tuner in = the TV signal of the built-in tuner 
Video decoder
: If the picture only appears in black & white or it flickers, then the video standard may be set incorrectly.
PAL_B is used in Germany and most European countries (France: SECAM; US/CAN: NTSC). 
VideoProcAmp
: For fine tuning of colors, brightness, contrast, etc. We recommend against changing any of the
manufacturer's settings. 
Format
: Do not change anything here! The capture format settings can be changed under "Resolution" in the
"Recording" dialog box. 
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Record screen contents (Plus version)
 Use this function to record everything that moves on your monitor. This process is called "screen
capturing". 

 Under "Recording quality", you will find various presets for different applications. You can either
record the entire monitor ("fullscreen"), a frame of variable size (e.g. to film the Windows Media
Player display), or a different video player. Click on "Configuration" to make custom size
adjustments.

Hint: Because many video players work with overlay, it is recommended to open each player before
 starting the capture! This way switching into "Overlay" mode can be prevented. 

 Click the "Record" button in the recording dialog. A small dialog with a red record button, a
black stop button as well as a frame with dashed bordering appears. Activate the option "Record
mouse pointer" to record the movements of the mouse pointer.

 Now select the screen area you wish to record, i.e. the screen of the video player in which the
video is playing. Drag the frame over the area you wish to record and adjust its size as required
by dragging the edges and corners.

 The actual recording process can be started by pressing the red "Record" button. The recording
starts; the record symbol appears in the task bar (tray).

 Once the video you wanted to record has come to an end, click on the "Record/Stop" button to
stop the recording. Recording ends and the recording dialog is visible once again.
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Edit after recording
The "Edit after recording" 
dialog
 can be opened from all
recording dialogs. 
All editing steps from
recording to automatic burning
can be carried out without
further user involvement. 

In the "Edit after recording" dialog you can: 
 Automatically search for and remove ads. For more on this please read the "Automatically search

for and remove ads" section in the PDF manual.
 Split up the material into scenes. Please read the "Automatic scene recognition" section for more

on this in the PDF manual.
 Set automatic chapter markers. Please read the "Set chapter markers automatically" section in

the "Edit menu" chapter in the PDF manual.
Burn disc immediately
: You can use this option to record and burn in a single step. Simply select the format you would like to
burn, insert a suitable blank disc into the drive, and then press record. 
Note: Make sure that the selected recording quality corresponds with the disc type (e.g. the preset "
MPEG
 DVD" for DVDs)! 
If you use your own settings for MPEG encoding (e.g. half image
 resolution for long-play DVDs), then make sure that the settings for recording and later for burning are
the same so that no new recording is necessary (Smart encoding). 
After recording, the program automatically switches to the "Burn" screen, the burn window opens, and
the disc is burned. The last set layout is used for the menu layout for the DVD. 
Tip
: This function is particularly suitable for burning lengthy disc projects directly to disc, since you can start
recording in the evening and have the finished DVD by morning. 
Export for mobile device: The recorded movie is immediately converted into the format of the selected
mobile device and transferred onto the device. The list field contains the device which has been selected
in the "Export video/audio
" dialog. 
Settings: Opens the export settings
 for the selected target device. 
Hint
: If you enter a file name and memory path in the export dialog, then the path is used but the file name is
ignored. For EPG-controlled TV recordings the name of the program is used instead. 
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Audio
 Songs, noises, or instruments can be easily recorded in MAGIX Movie Edit Pro 16 using the audio
 recording function. A hooked-up microphone or various audio devices (especially a stereo system) can
be used as recording sources. 
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Connecting the source for recording
 First of all, the source of the audio
 material must be connected to the sound card input. Again, there are several possibilities which primarily
depend on the type of equipment you have. 
If you want to record material from a stereo system, then you can use the line-out or AUX out jacks on
the back of your amplifier or tape deck. This involves connecting them to the sound card input (usually
red). 
If your amplifier has no separate output (other than for the speakers), then you can use the connection
intended for headphones for your recordings. In most cases, you will need a cable with two mini-stereo
jacks. This type of connection has the advantage of being able to set the headphone input signal level with
a separate volume. As headphone connections generally are not the best, it is advised that you use the
line outputs if possible. 
When recording cassettes from a tape deck, you can connect the tape deck's line out directly to the
sound card input. 
When recording from vinyl records, you should not connect the record player's output directly with the
sound card because the phono signal needs to be pre-amplified. A more suitable method would be to use
the headphone connection or an external pre-amp. 
If you are recording from a microphone, then please connect the microphone to the microphone jack on
your sound card (usually red). 
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Adjusting the signal level
 Adjusting the signal level to the sound card is also recommend to get the best sound quality during digital
recording. 
Once a recording source is connected to the sound card, the "Record" button opens the recording dialog
 and starts the recording source. 
You can now adjust the recording level with the help of the LED display in the recording dialog. For this,
you must first check off "Show levels". 
If the adjustment is set too high, distortion occurs and the incoming signal must be reduced. If you have
connected the source through either an amplifier or tape deck output to the sound card, you can only
reduce the signal level in your sound card's software mixer interface. You can access the mixer directly
from within the recording dialog via the "Recording level" button
. 
If you reduce input sensitivity by using the input fader
, the resolution at which the analog signal is digitized is also reduced. Try to set these automatic
controllers to the loudest sound level possible! 
The maximum setting for an optimal level is the loudest part of the material. The loudest part should be
adjusted to be the maximum. The actual recording begins when you press the "Record" button.  At the
end of the the recording you will be asked if you want to use the recording. Upon confirmation, the
newly-recorded material will be placed in the next free track at the position of the start maker in the
arrangement. 
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"Audio record" dialog

 Audio driver:
 Selects the sound card for the recording. 
Save audio file as/ save in the following folder:
 Here you can select the title of the audio file you wish to record. You can also select the folder where
you wish to store the file. 
Recording quality: Sets the sound quality of the recording. In the preset menu you can choose between
medium wave
 radio ("AM tuner"), UKW ("FM Radio"), DAT (Digital Audio Tape) and CD quality. 
Peakmeter (Monitor): Using the peakmeter, you can monitor the level of the incoming signal. Please
read more on this in the chapter "Adjusting levels"
 Recording: This button
 starts the actual recording. 
Stop: Click this button
 to stop recording 
Normalize after recording: With this option activated, your material's volume is raised to a proper level
after recording is completed. In order to achieve good results, you should try to record the source as
loud as possible without overmodulating it. To do so, refer to the peak meter reader in the recording 
dialog
. 
Playback while recording: This option is particularly important for spoken commentary, etc. If
activated, the selected movie (or selected scene
 if recorded in the "Edit" screen) is played while recording. This acts as orientation for the movie. 
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Advanced: Use this button
 to open a window where you can select from special features: 

Page 148



Advanced options
  "Mono" creates a mono recording and requires half of the hard drive space required for stereo.
 "Real-time sample rate adjustment" automatically matches the sample rate of a new file to be

recorded with the sample rate of the selected movie sound track.
 "Ducking" (reducing the sound volume): To add narration or other sound material to a video that

already has sound volume levels set, activate the option "Automatic reduction of sound volume of
remaining audio tracks". This automatically reduces the volume of audio objects in the arranger
during the recording session ("ducking"). A volume curve controls the whole process, produces
the fading in and out of effects automatically and guarantees consistent overall volume.
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AVCHD recording (Plus version)
 This recording is actually not really a recording as such, but rather "only" the transfer of the already
created video file and its import into the existing project
. 
AVCHD
 requires a special UDF driver (normally included with the camera) to be installed before the DVDs or
removable storage can be imported into Windows. This isn't necessary for AVCHD cameras with
built-in hard drives. The camera is preset as a drive as soon as the USB cable is connected to the PC.
This additional drive is then visible in the Media Pool, and the corresponding M2TS files can be simply
dragged from the list. 
Files with the M2TS extension can easily be dragged down from the Media Pool (above right). You will
be asked during the first import if you want to convert the movie into the MPEG
-2 format. You should definately answer this question with "Yes", since only then will you be able to edit
your movies in real time. We also recommend you activate the check box "Don't ask me again". The
advantage is that you won't have to answer this query every single time you import individual files. 
Switch on hardware acceleration, too (press "P -> Display options -> Playback in Arranger -> Video
mode -> Direct3D hardware acceleration"). This lets you playback multiple tracks simultaneously with a
modern graphics card (better than ATI Radeon 1300). Another advantage of converting to MPEG-2 is
the option of using "smart encoding". The sound will be re-encoded to guarantee synchronicity of image
and audio
. It is currently not possible to maintain 5.1 sound; this is automatically converted to MPEG stereo. 
Note: Since AVCHD contains AVC (also called H.264), it is necessary to activate the MPEG-4
encoder. MAGIX Movie Edit Pro 16 offers this option as soon as the codec is required. The Dolby
Digital Stereo decoder will also be required, since AVCHD
 files include Dolby Digital sound. 

AVCHD activation details
 Attention: For AVCHD support, Dolby Digital Stereo and the MPEG-4 codec must be activated. To
convert AVCHD videos to MPEG
-2, the MPEG-2 codec must be activated. 

Page 150



Import a non-copy-protected DVD
 In case the record screen is open, switch into the Edit screen. This can be done using a double click on
the desired movie
. 
Click in the Media Pool under "Import" on "Computer" and select by double clicking the DVD drive
where the DVD to be imported is located. 
Now you can load the listed VOB files into the project as described in the "Add objects into the project"
chapter. MAGIX Movie
 Edit Pro 16 recognizes which files belong together, so that you only have to load one file. 
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MAGIX Videorecorder
 MAGIX Movie
 Edit Pro 16 provides you with a PC-based TV and video recorder. A functional TV card/TV tuner box
or DVB-T/S card is required to use MAGIX Videorecorder. 
In this chapter
Hook up TVs or other display devices
Buttons overview
VCR settings
Setup for DVB cards
Configure channels for analog reception
Channel list for analog programs
Channel list for DVB cards
TV program
Timer programming
Manual timer programming
Timeshift mode
Save recorded programs
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Hook up TVs or other display devices
 With MAGIX Videorecorder and other suitable TV cards/TV tuner boxes you can transform your PC
into a TV. You can have your TV program displayed on devices connected to your computer like PC
monitors, video projectors or TV devices. Simply connect up the desired output device to the VGA
output (TV symbol) of your graphics card. 
Tip:
 When connecting video projectors to notebooks "No signal" may be displayed. In this case, switch to
the VGA output of the laptop using the key combination Fn+Screen key. 
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Buttons overview

1 Reset to start view
2 Recording
3 Timeshift mode
4 Instant record
5 Favorites + Channel list
6 Switch back to previous channel
7 Switch to next channel
8 Mute

: Turns off sound 
9 Turn down sound
10 Turn up sound
11 Hide/Show info area
12 Setup: Open settings dialog
13 Timer

: Program timer control 
14 Program: Electronic program guide (EPG)

DVB TV guide or (MAGIX Online TV Guide). 
15 Open recordings folder

If you have opened the MAGIX Videorecorder directly,
you can easily edit the program that you have just recorded
using the main program. 
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VCR settings

 The button opens the settings dialog
 for the VCR. 

Video driver: Configure the driver of your TV card here. You can also select DVB-S and DVB-T
cards. In this case the dialog is replaced with a simpler version (see below)
. 
Audio driver:
 Configure the audio driver of the sound card or the sound device you would like to use for recording
and playing TV sound. 
The peak meter indicates an existing audio signal. It is optimally calibrated if the loudest parts just reach 0
dB. 
Level: Here you can open a level fader
 to customize the controls. 
Automatic mixer control: Adjusts audio playback to the record status, i.e. you will hear the input signal
while you are watching live TV. The wave output is muted. The line input is also automatically selected as
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the recording source. Deactivate this option only if you want to use a different sound card input. With the 
Mixer button
 you can select the input manually. 
Save in the following folder: 
Select the folder to which you wish to save your video file. The standard recording folder (TV
recordings) is set as the default folder. 
Edit after recording:
 This option opens the "Edit after recording" dialog. Read more on this in the chapter "Recording
interface". 
Select record format: Choose from different recording formats according to your needs, or define your
own via "Configuration
". 
Advanced opens the special settings options of the TV card
. Please also observe the general information on TV formats. 
Optimize image for PC: This option activates a special deinterlacing function for optimizing TV playback
on your PC's screen. It is not supported by every graphics/TV card combination and in any case requires
a DirectX-compatible
 graphics card driver. 
Cable/Antenna:
 Specify whether you are receiving the TV signal via cable or an antenna. 
No picture while recording: To reduce the CPU
 load you can suppress output of the TV picture while recording. 

Remote Control
 Here you will find a selection of remote controls from various manufacturers for controlling the MAGIX
Videorecorder. If you find that you own none of the remote controls, simply try out various settings. 
Hint: Some remote controls require that their reception software is running, otherwise they will not be
recognized by MAGIX Movie
 Edit Pro 16. 
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Setup for DVB cards

 No picture while recording: 
This option serves to free up processing power on your computer: Pictures will not be displayed while
recording. 
Call up EPG information in the background: EPG information is open in the background while you
watch TV. Once you open the timer dialog
 for programming a recording, the information will be made available to you immediately. 
Synchronize time:
 The system clock is synchronized with the DVB time. 
Analyze commercials while recording:
 Commercials are recognized while recording. The programs are edited directly after recording (see
dialog: Edit after recording). 
Prefer Dolby® Digital Audio:
 If the channel offers Dolby® Digital sound in addition to the normal stereo sound, Dolby® will be
chosen automatically. 
To edit Dolby® Digital Audio in MAGIX Movie
 Edit Pro 16 a Dolby® Digital codec has to be activated. 
Play Dolby® Digital in surround mode: If you own a Dolby® Digital Surround sound stereo, you can
playback all programs with 5.1 Surround sound on your system by choosing this option. First, make sure
that the channel you've selected broadcasts in 5.1 format. To be able to receive the corresponding
programs in 5.1 Surround, you must either select the "Prefer Dolby® Digital Audio" option, or select an
Dolby®

 Digital audio channel for the network in the advanced mode. 
Edit after recording: This option opens the "Edit after recording" dialog
. Read more on this in the chapter "Recording interface". 

Remote Control
 Here you will find a selection of remote controls from various manufacturers for controlling the MAGIX
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Videorecorder. If you find that you own none of the remote controls, simply try out various settings. 
Hint: Some remote controls require that their reception software is running, otherwise they will not be
recognized by MAGIX Movie
 Edit Pro 16. 
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Configure channels for analog reception
 For digital TV reception (DVB-T/S) MAGIX Movie
 Edit Pro 16 is already equipped with a pre-configured channel list. 
With analog TV reception (antenna or cable), however, you will have to set up the TV channels you
can/wish to receive before using the TV or the VCR for the first time. This is done much in a similar way
to using a "real" TV by using the in-built channel search function. 

 In the start view of the MAGIX
Videorecorder click on the "TV" button
switch it on.

 On the transport control below click on
the television symbol to open the
favorites and the channel list.

 The empty
favorites list will
now open. 

 At the top of the
list click on the
"Channel list" 
button. You will
now be shown
the list of set
channels. The
favorites list is
empty, but that's
what is about to
change. Click on
"Advanced" to
access the
channel list
options.
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 In the options field to the right you can start the channel search function and configure the channel
list. 

Tip:
 The option "Switch on fine-tuning during autosearch" increases the likelihood of finding TV channels
accurately. Reception will improve, but it will take longer for the channel search function to complete. 
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Channel list for analog programs
You can access the channel list by clicking on the
corresponding symbol in the transport control and then
on the "Channel list" button. Open the "Channel list"
dialog options by clicking on the "Advanced" button
. 

Channel list: 
The programmed channels are displayed in the channel list to the left. 
Add/Remove channels: 
Use these options to add/remove channels from the list. 
Start channel search function:
 After opening the dialog for the first time, the first thing you should do is activate the station search
function. Here, according to the selected reception option (cable or antenna), the frequency range will be
searched for channels that it can receive. 
Switch on fine-tuning during autosearch: 
This option increases the likelihood of finding TV channels. Reception will improve, but it will take longer
for the channel search function to complete. Found channels will be numbered in the channel list. 
Move channel
: Use the arrows to move the position of a channel up and down in a list. 
Channel name:
 The corresponding channel name can be added to each channel entry. This has to be done manually,
because channel networks are not numbered uniformly. Select the channel from the list and enter the
appropriate name on the right. 
Video frequency: If the image
 of sound reception is poor, the frequency can be fine tuned using the "+" and "-" buttons to improve it. 
Note:
 It's important that the channels are given the correct names as the Electronic Program Guide programs
the VCR using these names. 
Import/Export:
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 You can save the current MAGIX channel list using the Export button. Using the Import button, it is
possible to import a channel list. This way you can, for example, use the channel list that you have
created in an earlier program version or in a different MAGIX program with a TV function. 
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Channel list for DVB cards
 If you select a DVB card as your TV tuner, a few details are changed in the station configuration.
Furthermore, DVB includes its own EPG (Electronic Programming Guide). 

Stations are grouped together in so-called "Bouquets". The station list shows only these channel bunches,
and individual stations can be displayed with a double click. They don't have to be renamed. At the top
of the list is a favorites packet, which allows you to sort your favorite stations with the "Favorites" button
. 
Use "Advanced"
 to access the settings for the station search function and for the individual channels. With DVB-S the
satellite can be selected, and with DVB-T you can select the region. Using frequency lists, you can
quickly find stations. With "Individual frequencies", you can make a specific station search through
particular frequencies. It will find available channels and sort them into new or available "bunches". 
Multi LNB configuration: Opens the hardware
 configuration for DVB-S cards. If the VCR opens correctly but you still don't receive a picture, you can
make additional settings here. If you have several LNBs connected to your satellite system, you can also
configure them here. 
List channels automatically: All channels are automatically listed alphabetically (irrespective of the
bunch they belong to). The channels are automatically marked with icons indicating whether they are
normal, encrypted ("crypt") or radio channels ("audio
"). 
Search for channels:
 Entering the first letter will help you find your channel faster. 
Edit channels:
 Here you can sort a channel into the favorites packet and specify whether or not EPG data should be
requested or not. Since some stations have multiple sound tracks, you can select them with "audio
channel". This concerns especially channels with Dolby® Digital 5.1 Surround Sound. 
Import/Export: You can save the current MAGIX channel list using the Export button
. Using the Import button, it is possible to import a channel list. This way you can, for example, use the
channel list that you have created in an earlier program version or in a different MAGIX program with a
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TV function. 
In case you use a DVB-T card, you can visit http://www.linuxtv.org/vdrwiki/index.php/Main_Page
 for more information. 
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TV program
 The "Program" button
 in TV mode of the MAGIX Videorecorder opens the TV program view. 

This provides the option to get informed without any paper about TV programs: The free DVB-TV
Guide offers a 14-day overview of the TV schedule. DVB reception via a DVB stick or a DVB card is
required for this to work. The program overview can be selected via the "TV program" button
. 

The DVB TV replaces your conventional TV guide and provides more comfort than your standard
guide: 

 You can search for specific programs, for example, if you can't quite remember which channel
shows your favorite program.

 Shows can be programmed directly as recordings without having to tediously program your
video recorder, saving you time.

 You can set the order of the channel list yourself, without having to stick to the order of your
standard TV guides.

Page 165



Additional information about the selected program
 The "Additional information" dialog
 can be opened by double-clicking on a program. Here you will find detailed information on the selected
program. This may also include an age recommendation if provided. 
Recording: The selected program is added to the timer of the VCR if you click on the "Record" button
. 

This symbol appears in programs that are broadcast in 
16:9
 (widescreen) format. 

Page 166



Capture options
 In this dialog
 you can specify actions that should be executed after the last programmed recording: shut down the
computer and update the EPG files. 
Recording time adjustment:
 If the EPG data differs from the actual starting and finishing times of the shows, you can set the buffer
times here to start the recording earlier or finish it later. 

Page 167



Timer programming
The timer programming for time-controlled VCR
recordings can be opened via the "Timer" button
. 

Note: If you use one of the two integrated EPGs (the DVB TV Guide or the MAGIX Online TV Guide,
the data of the EPG is used to make timer programming easier. If you choose not to use either of the
EPGs, you can also choose to execute the timer programming manually
. 
If recordings have been programmed and you exit MAGIX Movie
 Edit Pro 16, a small tray symbol makes sure that just before the recording starts, MAGIX Movie Edit
Pro 16 starts again and the VCR turns on. 
Note! 
The automatic updates from Windows XP (with SP2) & Windows Vista may force the computer to
reboot, so that the programmed recording will be interrupted or not started at all. For this reason, it is
recommended that you deactivate automatic updates for Windows. 
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Recordings: First of all, select the program you wish to record from the list on the left. Then click on the
"Record" button
 to move the show into the recording list on the right. 
More information
: Here you can check up on additional information relating to a show. 
Edit
: This button (or by double clicking entries in the recording list) opens the "Program recording" dialog. 
Remove
: This button removes the selected shows from the recording list. 
Manual programming
: You can also insert, edit, or remove recordings manually. This is especially necessary if you use neither
the DVB TV Guide nor MAGIX Online TV Guide. 
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Manual timer programming

 Recording start/end:
 Here you can specify when the recording should start and end as well as the date. Clicking on the date
opens up a calendar. 
Channel:
 Here you can specify which channel is to be recorded. 
Repeat:
 Here you can define a series of recordings to record daily or weekly shows. 
Recording/Folder name:
 You can also give the recording a descriptive title and change the recording folder. 
Correct time at end of recording (min):
 If the recording time was programmed via the EPG, you can add additional time to extend the record
time. 
Timeshift recording:
 Recording starts in Timeshift mode, i.e. you can already watch the program while it is being recorded. 

Timeshift mode
In Timeshift mode for analog TV cards the program can
be recorded and played back at the same time. This way,
a TV show can be watched with a time delay if so
wished. 

As soon as you switch to Timeshift mode, the show is "stopped". Of course, it remains running in the
background and is still being recorded. A transport console opens. Use this to move back and forth
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through the program. This way you can, for example: 
Stop the program to take a telephone call. To do so,
simply activate Timeshift mode. Once you're finished
with your call and you wish to resume viewing, click on
the playback button
. 
Fast forward the ads. Start the video recorder in
Timeshift mode when the program starts. Then do
something else for roughly the amount of time ads will
show throughout the duration of the program. When you
decide that you want to watch the program, press the
play button
. If an ad-block comes, simply use the "Jump ahead 30
seconds" button to skip the ads. 
Replay: Here you can rewind. Start Timeshift mode and
playback at the exact same time. Now move the
position slider
 to the far right. Playback is now in the "present". If
something exciting happens, you can use the "Jump back
30 seconds" button to get an action replay, just like if
you are watching a football match. 
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Timeshift mode
In Timeshift mode for analog TV cards the program can
be recorded and played back at the same time. This way,
a TV show can be watched with a time delay if so
wished. 

As soon as you switch to Timeshift mode, the show is "stopped". Of course, it remains running in the
background and is still being recorded. A transport console opens. Use this to move back and forth
through the program. This way you can, for example: 

Stop the program to take a telephone call. To do so,
simply activate Timeshift mode. Once you're finished
with your call and you wish to resume viewing, click on
the playback button
. 
Fast forward the ads. Start the video recorder in
Timeshift mode when the program starts. Then do
something else for roughly the amount of time ads will
show throughout the duration of the program. When you
decide that you want to watch the program, press the
play button
. If an ad-block comes, simply use the "Jump ahead 30
seconds" button to skip the ads. 
Replay: Here you can rewind. Start Timeshift mode and
playback at the exact same time. Now move the
position slider
 to the far right. Playback is now in the "present". If
something exciting happens, you can use the "Jump back
30 seconds" button to get an action replay, just like if
you are watching a football match. 
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Save recorded programs
 Use the video recorder button
 "Open recording folder" to access the folder with the recorded programs. 

A standard dialog
 for file selection now opens. 
You can sort the programs according to channel, name and record time, delete programs or view
advanced EPG information for the program. DVB radio recordings are not played by the video recorder,
but you can press a button
 to listen to the recordings using MAGIX Music Manager. 
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Insert object into the project
In this chapter
Video monitor
Load files
Load parts of film files.
MPEG-4 import
Automatic scene detection
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Video monitor
 All selection processes are conducted on the video monitor. Here you can view and edit material before
importing. There is a preview function for all of the files in the Media Pool. 

 Use the playback button to start the preview of video or image objects in Media Pool. For
special objects like titles or fades a preview is given.

 Audio files and synthesizer objects from the Media Pool can also be listened to using the
playback button. 

Tip: Useful presets for the arranger and video monitor can be found in the tab Display presets
 in the program settings. 

Full screen view
 The option "full screen" in the context menu
 maximizes the preview monitor. Alternatively, a double click on the monitor or "A+Enter" also maximizes
the window. The fullscreen view is especially recommended for working with two screens; one screen for
the film preview, and the other for the arranger. 
You can also shift the monitor into full screen mode and access it via the context menu (right mouse
button
). There, you can also hide and display the basic transport controls. 
With "Esc" you will go back to the normal view (or click on "smaller" button
 to the right in the fullscreen mode). 

Show movie overview
 The option "Film overview" in the "Window" menu
 enables an overview of teh entire arranger. All objects in the arranger will be displayed in the program
monitor. The overview display is especially recommended for work with long movies because the
reduced overview in the program monitor and the zoomed detailed view in the arranger present a good
combination. 
The film overview can be used for moving around in the movie
 and for editing certain parts: 

 When you click on a certain object in the video monitor, the arranger will zoom on that object. 
 Using the mouse, you can draw a frame in the video monitor ? and the corresponding range will

be zoomed in the arranger.
 When you move the playback marker in the video monitor, the arranger playback marker will

also move correspondingly.
Tip:
 If you use this option very often, you can use the keyboard shortcut (Shift + A). 

Load files
 Media files can be loaded into the Arranger from the Media Pool in several different ways: 

 The fastest way: Drag the desired file with the mouse button held down from the Media Pool
into the desired track. If there are objects at this position, the file is inserted at the desired time
position at the next empty track below.

 Load several files: If you would like to load several files, hold down the "Ctrl" key while
clicking on the entries you would like to use. If you would like to load a sequence of files, hold
the "Shift" key and first click on the first entry, then on the last. All entries lying in between are
marked. Every file can be moved from the Media Pool to the Arranger using drag & drop.
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 DVD files (VOB) with multiple audio tracks
 MAGIX Movie Edit Pro 16 also loads VOB files that contain multiple audio
 tracks. After the VOB file loads, simply click the audio object created and select the desired audio
track. 
Note: To view and select audio
 objects in the arrangement, Timeline mode must be active. 

Load parts of film files.
 For longer videos, it is recommended to define the areas which should be loaded into the project
 before import. For this, and in and out point is set, defining the area. This is done in the following way: 

 Please select a file from the Media Pool by double clicking on it. Play it back using the play
buttons to indicate the section which you want to use in the project.

 Either move the area markers directly with held
down mouse button or set them using the buttons or
the shortcut I and O. The shortcuts are especially
useful for exact positioning using the shuttle and the
jog wheel.

 Left-click on the monitor and drag it down with the held-down mouse. An object will appear on
the track and in the project folder simultaneously, corresponding to the selected area.
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Full screen view
 The option "full screen" in the context menu
 maximizes the preview monitor. Alternatively, a double click on the monitor or "A+Enter" also maximizes
the window. The fullscreen view is especially recommended for working with two screens; one screen for
the film preview, and the other for the arranger. 
You can also shift the monitor into full screen mode and access it via the context menu (right mouse
button
). There, you can also hide and display the basic transport controls. 
With "Esc" you will go back to the normal view (or click on "smaller" button
 to the right in the fullscreen mode). 

Show movie overview
 The option "Film overview" in the "Window" menu
 enables an overview of teh entire arranger. All objects in the arranger will be displayed in the program
monitor. The overview display is especially recommended for work with long movies because the
reduced overview in the program monitor and the zoomed detailed view in the arranger present a good
combination. 
The film overview can be used for moving around in the movie
 and for editing certain parts: 

 When you click on a certain object in the video monitor, the arranger will zoom on that object. 
 Using the mouse, you can draw a frame in the video monitor ? and the corresponding range will

be zoomed in the arranger.
 When you move the playback marker in the video monitor, the arranger playback marker will

also move correspondingly.
Tip:
 If you use this option very often, you can use the keyboard shortcut (Shift + A). 

Load files
 Media files can be loaded into the Arranger from the Media Pool in several different ways: 

 The fastest way: Drag the desired file with the mouse button held down from the Media Pool
into the desired track. If there are objects at this position, the file is inserted at the desired time
position at the next empty track below.

 Load several files: If you would like to load several files, hold down the "Ctrl" key while
clicking on the entries you would like to use. If you would like to load a sequence of files, hold
the "Shift" key and first click on the first entry, then on the last. All entries lying in between are
marked. Every file can be moved from the Media Pool to the Arranger using drag & drop.

 DVD files (VOB) with multiple audio tracks
 MAGIX Movie Edit Pro 16 also loads VOB files that contain multiple audio
 tracks. After the VOB file loads, simply click the audio object created and select the desired audio
track. 
Note: To view and select audio
 objects in the arrangement, Timeline mode must be active. 

Load parts of film files.
 For longer videos, it is recommended to define the areas which should be loaded into the project
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 before import. For this, and in and out point is set, defining the area. This is done in the following way: 
 Please select a file from the Media Pool by double clicking on it. Play it back using the play

buttons to indicate the section which you want to use in the project.
 Either move the area markers directly with held

down mouse button or set them using the buttons or
the shortcut I and O. The shortcuts are especially
useful for exact positioning using the shuttle and the
jog wheel.

 Left-click on the monitor and drag it down with the held-down mouse. An object will appear on
the track and in the project folder simultaneously, corresponding to the selected area.
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Show movie overview
 The option "Film overview" in the "Window" menu
 enables an overview of teh entire arranger. All objects in the arranger will be displayed in the program
monitor. The overview display is especially recommended for work with long movies because the
reduced overview in the program monitor and the zoomed detailed view in the arranger present a good
combination. 
The film overview can be used for moving around in the movie
 and for editing certain parts: 

 When you click on a certain object in the video monitor, the arranger will zoom on that object. 
 Using the mouse, you can draw a frame in the video monitor ? and the corresponding range will

be zoomed in the arranger.
 When you move the playback marker in the video monitor, the arranger playback marker will

also move correspondingly.
Tip:
 If you use this option very often, you can use the keyboard shortcut (Shift + A). 

Load files
 Media files can be loaded into the Arranger from the Media Pool in several different ways: 

 The fastest way: Drag the desired file with the mouse button held down from the Media Pool
into the desired track. If there are objects at this position, the file is inserted at the desired time
position at the next empty track below.

 Load several files: If you would like to load several files, hold down the "Ctrl" key while
clicking on the entries you would like to use. If you would like to load a sequence of files, hold
the "Shift" key and first click on the first entry, then on the last. All entries lying in between are
marked. Every file can be moved from the Media Pool to the Arranger using drag & drop.

 DVD files (VOB) with multiple audio tracks
 MAGIX Movie Edit Pro 16 also loads VOB files that contain multiple audio
 tracks. After the VOB file loads, simply click the audio object created and select the desired audio
track. 
Note: To view and select audio
 objects in the arrangement, Timeline mode must be active. 

Load parts of film files.
 For longer videos, it is recommended to define the areas which should be loaded into the project
 before import. For this, and in and out point is set, defining the area. This is done in the following way: 

 Please select a file from the Media Pool by double clicking on it. Play it back using the play
buttons to indicate the section which you want to use in the project.

 Either move the area markers directly with held
down mouse button or set them using the buttons or
the shortcut I and O. The shortcuts are especially
useful for exact positioning using the shuttle and the
jog wheel.

 Left-click on the monitor and drag it down with the held-down mouse. An object will appear on
the track and in the project folder simultaneously, corresponding to the selected area.
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Load files
 Media files can be loaded into the Arranger from the Media Pool in several different ways: 

 The fastest way: Drag the desired file with the mouse button held down from the Media Pool
into the desired track. If there are objects at this position, the file is inserted at the desired time
position at the next empty track below.

 Load several files: If you would like to load several files, hold down the "Ctrl" key while
clicking on the entries you would like to use. If you would like to load a sequence of files, hold
the "Shift" key and first click on the first entry, then on the last. All entries lying in between are
marked. Every file can be moved from the Media Pool to the Arranger using drag & drop.

 DVD files (VOB) with multiple audio tracks
 MAGIX Movie Edit Pro 16 also loads VOB files that contain multiple audio
 tracks. After the VOB file loads, simply click the audio object created and select the desired audio
track. 
Note: To view and select audio
 objects in the arrangement, Timeline mode must be active. 

Load parts of film files.
 For longer videos, it is recommended to define the areas which should be loaded into the project
 before import. For this, and in and out point is set, defining the area. This is done in the following way: 

 Please select a file from the Media Pool by double clicking on it. Play it back using the play
buttons to indicate the section which you want to use in the project.

 Either move the area markers directly with held
down mouse button or set them using the buttons or
the shortcut I and O. The shortcuts are especially
useful for exact positioning using the shuttle and the
jog wheel.

 Left-click on the monitor and drag it down with the held-down mouse. An object will appear on
the track and in the project folder simultaneously, corresponding to the selected area.
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Load parts of film files.
 For longer videos, it is recommended to define the areas which should be loaded into the project
 before import. For this, and in and out point is set, defining the area. This is done in the following way: 

 Please select a file from the Media Pool by double clicking on it. Play it back using the play
buttons to indicate the section which you want to use in the project.

 Either move the area markers directly with held
down mouse button or set them using the buttons or
the shortcut I and O. The shortcuts are especially
useful for exact positioning using the shuttle and the
jog wheel.

 Left-click on the monitor and drag it down with the held-down mouse. An object will appear on
the track and in the project folder simultaneously, corresponding to the selected area.
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MPEG-4 import
 MPEG -4 files can be loaded from the Media Pool just like other files using drag & drop. Videos that
have a higher horizontal resolution than 768 pixels can only be imported by MAGIX Movie
 Edit Pro 16 Plus. 
Note: To import and export AVC and MPEG-4 files, the MEPG-4 codec must first be activated. A
dialog will open if the codec is required. Files with a horizontal resolution of more than 768 pixels can
only be loaded in MAGIX Movie
 Edit Pro 16 Plus. 
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Automatic scene detection 

Automatic scene recognition can be opened via the "Effects" menu
. The scene recognition function analyzes the film for scene transitions and scans for drastic changes in the
brightness and color distribution within the picture. 
Automatically created timestamps from digital video devices (the points in time at which the device was
turned on and off) are also marked as scenes. 

1. First, select "Start" from the "Search scene change" box. The search for possible scene transitions
will begins. If you have a large amount of material, then this may take a while, but the image
analysis has to be done just once for each recording. The results are saved together with the
video file.

1. If the scene recognition is performed again with the same source material, then the scene
transitions found are immediately displayed. If you are still not happy with the resulting scene
partitioning simply repeat and correct where necessary.

2.  All found scene transitions in the list can be checked in the dialog. Every scene marker can be
selected or deleted. Select a scene transition from the list of found scene transitions and use the
preview images to check whether the found transition is really a scene change or not. 

Tip: 
This option is helpful, for example, if a camera flash was captured in the source footage. The flash from
the camera would cause a sudden brightness modification even though there was no actual scene
change. 
The preview always displays the end of the previous scene and the beginning of the new scene. If the
images do not differ except for the brightness, then the scene may have been falsely recognized. In this
case select "Delete scene marker"
. 
Via the zoom +/- buttons you can enlarge the part of the arranger where the selected scene begins or
previous scene ended. 
You can use the "Sensitivity"
 controller to change the sensitivity of the scene recognition to detect different scene changes, depending
on the settings. 
"Action on OK" lets you specify whether the movie should be cut at the selected scene transition or at
all scene
 transitions and whether the found scenes should be saved as takes. 
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Working with objects
In this chapter
Select objects
Moving objects
Splitting objects
Edit menu
Duplicate objects
Object handles
Shrink or interlace videos
Extract sound from videos
Save objects separately
Video mix
Magnetic objects
Transitions (fades)
Overview mode
Grid and snap
Searching for and removing ads (Plus version)
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Select objects
 To edit or delete objects using the menus, you must first select them. To do so, simply click on the
object you wish to select. Objects will change color to show that they have been selected. 
When the "Shift" key is pressed, multiple objects are selected. You can open up a rectangle positioning
the mouse over the object, then holding down the mouse button
 and marking all objects within the rectangle ("elastic band selection") by left clicking and dragging. 
Any object can be combined with others to make up a group to avoid objects being unintentionally
moved out of relation to each other. Once they are combined, clicking on one object of a group will
select the entire group. To group or ungroup objects, use the buttons in the tool bar or the corresponding
commands in the "Edit" menu
. 
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Moving objects
 Any object selection can be moved (dragged) along the horizontal timeline or vertically into different
tracks by clicking and holding the left mouse button on the selected objects. After releasing the mouse
button
 the objects appear at the new location. 
If the "Shift" key is pressed while moving the object selection, then the object's horizontal time position
will be maintained. The object selection can only be moved vertically (up and down to different tracks). 

Splitting objects
 All objects can be split. Each object section then becomes is then split into individual objects. 

 First of all, select the object to be split.
 Position the playback marker at the position where

the movie is to be cut.
 Click on the "Cut" button or select the "Cut" option in

the "Edit" menu.
In order to rejoin these split objects at a later stage, simply highlight the individual parts and select the
command "Create group" to group the selected objects together. 

Edit menu
With a click on the small arrow beside the cut button, you can
access the cut menu
. There you will find further relevant commands. 
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Splitting objects
 All objects can be split. Each object section then becomes is then split into individual objects. 

 First of all, select the object to be split.
 Position the playback marker at the position where

the movie is to be cut.
 Click on the "Cut" button or select the "Cut" option in

the "Edit" menu.
In order to rejoin these split objects at a later stage, simply highlight the individual parts and select the
command "Create group" to group the selected objects together. 

Edit menu
With a click on the small arrow beside the cut button, you can
access the cut menu
. There you will find further relevant commands. 
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Edit menu
With a click on the small arrow beside the cut button, you can
access the cut menu
. There you will find further relevant commands. 
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Split
 This command cuts a scene
 at the point where the playback marker is positioned. This way, two free-standing objects are created. 
Keyboard shortcut: T 

Remove start
 This command cuts a scene
 at the point where the playback marker is positioned and removes the material before the playback
marker. 
Keyboard shortcut: K 

Remove object end
 This command cuts a scene
 at the point where the playback marker is positioned and removes the material behind the back marker. 
Keyboard shortcut: U 

Remove scene
 If you want to cut a scene out of a movie
 retroactively, this option automatically moves all objects, titles, and transitions on all tracks forwards so
that no gaps result. 
Objects on other tracks which project
 into the area of the selected scene will not be moved automatically; they will remain at the current
position. 
Keyboard shortcut: Ctrl + Del 

Split movie
 This command splits a movie at the point where the playback marker is positioned, making two separate
movies. The part before the playback marker will remain in the arranger. The remaining part will be
erased from the current arranger and turned into a new movie, which can be found in the "Window" menu
. 
Keyboard shortcut: Alt + T 

Duplicate objects
 It is easy to copy objects to create larger arrangements from small audio
 or video loops quickly. Speed up this process by clicking on the object to be copied with the mouse
while holding down the "Ctrl" key. This generates a copy which you can immediately drag to the desired
position. 
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Remove start
 This command cuts a scene
 at the point where the playback marker is positioned and removes the material before the playback
marker. 
Keyboard shortcut: K 

Remove object end
 This command cuts a scene
 at the point where the playback marker is positioned and removes the material behind the back marker. 
Keyboard shortcut: U 

Remove scene
 If you want to cut a scene out of a movie
 retroactively, this option automatically moves all objects, titles, and transitions on all tracks forwards so
that no gaps result. 
Objects on other tracks which project
 into the area of the selected scene will not be moved automatically; they will remain at the current
position. 
Keyboard shortcut: Ctrl + Del 

Split movie
 This command splits a movie at the point where the playback marker is positioned, making two separate
movies. The part before the playback marker will remain in the arranger. The remaining part will be
erased from the current arranger and turned into a new movie, which can be found in the "Window" menu
. 
Keyboard shortcut: Alt + T 

Duplicate objects
 It is easy to copy objects to create larger arrangements from small audio
 or video loops quickly. Speed up this process by clicking on the object to be copied with the mouse
while holding down the "Ctrl" key. This generates a copy which you can immediately drag to the desired
position. 
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Remove object end
 This command cuts a scene
 at the point where the playback marker is positioned and removes the material behind the back marker. 
Keyboard shortcut: U 

Remove scene
 If you want to cut a scene out of a movie
 retroactively, this option automatically moves all objects, titles, and transitions on all tracks forwards so
that no gaps result. 
Objects on other tracks which project
 into the area of the selected scene will not be moved automatically; they will remain at the current
position. 
Keyboard shortcut: Ctrl + Del 

Split movie
 This command splits a movie at the point where the playback marker is positioned, making two separate
movies. The part before the playback marker will remain in the arranger. The remaining part will be
erased from the current arranger and turned into a new movie, which can be found in the "Window" menu
. 
Keyboard shortcut: Alt + T 

Duplicate objects
 It is easy to copy objects to create larger arrangements from small audio
 or video loops quickly. Speed up this process by clicking on the object to be copied with the mouse
while holding down the "Ctrl" key. This generates a copy which you can immediately drag to the desired
position. 
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Remove scene
 If you want to cut a scene out of a movie
 retroactively, this option automatically moves all objects, titles, and transitions on all tracks forwards so
that no gaps result. 
Objects on other tracks which project
 into the area of the selected scene will not be moved automatically; they will remain at the current
position. 
Keyboard shortcut: Ctrl + Del 

Split movie
 This command splits a movie at the point where the playback marker is positioned, making two separate
movies. The part before the playback marker will remain in the arranger. The remaining part will be
erased from the current arranger and turned into a new movie, which can be found in the "Window" menu
. 
Keyboard shortcut: Alt + T 

Duplicate objects
 It is easy to copy objects to create larger arrangements from small audio
 or video loops quickly. Speed up this process by clicking on the object to be copied with the mouse
while holding down the "Ctrl" key. This generates a copy which you can immediately drag to the desired
position. 
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Split movie
 This command splits a movie at the point where the playback marker is positioned, making two separate
movies. The part before the playback marker will remain in the arranger. The remaining part will be
erased from the current arranger and turned into a new movie, which can be found in the "Window" menu
. 
Keyboard shortcut: Alt + T 

Duplicate objects
 It is easy to copy objects to create larger arrangements from small audio
 or video loops quickly. Speed up this process by clicking on the object to be copied with the mouse
while holding down the "Ctrl" key. This generates a copy which you can immediately drag to the desired
position. 
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Duplicate objects
 It is easy to copy objects to create larger arrangements from small audio
 or video loops quickly. Speed up this process by clicking on the object to be copied with the mouse
while holding down the "Ctrl" key. This generates a copy which you can immediately drag to the desired
position. 
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Object handles
 All objects can be re-sized with the "object handles
" on the lower edge. Move the mouse over one of the lower corners of the object until the mouse pointer
becomes a double arrow. You can now stretch the object as much as you like. 

5 "handles": Length, fade, brightness (volume) 
An object can be faded in or out using the handles to the left and right upper corners of the object.
Crossfades between different objects can be created by overlapped positioning of objects that are fading
in and out. The length of the crossfade
 can be adjusted with the handles. 
Using the brightness/volume handle located centrally at the top of the object, adjusts the volume of audio
or MIDI objects, or the brightness of video and image
 objects. Even if several objects are playing simultaneously, the volume or brightness of individual objects
can still be altered. 
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Shrink or interlace videos
 Videos can be made smaller, e.g. to show a foreground video in a cut-out of a background video. To do
this, both videos have to be placed above each other in the arranger. 

 Place one video above the other in the tracks.
 Position the foreground video on the track beneath the background video.

Note
: Make sure that the mixing effect "Stamp" is active under "Video effects -> Chroma key". 

 Select the foreground video, and in the Media pool under "Effects -> Movement effects", select
the entry "Position/Size" or "Crop/Zoom".

 You can change the image area/size by holding down the mouse button and dragging the edges of
the video in the program monitor. This is also useful for placing the selected video at the desired
position in the program monitor.

For more detailed information, see the section entitled "Movement effects in Media Pool" in the chapter "
Effects and titles". Nearly all preset effects may be automated or animated. To animate effects or
produce movements, please read the "Animating objects
" chapter. 
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Extract sound from videos
 Video with sound material appears in the arranger on two tracks as two objects (an audio
 object and a video object). The two objects automatically form a group. 
To edit the video and audio material separately from one another, the objects can be separated with the 
Ungroup function in the "Edit" menu or button in the arranger. Now you can replace the audio
 or the video track, or process each file separately. Rejoin/regroup the tracks with the "Export
arrangement" function. 
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Save objects separately
 You can easily save the object from the Arranger as separate files. Objects contain a reference to any
multimedia file or a special objects (video, sound, visual, etc.) with all additional properties that an object
can have like in and out point, fade and effects including effect curves that can be used in MAGIX Movie
 Edit Pro 16. 
In MAGIX Movie Edit Pro 16 you can use Takes for various applications. 

 You can divide your videos into takes while loading into the Arranger. To do this, first press the
"Media/Film" button. The transport functions of the transport control no longer apply to the
objects in the Arranger but rather to the video file selected in the Media Pool.

 The Extras button lets you set in and out points for scenes. The selected scene can subsequently
be saved to the Takes directory.

 All scenes found by the automatic scene recognition function can be stored in the Takes
directory. This creates the basis for a quick assembly of found scenes. 

 This takes directory may be used in both direction: either as a source of takes to be dragged into
the Arranger or a destination directory for new scenes. Use the Takes directory to build complex
storyboards: The individual scenes that make up the video are cut first, before being arranged on
the tracks. 

 Since Takes also contain corresponding effects, one can store different variations of the same
movie with different effects (for example, video cleaning) in the Takes directory. The Takes
directory uses very little memory in contrast to rendering out the actual video files! 
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Video mix
 This term refers to mixing various videos while simultaneously playing them. The video objects to be
mixed must be placed one below the other in the arranger so they overlap in time. Add a special video
mix effect to the lower video, which determines the parts that will be transparent for the upper video. This
way, you look from the bottom to the top through the arranger. 
To make a dancer dance in front of a landscape using the "blue box" effect, the landscape must be placed
on, for example, track 1 and the dancer on track 2 and the "blue box" effect be activated for the dancer. 
Tip: For further details on video effects and adjustments, see the chapter "Video effects
". 

Magnetic objects
 You can attach a video, picture, or text object to moving picture content of another video. The "Image
 object" automatically completes the movement of a picture element from the film. For example, you
could use this method to insert a hat that stays on someone's head throughout, even if the person hops
through the picture. Let's roll: 

 Place an image object (e.g. a photo of a hat) on a track below a video with a corresponding
image element (e.g. a walking person). The picture element should have enough contrast in it
(bright-dark difference) and should have a consistent size.

 In the Media Pool under "Effects -> Movement effects -> Position/Position", you can match the
zoom of the image object to the video and then position it precisely (i.e. add the hat to the
person).

 Right click on the image object and select the "Attach to image position in the video".
 In the "Attach to image position in the video" dialog, click on "Change size and position". 
 Select an image section in the preview monitor using the mouse which you would like the image

object to follow. This section should have as high a level of contrast as possible.
 Calculation of the object movement starts automatically.
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Transitions (fades)
 When importing video files into the arranger, individual objects usually follow directly after one another.
This is called a "hard cut". However, you can make scenes blend or "transition" into each other. 
This means that for the duration of a transition, two objects are shown at once and can be mixed "faded"
together in different ways. You will find numerous blends in the Media Pool's transition directory. 
In this chapter
Simple crossfade
Fades from the Media Pool
Custom fades via alpha keying (Plus version)
3D transitions
3D series

Simple crossfade

 A simple transition can be created in the arranger by dragging one object over another. A crossfade will
be automatically created. During this standard transition, the brightness of both objects is increased, i.e.
the first clip fades out while the second clip fades in. The duration of the crossfade is displayed in the
arranger by white crossing lines. You can adjust the length of the crossfade by dragging the upper handle
 of the second object to the left or to the right. 

To select a different fade click on the transition symbol
displayed when an object is selected. 

The fade menu
 opens. The transition icon will change, depending on your selection. 

Fades from the Media Pool
 To open the fade directory, click the "Fade" button
; double clicking enables a preview of the fade in the preview monitor. 
Simply drag the desired fade preset onto the border between the two objects. Only when the mouse
pointer with the transition preset is placed over a scene
 change will it turn into an object symbol. The object at the back will be shifted to the front to
accommodate the transition. 
The length of a transition is decided by you, so if a transition is shortened, it means that the resulting effect
is speeded up. 
Some transitions can be adjusted even more exactly. To do so, click the corresponding fade symbol in
the timeline or in the storyboard and select "Settings". An object's fade symbol in the Media Pool can
represent an entire group of different effects. 
The alpha fades (in the directory: iris, objects, random, etc.) are actually pre-produced black and white
videos combined with the alpha keying effect. 
Note: Use transitions economically! Most professional movies or TV shows use hard cuts as the rule
and transitions less frequently. Videos appear unprofessional and too ornate if fade effects are added to
every change of scene
. 
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Custom fades via alpha keying (Plus version)
 Alpha keying extends the range of transition effects used in MAGIX Movie
 Edit Pro 16 to produce black & white movie transitions or selected color fade-ins and fade-outs. You
can create such a video from any video material (also color) by exporting it as a transition (File -> Export
movie -> Export as transition). 
The loaded movie is then exported as a black and white video in mxv format and stored in the fade
directory. Afterwards, it will be available on the Media Pool and in the fade menu
. 

3D transitions

 General options
 3D power effects offer exciting and varied opportunities for creating transitions between two videos.
You will find the 3D effects in the Media Pool's transitions directory. 
To display the 3D fades as smoothly as possible, the program uses the accelerator features of your
graphics adaptor. 3D functions can be used with both software
 standards: Direct3D and OpenGL. These standards are variably supported by the respective graphics
card drivers. For this reason, you can switch between different fade settings for each standard. 

Settings
 In the transition settings you can adjust the look and reaction of the 3D transitions. To do so, click the
corresponding fade symbol in the timeline or in the storyboard and select "Settings". 
The following options are then available to you: 
Anti-aliasing
: An undesirable step effect is usually created at the borders of 3D objects. Anti-aliasing reduces this
effect, but also requires more computer power. This setting applies globally for all 3D fades. Switching
anti-aliasing for a 3D transitions therefore ensures that this setting is applied to all other 3D transitions 
Mirror X/Y: This option lets you influence the movement curve of the 3D objects within the transitions.
The "X axis mirror" option mirrors the movement of the object horizontally. The option "Y axis mirror"
mirrors the movement of the object vertically
 (along the Y axis). 
Rendering: Determine which software standard (see above) you would like to use to render the 3D
objects, i.e. OpenGL or Direct3D. Both modes use the hardware
 functions of the graphics card to render the 3D transition. Nevertheless, they can produce different
results, both in performance as well as in the final look of the transitions. 
To use Direct3D, you have to have DirectX9.0a installed. OpenGL requires an OpenGL1.1 driver. 
This setting applies globally to all 3D transitions. Switching between the render modes of a 3D transition
therefore ensures that all other 3D transitions also use this setting. 
Hardware acceleration deactivation
: Hardware-accelerated rendering on the graphics card increases the performance multiple times over;
however, it may lead to problems on some systems. If errors should occur in connection with the 3D
transitions, you can deactivate hardware acceleration for calculating 3D transitions. 
To do this, select the "Program settings" item from the file menu
 and deactivate the options "Hardware acceleration for 3D effects". To apply these changes, you will
need to restart the program. 

Troubleshooting
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 Problem
: The 3D transition display in the video monitor is sluggish and jittery. 
Solution: The performance of the 3D power effects is dependent on your graphics adapter's CPU
power. To achieve a smoother display you can deactivate anti-aliasing in the 3D transitions settings dialog
, or you can choose a lower resolution for your screen. Furthermore, you should ensure that you have the
latest driver for your graphics card installed. During export or burning to disc, transitions will be displayed
fluidly in any case. 
Problem
: The screen remains black or displays errors during 3D transitions. 
Solution: The 3D transitions use hardware-accelerated rendering on your graphics card to calculate the
image
. This can lead to compatibility problems on certain systems. Please ensure that you have the latest driver
for your graphics card installed. In certain circumstances, this may also fix the switchover between the
render modes (in the settings dialog of the transitions) or solve the problem by deactivating anti-aliasing. 
If there are still problems, however, you can deactivate hardware acceleration completely. Refer to
"Deactivating hardware acceleration" for more info. 
Problem
: A warning that there is insufficient graphics card memory for rendering the transition is displayed when
exporting or burning a slideshow containing 3D transitions. 
Solution
: The video memory on your graphics card is insufficient to render the 3D effect at the desired resolution.
Select a lower resolution (e.g. 720 x 576) in the export dialog. If the problem persists, deactivate the
hardware acceleration as described in the section "Deactivating hardware acceleration". 
Problem: Only a crossfade
 is displayed when previewing a 3D transition. A warning is displayed that insufficient graphics card
memory is available 
Solution
: The video memory of your graphics card is insufficient to render the 3D effect at the desired resolution.
Right click the video monitor and then select a lower resolution in "Resolution presets". If the problem
persists, try deactivating hardware acceleration as described above. 
Problem
: Only a crossfade is displayed when previewing a 3D transition. A warning is displayed that the 3D
transition may not be displayed correctly. 
Solution: Deactivate hardware acceleration; see "Deactivating hardware
 acceleration". 
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3D series
 The 3D series are a further development of 3D transitions
, whereby the transitions are thematically sorted. For instance, you can make photos pop up and
disappear on a notice board or make it look as if the photos were hanging on the walls of a gallery. 
There are several options to load 3D series for photos or scene
 transitions: 

 Click the "Fades -> 3D -> 3D series" button in the Media Pool. Select the desired 3D series and
drag it onto the first scene or image transition where the 3D transition should start.

 In the transitions menu between two scenes choose the
option "3D series". Click on the desired 3D series to
select it.

You can select how many of the subsequent fades should be replaced by the 3D series in the dialog
. 
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Overview mode

 The "Scene
 overview" mode is a special view that improves manageability and categorization of scenes. All scenes
are listed one after the other (in multiple lines, like in a text program) and can be copied, cut, moved,
deleted and inserted. 
In the "Overview" mode, there are no start, play, or end markers. The scene being played back has a 
frame
 around it. 

Zoom fader
 This slider
 specifies how large the photos will appear in the storyboard. The smaller the scenes, the more of them
you'll be able to fit on screen. 

Maximize: Use this button
 to maximize the scene overview to fullscreen. 
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Grid and snap
 The time of the arrangement is displayed by the horizontal course of the tracks. To structure this course,
a timeline with a grid has been positioned at the top above the first track. 
A grid is also displayed in the arranger area. The raster ensures that the objects always "snap" to certain
points so that they can be positioned precisely according to the beat. Two consecutive objects will
seamlessly snap together even if they are on different tracks. This avoids undesired gaps or overlaps. 
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Searching for and removing ads (Plus
version)

 The "Ad killer" feature can be used to automatically locate and remove commercials in recorded TV
programs. 
How it works: First, characteristics typical of commercials are located, and then the entire section
including the ads is edited and removed. This is particularly effective in movies broadcast in 16:9
widescreen format since there are two visible black borders at the top and bottom. The borders
disappear when ads are shown, so the ad killer detects this when they disappear and edits the movie at
these positions. Using the button
 "Get black value" you can click on the black bars in the monitor and thus set the color shade in order to
improve detection. A further characteristic typical for commercials is raising (maximizing) the volume. 
Specify in this dialog
 whether you want to cut the ad block immediately or highlight it first. You also have various search and
display options. 
Keyboard shortcut: Shift + C 
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Markers
 MAGIX Movie Edit Pro 16 also allows you to set various types of markers within your project
. 

The Lock button
 lets you lock all markers (jump markers,
chapter markers) against accidental moving
or deleting. 

In this chapter
Playback marker
Set project marker
Area marker (in and out points)
Chapter markers
Scene markers
Ad markers
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Playback marker
The playback marker indicates the point from which the
material ? either the arrangement or a selected file from the
Media Pool ? will be played back. There is a playback
marker below each preview monitor and an additional one
above the timeline in the arranger. 

The playback marker is displayed as a red triangle below the monitors. In the arranger it is displayed as a
red triangle. 
In order to move the playback marker, simply double click on the desired area below the monitor.
Alternatively, you can click on the playback marker and move it by dragging it with the mouse. While
being moved, the current image
 will appear on the monitor, letting you see exactly where in the material you are located. 
The playback marker in the video monitor can also be moved by clicking on the lower section of the time
scale in the arranger. The playback marker will also be moved on the program monitor, as both markers
are coupled to each other. 
The exact position of the playback marker can be seen in the time display at the top left, below the
corresponding monitor. There, you can change the displayed values (Hour:Minute:Second:Frame
) per mouse click to reach a certain point in time. Simply enter the desired value and the playback marker
will jump to the corresponding position. 
Tip
: In the "Playback" tab under "File -> Settings -> Program", you can set whether repeatedly pressing the
space bar resets the playback marker to the current position or moves it to the original position. 

Set project marker
 The menu provides the option of placing a project marker at the current playback location. These
provide a way to mark certain segments or events of interest in the project
, etc. 
After selecting the menu, a dialog
 for entering the name of the marker to be created will open. The first 10 project markers may be
selected using the number keys 1-0 (0 accesses the 10th marker). This allows you to jump to a particular
position of a longer video immediately, without scrolling and searching. 
Project markers can be deleted or renamed at any time via the context menu
. They do not have any direct effect on the results of your work, but they can be very helpful. 

Area marker (in and out points)
 Area markers are the start markers (in-points) and end markers (out-points). The serve to mark a
certain area, which will be played back by pressing the "area playback" button
 at the bottom of the corresponding monitor. 

To the left, you see a start marker, and to the right, an end marker. 
The area markers in the arrangement serve to indicate the paste position of new video or sound material. 
Hint:
 The value between both markers shows the length of the selected area following the pattern of
Hours:Minutes:Seconds:Frames. 
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Ranges in the video monitor
 There are various options for changing the playback area and the in/out points. 

 Set the playback marker at the desired position and press "Set range start" or "Set range end"
underneath the monitor to set the in and out points.

 Click on one of the markers below the monitor and move it to the desired position by dragging it.
 Click one of the markers in the upper-most bar in the arranger and drag it.
 Right clicking on the bar moves the out point to the position of the mouse cursor. The area grows

or shrinks in size correspondingly. Left clicking moves the in point, whereby the area size stays
constant (out point is moved as well).

 You can adjust the position of the entire range by clicking the blue bar between the markers and
moving it by dragging while holding down "Crtl".

Keyboard shortcut: 
Set the start of the range (in point) at the position of the playback marker: "I" 
Set the end of the range (out point) at the position of the playback marker: "O" 

Chapter markers
The chapter marker defines the start of the new chapter.
Chapters improve navigation when burning your project
to CD or DVD
. 

The following options can be accessed via the "Edit" menu
 or by right clicking on a playback marker. 

Marker > Set chapter marker
Sets a chapter marker at the position of the playback marker.
This creates a chapter entry in the disc menu, in case you are
planning to burn the movie
 to CD/DVD. 

You can rename your chapter markers by right clicking and selecting "Rename". The name then appears
in the chapter menu
. 
Shortcut: Shift + Enter 

Marker > Automatic chapter markers
 Automatically sets chapter markers in the arrangement based on certain rules. These chapter markers
determine the chapters in your DVD menu
. This function is useful if you want to burn your recording onto disc right away. 
There are a few options for automatic chapter generation: 
At the beginning of the movie: 
The movie contains only one chapter 
At the object starts in a track...:
 Every object in a track creates a chapter. Track 1 is preset. 
At the position of existing title objects:
 Subtitles, for instance as faded-in subheadings, give the position of the chapter markers. 
Provide interval (in minutes)/provide quantity:
 If the chapters are separated without any particular method and are just needed for quicker navigation,
you can also insert chapter markers in pre-defined intervals or as a pre-defined number of chapter
markers. 
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Titling the chapter markers:
 To title the chapter markers, you can use a user-defined name with consecutive numbers or the object
name or text from the text objects. 
Optionally, you can delete existing chapter markers and confine the automatic chapter marker function to
the area between the start and end markers. 
Keyboard shortcut: Alt + Shift + Enter 

Marker > Delete (all) chapter markers
 Deletes one or all chapter markers. This removes chapter entries from the disc menu
. Read more in "Burn screen". 
Keyboard shortcut: Ctrl + Enter / Alt + Ctrl + Enter 

Scene markers
 Scene markers separate a complete video into scenes. You can load any video into MAGIX Movie
 Edit Pro 16 and have it divided into scenes. 
Simply drag the desired video into the arranger. Then, right click on the video and select "Scene
recognition". The following dialog
 appears: 

After clicking "Start search", an overview of the detected scenes will be displayed underneath the scene
control. 
Delete scene markers
: Here you can delete individual markers by selecting them from a list. 
Delete all markers: Deletes all project
 markers. 
Action on OK: You have three possibilities: Either MAGIX Movie Edit Pro 16 splits your video into
individual scenes ("Cut at all markers"), your select a scene and cut only at this position ("Cut at selected
marker") or you can save the scenes as "Takes
". 
After deciding in favor of one of these options, red scene
markers will appear on the timeline in the arranger. The
scenes can then be split according to the selected option
and edited. 
Note
: An important difference between a scene and a chapter marker is that a scene marker can be set only
within a continuous video, while a chapter marker can include several videos consecutive videos. 
Additional information about scene recognition is provided in chapter "Insert objects into the project
". 
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Shortcut for scene
 recognition: Shift + Z 

Ad markers
Ad markers indicate detected ad pauses. For more on
this, please read the "Search for and remove ads" chapter
. 
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Set project marker
 The menu provides the option of placing a project marker at the current playback location. These
provide a way to mark certain segments or events of interest in the project
, etc. 
After selecting the menu, a dialog
 for entering the name of the marker to be created will open. The first 10 project markers may be
selected using the number keys 1-0 (0 accesses the 10th marker). This allows you to jump to a particular
position of a longer video immediately, without scrolling and searching. 
Project markers can be deleted or renamed at any time via the context menu
. They do not have any direct effect on the results of your work, but they can be very helpful. 

Area marker (in and out points)
 Area markers are the start markers (in-points) and end markers (out-points). The serve to mark a
certain area, which will be played back by pressing the "area playback" button
 at the bottom of the corresponding monitor. 

To the left, you see a start marker, and to the right, an end marker. 
The area markers in the arrangement serve to indicate the paste position of new video or sound material. 
Hint:
 The value between both markers shows the length of the selected area following the pattern of
Hours:Minutes:Seconds:Frames. 

Ranges in the video monitor
 There are various options for changing the playback area and the in/out points. 

 Set the playback marker at the desired position and press "Set range start" or "Set range end"
underneath the monitor to set the in and out points.

 Click on one of the markers below the monitor and move it to the desired position by dragging it.
 Click one of the markers in the upper-most bar in the arranger and drag it.
 Right clicking on the bar moves the out point to the position of the mouse cursor. The area grows

or shrinks in size correspondingly. Left clicking moves the in point, whereby the area size stays
constant (out point is moved as well).

 You can adjust the position of the entire range by clicking the blue bar between the markers and
moving it by dragging while holding down "Crtl".

Keyboard shortcut: 
Set the start of the range (in point) at the position of the playback marker: "I" 
Set the end of the range (out point) at the position of the playback marker: "O" 

Chapter markers
The chapter marker defines the start of the new chapter.
Chapters improve navigation when burning your project
to CD or DVD
. 

The following options can be accessed via the "Edit" menu
 or by right clicking on a playback marker. 
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Marker > Set chapter marker
Sets a chapter marker at the position of the playback marker.
This creates a chapter entry in the disc menu, in case you are
planning to burn the movie
 to CD/DVD. 

You can rename your chapter markers by right clicking and selecting "Rename". The name then appears
in the chapter menu
. 
Shortcut: Shift + Enter 

Marker > Automatic chapter markers
 Automatically sets chapter markers in the arrangement based on certain rules. These chapter markers
determine the chapters in your DVD menu
. This function is useful if you want to burn your recording onto disc right away. 
There are a few options for automatic chapter generation: 
At the beginning of the movie: 
The movie contains only one chapter 
At the object starts in a track...:
 Every object in a track creates a chapter. Track 1 is preset. 
At the position of existing title objects:
 Subtitles, for instance as faded-in subheadings, give the position of the chapter markers. 
Provide interval (in minutes)/provide quantity:
 If the chapters are separated without any particular method and are just needed for quicker navigation,
you can also insert chapter markers in pre-defined intervals or as a pre-defined number of chapter
markers. 
Titling the chapter markers:
 To title the chapter markers, you can use a user-defined name with consecutive numbers or the object
name or text from the text objects. 
Optionally, you can delete existing chapter markers and confine the automatic chapter marker function to
the area between the start and end markers. 
Keyboard shortcut: Alt + Shift + Enter 

Marker > Delete (all) chapter markers
 Deletes one or all chapter markers. This removes chapter entries from the disc menu
. Read more in "Burn screen". 
Keyboard shortcut: Ctrl + Enter / Alt + Ctrl + Enter 

Scene markers
 Scene markers separate a complete video into scenes. You can load any video into MAGIX Movie
 Edit Pro 16 and have it divided into scenes. 
Simply drag the desired video into the arranger. Then, right click on the video and select "Scene
recognition". The following dialog
 appears: 
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After clicking "Start search", an overview of the detected scenes will be displayed underneath the scene
control. 
Delete scene markers
: Here you can delete individual markers by selecting them from a list. 
Delete all markers: Deletes all project
 markers. 
Action on OK: You have three possibilities: Either MAGIX Movie Edit Pro 16 splits your video into
individual scenes ("Cut at all markers"), your select a scene and cut only at this position ("Cut at selected
marker") or you can save the scenes as "Takes
". 
After deciding in favor of one of these options, red scene
markers will appear on the timeline in the arranger. The
scenes can then be split according to the selected option
and edited. 
Note
: An important difference between a scene and a chapter marker is that a scene marker can be set only
within a continuous video, while a chapter marker can include several videos consecutive videos. 
Additional information about scene recognition is provided in chapter "Insert objects into the project
". 
Shortcut for scene
 recognition: Shift + Z 

Ad markers
Ad markers indicate detected ad pauses. For more on
this, please read the "Search for and remove ads" chapter
. 
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Area marker (in and out points)
 Area markers are the start markers (in-points) and end markers (out-points). The serve to mark a
certain area, which will be played back by pressing the "area playback" button
 at the bottom of the corresponding monitor. 

To the left, you see a start marker, and to the right, an end marker. 
The area markers in the arrangement serve to indicate the paste position of new video or sound material. 
Hint:
 The value between both markers shows the length of the selected area following the pattern of
Hours:Minutes:Seconds:Frames. 

Ranges in the video monitor
 There are various options for changing the playback area and the in/out points. 

 Set the playback marker at the desired position and press "Set range start" or "Set range end"
underneath the monitor to set the in and out points.

 Click on one of the markers below the monitor and move it to the desired position by dragging it.
 Click one of the markers in the upper-most bar in the arranger and drag it.
 Right clicking on the bar moves the out point to the position of the mouse cursor. The area grows

or shrinks in size correspondingly. Left clicking moves the in point, whereby the area size stays
constant (out point is moved as well).

 You can adjust the position of the entire range by clicking the blue bar between the markers and
moving it by dragging while holding down "Crtl".

Keyboard shortcut: 
Set the start of the range (in point) at the position of the playback marker: "I" 
Set the end of the range (out point) at the position of the playback marker: "O" 

Chapter markers
The chapter marker defines the start of the new chapter.
Chapters improve navigation when burning your project
to CD or DVD
. 

The following options can be accessed via the "Edit" menu
 or by right clicking on a playback marker. 

Marker > Set chapter marker
Sets a chapter marker at the position of the playback marker.
This creates a chapter entry in the disc menu, in case you are
planning to burn the movie
 to CD/DVD. 

You can rename your chapter markers by right clicking and selecting "Rename". The name then appears
in the chapter menu
. 
Shortcut: Shift + Enter 

Marker > Automatic chapter markers
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 Automatically sets chapter markers in the arrangement based on certain rules. These chapter markers
determine the chapters in your DVD menu
. This function is useful if you want to burn your recording onto disc right away. 
There are a few options for automatic chapter generation: 
At the beginning of the movie: 
The movie contains only one chapter 
At the object starts in a track...:
 Every object in a track creates a chapter. Track 1 is preset. 
At the position of existing title objects:
 Subtitles, for instance as faded-in subheadings, give the position of the chapter markers. 
Provide interval (in minutes)/provide quantity:
 If the chapters are separated without any particular method and are just needed for quicker navigation,
you can also insert chapter markers in pre-defined intervals or as a pre-defined number of chapter
markers. 
Titling the chapter markers:
 To title the chapter markers, you can use a user-defined name with consecutive numbers or the object
name or text from the text objects. 
Optionally, you can delete existing chapter markers and confine the automatic chapter marker function to
the area between the start and end markers. 
Keyboard shortcut: Alt + Shift + Enter 

Marker > Delete (all) chapter markers
 Deletes one or all chapter markers. This removes chapter entries from the disc menu
. Read more in "Burn screen". 
Keyboard shortcut: Ctrl + Enter / Alt + Ctrl + Enter 

Scene markers
 Scene markers separate a complete video into scenes. You can load any video into MAGIX Movie
 Edit Pro 16 and have it divided into scenes. 
Simply drag the desired video into the arranger. Then, right click on the video and select "Scene
recognition". The following dialog
 appears: 

After clicking "Start search", an overview of the detected scenes will be displayed underneath the scene
control. 
Delete scene markers
: Here you can delete individual markers by selecting them from a list. 
Delete all markers: Deletes all project

Page 219



 markers. 
Action on OK: You have three possibilities: Either MAGIX Movie Edit Pro 16 splits your video into
individual scenes ("Cut at all markers"), your select a scene and cut only at this position ("Cut at selected
marker") or you can save the scenes as "Takes
". 
After deciding in favor of one of these options, red scene
markers will appear on the timeline in the arranger. The
scenes can then be split according to the selected option
and edited. 
Note
: An important difference between a scene and a chapter marker is that a scene marker can be set only
within a continuous video, while a chapter marker can include several videos consecutive videos. 
Additional information about scene recognition is provided in chapter "Insert objects into the project
". 
Shortcut for scene
 recognition: Shift + Z 

Ad markers
Ad markers indicate detected ad pauses. For more on
this, please read the "Search for and remove ads" chapter
. 
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Chapter markers
The chapter marker defines the start of the new chapter.
Chapters improve navigation when burning your project
to CD or DVD
. 

The following options can be accessed via the "Edit" menu
 or by right clicking on a playback marker. 

Marker > Set chapter marker
Sets a chapter marker at the position of the playback marker.
This creates a chapter entry in the disc menu, in case you are
planning to burn the movie
 to CD/DVD. 

You can rename your chapter markers by right clicking and selecting "Rename". The name then appears
in the chapter menu
. 
Shortcut: Shift + Enter 

Marker > Automatic chapter markers
 Automatically sets chapter markers in the arrangement based on certain rules. These chapter markers
determine the chapters in your DVD menu
. This function is useful if you want to burn your recording onto disc right away. 
There are a few options for automatic chapter generation: 
At the beginning of the movie: 
The movie contains only one chapter 
At the object starts in a track...:
 Every object in a track creates a chapter. Track 1 is preset. 
At the position of existing title objects:
 Subtitles, for instance as faded-in subheadings, give the position of the chapter markers. 
Provide interval (in minutes)/provide quantity:
 If the chapters are separated without any particular method and are just needed for quicker navigation,
you can also insert chapter markers in pre-defined intervals or as a pre-defined number of chapter
markers. 
Titling the chapter markers:
 To title the chapter markers, you can use a user-defined name with consecutive numbers or the object
name or text from the text objects. 
Optionally, you can delete existing chapter markers and confine the automatic chapter marker function to
the area between the start and end markers. 
Keyboard shortcut: Alt + Shift + Enter 

Marker > Delete (all) chapter markers
 Deletes one or all chapter markers. This removes chapter entries from the disc menu
. Read more in "Burn screen". 
Keyboard shortcut: Ctrl + Enter / Alt + Ctrl + Enter 

Scene markers
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 Scene markers separate a complete video into scenes. You can load any video into MAGIX Movie
 Edit Pro 16 and have it divided into scenes. 
Simply drag the desired video into the arranger. Then, right click on the video and select "Scene
recognition". The following dialog
 appears: 

After clicking "Start search", an overview of the detected scenes will be displayed underneath the scene
control. 
Delete scene markers
: Here you can delete individual markers by selecting them from a list. 
Delete all markers: Deletes all project
 markers. 
Action on OK: You have three possibilities: Either MAGIX Movie Edit Pro 16 splits your video into
individual scenes ("Cut at all markers"), your select a scene and cut only at this position ("Cut at selected
marker") or you can save the scenes as "Takes
". 
After deciding in favor of one of these options, red scene
markers will appear on the timeline in the arranger. The
scenes can then be split according to the selected option
and edited. 
Note
: An important difference between a scene and a chapter marker is that a scene marker can be set only
within a continuous video, while a chapter marker can include several videos consecutive videos. 
Additional information about scene recognition is provided in chapter "Insert objects into the project
". 
Shortcut for scene
 recognition: Shift + Z 

Ad markers
Ad markers indicate detected ad pauses. For more on
this, please read the "Search for and remove ads" chapter
. 
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Scene markers
 Scene markers separate a complete video into scenes. You can load any video into MAGIX Movie
 Edit Pro 16 and have it divided into scenes. 
Simply drag the desired video into the arranger. Then, right click on the video and select "Scene
recognition". The following dialog
 appears: 

After clicking "Start search", an overview of the detected scenes will be displayed underneath the scene
control. 
Delete scene markers
: Here you can delete individual markers by selecting them from a list. 
Delete all markers: Deletes all project
 markers. 
Action on OK: You have three possibilities: Either MAGIX Movie Edit Pro 16 splits your video into
individual scenes ("Cut at all markers"), your select a scene and cut only at this position ("Cut at selected
marker") or you can save the scenes as "Takes
". 
After deciding in favor of one of these options, red scene
markers will appear on the timeline in the arranger. The
scenes can then be split according to the selected option
and edited. 
Note
: An important difference between a scene and a chapter marker is that a scene marker can be set only
within a continuous video, while a chapter marker can include several videos consecutive videos. 
Additional information about scene recognition is provided in chapter "Insert objects into the project
". 
Shortcut for scene
 recognition: Shift + Z 

Ad markers
Ad markers indicate detected ad pauses. For more on
this, please read the "Search for and remove ads" chapter
. 
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Ad markers
Ad markers indicate detected ad pauses. For more on
this, please read the "Search for and remove ads" chapter
. 
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Trim Objects
 Trimming provides exact placement of object borders or transitions. MAGIX Movie Edit Pro 16 has
two different trimmers, and these can be opened using the context menu for a video or image
 object. 
In this chapter
General advice for operating both trim editors
Trimmer for individual objects
Cut trimmer
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General advice for operating both trim
editors
 Play functions
: The trim window contains its own play functions that allow the object to be played individually or in
relation to the arrangement. 

 The right play button plays the arrangement normally. Note: Replays can sometimes appear
shaky because the processor may be overworked, and some frames may be left out.

 The middle play button plays the arrangement "frame-by-frame", which means no frames are left
out, but that the replay may be slower.

 The left play button renders material before playing. This method ensures a smoother playback.
The start marker in the timeline is reset when the rewind and fast-forward functions are activated,
allowing for complete control of transitions between two videos. 
Increments: A click on the +/- buttons in both trim editors places the handle or the material within an
object exactly into a frame. With the "Ctrl" key you can increase the frame
 rate (5 frames/sec per mouse click). 
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Trimmer for individual objects
 A schematic display of the selected object and its handles
 can be found in the center of the trimming window. 

Fade in/out (4, 5):
 These buttons adjust the upper fade handles of an object. 
Object content (3):
 Here you can move the video material to be played without changing the object length. 
Position (2):
 Moves the object on the track. 
First frame/End fade-in (7):
 Toggles the left monitor between the first frame of the object and the end of the transition. 
Start fade-out/Last Frame (8):
 Toggles the right monitor between the start of the transition and the last frame of the object. 
Left/right arrow buttons (1, 6):
 Here you can adjust the lower object handles. 
Next object/cut (9, 10):
 The buttons below and to the right skip to the next/previous object and/or cut in the arranger. These
buttons make it easy to move and trim objects in the arrangement without having to leave the trimmer. 
Keyboard shortcut: Q 
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Cut trimmer

 A schematic display of the selected transition and its handles
 can be found at the center of the trimming window. 
Left arrow buttons (1): These buttons move the last frame
 of the first object while adjusting the second. The length of the transition remains. The display indicates
the relative change in comparison with the starting situation when the trimmer was opened. 
Position (2): 
Moves the second object. The length of the transition is changed. This corresponds with shifting an
object in the arranger. 
Object content (3): Moves the movie
 under the second object. The length of the object and the object itself are not changed. 
Crossfade (4):
 Changes the transition's length between both objects. The objects remain of equal length. The length can
be numerically entered. 
Middle arrow buttons (5):
 Shifts the existing transition. Both objects remain in their positions, but the transition's center point
moves. 
Transition (6):
 Displays the type of transition. A mouse click opens a popup window from which you can select a
transition. 
Right arrow buttons (7):
 Move the first frame of the second object. The first object and the transition remains. Only the length of
the second object changes. 
Start fade-out/Last frame (8):
 Switches the left monitor between the start of the transition and the last frame of the object. 
First frame/End fade-in (9):
 Switches the right monitor between the first frame of the following object and the end of the transition. 
Next cut (10)/Next object (11):
 The buttons below and to the right skip to the next/previous object and/or cut in the arranger. These
buttons make it easy to move and trim cuts in the arrangement without having to leave the trimmer. 
Keyboard shortcut: N 
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Multi-cam editing (Plus
version)
 Multi-cam editing enables easy cutting of various recordings of the same scene from different camera
perspectives. The preview monitor shows the image
 material from two sources next to each other, from which the "program" can be cut in real time using
your mouse ? just like in a real studio. 
In this chapter
Preparation
Source tracks and preview images
Multicam edit functions
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Preparation
 Multicam editing is a special arranger mode. The top two tracks serve as target tracks for copying sound
and video from two different source tracks. The two top tracks must be empty when switching into the
multicam mode, otherwise existing objects will be moved to a different track. 
Next, load various video recordings of the same scene
 one under the other starting on track 3 in the arranger. 
It is important that the individual sources are synchronized to each other exactly. It is best to find a
noticeable movement, or an "o" sound, if audio
 was recorded. 
To localize the sound in the audio track exactly, you may have to create a wave
 display of the track. Right click on the sound track and choose "Create wave form display". 
You can use a clapperboard during filming, since this offers both sound and motion; an actor's clapping in
front of running camera before the start of the scene is also helpful. Set a grid point at this position in the
object ("Alt + Shift + P"). You can now move the source objects over each other, so that the grid points
are aligned. 
It is also important that you make all effect settings for the output material (e.g. video or audio cleaning) 
before the multicam edit on the objects on the source track and on the master audio track
. These effects will be transferred to the objects in the target track with the edit. Otherwise, you will have
to apply the effects from every single object to the target track. 

You can activate "Multicam" mode with this button or with the
"Multicam" command in the "Edit" menu
. 
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Source tracks and preview images
 The assignment of tracks as source tracks for the multicam cut takes place automatically. When the
multicam mode is activated, the source tracks will be assigned to all tracks containing video objects
starting from track 3. 
You can also conduct or change the assignment manually. To do so, right click on the trackbox of the
corresponding track to active or deactivate a track as a source track. In this way, you can use more than
two tracks for multicam editing, but no more than two simultaneously. The source tracks are marked
using color. 

A preview appears in the program monitor for every assigned track, and the source track's color
corresponds to the preview images so that you can quickly assign each preview image
. 
If the objects created using multicam cut are located on the target track, a preview image of the
corresponding source track highlighted with a yellow frame
 will be shown for length of playback. 
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Multicam edit functions
 You can edit various sources in the the target track during playback in real time or during stopped
playback. 

Real-time multicam editing
 You can edit various sources together during playback in real time. 

1. Start playback.
2. Click on the desired source in the preview monitor.
3. The corresponding video added into the target track starting from this time point.
4. To switch the source, click on another source, and a new object from another source will be

created from this point. You can repeat this process as often as you like.
For precise editing in the target track, use the usual edit functions or the Trimmer. Keep in mind that as
long as you are in multicam mode, only the object borders are moved, and not the objects themselves.
Otherwise, gaps or image
 jumps could result while you use the multicam edit function again later. 

Replacing an object's source
 Replacing an object's video material in the target track with another source: 

1. Select the object for which the source is to be replaced in the target track.
2. Click the source you want to replace the video material in the source monitor object.
3. The video material will be replaced by the material selected in the new source. The project length

is not changed.

 Insert cut
 Insert material from one of the sources between any position on the target track and the next object. 

1. Place the playback marker on the desired position.
2. Click on the desired source in the preview monitor.
3. The material from this source will be added to the target track, the new object will end at the next

object, and the section lying below an existing object will be overwritten.

 Overwrite range
 You can overwrite a selected area of the target track with one of the source videos. 

1. At the upper edge of the arranger, select an area to edit by determining the in point by clicking
and the out point by right clicking. Or use the corresponding buttons in the transport control.

2. Click the desired source in the program monitor. 
3. The target track will be overwritten with the video material from the selected source in the

selected area.

 Master audio track
 Normally, videos in the source track are edited together with their audio
 tracks. Since the original sound can differentiate from camera to camera due to different camera
positions, you will probably prefer using either the soundtrack from only one camera for all settings, or to
replace the soundtrack completely (for music videos, for example, you will use the studio version of the
original track). 
Right click on the track box of one of the source audio tracks or a different audio track and select
"Multicam: Master audio track" from the context menu
 to assign a master audio track for multicam editing. The master audio track will be appear in a dark
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color. 
Now, during every multicam cut, material from the master audio
 track will be inserted on track 2, independent of the source track used. 
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Master audio track
 Normally, videos in the source track are edited together with their audio
 tracks. Since the original sound can differentiate from camera to camera due to different camera
positions, you will probably prefer using either the soundtrack from only one camera for all settings, or to
replace the soundtrack completely (for music videos, for example, you will use the studio version of the
original track). 
Right click on the track box of one of the source audio tracks or a different audio track and select
"Multicam: Master audio track" from the context menu
 to assign a master audio track for multicam editing. The master audio track will be appear in a dark
color. 
Now, during every multicam cut, material from the master audio
 track will be inserted on track 2, independent of the source track used. 

Page 234



Titles and effects
 MAGIX Movie Edit Pro 16 offers a large palette of video effects. The video effects that are used the
most can be found directly in the Media Pool, while others can be found in the object context menu or in
the "Effects" menu
. 
In this chapter
3D text
Apply fades
Apply effects to objects
Video effects in the Media Pool
Movement effects in the Media Pool
Video effect plug-ins
Image stabilization
Create panorama pictures
Borders
Title Editor
Slideshow Maker
Master effects
TV picture
Audio Effects
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3D text
 3D text can be created directly from the Title Editor. Click the Title Editor and then press the "X3D
title" button
. The title object will now be turned into a MAGIX 3D object. If you have also installed MAGIX 3D
Maker, the program will open for you to work on the text. 
Presets are also located in the Media Pool under "Titles -> 3D". You can enter or process text here. 
For more information about MAGIX 3D Maker, try the help file. You can open it by pressing "F1" from
within the program. 
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Apply fades
 Fades can be selected in the Media Pool under "fades" and moved into the space between two objects
using drag & drop. In addition, they are available directly in the fades menu
 between two objects (see figure). 

Find out more on this topic under "Transitions"
. 
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Apply effects to objects
 All title and effects for objects are accessible via the Media Pool. There are various methods for
applying effects: 

 Titles, static effects and audio effect presets are loaded into the corresponding object using drag
& drop. 

 Effects that can be animated (in Media Pool under "Effects -> Video effects/movement effects")
will be applied directly to the objects selected earlier as soon as changes are made in the Media
Pool.
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Video effects in the Media Pool
 Video effects in the Media Pool can always be opened independently from the selection of an object. 
The program monitor displays the starting image
 of the video. The playback marker enables you to jump to a specific position in the video in order to
check the results of the effects by starting and stopping playback. 
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Brightness & Contrast
 Brightness/Contrast
: Use the sliders to increase or reduce the brightness and the contrast of the picture. 
Selective brightness (gamma)
: "Gamma" determines the mean grayscale that can be calculated from the various color ranges. "Selective
brightness" is the most important function for enhancing images. In the preset list select various adjustment
curves and edit the dark, middle, or brightest points in the picture. 
Using the fader
 you can also set the power of the brightness/darkness adjustments. 
Auto exposure: With this button
 you can automatically optimize the exposure and contrast with a click. 
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Color

 White balance
 All light is not the same. Depending on whether it is sunlight or artificial light, this will have an effect on
color variation. The human brain is able to compensate for this variation: A white sheet of paper will still
look white under candlelight, although it is in fact much more yellow than by daylight. 
In order to imitate this filtering done by the brain, a camera must also analyze and correct the light. White
balance does the same thing to a picture that the brain does by setting the camera to the so-called "color
temperature" of the surroundings. 
If you do not possess a camera which performs this function automatically, you can apply the white
balance function in MAGIX Movie
 Edit Pro 16. 
An incorrect white balance can lead to an unnatural blue or red hue. 
Directions: To use the white balance, click on the button
 to the right of the label "White balance" and then select a point which represents white or a neutral gray
to the "outside world". The color temperature is then corrected automatically. 
Tip
: Cool color effects can be achieved by setting a different color as the white benchmark. There is
definitely room for experimentation! 

Red-eye-removal
 This photo function removes unnatural redeye that the results from using a flash. Click on the eye symbol
and then select the red pupils in the preview monitor using the mouse. 
Hint:
 For photo optimization, we recommend you use MAGIX Photo Manager. The program is installed
automatically and can be used for quick previewing and easy management of pictures from your
database. It has a tool for correcting redeye and setting auto color and white balance to control
discoloration in pictures. 

Saturation
 You can increase or reduce the color portions of images with the "saturation" fader
. A newly developed algorithm is applied which makes color changes related to other parameters (for
example contrast settings) in order to achieve the most natural coloration possible. With just a little bit of
experimentation, you can achieve astounding results ? anything from turning summer snapshots into
autumnal scenes to funky pop art! 

Hue
 Select a color for coloring the image
 from the color chart. 

Red/Green/Blue
 Using the "Red/Green/Blue" slider
, you can change the color portion mix for each color. 

Edit color ranges individually
 Secondary color correction allows individual colors in video and image
 objects to be adjusted. This includes essentially two layers, the fore and background. The master layer
may also be used to influence the overall image. 
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The foreground layer corresponds with the mask created, and editing in the background changes all of
the areas outside of this mask. The mask may be assigned to a certain color or to multiple colors
simultaneously. 
To open color correction, click the video or image
 object and open the entry "Color correction" via "Video effects" in the Media Pool. 

"Add" allows a color to be
selected with the pipette tool
to create a mask. MAGIX 
Movie
 Edit Pro 16 displays the mask
in black and white stripes to
highlight the current selection. 

Click with the pipette tool on the
color in the program monitor that
you would like to add to the
current layer until your selection
is complete. 
Unwanted colors can be
removed from the selection again
by selecting "Remove" and
clicking the corresponding
color. 

Select the layers
(fore and
background) to
edit. 

Now edit the selection as
usual. 

A classic example:
Saturation of all
brightness areas on the
background layer is
reduced, and colors in
the foreground are
adjusted as desired. 
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Chroma key
 This section contains the mixing effects for chroma keying used to mix together a foreground and
background video to create an overlay effect. 
Note: The background video must be present in the track above the object for the foreground!
For example, track 1: background, track 2: foreground 
Stamp: The currently selected object is "stamped" onto the video on the track above the object. This is
only possible if the bottom video takes up only a part of the image, as otherwise only the bottom
(currently selected) video would be visible. The object should be reduced or moved first. This can be
achieved using the edit functions (see above) or the "Selection" sub-menu in the "Effect" menu. To find
out more, read "Shrink or interlace videos
". 
Color
: Select the range with the color that should be transparent in the video monitor. The video is made
transparent in the areas featuring this color, and the video on the top track can be seen "through" these
areas. 
Mix: This button mixes the two videos together. With the aid of the fade handles
, very soft cross-fades can be achieved between the partially overlapping videos. 
Black/blue/white/green screen
: The selected video covers up the video on the top track and all black/blue/white/green areas appear
transparent. This makes it possible to "place" a person who has been recorded in front of a blue (or
green, white or black) background into any type of landscape or background. 
Alpha: This video effect uses the brightness of a video to control a cross-fading effect between two other
videos on neighboring tracks. The additional videos should be situated directly above and below the
alpha-keying object.
In all black parts of the alpha-keying object, the top video is faded in, while in all white passages the
bottom video is shown. Grey passages are permeable for both videos and create a mixture of the two. In
the case of colored passages, the brightness of the color is used for control purposes. 
Video level: The video level essentially changes the brightness of the video before other video effects are
applied. This can have significant influence on the effects, especially in case of chroma keying. The effect
can be automated; read about this in the chapter "Animating objects
". 
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Artistic filter
 Erosion: The image
 is broken up by means of small rectangles and resembles a "patchwork". 
Dilate
: The image is broken down into cell-like elements. 
Emboss
: The edges are strongly highlighted. 
Substitution
: Using the rainbow scale red, green, and blue parts are exchanged. Quickly create surreal landscapes
and green faces. 
Shift
: The color values are increasingly inverted. Blue colors turn red; green ones appear purple. 
Quantize
: Depending on the setting, colors are either rounded up or down so that the overall number of colors is
reduced. This creates impressive grids and patterns. 
Color fill: Using this slider
, you can color in your video using red, green and blue colors (the basic TV colors). 
Contour: The image
 is reduced to its contours in two sizes (3 x 3 or 5 x 5); vertical or horizontal contours may be selected. 
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Distortion
 Motion: Moving parts of the image
 are enhanced and warped. 
Echo
: The moving images create an optical "echo"; previous images stand still and gradually turn paler until
they completely disappear. 
Whirlpool
: The image is twisted into an "S" shape. 
Fisheye
: The perspective is distorted as if the image were viewed through a fisheye lens. 
Mosaic
: The video is depicted as a mosaic. 
Lens
: The image is dynamically distorted at the edges. 
Sand
: The image is depicted in a granulated manner. 
Kaleidescope
: The left upper corner is mirrored horizontally and vertically. 
Horizontal/Vertical mirror
: The object is reflected vertically or horizontally ?  it appears on its side or upside down. 
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Sharpness
 The fader allows you to regulate the level of image
 sharpness or apply a soft filter. 
"Fine adjustment" allows you to set how sharp surfaces or edges should appear. This enables you to
effectively reduce image
 distortions (noise). 
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Speed
 The playing speed can be adjusted with the slider
 control. The range between 0 and 1 plays the video slowly; values above 1 accelerate playback. If the
playing speed is increased, the object length in the arranger is automatically shortened. 
Reverse: This button
 reverses the playback direction (with the same tempo). 
Note: Since the soundtrack of a movie cannot be played backwards, you have to first separate the
movie object from its soundtrack
. The speed effects cannot be animated! 
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Animation
 Nearly all preset effects may be automated or animated. To animate effects or produce movements,
please read the "Animating objects
" chapter. 

Page 248



Movement effects in the Media Pool
 Size & Position

 Values in:
 Set whether the values are applied in percent or pixels. 

Position
 Left: Enter the start position from the left image
 border. 
Top: 
Enter the start position from the top image border. 
Center:
 Based on the current image size, the image starting points (left and top) will be positioned so that they
are centered. 
Note: Negative values can, of course, also be entered. The image
 borders will then be outside of the visible area. 

Size
 Width: Enter the width of the image
. 
Height:
 Enter the height of the image. 
Note: The size and the position of the image can be roughly entered in the program monitor by simply
moving the image into it and dragging on the handles
. 
Maximize: The image will be maximized according to the movie
's resolution. 
Set original size:
 The image will be scaled to its original size. 
Retain proportions:
 This option makes sure that the image will not be stretched or distorted. The proportions of width to
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height will remain the same. 
Edit: In the "Edit" mode you can change the position and size of the image using handles
 that can be displayed or hidden. 
The frame
 of the video monitor can be moved with the keyboard. 
Nudge the screen 1 pixel: Arrow keys 
Nudge the screen 5 percent: Shift + arrow keys 

Camera movement

 Cutaway
 Cropped cutaways can be used to: 

 display just one section of the photo. 
 to move the clip through the picture with the help of a movement effect ? the result is a type of

camera movement. Please read more on this in the next chapter, "Movement".
In the program monitor, you can set a picture section to serve as the basis for the movement effect. Press
the left mouse button
 and drag out the section you want to use. 

Alternatively, both buttons can be used to specify the section. 
Keep proportions: In this menu
, you can select the format for the section. The format of the original picture is used as the default. 

Movement in direction
Determine the direction in which the selected section
or image
 will move during the time indicated under "duration". In
addition to horizontal and vertical movements, diagonal
movements are also possible. 

Fullscreen
: If this check box is active, the opened section will zoom to fullscreen. If this option is switched off, it
won't be possible to add movement to the section. 
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Preview
: Displays a preview of the section at the playback marker location. 

Direction and time
Zoom in
: The entire picture is displayed and then zoomed to show
only a smaller picture section according to the time set in
"Length of movement". If no portion is previously set, a
central portion of 50% of the picture is set. 
Zoom out
: The selected picture section is displayed and is then
zoomed out to display the entire picture according to the
time set in "Time period". If no portion is previously set, a
central portion of 50% of the picture is set. 

Direction and time
 The value specified here determines the position at which the keyframes for the corresponding
movement effect are set as standard. They determine the positions at which the pan start and stops. 
Note: Automatically placed keyframes can be edited retroactively, and the option will then be set to
"User defined". Read the section "Changing an effect's keyframes" in the chapter "Animating objects
". 

Movement & zoom
Reset:
 This option applies a static zoom to show the
selected section of the picture only. 

The frame
 of the video monitor can be moved with the keyboard. 
Nudge the screen 1 pixel: Arrow keys 
Nudge the screen 5 percent: Shift + arrow keys 
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Size & Position

 Values in:
 Set whether the values are applied in percent or pixels. 

Position
 Left: Enter the start position from the left image
 border. 
Top: 
Enter the start position from the top image border. 
Center:
 Based on the current image size, the image starting points (left and top) will be positioned so that they
are centered. 
Note: Negative values can, of course, also be entered. The image
 borders will then be outside of the visible area. 

Size
 Width: Enter the width of the image
. 
Height:
 Enter the height of the image. 
Note: The size and the position of the image can be roughly entered in the program monitor by simply
moving the image into it and dragging on the handles
. 
Maximize: The image will be maximized according to the movie
's resolution. 
Set original size:
 The image will be scaled to its original size. 
Retain proportions:
 This option makes sure that the image will not be stretched or distorted. The proportions of width to
height will remain the same. 
Edit: In the "Edit" mode you can change the position and size of the image using handles
 that can be displayed or hidden. 
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The frame
 of the video monitor can be moved with the keyboard. 
Nudge the screen 1 pixel: Arrow keys 
Nudge the screen 5 percent: Shift + arrow keys 

Camera movement

 Cutaway
 Cropped cutaways can be used to: 

 display just one section of the photo. 
 to move the clip through the picture with the help of a movement effect ? the result is a type of

camera movement. Please read more on this in the next chapter, "Movement".
In the program monitor, you can set a picture section to serve as the basis for the movement effect. Press
the left mouse button
 and drag out the section you want to use. 

Alternatively, both buttons can be used to specify the section. 
Keep proportions: In this menu
, you can select the format for the section. The format of the original picture is used as the default. 

Movement in direction
Determine the direction in which the selected section
or image
 will move during the time indicated under "duration". In
addition to horizontal and vertical movements, diagonal
movements are also possible. 

Fullscreen
: If this check box is active, the opened section will zoom to fullscreen. If this option is switched off, it
won't be possible to add movement to the section. 
Preview
: Displays a preview of the section at the playback marker location. 
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Direction and time
Zoom in
: The entire picture is displayed and then zoomed to show
only a smaller picture section according to the time set in
"Length of movement". If no portion is previously set, a
central portion of 50% of the picture is set. 
Zoom out
: The selected picture section is displayed and is then
zoomed out to display the entire picture according to the
time set in "Time period". If no portion is previously set, a
central portion of 50% of the picture is set. 

Direction and time
 The value specified here determines the position at which the keyframes for the corresponding
movement effect are set as standard. They determine the positions at which the pan start and stops. 
Note: Automatically placed keyframes can be edited retroactively, and the option will then be set to
"User defined". Read the section "Changing an effect's keyframes" in the chapter "Animating objects
". 

Movement & zoom
Reset:
 This option applies a static zoom to show the
selected section of the picture only. 

The frame
 of the video monitor can be moved with the keyboard. 
Nudge the screen 1 pixel: Arrow keys 
Nudge the screen 5 percent: Shift + arrow keys 
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Camera movement

 Cutaway
 Cropped cutaways can be used to: 

 display just one section of the photo. 
 to move the clip through the picture with the help of a movement effect ? the result is a type of

camera movement. Please read more on this in the next chapter, "Movement".
In the program monitor, you can set a picture section to serve as the basis for the movement effect. Press
the left mouse button
 and drag out the section you want to use. 

Alternatively, both buttons can be used to specify the section. 
Keep proportions: In this menu
, you can select the format for the section. The format of the original picture is used as the default. 

Movement in direction
Determine the direction in which the selected section
or image
 will move during the time indicated under "duration". In
addition to horizontal and vertical movements, diagonal
movements are also possible. 

Fullscreen
: If this check box is active, the opened section will zoom to fullscreen. If this option is switched off, it
won't be possible to add movement to the section. 
Preview
: Displays a preview of the section at the playback marker location. 

Direction and time
Zoom in
: The entire picture is displayed and then zoomed to show
only a smaller picture section according to the time set in
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"Length of movement". If no portion is previously set, a
central portion of 50% of the picture is set. 
Zoom out
: The selected picture section is displayed and is then
zoomed out to display the entire picture according to the
time set in "Time period". If no portion is previously set, a
central portion of 50% of the picture is set. 

Direction and time
 The value specified here determines the position at which the keyframes for the corresponding
movement effect are set as standard. They determine the positions at which the pan start and stops. 
Note: Automatically placed keyframes can be edited retroactively, and the option will then be set to
"User defined". Read the section "Changing an effect's keyframes" in the chapter "Animating objects
". 

Movement & zoom
Reset:
 This option applies a static zoom to show the
selected section of the picture only. 

The frame
 of the video monitor can be moved with the keyboard. 
Nudge the screen 1 pixel: Arrow keys 
Nudge the screen 5 percent: Shift + arrow keys 
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Rotation & Mirror

This button
 resets all settings. 

Note:
 If you animate the object using keyframes, then only the current keyframe is affected by pressing reset. 

Rotate
Rotates the image
 on the horizontal axis. 

Rotates the image on the vertical axis. 

Rotates the image around its center point. 

Straighten horizon 
The image can be rotated around the axis via the slider
. The image is automatically zoomed to avoid black edges. 
Show guidelines
: Activating this check box displays a grid in the program monitor for orientation during horizontal
straightening. 

Mirror
Mirrors the image
 on the vertical axis. 
Mirrors the image on the horizontal axis. 

Rotates the image 90° clockwise. 

Rotates the image 90° counterclockwise. 

Presets
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 Various useful presets are located here. 
A dialog
 opens for opening presets from other folders. 
Save your owns settings as a preset. 
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3D distortion
 This makes real 3D positioning of images possible, letting you distort the image
 in space and move it. Enter the individual corner points numerically or move them in the program monitor
using the mouse. 

This button
 resets all settings. 
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Animation
 Nearly all preset effects may be automated or animated. To animate effects or produce movements,
please read the "Animating objects
" chapter. 
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Video effect plug-ins
 Additional effects may be loaded into MAGIX Video Pro X2 in the form of video effect plug-ins. Video
effects plug-ins are additional programs of third-party manufacturers that can be used to add additional
video effects to video objects. You can use them to extend the comprehensive effects selection of
MAGIX Movie
 Edit Pro 16 even further. 
MAGIX Movie Edit Pro 16 supports the plug-in format of the freeware video editing software
 "VirtualDub", as well as the "VitaScene" and "Adorage" program by "proDAD". A selection of tested
VirtualDub plug-ins (.vdf files, also called VirtualDub filters) and Adorage plug-ins can be downloaded
as an installer package directly from within MAGIX Movie Edit Pro 16. 
Important examples of using plug-ins are, for instance, removing channel logos, disturbances or adding
special effects. 
In this section:
Using video effect plug-ins
Video plug-ins manager
Advanced...
Remove a channel logo with the "Logoaway" plug-in
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Using video effect plug-ins
 In order to be able to use plug-ins, you have to install them first. MAGIX Movie Edit Pro 16 checks
whether plug-ins are already available. If not, it will offer to download them from the Internet or to
manually set the plug-in
 path . 
Note: For the included proDAD programs in the Plus version, please read the special chapter at the end
of this manual! 
In order to use a video effect plug-in, select the video or image object first, then open "Effects -> Video
effects -> Video effects plug-ins" in the Media Pool menu. It lists all available plug-ins on the right side of
the dialog
. 
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Video plug-ins manager

 Effect templates for plugins: MAGIX Movie Edit Pro 16 does not include plugins due to licensing
grounds. However, presets for removing the Channel Logo are provided for some TV channels with the
"logoaway" plug-in
. 

You can save your personal settings by pressing the
"Save" button and remove them from the list by
pressing the "Delete" button
. 

Available plug-ins:
 Here all available plug-ins are listed. 
Add plug-in:
 The selected plug-in is added to the editing chain (plug-ins on the current object list is on the right). You
can load as many plug-ins as you like simultaneously. They are then edited subsequently according to the
list sequence. 
Plug-in settings: Here you can open the settings dialog
 for the selected plug-in. All plug-in settings on the entire list can be saved as a preset (effect templates
for plug-ins). 
Advanced: Opens the Advanced settings
 dialog. 
Navigation buttons:
 Unlike in the Media Pool you can switch to the previous or next movie with the navigation buttons in the
lower part of the dialog of a movie. 
Apply from previous: Uses the settings of the previously set movie. This option is only active if you are
editing objects in sequence with the navigation buttons (see above). 
OK: 
The adjustments made to the settings will be applied to the current movie. 
Apply to all: 
The effects will be applied to all video and picture objects in the slideshow. 
Cancel: Closes the dialog
, the settings will not be applied. 
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Advanced...

 In the "Advanced" dialog, you can specify the search path for plug-ins. MAGIX Movie Edit Pro 16
checks these for available plug-in files at program start and adds these to the list of available plug-ins. "
Add path" adds new search paths, and "Delete path
" removes them from the list again. 
Check for file extension only
: Accelerates the search for new plug-ins if a larger number of plug-ins are available by not checking if
they are valid. 
Scan subfolders
: Extends the search to subfolders below the selected paths. 
Local settings
 Recalculate video effects plug-in on bitmaps for each frame dynamically: If you apply a plug-in to
a bitmap (image), then this option must be activated in case the plug-in
 creates moving effects. 
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Remove a channel logo with the "Logoaway" plug-in
 The "Logoaway" freeware plug-in by Krzystof Wojdan is a high-quality option for removing the channel
logo from your video material. The plug-in attempts to remove the channel logo by reconstructing image
 elements using from the surrounding area. 
Since each station positions its logo at a different location and in different sizes, you can select the presets
for different channels from the effects templates. 
Hint: The broadcasting rights of each channel must be observed. Commercial use of the edited material
clearly constitutes a breach of copyright
. 
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Image stabilization
 The motion stabilizer reduces unsteady camera motion and helps to smooth pans. This option can be
accessed from the context menu
 of a video object or via "Effects -> Open video objects". 
Functionality
 Image
 stabilization balances undesired picture movements. The motion stabilizer equalizes inadvertent
movements in the image by moving the image in the opposite direction in accordance with the wrong
movements. This produces unusable edges in the footage that are cut off automatically, and black strips
replace the edge of the shifted picture, which are then removed using a zoom shot. The result is a clearly
more stable, almost imperceptibly larger picture. 
Application
 Activate the motion stabilizer in the video object FX or context menus. You will see the current video
object in the preview monitor. 
First, check the movie material for shaky scenes by clicking on the "Stabilize" button. Based on the preset
parameters, a relative shift between the pictures is calculated. After concluding the analysis, take a look
at the suggested correction, then use the slider
 for further adjustments. Once you are happy with the final correction, click "OK". If the first scan did not
provide a satisfactory result, try changing the parameters below and repeat the process. 
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Image stabilization dialog

 Stabilizing radius: To prevent the image
 stabilizer from recognizing every camera movement as unwanted shakiness, you can determine the radius
within which movement is accepted; the larger the stabilization radius, the more shakiness is corrected.
Changing this parameter will require re-analysis of the source footage. 
Analysis area
: This area determines the area of the footage that should be analyzed. The center of the image is preset.
If shaking occurs in one area more than in another,  then you can move the analysis area (e.g. a
foreground element at the edge is especially shaky). To do this, use the mouse to "capture" the shaky
area. The smaller the area, the quicker the analysis will be calculated. Generally, changing this parameter
will require re-analysis of the source footage. 
Maximum movement
: Correction moves the image accordingly to the shaking movements. This means that the edge of the
image will be removed. This value determines how large the edge area is which may be cut away by the
stabilization feature; the smaller the value, the less movement correction. Changes to this value are
immediately applied. 
Temporal smoothing
: This value determines the speed of the movements considered shaky. This allows you to differentiate
between a panning shot and a nervous hand-held shot. Changes to this value are immediately applied. 
Cancel: Exits the dialog
 without accepting changes to settings. 
Reset
: Resets the current settings. 
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Create panorama pictures
 This function will turn your photos into a sensation. Add new life to your holiday memories and create
great panoramas with only a few clicks. You don't need to create only "proper" panoramas; let your
imagination run wild and put together anything you want to! You'll see your photos in a new light and
create stunning montages. 

Select pictures for panorama
 Load all necessary images into the film project as usual. The images that should make up the panorama
should be selected one after the other while holding down the "Shift" key. Select the entry "Panorama
photo" from the context menu "Effects
 -> Video object effects". 

Invert image sequence for panorama image
 Sometimes photos are accidentally loaded in the wrong sequence or were created from left to right. If
you forgot to sort your photos correctly beforehand, then simply click "Invert sequence". 

Calculating the panorama image
 If you click "Create", the panorama image
 will be processed. Depending on the resolution and number of original images included, this may take
some time. The original photos are replaced in your slideshow with the panorama image you've created,
but the original files on the hard drive will remain intact. 
Hint: You can create a panorama image
 from a maximum of six images. Click on "More options" for more information on the upgrade. 

Finished panorama (2 images)

 Finished panorama from 2 images 
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Borders
 The "Frame" directory can be accessed via the button in Media Pool. There, you will find bitmap
patterns for the borders of videos. These are much like picture-frames that can be modified by video mix
effects. Drag them to the lowest track of the arranger and select the Bluescreen or Greenscreen effect to
make the blue or green space in the middle transparent for the upper videos. This way you can see the
objects of the upper tracks of the arranger in the field
. 
You can use the lower handles to adjust the size of the borders to fit any length of the video. This allows
you to add a frame
 to a video from start to end. You can also achieve interesting effects by inserting and discarding borders
within a video. 
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Title Editor
 Titles can be used for many applications: as a running text (ticker), subtitles, speech and thought bubbles,
to display date and time, and much more. 

The button in the toolbar
 opens the Title Editor. 

Enter text, e.g. for subtitles, lead or end credits in the video monitor. Texts can be displayed in all kinds
of fonts and colors. 
If you want to format individual words or letters, select them with the mouse and choose a different
format or color. If no selection is made, the entire text will be formatted. 
In this section:
Creating titles from a template
Creating titles without a template
Edit title
Advanced Title Editor settings
3D text
Add time code
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Creating titles from a template
 The Media Pool includes the tab "Title" beside the entry "General", and this features additional,
thematically named title templates. 

 Open one of these entries and select any title template. A simple mouse-click provides a
preview, and double-clicking creates a title object using the template.

Note
: Templates may be applied to an existing title object. Settings outside of the text will be lost! 
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Creating titles without a template
  Try clicking on the entry "General" under "Title" in the Media Pool.
 Next, click in the video monitor on the location where the title should be positioned. 
 Next, simply enter the text via your keyboard.
 After the text has been entered, click the check mark to confirm your entry.
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Edit title
  Click again on the title in the video monitor window or the title object in "Timeline" mode.
 Now change the text however you like. 
 Confirm your entry by clicking the check mark next to the positioning frame.

 Font

Font
: Select the font here that should be
displayed for the text. 

Font style
: Choose here whether all of the text or parts of it
should be shown bold, in italics, or underlined. 
Font size
: Set the size of the text here. 
Direction: Choose here whether the text should be
justified to the left, centered, or to the right within the
positioning frame
. 
Color: Press this button
 to choose the font color. 

Effects

Font style
: Choose here whether all of the text or parts of it
should be shown bold, in italics, or underlined. 
Outline/shadow/3D: This function allows you to add
shadows, 3D effects, and an outline to the text. These
settings can be adjusted in detail via "Advanced
". 

The X3D button converts the title object into a Xara 3D text
object. More about Xara 3D text objects is described in the
section "3D text
". 

Animation

You can make your credits scroll down the
screen, and many other text movements and
effects and designs are also available. 

The display duration for the subject can be set here. 

Templates for animated text are arranged in the other Media Pool categories; the icon and the description
are there to help you find the correct settings. 
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Title object

Center position
: Clicking "Center position" puts the title back in the middle. 

Delete
: The whole title object, i.e. text and settings, will
be deleted. 
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Font

Font
: Select the font here that should be
displayed for the text. 

Font style
: Choose here whether all of the text or parts of it
should be shown bold, in italics, or underlined. 
Font size
: Set the size of the text here. 
Direction: Choose here whether the text should be
justified to the left, centered, or to the right within the
positioning frame
. 
Color: Press this button
 to choose the font color. 

Effects

Font style
: Choose here whether all of the text or parts of it
should be shown bold, in italics, or underlined. 
Outline/shadow/3D: This function allows you to add
shadows, 3D effects, and an outline to the text. These
settings can be adjusted in detail via "Advanced
". 

The X3D button converts the title object into a Xara 3D text
object. More about Xara 3D text objects is described in the
section "3D text
". 

Animation

You can make your credits scroll down the
screen, and many other text movements and
effects and designs are also available. 

The display duration for the subject can be set here. 

Templates for animated text are arranged in the other Media Pool categories; the icon and the description
are there to help you find the correct settings. 

Title object

Center position
: Clicking "Center position" puts the title back in the middle. 
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Delete
: The whole title object, i.e. text and settings, will
be deleted. 
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Effects

Font style
: Choose here whether all of the text or parts of it
should be shown bold, in italics, or underlined. 
Outline/shadow/3D: This function allows you to add
shadows, 3D effects, and an outline to the text. These
settings can be adjusted in detail via "Advanced
". 

The X3D button converts the title object into a Xara 3D text
object. More about Xara 3D text objects is described in the
section "3D text
". 

Animation

You can make your credits scroll down the
screen, and many other text movements and
effects and designs are also available. 

The display duration for the subject can be set here. 

Templates for animated text are arranged in the other Media Pool categories; the icon and the description
are there to help you find the correct settings. 

Title object

Center position
: Clicking "Center position" puts the title back in the middle. 

Delete
: The whole title object, i.e. text and settings, will
be deleted. 
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Animation

You can make your credits scroll down the
screen, and many other text movements and
effects and designs are also available. 

The display duration for the subject can be set here. 

Templates for animated text are arranged in the other Media Pool categories; the icon and the description
are there to help you find the correct settings. 

Title object

Center position
: Clicking "Center position" puts the title back in the middle. 

Delete
: The whole title object, i.e. text and settings, will
be deleted. 
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Title object

Center position
: Clicking "Center position" puts the title back in the middle. 

Delete
: The whole title object, i.e. text and settings, will
be deleted. 
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Advanced Title Editor settings
 Options
 Only use visible TV area: The text will be zoomed so that it will always be within the TV's limits,
which is specified in the Movie effect settings
. 
Background
 Specify here whether the text's background should appear black or white. This is only meaningful if no
other video or image
 object is in the background. 
Text effects
 Edit different text effects in detail. One color may be set for each effect. 
Shadow: The position of the shadow may be set on the horizontal and vertical axes.
Transparency makes the background "shine through" more or less.
Soften
 makes the edge of the shadow harder or softer. 
Outline: A border appears around the letters in the text.
A filled outline appears in the color selected, i.e. as a line in the set width.
If the option is deactivated, then the color of the outline will match the text color; the color of the outline
is selected here. 
3D
: The text appears with a 3D-style outline. The width and thickness of the 3D contour (H) can be set in
points. 
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3D text
 3D text can be created directly from the Title Editor. Click the Title Editor and then press the "X3D
title" button
. The title object will now be turned into a MAGIX 3D object. If you have also installed MAGIX 3D
Maker, the program will open for you to work on the text. 
Presets are also located in the Media Pool under "Titles -> 3D". You can enter or process text here. 
For more information about MAGIX 3D Maker, try the help file. You can open it by pressing "F1" from
within the program. 
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Add time code
 MAGIX Movie Edit Pro 16 can add a time or date ("timecode") to the picture material. To add a
timecode, right click on the video object and choose the "Fade in date as title" option from the context
menu
. 

 If you're using a DV-AVI file (a digital recording from a camcorder, for instance), then the
recording date will be used from the selected section.

 If you're using a different file, the creation date will be used as the timecode.
The title editor is then opened in order to customize the entry. 

Page 282



Slideshow Maker
 Slideshow Maker is ideal for converting still images into moving pictures, adding background music, and
effects. 
Open Slideshow Maker via "File -> Edit -> Wizards". 

In this section:
Style template
Intensity
Transitions
Effects
Properties & title
Background music
Create movie
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Style template
 Select a template that best matches your needs. 

Save/delete style template 
Style templates you have created
yourself appear in the list of included
style templates when you use the
default folder provided as a save
location. 
If you like, these can be deleted again. 
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Intensity
 Controls the portion of video and image
 objects that feature effects. 
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Transitions
 The different sliders are used to set the portion of individual fade types. 
3D / Other: Details
 activates effects or fades in the corresponding category. The arrow below the preview monitor plays a
preview. 
Fade duration
: Set the length of the fades in seconds. 
Random fades
: The fades are set to random values. 
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Effects
 The faders enable the respective effects types to be specified.Details
 activates effects or fades in the corresponding category. The arrow below the preview monitor plays a
preview. 
Treat special image formats intelligently: Panoramas and portrait photos can be treated "intelligently".
If this option is activated, then panoramas and portraits will be treated with special effects adjusted to the
format. These effects can also be selected in the detail view.
If this option is selected, then these images will use the same effects as all other images. 
Random effects
: The faders that control the amount of effects are set randomly. 
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Properties & title
In this section:
Film length
Including video objects
Opening and closing credits
Group associated recordings together

Page 288



Film length
 Resulting film length
: This is an estimation of how long the film will be after applying Slideshow Maker. 
Available music: This is the complete length of the music that is currently selected. Background music
 enables detailed settings for the pieces of music to be used. 
Adjust film length to the music
: An attempt is made to adjust the length of photo objects to the background music. If the film is too short
the music will be cut off. If the film is too long, the music will repeat. 
Adjust music length to the film: Photo objects have a set length, and the resulting film is filled with
music. The music at the end of the movie
 is simply faded out. 
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Including video objects
 Process videos
: If this option is set, then videos will be automatically processed with effects and transitions. 
Length
: Settings may be made here about whether the original length of the video should be maintained or if it
should be shortened. 
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Opening and closing credits
 Set the text for opening and closing credits here. 
Text
: Enter the corresponding text for opening and closing credits that should be added by Slideshow
Maker. 
File: A title template, a video, or an image
 file may also be used. 
Note: Titles created using Slideshow Maker may also be edited
 at any time. 
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Group associated recordings together
 If this option is active, an attempt is made to detect associated events via their date information and to
separate them from each other optically. Detection of individual events is based on the time span of these
events to achieve a sensible separation. 
Begin group with black fade
:A black fade is added between the different events. 
Begin group with title and black fade
:A black fade is added between the different events. A title is also faded in with a suitable duration, e.g.
1st/2nd/3rd day, provided the events take place over multiple days. 
Begin group with title and picture
:A black fade is added between the different events. A title is also faded in with a suitable duration after
the black fade, e.g. 1st/2nd/3rd day, provided the events take place over multiple days. 
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Background music
 Specify here whether and which music should be used for the background. 
Use background music
: Adds background music. 
Load file(s): A file selection dialog
 will open to choose a folder with pieces of music where you can select one or multiple files. 
Remove
: The selected pieces are removed from the list and will not be used. 
Preview
: Previews the selected piece of music. 
Volume: This slider
 controls the volume ratio between the original sound and the background music. 
Tip
: Pieces of music in the first track are listed and used for the background music, provided they are not
removed. 
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Create movie
After all of the important
settings have been made,
click this button
 to produce the film. 

If the results do not match what you imagined, then click "Cancel" to discard the changes. Otherwise,
you can change the settings again or select another style template and click "Create film
". 
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Master effects
 All of the settings made here influence the entire movie. Settings are made separately for each individual
movie in the project. You can open the effects from the the settings via the "Effects" menu
. 
On the right, you'll see a preview of the current settings. Use the position slider to jump to different
positions in the movie or to various scenes in order to see how the selected setting affects the image
 material. 
In this section:
Brightness/Contrast
Color
Sharpness
TV picture
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Brightness/Contrast
 Brightness/Contrast: Use the faders to increase or reduce the brightness and contrast of the image
. 
Selective brightness (gamma): "Gamma" sets the middle gray value transmitted from various color
areas. In the presets menu you can determine which color areas should be used. Using the fader
 you can also set the intensity of the brightness or darkness. 
Color space correction (master effect):
 This option combats colors that are too strong and cannot be properly displayed on your TV. The color
saturation of the photos in question are "turned down" to the maximum level at which they can be
properly displayed. 

Color
 Saturation: Use the saturation slider to increase or reduce the hue proportions in the image
. A newly developed algorithm is now applied that carries out color changes in relation to other
parameters (e.g. contrast settings) to achieve the most natural coloring possible. With just a little bit of
experimentation, you can achieve the most astounding results ? anything from turning summer snapshots
into autumnal scenes to funky pop art... 
Hue
: Use the palette to select a hue for coloring the picture. 
Red/Green/Blue: The "Red/Green/Blue" slider
 corrects the color proportion mix. 

Sharpness
 This fader allows you to regulate the level of image
 sharpness. 
The "fine tuning" option allows you to determine the level of focus for particular surfaces or borders. 
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TV picture
 This option ensures that the image
 size is adapted to fit the real television picture (anti-cropping). Without adjustment, the television might
otherwise crop the image borders. 
Fade in TV display area in the preview monitor:
 This option displays the image borders of the television as lines in the preview monitor. The four image
borders of the TV display area can be set by means of the 4 input fields. In this case, it is necessary to
know the actual size of the TV picture. To determine it, proceed as follows: 
The four image margins can be proportionally adjusted by means of the four input fields. Here it is
important to find the optimal balance between distortion, reduction, bar formation and image cropping: 

 If the same value is entered for every margin, the image size is reduced proportionally. In this
case no distortions will occur, but there will be bars along the edges.

 If different values are entered for the 4 fields, the image size is reduced disproportionally. This
causes image distortion.

Apply margin to:
 With this option the entered values for the four margins are applied as an image reduction. The result can
immediately be viewed on the preview monitor. 
Determining the visible TV frame size
 To determine the picture properties of your television as well as optimal image size editor settings, you
should perform a test run. 

1. Load the Visible TV picture.mvm film from the "My projects > visible TV picture" folder in
Media Pool.

2. Play back the film and read the instructions on the video screen.
3. Copy the slideshow to CD or DVD.
4. Place the disc into your player and play back the film. Compare the TV picture to the picture

displayed on your video screen by MAGIX Movie Edit Pro 16.
5. Determine the proportional value of the borders cropped by the television with the 4

measurement scales along the edges of the test picture.
6. Enter the values in the "Full TV size" editor.

The image
 size is now optimized to your TV picture. Please note: Depending on device settings and disc carrier
type, the cropping values may vary slightly. 

TV picture
 In the context menu
 or in the Effects > Video object effects you will find various adjustments for various specifics of the TV
picture. 
Next to the interlace and anti-flickering filter in the object properties, you will find the option to adjust
the image
 to the real proportions of the TV picture. A special algorithm ensures an optimal ratio between image
size and image borders (anti cropping). 
Interpolation for interlace source material:
 Select this option to remove ridge structures from the (video) image. If, for instance, you extract freeze
frames from a video, these ridge structures appear in image sections showing movement. 
Anti-flicker filter: 
Select this option for freeze frames with very fine structures and high contrast. This filter reduces line
flickering during TV playback. 
Border cropping - offset: Select this option if the edges are cropped during playback on your television.
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Values stored in "Film effect settings"
 will be applied. 
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Audio Effects
In this chapter
Load audio effects from the Media Pool
Using audio effects
Control Effect devices
Sound optimization
Audio effect dialogs
Audio effects in the mixer
MAGIX Mastering Suite
Automatic track damping

Load audio effects from the Media Pool
 In „Effects" > „Audio
 effects" you find several audio effects you can drag & drop onto the audio object. A preview is played
by double clicking the effect. 
Another advantage of this so-called "object-oriented" working method is that automations are moved
automatically with objects when they are moved, since they are attached to the object and not to the
track itself. 

General
Under "Effects -> 
Audio effects ->
General", you will find
audio effects that can
be animated using 
effects curves
. This means that
certain effect settings
can be changed during
playback. 
Effect curves are always object related, i.e. they only apply to one object and are moved or copied
together with the object. 
Note
: The faders AUX 1 and AUX 2 control the volume at which the object's signal is sent to the
corresponding FX tracks in the mixer. 
Audio Cleaning, Echo/Reverb, and Timestrech/Resample
 can also be accessed here. 
Note
: Volume and balance curves are also present in the track. The set values in the curve are also active,
respectively. 

Audio effects presets
 Under "Effects -> Audio effects -> Audio effects presets", you'll find a broad palette of effects settings
which you can add to audio
 objects via drag & drop. A preview can be played back by double-clicking the object corresponding
preset. 

Synthesizer
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 Synthesizers in MAGIX Movie
 Edit Pro 16 can be loaded as individual objects. This is less of an effect than a technical means of
producing your own sound effects. More information is available in "Synthesizers". 
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Load audio effects from the Media Pool
 In „Effects" > „Audio
 effects" you find several audio effects you can drag & drop onto the audio object. A preview is played
by double clicking the effect. 
Another advantage of this so-called "object-oriented" working method is that automations are moved
automatically with objects when they are moved, since they are attached to the object and not to the
track itself. 

General
Under "Effects -> 
Audio effects ->
General", you will find
audio effects that can
be animated using 
effects curves
. This means that
certain effect settings
can be changed during
playback. 
Effect curves are always object related, i.e. they only apply to one object and are moved or copied
together with the object. 
Note
: The faders AUX 1 and AUX 2 control the volume at which the object's signal is sent to the
corresponding FX tracks in the mixer. 
Audio Cleaning, Echo/Reverb, and Timestrech/Resample
 can also be accessed here. 
Note
: Volume and balance curves are also present in the track. The set values in the curve are also active,
respectively. 

Audio effects presets
 Under "Effects -> Audio effects -> Audio effects presets", you'll find a broad palette of effects settings
which you can add to audio
 objects via drag & drop. A preview can be played back by double-clicking the object corresponding
preset. 

Synthesizer
 Synthesizers in MAGIX Movie
 Edit Pro 16 can be loaded as individual objects. This is less of an effect than a technical means of
producing your own sound effects. More information is available in "Synthesizers". 
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Using audio effects
 Track effects
 Besides audio
 effects in the object (audio cleaning, reverb/echo, timestretch/resample, Surround, etc.), a separate track
effects rack with equalizer, reverb/echo, compressor as well as plug-ins can be used in each mixer track. 

The plug-ins are loaded via the plug-ins slot. 

You can open the track audio effects rack with the FX 
button
. 

A light blue track FX button
 indicates that effects are active in the track. 
Track effects always affect all audio objects of a track, for instance, they also affect individual record
takes of an audio recording. 
Master effects
 Master effects influence the mixed sum of all audio tracks. For this purpose a Master Audio Effects
Rack and further plug-ins are provided. The MAGIX Mastering Suite
 is also available to help produce perfect sound. 
Note
: This saves storage space as opposed to applying an effect to each object individually. Object effects, on
the other hand, that are only calculated for the affected object are played back to save computing
power. 
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Control Effect devices
 The effects are controlled in the conventional way by the use of slider
 controls, turning knobs, buttons or using graphic sensor fields. 
Sensor fields: Sensor fields can be intuitively used with mouse movethe sound of the audio
 and the respective effect settings change according to the mouse movement. For every effect, two
settings are simultaneously affected within the sensor fields (such as echo delay and feedback). 
Power:
 Every effects device in the rack can be separately switched on or off. 
Reset: Every effect has a reset button
 that restores the effect device's initial default (off). The effect is not calculated into the sound, and the
effect is not rendered. 
Preset: Each effects device is equipped with a selection of presets are selected through the dropdown
menu
. 
Bypass: Some effects are equipped with a bypass button
 which bypasses the effects device. The bypass button allows you to directly compare the neutral,
unedited sound of the audio object with the effects setting you have chosen. 
A/B: Similar to the bypass button, the A/B button also compares two settings with each other. If you
have selected a preset for the effect and make manual changes to it later, you can compare the original
preset sound with the new settings by using the A/B button
. 
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Sound optimization
 This option opens an editor for correcting audio
 material discrepancies. 
Select the cleaning function you desire from the upper part of the dialog
: 

 The equalizer allows you to manipulate the frequency spectrum ? perfect for cleaning up muffled
dialog. 

 The compressor is a dynamic volume control that lends the overall sound a deeper, richer quality.
 The stereo FX processor justifies the position of the sound in the stereo panorama.
 DeNoiser, DeClipper, and DeHisser are professional noise reduction tools that do exactly what

their titles say they do.
Presets: You can try out the suitability of a number of presets in the preset menu
. 
Temporarily deactivate all effects:
 Switches all the effects off. 
Apply to all scenes: Applies the selected cleaning settings of all effects to every scene of the movie
. 

DeClipper
 Should the input level of an audio
 recording be too high, then overmodulation (digital distortion) may result at the loudest parts (the signal
peaks). This digital distortion can also be called "clipping". At the overmodulated area, the values that are
too high are simply cut off, and the typical, quite unpleasant sounding crackling distortions are heard. 
MAGIX Movie
 Edit Pro 16 contains a special function for dealing with digital clipping and analog distortions. 
Using the fader, you can set at what level the DeClipper should register a signal as being overmodulated
and, if required, correct it (clip level
). This is important, since different sound cards show different clipping methods. The more the fader is
turned up, the lower the level recognized by the program as overmodulated. If the clip level is set too
high, unwanted sound modification may occur. 
Get clip level: The clip level
 is gauged automatically. 

DeNoiser
 The DeNoiser removes persistent background noise like computer hum, hissing, noises from sound
charts, disturbance from ground circuits, interference from audio
 equipment with high-impedance outputs (such as record players), impact noise, or the turntable rumble. 
The DeNoiser requires a noise sample. Some typical noise sounds are included in the "Preset" selection
menu
. 
Set the degree to which the noise should be reduced with the fader
. It is often better to reduce interference signals by 3-6 dB rather than as much as is possible in order to
keep the sound "natural". 
A different option consists of creating a noise sample yourself. All that's needed is a short section from
the audio track in which the distortion can be found. To get it, switch to the DeNoiser dialog by pressing
"Advanced
". 

DeNoiser – Advanced settings
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 Step 1: Choose a noise sample
 First of all, a sample of the distortion you wish to remove must be selected, i.e. a so-called "noise
sample". 
You have two options to choose from: 
Pick out typical background noise: You can select and use a number of typical background noises
from the flip menu. Select one and listen to it by pressing the "Play" button
. If it is similar to the background noise in your sound track, go ahead and use it (see "Step 2: Removing
background noise"). 
Extract a new noise sample from an audio track:
 You can also pick out a short passage (from the existing sound track) in which you can hear the
background noise. 
Automatic search:
 Searches especially quiet passages in which background noise is most noticeable. 
Previous / Play / Next:
 These buttons allow you to play all of the passages found for easy comparison. 
Save as: Once found, you can save noise samples to the hard drive. They then appear as entries in the
"Typical background noises" flip menu
 to be used in other projects. 
If you only wish to use the noise sample in the current project
, you don't have to save. Instead just go to the "Remove noise" category. 
Step 2: Removing background noise
 Noise level:
 The level of the noise reduction function should be set as precisely as possible. Values that are too low
are expressed at a low distortion dampening level and in artifacts, like noises or "twittering" (see below).
High settings produce dull results ? useful signals that sound similar to hissing noises are also filtered
away. Try to find the best setting for the project at hand. 
Reducer:
 This sets the balance between the original signal and the signal with the applied noise reduction. It's often
better to reduce interference signals by 3-6 dB rather than as much as is possible, so as to keep the
sound "natural". In case of buzzing, it's best to apply complete removal. 

Dehisser
 The DeHisser eliminates regular "white" noise typically produced by analog tape recordings, microphone
pre-amplifiers, A/D converters, or transformers. 
Noise reduction can be regulated in decibels with the fader
. It is often better to reduce interference signals by 3-6 dB rather than as much as possible in order to
keep the sound "natural". 
Noise level: 
You can choose between different noise levels. The level of the noise reduction function should be set as
precisely as possible. Low settings result in incomplete deletion of the hissing. Incomplete deleting of
hissing produces artifacts and should be avoided, since high settings will produce dull results and some
useful signals (i.e. woodwinds) which are similar to hissing are also filtered away. 

Equalizer
 The 10-track equalizer divides the frequency spectrum into 10 areas (tracks) and supplies them with
separate volume controls to allow you to achieve many impressive effects, from the simple rising of the
bass to total sound transformation. If you raise the low frequencies too much throughout the whole level,
it might cause distortions. 
Fader: 
The volume of each of the 10 frequency bands can be set separately with the 10 volume controls. 
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Link frequency bands:
 The frequency fields can be bundled together flexibly in order to avoid artificial-sounding exaggeration in
individual frequency fields. 

Compressor
 The compressor is essentially an automated dynamic volume control tool. Pitch dynamics are limited,
loud passages stay loud, and low passages become louder. Compression is often used to make the
material more powerful, particularly for bass recordings and vocals, but also as master effects in the
mixer for adding to the overall sound. 
Ratio:
 Regulates the compression ratio. 
Function: 
Defines the compressor's mode of operation depending upon the sound material. 

Stereo FX
 The stereo FX processor provides adjustment of the alignment of the audio
 material in the stereo balance. If the stereo recordings sound weak and undifferentiated, an extension of
the stereo base width can often provide better transparency. 
Bandwidth control: 
Adjust the bandwidth between mono (on the extreme left), unchanged base width (center) and maximum
bandwidth ("wide" on the extreme right). 
Reducing the bandwidth can raise the overall level. In extreme cases, when the left and the right channels
include identical material and the bandwidth control is pushed to the extreme left on "mono", the result
can be a level increase of 3 decibels. 
Raising the bandwidth (values of 100) diminishes the mono compatibility. 
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DeClipper
 Should the input level of an audio
 recording be too high, then overmodulation (digital distortion) may result at the loudest parts (the signal
peaks). This digital distortion can also be called "clipping". At the overmodulated area, the values that are
too high are simply cut off, and the typical, quite unpleasant sounding crackling distortions are heard. 
MAGIX Movie
 Edit Pro 16 contains a special function for dealing with digital clipping and analog distortions. 
Using the fader, you can set at what level the DeClipper should register a signal as being overmodulated
and, if required, correct it (clip level
). This is important, since different sound cards show different clipping methods. The more the fader is
turned up, the lower the level recognized by the program as overmodulated. If the clip level is set too
high, unwanted sound modification may occur. 
Get clip level: The clip level
 is gauged automatically. 

DeNoiser
 The DeNoiser removes persistent background noise like computer hum, hissing, noises from sound
charts, disturbance from ground circuits, interference from audio
 equipment with high-impedance outputs (such as record players), impact noise, or the turntable rumble. 
The DeNoiser requires a noise sample. Some typical noise sounds are included in the "Preset" selection
menu
. 
Set the degree to which the noise should be reduced with the fader
. It is often better to reduce interference signals by 3-6 dB rather than as much as is possible in order to
keep the sound "natural". 
A different option consists of creating a noise sample yourself. All that's needed is a short section from
the audio track in which the distortion can be found. To get it, switch to the DeNoiser dialog by pressing
"Advanced
". 

DeNoiser – Advanced settings
 Step 1: Choose a noise sample
 First of all, a sample of the distortion you wish to remove must be selected, i.e. a so-called "noise
sample". 
You have two options to choose from: 
Pick out typical background noise: You can select and use a number of typical background noises
from the flip menu. Select one and listen to it by pressing the "Play" button
. If it is similar to the background noise in your sound track, go ahead and use it (see "Step 2: Removing
background noise"). 
Extract a new noise sample from an audio track:
 You can also pick out a short passage (from the existing sound track) in which you can hear the
background noise. 
Automatic search:
 Searches especially quiet passages in which background noise is most noticeable. 
Previous / Play / Next:
 These buttons allow you to play all of the passages found for easy comparison. 
Save as: Once found, you can save noise samples to the hard drive. They then appear as entries in the
"Typical background noises" flip menu
 to be used in other projects. 
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If you only wish to use the noise sample in the current project
, you don't have to save. Instead just go to the "Remove noise" category. 
Step 2: Removing background noise
 Noise level:
 The level of the noise reduction function should be set as precisely as possible. Values that are too low
are expressed at a low distortion dampening level and in artifacts, like noises or "twittering" (see below).
High settings produce dull results ? useful signals that sound similar to hissing noises are also filtered
away. Try to find the best setting for the project at hand. 
Reducer:
 This sets the balance between the original signal and the signal with the applied noise reduction. It's often
better to reduce interference signals by 3-6 dB rather than as much as is possible, so as to keep the
sound "natural". In case of buzzing, it's best to apply complete removal. 

Dehisser
 The DeHisser eliminates regular "white" noise typically produced by analog tape recordings, microphone
pre-amplifiers, A/D converters, or transformers. 
Noise reduction can be regulated in decibels with the fader
. It is often better to reduce interference signals by 3-6 dB rather than as much as possible in order to
keep the sound "natural". 
Noise level: 
You can choose between different noise levels. The level of the noise reduction function should be set as
precisely as possible. Low settings result in incomplete deletion of the hissing. Incomplete deleting of
hissing produces artifacts and should be avoided, since high settings will produce dull results and some
useful signals (i.e. woodwinds) which are similar to hissing are also filtered away. 

Equalizer
 The 10-track equalizer divides the frequency spectrum into 10 areas (tracks) and supplies them with
separate volume controls to allow you to achieve many impressive effects, from the simple rising of the
bass to total sound transformation. If you raise the low frequencies too much throughout the whole level,
it might cause distortions. 
Fader: 
The volume of each of the 10 frequency bands can be set separately with the 10 volume controls. 
Link frequency bands:
 The frequency fields can be bundled together flexibly in order to avoid artificial-sounding exaggeration in
individual frequency fields. 

Compressor
 The compressor is essentially an automated dynamic volume control tool. Pitch dynamics are limited,
loud passages stay loud, and low passages become louder. Compression is often used to make the
material more powerful, particularly for bass recordings and vocals, but also as master effects in the
mixer for adding to the overall sound. 
Ratio:
 Regulates the compression ratio. 
Function: 
Defines the compressor's mode of operation depending upon the sound material. 

Stereo FX
 The stereo FX processor provides adjustment of the alignment of the audio
 material in the stereo balance. If the stereo recordings sound weak and undifferentiated, an extension of
the stereo base width can often provide better transparency. 
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Bandwidth control: 
Adjust the bandwidth between mono (on the extreme left), unchanged base width (center) and maximum
bandwidth ("wide" on the extreme right). 
Reducing the bandwidth can raise the overall level. In extreme cases, when the left and the right channels
include identical material and the bandwidth control is pushed to the extreme left on "mono", the result
can be a level increase of 3 decibels. 
Raising the bandwidth (values of 100) diminishes the mono compatibility. 
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DeNoiser
 The DeNoiser removes persistent background noise like computer hum, hissing, noises from sound
charts, disturbance from ground circuits, interference from audio
 equipment with high-impedance outputs (such as record players), impact noise, or the turntable rumble. 
The DeNoiser requires a noise sample. Some typical noise sounds are included in the "Preset" selection
menu
. 
Set the degree to which the noise should be reduced with the fader
. It is often better to reduce interference signals by 3-6 dB rather than as much as is possible in order to
keep the sound "natural". 
A different option consists of creating a noise sample yourself. All that's needed is a short section from
the audio track in which the distortion can be found. To get it, switch to the DeNoiser dialog by pressing
"Advanced
". 

DeNoiser – Advanced settings
 Step 1: Choose a noise sample
 First of all, a sample of the distortion you wish to remove must be selected, i.e. a so-called "noise
sample". 
You have two options to choose from: 
Pick out typical background noise: You can select and use a number of typical background noises
from the flip menu. Select one and listen to it by pressing the "Play" button
. If it is similar to the background noise in your sound track, go ahead and use it (see "Step 2: Removing
background noise"). 
Extract a new noise sample from an audio track:
 You can also pick out a short passage (from the existing sound track) in which you can hear the
background noise. 
Automatic search:
 Searches especially quiet passages in which background noise is most noticeable. 
Previous / Play / Next:
 These buttons allow you to play all of the passages found for easy comparison. 
Save as: Once found, you can save noise samples to the hard drive. They then appear as entries in the
"Typical background noises" flip menu
 to be used in other projects. 
If you only wish to use the noise sample in the current project
, you don't have to save. Instead just go to the "Remove noise" category. 
Step 2: Removing background noise
 Noise level:
 The level of the noise reduction function should be set as precisely as possible. Values that are too low
are expressed at a low distortion dampening level and in artifacts, like noises or "twittering" (see below).
High settings produce dull results ? useful signals that sound similar to hissing noises are also filtered
away. Try to find the best setting for the project at hand. 
Reducer:
 This sets the balance between the original signal and the signal with the applied noise reduction. It's often
better to reduce interference signals by 3-6 dB rather than as much as is possible, so as to keep the
sound "natural". In case of buzzing, it's best to apply complete removal. 

Dehisser
 The DeHisser eliminates regular "white" noise typically produced by analog tape recordings, microphone
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pre-amplifiers, A/D converters, or transformers. 
Noise reduction can be regulated in decibels with the fader
. It is often better to reduce interference signals by 3-6 dB rather than as much as possible in order to
keep the sound "natural". 
Noise level: 
You can choose between different noise levels. The level of the noise reduction function should be set as
precisely as possible. Low settings result in incomplete deletion of the hissing. Incomplete deleting of
hissing produces artifacts and should be avoided, since high settings will produce dull results and some
useful signals (i.e. woodwinds) which are similar to hissing are also filtered away. 

Equalizer
 The 10-track equalizer divides the frequency spectrum into 10 areas (tracks) and supplies them with
separate volume controls to allow you to achieve many impressive effects, from the simple rising of the
bass to total sound transformation. If you raise the low frequencies too much throughout the whole level,
it might cause distortions. 
Fader: 
The volume of each of the 10 frequency bands can be set separately with the 10 volume controls. 
Link frequency bands:
 The frequency fields can be bundled together flexibly in order to avoid artificial-sounding exaggeration in
individual frequency fields. 

Compressor
 The compressor is essentially an automated dynamic volume control tool. Pitch dynamics are limited,
loud passages stay loud, and low passages become louder. Compression is often used to make the
material more powerful, particularly for bass recordings and vocals, but also as master effects in the
mixer for adding to the overall sound. 
Ratio:
 Regulates the compression ratio. 
Function: 
Defines the compressor's mode of operation depending upon the sound material. 

Stereo FX
 The stereo FX processor provides adjustment of the alignment of the audio
 material in the stereo balance. If the stereo recordings sound weak and undifferentiated, an extension of
the stereo base width can often provide better transparency. 
Bandwidth control: 
Adjust the bandwidth between mono (on the extreme left), unchanged base width (center) and maximum
bandwidth ("wide" on the extreme right). 
Reducing the bandwidth can raise the overall level. In extreme cases, when the left and the right channels
include identical material and the bandwidth control is pushed to the extreme left on "mono", the result
can be a level increase of 3 decibels. 
Raising the bandwidth (values of 100) diminishes the mono compatibility. 
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DeNoiser – Advanced settings
 Step 1: Choose a noise sample
 First of all, a sample of the distortion you wish to remove must be selected, i.e. a so-called "noise
sample". 
You have two options to choose from: 
Pick out typical background noise: You can select and use a number of typical background noises
from the flip menu. Select one and listen to it by pressing the "Play" button
. If it is similar to the background noise in your sound track, go ahead and use it (see "Step 2: Removing
background noise"). 
Extract a new noise sample from an audio track:
 You can also pick out a short passage (from the existing sound track) in which you can hear the
background noise. 
Automatic search:
 Searches especially quiet passages in which background noise is most noticeable. 
Previous / Play / Next:
 These buttons allow you to play all of the passages found for easy comparison. 
Save as: Once found, you can save noise samples to the hard drive. They then appear as entries in the
"Typical background noises" flip menu
 to be used in other projects. 
If you only wish to use the noise sample in the current project
, you don't have to save. Instead just go to the "Remove noise" category. 
Step 2: Removing background noise
 Noise level:
 The level of the noise reduction function should be set as precisely as possible. Values that are too low
are expressed at a low distortion dampening level and in artifacts, like noises or "twittering" (see below).
High settings produce dull results ? useful signals that sound similar to hissing noises are also filtered
away. Try to find the best setting for the project at hand. 
Reducer:
 This sets the balance between the original signal and the signal with the applied noise reduction. It's often
better to reduce interference signals by 3-6 dB rather than as much as is possible, so as to keep the
sound "natural". In case of buzzing, it's best to apply complete removal. 

Dehisser
 The DeHisser eliminates regular "white" noise typically produced by analog tape recordings, microphone
pre-amplifiers, A/D converters, or transformers. 
Noise reduction can be regulated in decibels with the fader
. It is often better to reduce interference signals by 3-6 dB rather than as much as possible in order to
keep the sound "natural". 
Noise level: 
You can choose between different noise levels. The level of the noise reduction function should be set as
precisely as possible. Low settings result in incomplete deletion of the hissing. Incomplete deleting of
hissing produces artifacts and should be avoided, since high settings will produce dull results and some
useful signals (i.e. woodwinds) which are similar to hissing are also filtered away. 

Equalizer
 The 10-track equalizer divides the frequency spectrum into 10 areas (tracks) and supplies them with
separate volume controls to allow you to achieve many impressive effects, from the simple rising of the
bass to total sound transformation. If you raise the low frequencies too much throughout the whole level,
it might cause distortions. 
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Fader: 
The volume of each of the 10 frequency bands can be set separately with the 10 volume controls. 
Link frequency bands:
 The frequency fields can be bundled together flexibly in order to avoid artificial-sounding exaggeration in
individual frequency fields. 

Compressor
 The compressor is essentially an automated dynamic volume control tool. Pitch dynamics are limited,
loud passages stay loud, and low passages become louder. Compression is often used to make the
material more powerful, particularly for bass recordings and vocals, but also as master effects in the
mixer for adding to the overall sound. 
Ratio:
 Regulates the compression ratio. 
Function: 
Defines the compressor's mode of operation depending upon the sound material. 

Stereo FX
 The stereo FX processor provides adjustment of the alignment of the audio
 material in the stereo balance. If the stereo recordings sound weak and undifferentiated, an extension of
the stereo base width can often provide better transparency. 
Bandwidth control: 
Adjust the bandwidth between mono (on the extreme left), unchanged base width (center) and maximum
bandwidth ("wide" on the extreme right). 
Reducing the bandwidth can raise the overall level. In extreme cases, when the left and the right channels
include identical material and the bandwidth control is pushed to the extreme left on "mono", the result
can be a level increase of 3 decibels. 
Raising the bandwidth (values of 100) diminishes the mono compatibility. 
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Dehisser
 The DeHisser eliminates regular "white" noise typically produced by analog tape recordings, microphone
pre-amplifiers, A/D converters, or transformers. 
Noise reduction can be regulated in decibels with the fader
. It is often better to reduce interference signals by 3-6 dB rather than as much as possible in order to
keep the sound "natural". 
Noise level: 
You can choose between different noise levels. The level of the noise reduction function should be set as
precisely as possible. Low settings result in incomplete deletion of the hissing. Incomplete deleting of
hissing produces artifacts and should be avoided, since high settings will produce dull results and some
useful signals (i.e. woodwinds) which are similar to hissing are also filtered away. 

Equalizer
 The 10-track equalizer divides the frequency spectrum into 10 areas (tracks) and supplies them with
separate volume controls to allow you to achieve many impressive effects, from the simple rising of the
bass to total sound transformation. If you raise the low frequencies too much throughout the whole level,
it might cause distortions. 
Fader: 
The volume of each of the 10 frequency bands can be set separately with the 10 volume controls. 
Link frequency bands:
 The frequency fields can be bundled together flexibly in order to avoid artificial-sounding exaggeration in
individual frequency fields. 

Compressor
 The compressor is essentially an automated dynamic volume control tool. Pitch dynamics are limited,
loud passages stay loud, and low passages become louder. Compression is often used to make the
material more powerful, particularly for bass recordings and vocals, but also as master effects in the
mixer for adding to the overall sound. 
Ratio:
 Regulates the compression ratio. 
Function: 
Defines the compressor's mode of operation depending upon the sound material. 

Stereo FX
 The stereo FX processor provides adjustment of the alignment of the audio
 material in the stereo balance. If the stereo recordings sound weak and undifferentiated, an extension of
the stereo base width can often provide better transparency. 
Bandwidth control: 
Adjust the bandwidth between mono (on the extreme left), unchanged base width (center) and maximum
bandwidth ("wide" on the extreme right). 
Reducing the bandwidth can raise the overall level. In extreme cases, when the left and the right channels
include identical material and the bandwidth control is pushed to the extreme left on "mono", the result
can be a level increase of 3 decibels. 
Raising the bandwidth (values of 100) diminishes the mono compatibility. 
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Equalizer
 The 10-track equalizer divides the frequency spectrum into 10 areas (tracks) and supplies them with
separate volume controls to allow you to achieve many impressive effects, from the simple rising of the
bass to total sound transformation. If you raise the low frequencies too much throughout the whole level,
it might cause distortions. 
Fader: 
The volume of each of the 10 frequency bands can be set separately with the 10 volume controls. 
Link frequency bands:
 The frequency fields can be bundled together flexibly in order to avoid artificial-sounding exaggeration in
individual frequency fields. 

Compressor
 The compressor is essentially an automated dynamic volume control tool. Pitch dynamics are limited,
loud passages stay loud, and low passages become louder. Compression is often used to make the
material more powerful, particularly for bass recordings and vocals, but also as master effects in the
mixer for adding to the overall sound. 
Ratio:
 Regulates the compression ratio. 
Function: 
Defines the compressor's mode of operation depending upon the sound material. 

Stereo FX
 The stereo FX processor provides adjustment of the alignment of the audio
 material in the stereo balance. If the stereo recordings sound weak and undifferentiated, an extension of
the stereo base width can often provide better transparency. 
Bandwidth control: 
Adjust the bandwidth between mono (on the extreme left), unchanged base width (center) and maximum
bandwidth ("wide" on the extreme right). 
Reducing the bandwidth can raise the overall level. In extreme cases, when the left and the right channels
include identical material and the bandwidth control is pushed to the extreme left on "mono", the result
can be a level increase of 3 decibels. 
Raising the bandwidth (values of 100) diminishes the mono compatibility. 
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Compressor
 The compressor is essentially an automated dynamic volume control tool. Pitch dynamics are limited,
loud passages stay loud, and low passages become louder. Compression is often used to make the
material more powerful, particularly for bass recordings and vocals, but also as master effects in the
mixer for adding to the overall sound. 
Ratio:
 Regulates the compression ratio. 
Function: 
Defines the compressor's mode of operation depending upon the sound material. 

Stereo FX
 The stereo FX processor provides adjustment of the alignment of the audio
 material in the stereo balance. If the stereo recordings sound weak and undifferentiated, an extension of
the stereo base width can often provide better transparency. 
Bandwidth control: 
Adjust the bandwidth between mono (on the extreme left), unchanged base width (center) and maximum
bandwidth ("wide" on the extreme right). 
Reducing the bandwidth can raise the overall level. In extreme cases, when the left and the right channels
include identical material and the bandwidth control is pushed to the extreme left on "mono", the result
can be a level increase of 3 decibels. 
Raising the bandwidth (values of 100) diminishes the mono compatibility. 
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Stereo FX
 The stereo FX processor provides adjustment of the alignment of the audio
 material in the stereo balance. If the stereo recordings sound weak and undifferentiated, an extension of
the stereo base width can often provide better transparency. 
Bandwidth control: 
Adjust the bandwidth between mono (on the extreme left), unchanged base width (center) and maximum
bandwidth ("wide" on the extreme right). 
Reducing the bandwidth can raise the overall level. In extreme cases, when the left and the right channels
include identical material and the bandwidth control is pushed to the extreme left on "mono", the result
can be a level increase of 3 decibels. 
Raising the bandwidth (values of 100) diminishes the mono compatibility. 
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Audio effect dialogs
 Some of the following effects can be opened individually (via the context menu
), or as part of the track or master effects rack. However, the functionality remains the same. 
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Reverb/Delay

 The reverb effect device offers newly developed and very realistic reverb algorithms to add more room
depth to your recording. 
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Reverb
 Reverb is probably the most important, but also the most difficult effect to generate. 

Fundamentals
 Our everyday experience shows that not every room matches every instrument. Thus we have designed
"virtual" rooms. However, it still remains important to find the correct parameters. Here are some
examples of parameters that are decisive for the sound impression in real and virtual rooms: 

 Size of room: The larger the room, the longer the sound travels between walls or objects. Our
brain "calculates" the size from the time difference. The size impression is mainly determined from
so-called first reflections and the discreet echo. We don't notice a (diffused) reverb.

 The reverberation time is mainly influenced by the composition of the walls, ceilings, and floors.
This reverb time is highly frequency-dependent. For instance, the highs and mids are dampened
more in rooms with curtains, carpets, furniture, and some corners than in an empty, tiled room.

 The density of the reflection. The sequence of the first reflection is particularly important. A room
with many individually recognizable echoes feels alive, especially if they are quite far apart.

 The diffusion. Simple reverb machines do not take into account that reflections become more and
more complex as they develop. They blur the first echoes at the beginning, which sounds artificial
and "two-dimensional" for many signals. Our reverb effect works like a real room instead where
individual echoes can still be heard at the beginning of the reverb but then reflect amongst each
other more and more until they disappear in the signal sustain as a so-called "diffused hiss".

The presets include many rooms that were designed for certain instruments and applications and whose
internal parameters have been optimized for these applications. However, you can influence most of the
characteristics of the room using the provided sliders. 
In addition to the rooms we have modeled two device types in the reverb effect that allow you to create
an artificial reverb for a longer time: Plate Reverb and Spring Reverb. 

Plate reverb
 A plate reverb consists of a large metal plate (often 0.5 to 1m² thick, or more) that is put into motion by
a magnet and coil system (similar to a loudspeaker). On the reverb plate, so-called "taps" are positioned
at different locations. These are pick-ups comparable to those on a guitar. Reverb plates have a very
dense sound (high diffusion); no direct echo can be heard. They are therefore ideal for percussive metal.
A plate reverb generates a smooth "pleasant effect" with vocals. 

Spring reverb
 You probably remember spring reverb from guitar and keyboard amps, particularly the older ones. At
the bottom of these amps, a unit consisting of two to four spirals is mounted on a vibration-free carriage.
As with the reverb plate, it uses systems for transforming the electric signal into a mechanical one. There
are different designs and sizes of spring reverb; however, they all have the same quite peculiar sound: the
typical "bloing" sound when the springs are moved, similar to splashing. When the reverb dies away the
basic pitch of the spring(s) can usually be heard quite clearly. Furthermore, the frequency range is
considerably limited due to the losses in the spirals and in the used pick-up/transmitter. Despite this, the
sound is special and some of the latest music styles (e.g. dub & reggae) would hardly be possible without
spring reverb. 

Parameters
 The reverb effect has the following parameters: 
Size: 
Defines the size of the room (or the system for the plate and spring). With some low "size" settings, you
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can also reduce the distance between the individual reflections. This allows resonance to develop
(accentuated frequency ranges), which can sound oppressive if the reverb sustain is too long. The proper
size for each instrument can be gauged by taking into account the interplay between the room and the
resonance. 
Time: 
Reverberation time. This controller lets you define how far the echo will be absorbed, i.e. the time for the
reverb to die away. Turning this knob to the left minimizes the time. You will then only hear the first
reflection. Turning the knob to the right minimizes the absorption, and therefore results in a long sustained
reverberation. 
Color: 
Within certain limits, you can influence the sound characteristic of the effect. The effect of this controller
depends on the used preset. In rooms, "color" controls the dampening of the highs in the reverb (from
dark to bright) as well as pre-filtering of the signal. The controllers for plate and spring presets also
determine the dampening of the basses. 
Mix: 
This controller sets the mix ratio between the original and the edited signal. For rooms, you can quite
easily move a signal further into the room by increasing the amount of effect. The last four presets are
intended for use in an AUX channel of the mixer and are set to 100%. 

Presets
 The presets are primarily sorted by instruments, but you can (and should) choose which preset you want
to use for which instrument. 

Delay
 This effect is like an echo which delays the signal and repeats it. 
Delay
: This sets the period of time between the individual echoes. The more the control is turned to the left, the
faster the echoes will follow each other. 
Feedback
: This adjusts the number of echoes. Turn the dial completely to the left, there is no echo at all; turn it
completely to the right and there are seemingly endless repetitions. 
Mix: This fader
 determines how much of the unprocessed original sound (dry signal) is subjected to the echo (wet
signal). Application of this effect in an AUX bus requires the controller to be set to 100% (all the way to
the right). 
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Timestretch and pitchshift

 This effect device changes the object's speed and/or pitch. 
Pitch:
 This control changes the pitch independent of the object's speed ('pitch-shifting'). 
Tempo:
 This control changes the tempo independent of the pitch ("time-stretching"). The object acts as if it were
compressed or stretched on the track. 
Tones/BPM:
 These fields are used to numerically enter the pitch or speed change. Only MAGIX Soundpool files are
suitable for numerical entries as the contain information on pitch and speed. 
Setup: This button opens a setup dialog
 where you can select various pitchshifting and timestretching procedures. 

 Standard: Timestretching and pitchshifting in standard quality. This method is suitable for audio
material without a pronounced beat. Beat markers are evaluated to improve audio quality.

 Smoothed: Timestretching and pitchshifting for audio material without pulsing elements. The
method is suitable for polyphonic orchestral instruments, pauses, speech, and singing. Beat
markers are not evaluated. 

 Here a considerably more complex algorithm is used which requires more processing time. The
material can now also be used on very large factors (0.2...50) without bringing about strong
artifacts. The material is "smoothed", which makes the sound softer and emits it at an adjusted
phase level. This smoothing is hardly audible, for example, with speech, singing or solo
instrumentation. Problems in the shape of distortions may arise with more complex spectra
(sound mixes from various instruments or finished mixes).

 Beat marker slicing: Beat-synchronous timestretching and pitchshifting via splitting and
temporal repositioning. Exactly set beat markers are required at the beats or transients. The
markers can be generated in real time (automatically) or read from the WAV file if available
(patched). In the Plus version's included MAGIX Music Editor, a patching tool is provided for
users to set the markers themselves. The algorithm is suitable for rhythmic material that can be
divided into individual beats or notes. This requires a low audio level before each beat or note.

 Beat marker stretching: Beat-synchronous timestretching and pitchshifting in standard quality.
The material is stretched between beat markers positions so that the beats or attacks at the beat
marker positions are not impaired by stretching. The markers can be generated in real time
(automatically) or read from the source file if available (patched). This method is suitable for
rhythmic material that can not be divided into individual beats or notes because the beats or notes
overlap each other.

 Beat marker stretching (smoothed): Beat-synchronized timestretching and pitchshifting in high
audio quality even with extreme time extension. Beat markers are used at the beats or transients.
The markers can be generated in real time (automatically) or read from the WAV file if available
(patched). This method is suitable for rhythmic material that can not be divided into individual
beats or notes because the beats or notes overlap each other. This method requires a lot of
processing time which is why it should be used sparingly on less powerful systems.

 Universal HQ: Universal methods for timestretching and pitchshifting in very high audio quality.
Suitable for all types of audio material. Beat markers are evaluated to improve audio quality. This
method requires so much processing time, that a realtime application is recommended only in
exceptional situations. Using the apply function is recommended instead.
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 Monophonic voice: Timestretching and pitchshifting for vocal solos, speech, or solo instruments.
The material must not contain background noise, and excessive reverb may also be detrimental to
the use of this method. With suitable material the audio quality is very high. In addition, the
formants remain when pitchshifting. 

 Resampling: Pitch shift and tempo cannot be changed individually. This method requires
considerably little CPU time. 
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Audio effects in the mixer
In this section:
Equalizer
Compressor
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Equalizer

 The 10-band equalizer subdivides the frequency spectrum into ten areas ('bands') and equips them with
separate volume controls. This way it is possible to create many impressive effects, from a simple
boosting of the bass to complete elimination of a certain range of frequencies. Note: If low frequencies
are boosted too much, the overall sound level is heavily increased which may lead to distortion. In this
event, adjust the overall volume downward by using the 'master volume' control situated at the bottom
center of the effect rack. 
Slider control
: Each of the ten frequency ranges can be separately boosted or turned down with the ten volume
controls. 
Link bands: Using this button
 randomly combines the frequency ranges with each other in to avoid artificial-sounding overemphasis of
an individual frequency range. 
Touch screen (right EQ section): This is the 'sensor field
' of the EQ. Here you can draw any type of curve with the mouse. This will be immediately translated into
a corresponding control setting on the left side of the EQ. 
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Compressor

 The compressor is an automated dynamic volume control. It limits overall dynamics, maintains the
volume of loud passages so they stay loud, and increases the volume of low passages. A compressor can
be put to good use for bass recordings and vocals, but also as a master effect in the mixer for subsequent
editing of the overall sound. 
Processing is carried out using a "look-ahead" method, similar to high-quality studio appliances. There
are no peak overmodulations or other artifacts, as the algorithm can never be 'surprised' by sudden level
peaks. 
Ratio:
 This parameter controls the amount of compression. 
Threshold:
 Set the volume threshold, below and above which compression is applied. 
Attack:
 Sets the algorithm's reaction speed to increasing sound levels. Short attack times can create an
undesirable "pumping" sound, as the volume is quickly reduced or increased correspondingly. 
Release:
 Sets the algorithm's reaction speed to falling sound levels. 
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MAGIX Mastering Suite
 The MAGIX Mastering Suite is a special effects rack for use with the mixer master channel. Its effects
provide audio
 mastering functions to give the finished mixed music file a final polish. 
The On/Off switches 
switch the effects on and off individually. Each effect has a range of presets that can all be picked from a
list along the lower border of the effect. 

The settings of all effects can also be saved
together as one preset
 so that you can use your ideal mastering
setting again for other arrangements. 
Each effect can be reset by pressing the
"Reset" button. You can press the
"Bypass" button
 to temporarily deactivate the effects. 

In this section:
Parametric Equalizer
MultiMax
Stereo FX
Digital Audio Meter
Limiter
Note: 5.1 Surround mode only provides the compressor and parametric equalizer
 devices in this case. 
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Parametric Equalizer
 The parametric equalizer consists of four filter bands for adjusting the overall sound of the music track.
Each band is a filter with a typical "bell shape". Within a certain frequency range and around an
adjustable middle frequency, you can increase or reduce the signal level gain. The width of this frequency
range is called bandwidth. The bandwidth is defined by the Q value. The higher the Q value, the
narrower and steeper the filter curve. 
You can influence the basic sound of the mix by increasing and decreasing the broadband to give it more
"depth" (lower center = 200-600 Hz) or more "air" (highs = 10Khz). You can also decrease the narrow
bandwidth (high Q value) in the frequency response, e.g. to remove disruptive frequencies. 

Graphic: 
The resulting frequency path of the
equalizer is displayed in the graphic. The
frequency is spread out horizontally, the
increase or decrease of the respective
frequency, vertically. 

The blue bullets 1-4 symbolize the four wave
 bands. You can move them around with the mouse until you find your desired frequency response. 

Peak meter:
 The peak meter gives you control over the output level of the equalizer. The adjacent master gain
controller can be used to balance the level with the EQ. 

Edit: The "Edit" button
 opens the fine tuning for the four bands: 

Parameter selection:
 With the buttons on the right you can select the parameter that can be adjusted with four faders of each
band. Furthermore, there are number keys to enter every parameter of the bands. 
Gain dB: These controllers allow you to raise or lower the filter. Setting the controller to 0 deactivates
the filter and doesn't use CPU
 power. 
Freq. Hz:
 The center frequency of the individual filters can be set between 10 Hz and 24 kHz with the frequency
controllers. Freely choosing the frequency enables multiple filters to be set to the same frequency in order
to have a greater effect. 
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Q (bandwidth):
 Set the bandwidth of the individual filters between 10 Hz and 10 kHz. 
There is still a peculiarity among bands 1 and 4; The filter curve for these bands can be changed from a
normal "peaking" EQ filter ( ) to "shelving" ( ) (this is the basic setting) and high (band 1) or
high-cut (band 4) 
. When using the "shelving" filter, a soft increase or decrease in all frequencies happens above or below
the filter frequency, and the Q parameter does not have a function here. With a low-cut or high-cut filter,
all frequencies below (low-cut) or above (high-cut) the set frequency are filtered out. 
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MultiMax

 MultiMax is a compressor with three independent frequency bands. The dynamics are edited separately
for each band. 
The benefit of a multi-band compressor in comparison to a "normal" compressor is that the "pumping"
tendency and other disturbing side effects are dramatically reduced when editing the dynamics. For
instance, it can prevent a bass top peak from "reducing" the entire signal. 
Multi-band technology also lets you specifically edit individual frequency ranges. 
Link bands: When this function is activated and one fader
 is adjusted, all faders are changed in the same ratio. The type of dynamic editing is not influenced. 
High quality: When the "high quality" setting is activated, an even more precise algorithm is used, but this
requires more processing power. We recommend that you switch on this setting before you export the 
project
. 
Setting the frequency band
: The settings of the frequency bands are changed directly in the graphic. Simply click on the separator
lines and move them. 
Bass/Mid/High
: These knobs control the level of compression for each frequency band. 
Presets
 In MultiMax you can use the presets to open further special functions. 
Dynamic expander
: Compression that is too high will result in audible noise (usually defined as a pumping sound).
Particularly radio recordings are recorded with very high compression rates to increase the perceived
volume. Unfortunately compression reduces the dynamics (interval between the quietest and loudest
part). The expander enhances the dynamics of the recording. 
Cassette NR-B decoder: MAGIX Movie
 Edit Pro 16 simulates decoding of Dolby B + C noise suppression if no Dolby player is available.
Cassettes recorded with Dolby B or C sound more muffled and slurry if played back without
corresponding Dolby. 
Noise gate
: This cleaning function suppresses noise entirely below a certain noise level. This lets you create, for
example, song transitions that are entirely noise-free. 
Leveler: This setting automatically sets the entire material to an identical volume level. The volume
control knob is no longer required. You can use this function to equalize greater volume differences within
a song. To equalize volume variations between different songs you can also use the function "Normalize
loudness" from the "Effects" menu
. 
DeEsser
: These special presets are for removing overstressed hiss sounds from speech recordings. 
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Stereo FX

 The Stereo FX enhancer allows you to determine the positioning of the audio
 material in the stereo picture. If the stereo recordings sound out of focus and undifferentiated, an
extension of the stereo base width can often provide better transparency. 
Bandwidth control:
 Adjusts the bandwidth between mono (on the extreme left), unchanged bandwidth (center), and
maximum bandwidth ("wide", on the extreme right). Reducing the bandwidth can produce a rise in the
level. In extreme cases, e.g. when the left and the right channels include identical material and the
bandwidth control is pushed to the extreme left on "mono", the result can increase the level by 3 dB. 
Raising the bandwidth (values of 100) diminishes the mono compatibility. This means that recordings
edited this way sound hollow when listened to in mono. 
Volume control:
 Adjusts the volume of every single channel, thereby adjusting the entire balance. The reduction of left
and right levels is displayed under the control buttons. A centered recording can later be moved to the
left or right of the stereo balance. 
Stereo meter:
 This provides a graphic display of the phase relation of the audio signal. You can use it to review the
orientation of the signal in the stereo balance and the effect of the stereo enhancer. 
In order to achieve greatest compatibility with mono, the display should come closest to a diagonal line.
Otherwise some frequency ranges may erase themselves if the stereo signal is played on a mono device. 
Karaoke presets:
 These presets open a special karaoke effect that more or less eliminates vocals. It deletes middle
frequencies typical for human vocals during playback so that someone else can do the singing. 
In typical karaoke songs, the lyrics are usually displayed as subtitles in the video clip so that the singer
can follow along. MAGIX Movie
 Edit Pro 16 also comes with a suitable feature: the title editor, which can be used to create karaoke
subtitles. Please read the "Title editor" section in the chapter "Images and video objects". 
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Digital Audio Meter

 On the lower border of the MAGIX Mastering Suite there is a digital audio meter which provides
separate control method displays for 10 wave
 bands on each channel. This device is used for orientation purposes, e.g. selective equalizer editing. 

Limiter
Limiter: 
MultiMax includes a limiter that prevents clipping
by automatically lowering the level. Quiet parts
remain untouched. Unlike the Compressor, it
does not try to change the basic sound. 
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Automatic track damping
 This command automatically dampens the volume of other audio objects to add movie
 comments. You can also specify whether you want to dampen the original sound of the video, or all
sound tracks. 
In the dialog
, you can activate and deactivate the dampening value. 
You can use this command while recording audio
 (audio recording, advanced options). 
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Animate objects
 Different kinds of animations are provided in the Media Pool. The "Effects" tab under "Video effects",
"Movement effects" and "Audio
 effects > General" provides you with the effects which can animated using keyframes. 
The following objects can be animated: 

 Video objects
 Image objects (still images)
 Title objects
 MAGIX 3D Maker objects (3D texts)
 Visual objects
 Audio objects

In this chapter
Preparing animations
Place keyframe
Copy keyframe
Display keyframes of individual parameters
Retroactively editing an effect's keyframes
Soft movement
Delete keyframe
Editing an effects curve in the object
Effects curves - Additional functions
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Preparing animations
  First, select the object in the Arranger to animate.
 For complex animations, we recommend placing a marker beforehand for orientation.
 In the Media Pool, open the "Effects" tab and click on the effect you would like to animate under

"Video effects" or "Movement effects".
Note: For audio effects, activate the effect to be animated in the audio object's context menu
. 

 If necessary, set up the effect however you would like it for the start of the animation.
 There is a timeline in the lower section of the Media Pool. You can see here which animated

effects are applied to the selected object. Keyframes may be placed, selected, moved, and
deleted.

There are two stippled lines in the
timeline to help you orientate
yourself while you edit
movement. These lines will help
you recognize the start or end of
the transition. 

Place keyframe
 Click the timeline to set the playback marker at the locations where a keyframe should be added. 
Note
: You can also use the timeline in the arranger for exact positioning. If you are using markers for
orientation, then this is the easier choice. 

The button
 places keyframes for all parameters required in the animation. 

Additional keyframes can be added simply by placing the playback marker at the next keyframe location
and changing the parameters 
The positioned keyframes can also be retroactively moved via drag & drop. 

Copy keyframe
Select the keyframes to be copied by clicking them and then
press the "Copy" button
. 
Next, set the playback marker at the location for insertion and
the press the "Insert" button
. 

Display keyframes of individual parameters
 Multiple keyframes are added simultaneously to effects if they include multiple parameters. 

Click the small arrow beside the name of the
animated effect to display all of its parameters. 
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Now all keyframes of the effects parameter can
be individually moved, deleted, activated, and
deactivated. 

Note
: Only those parameters are listed which are used for the animation. As soon as another parameter is
required for editing the effect, it becomes visible to you here. 

Retroactively editing an effect's keyframes
 Previously set keyframes can be retroactively and temporally moved and their values edited. 
Keyframes can be moved via drag & drop. Simply click on the keyframe and drag it to the desired
position. 
To change an effect's setting for an already positioned keyframe, click the keyframe and adjust the effect
in the Media Pool. 

Soft movement
Normally, a hard, unnatural pan results after points are set. 

This option makes sure that the progression of these movements is executed softer and more naturally.
However, you should note that it can happen that a pan slightly exceeds the frame
 border. 

Delete keyframe
Select the keyframe to be deleted by
clicking it. 

This button
 removes the selected keyframe. 

Editing an effects curve in the object
Activate effects curve: For each animated
effects parameter, a curve is created and placed
over the object. Click this button
 to display the effects curve on the object. 

The curve can either be
edited with the
individual curve points
(in "Standard" mouse
mode) or by freely
drawing the effect curve
(in "Curve" mouse
mode). 
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New curve points can be added to the curve in "Standard" mode via "Ctrl + Shift" and clicking; existing
ones can be deleted in the same way. Every curve point can be moved with the mouse horizontally and
vertically. 
Note
: The buttons for activating effects curves are first displayed once the first keyframe has been placed. 

Effects curves - Additional functions

 The context menu
 can also be opened via the small arrow beside the effects indicator. 
Delete effects
: Removes the selected effect completely. 
Delete effects curve
: Removes the effects curve to be created again. 
Copy effects curve: The effects curve is copied to the clipboard
 to be used at other positions. 
Insert effects curve
: A previously copied effects curve can be inserted elsewhere with this function at any time. This may be
in the same object or in another object. 
Note: If you would like to insert the curve into a longer or shorter object, then think about setting the
option "Connect curve length with object length" correctly before copying
. 
Connect curve length with object length: If this option is set, then changes to object length will affect
the effects curve accordingly.
In practice, this behavior is needed rarely, for example if objects are stretched or compressed. The
option is deactivated by default for this reason. 
Load effects curve: A previously saved effects curve may be loaded via this menu
 item. This is useful, for example, if you have added your own default animations. 
Caution!
 The current effects curve will be overwritten as another one is loaded. 
Save effects curves
: Effects curves can be saved as a separate file. This is useful, for example, if you want to add your own
default animations and simply load them again at other positions again. 
Tip
: Be aware that during saving the setting "Connect curve length with object length" is saved as well and
applied during loading. 
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Place keyframe
 Click the timeline to set the playback marker at the locations where a keyframe should be added. 
Note
: You can also use the timeline in the arranger for exact positioning. If you are using markers for
orientation, then this is the easier choice. 

The button
 places keyframes for all parameters required in the animation. 

Additional keyframes can be added simply by placing the playback marker at the next keyframe location
and changing the parameters 
The positioned keyframes can also be retroactively moved via drag & drop. 

Copy keyframe
Select the keyframes to be copied by clicking them and then
press the "Copy" button
. 
Next, set the playback marker at the location for insertion and
the press the "Insert" button
. 

Display keyframes of individual parameters
 Multiple keyframes are added simultaneously to effects if they include multiple parameters. 

Click the small arrow beside the name of the
animated effect to display all of its parameters. 

Now all keyframes of the effects parameter can
be individually moved, deleted, activated, and
deactivated. 

Note
: Only those parameters are listed which are used for the animation. As soon as another parameter is
required for editing the effect, it becomes visible to you here. 

Retroactively editing an effect's keyframes
 Previously set keyframes can be retroactively and temporally moved and their values edited. 
Keyframes can be moved via drag & drop. Simply click on the keyframe and drag it to the desired
position. 
To change an effect's setting for an already positioned keyframe, click the keyframe and adjust the effect
in the Media Pool. 

Soft movement
Normally, a hard, unnatural pan results after points are set. 
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This option makes sure that the progression of these movements is executed softer and more naturally.
However, you should note that it can happen that a pan slightly exceeds the frame
 border. 

Delete keyframe
Select the keyframe to be deleted by
clicking it. 

This button
 removes the selected keyframe. 

Editing an effects curve in the object
Activate effects curve: For each animated
effects parameter, a curve is created and placed
over the object. Click this button
 to display the effects curve on the object. 

The curve can either be
edited with the
individual curve points
(in "Standard" mouse
mode) or by freely
drawing the effect curve
(in "Curve" mouse
mode). 

New curve points can be added to the curve in "Standard" mode via "Ctrl + Shift" and clicking; existing
ones can be deleted in the same way. Every curve point can be moved with the mouse horizontally and
vertically. 
Note
: The buttons for activating effects curves are first displayed once the first keyframe has been placed. 

Effects curves - Additional functions

 The context menu
 can also be opened via the small arrow beside the effects indicator. 
Delete effects
: Removes the selected effect completely. 
Delete effects curve
: Removes the effects curve to be created again. 
Copy effects curve: The effects curve is copied to the clipboard
 to be used at other positions. 
Insert effects curve
: A previously copied effects curve can be inserted elsewhere with this function at any time. This may be
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in the same object or in another object. 
Note: If you would like to insert the curve into a longer or shorter object, then think about setting the
option "Connect curve length with object length" correctly before copying
. 
Connect curve length with object length: If this option is set, then changes to object length will affect
the effects curve accordingly.
In practice, this behavior is needed rarely, for example if objects are stretched or compressed. The
option is deactivated by default for this reason. 
Load effects curve: A previously saved effects curve may be loaded via this menu
 item. This is useful, for example, if you have added your own default animations. 
Caution!
 The current effects curve will be overwritten as another one is loaded. 
Save effects curves
: Effects curves can be saved as a separate file. This is useful, for example, if you want to add your own
default animations and simply load them again at other positions again. 
Tip
: Be aware that during saving the setting "Connect curve length with object length" is saved as well and
applied during loading. 
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Copy keyframe
Select the keyframes to be copied by clicking them and then
press the "Copy" button
. 
Next, set the playback marker at the location for insertion and
the press the "Insert" button
. 

Display keyframes of individual parameters
 Multiple keyframes are added simultaneously to effects if they include multiple parameters. 

Click the small arrow beside the name of the
animated effect to display all of its parameters. 

Now all keyframes of the effects parameter can
be individually moved, deleted, activated, and
deactivated. 

Note
: Only those parameters are listed which are used for the animation. As soon as another parameter is
required for editing the effect, it becomes visible to you here. 

Retroactively editing an effect's keyframes
 Previously set keyframes can be retroactively and temporally moved and their values edited. 
Keyframes can be moved via drag & drop. Simply click on the keyframe and drag it to the desired
position. 
To change an effect's setting for an already positioned keyframe, click the keyframe and adjust the effect
in the Media Pool. 

Soft movement
Normally, a hard, unnatural pan results after points are set. 

This option makes sure that the progression of these movements is executed softer and more naturally.
However, you should note that it can happen that a pan slightly exceeds the frame
 border. 

Delete keyframe
Select the keyframe to be deleted by
clicking it. 

This button
 removes the selected keyframe. 
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Editing an effects curve in the object
Activate effects curve: For each animated
effects parameter, a curve is created and placed
over the object. Click this button
 to display the effects curve on the object. 

The curve can either be
edited with the
individual curve points
(in "Standard" mouse
mode) or by freely
drawing the effect curve
(in "Curve" mouse
mode). 

New curve points can be added to the curve in "Standard" mode via "Ctrl + Shift" and clicking; existing
ones can be deleted in the same way. Every curve point can be moved with the mouse horizontally and
vertically. 
Note
: The buttons for activating effects curves are first displayed once the first keyframe has been placed. 

Effects curves - Additional functions

 The context menu
 can also be opened via the small arrow beside the effects indicator. 
Delete effects
: Removes the selected effect completely. 
Delete effects curve
: Removes the effects curve to be created again. 
Copy effects curve: The effects curve is copied to the clipboard
 to be used at other positions. 
Insert effects curve
: A previously copied effects curve can be inserted elsewhere with this function at any time. This may be
in the same object or in another object. 
Note: If you would like to insert the curve into a longer or shorter object, then think about setting the
option "Connect curve length with object length" correctly before copying
. 
Connect curve length with object length: If this option is set, then changes to object length will affect
the effects curve accordingly.
In practice, this behavior is needed rarely, for example if objects are stretched or compressed. The
option is deactivated by default for this reason. 
Load effects curve: A previously saved effects curve may be loaded via this menu
 item. This is useful, for example, if you have added your own default animations. 
Caution!
 The current effects curve will be overwritten as another one is loaded. 
Save effects curves
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: Effects curves can be saved as a separate file. This is useful, for example, if you want to add your own
default animations and simply load them again at other positions again. 
Tip
: Be aware that during saving the setting "Connect curve length with object length" is saved as well and
applied during loading. 
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Display keyframes of individual parameters
 Multiple keyframes are added simultaneously to effects if they include multiple parameters. 

Click the small arrow beside the name of the
animated effect to display all of its parameters. 

Now all keyframes of the effects parameter can
be individually moved, deleted, activated, and
deactivated. 

Note
: Only those parameters are listed which are used for the animation. As soon as another parameter is
required for editing the effect, it becomes visible to you here. 

Retroactively editing an effect's keyframes
 Previously set keyframes can be retroactively and temporally moved and their values edited. 
Keyframes can be moved via drag & drop. Simply click on the keyframe and drag it to the desired
position. 
To change an effect's setting for an already positioned keyframe, click the keyframe and adjust the effect
in the Media Pool. 

Soft movement
Normally, a hard, unnatural pan results after points are set. 

This option makes sure that the progression of these movements is executed softer and more naturally.
However, you should note that it can happen that a pan slightly exceeds the frame
 border. 

Delete keyframe
Select the keyframe to be deleted by
clicking it. 

This button
 removes the selected keyframe. 

Editing an effects curve in the object
Activate effects curve: For each animated
effects parameter, a curve is created and placed
over the object. Click this button
 to display the effects curve on the object. 
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The curve can either be
edited with the
individual curve points
(in "Standard" mouse
mode) or by freely
drawing the effect curve
(in "Curve" mouse
mode). 

New curve points can be added to the curve in "Standard" mode via "Ctrl + Shift" and clicking; existing
ones can be deleted in the same way. Every curve point can be moved with the mouse horizontally and
vertically. 
Note
: The buttons for activating effects curves are first displayed once the first keyframe has been placed. 

Effects curves - Additional functions

 The context menu
 can also be opened via the small arrow beside the effects indicator. 
Delete effects
: Removes the selected effect completely. 
Delete effects curve
: Removes the effects curve to be created again. 
Copy effects curve: The effects curve is copied to the clipboard
 to be used at other positions. 
Insert effects curve
: A previously copied effects curve can be inserted elsewhere with this function at any time. This may be
in the same object or in another object. 
Note: If you would like to insert the curve into a longer or shorter object, then think about setting the
option "Connect curve length with object length" correctly before copying
. 
Connect curve length with object length: If this option is set, then changes to object length will affect
the effects curve accordingly.
In practice, this behavior is needed rarely, for example if objects are stretched or compressed. The
option is deactivated by default for this reason. 
Load effects curve: A previously saved effects curve may be loaded via this menu
 item. This is useful, for example, if you have added your own default animations. 
Caution!
 The current effects curve will be overwritten as another one is loaded. 
Save effects curves
: Effects curves can be saved as a separate file. This is useful, for example, if you want to add your own
default animations and simply load them again at other positions again. 
Tip
: Be aware that during saving the setting "Connect curve length with object length" is saved as well and
applied during loading. 
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Retroactively editing an effect's keyframes
 Previously set keyframes can be retroactively and temporally moved and their values edited. 
Keyframes can be moved via drag & drop. Simply click on the keyframe and drag it to the desired
position. 
To change an effect's setting for an already positioned keyframe, click the keyframe and adjust the effect
in the Media Pool. 

Soft movement
Normally, a hard, unnatural pan results after points are set. 

This option makes sure that the progression of these movements is executed softer and more naturally.
However, you should note that it can happen that a pan slightly exceeds the frame
 border. 

Delete keyframe
Select the keyframe to be deleted by
clicking it. 

This button
 removes the selected keyframe. 

Editing an effects curve in the object
Activate effects curve: For each animated
effects parameter, a curve is created and placed
over the object. Click this button
 to display the effects curve on the object. 

The curve can either be
edited with the
individual curve points
(in "Standard" mouse
mode) or by freely
drawing the effect curve
(in "Curve" mouse
mode). 

New curve points can be added to the curve in "Standard" mode via "Ctrl + Shift" and clicking; existing
ones can be deleted in the same way. Every curve point can be moved with the mouse horizontally and
vertically. 
Note
: The buttons for activating effects curves are first displayed once the first keyframe has been placed. 

Effects curves - Additional functions
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 The context menu
 can also be opened via the small arrow beside the effects indicator. 
Delete effects
: Removes the selected effect completely. 
Delete effects curve
: Removes the effects curve to be created again. 
Copy effects curve: The effects curve is copied to the clipboard
 to be used at other positions. 
Insert effects curve
: A previously copied effects curve can be inserted elsewhere with this function at any time. This may be
in the same object or in another object. 
Note: If you would like to insert the curve into a longer or shorter object, then think about setting the
option "Connect curve length with object length" correctly before copying
. 
Connect curve length with object length: If this option is set, then changes to object length will affect
the effects curve accordingly.
In practice, this behavior is needed rarely, for example if objects are stretched or compressed. The
option is deactivated by default for this reason. 
Load effects curve: A previously saved effects curve may be loaded via this menu
 item. This is useful, for example, if you have added your own default animations. 
Caution!
 The current effects curve will be overwritten as another one is loaded. 
Save effects curves
: Effects curves can be saved as a separate file. This is useful, for example, if you want to add your own
default animations and simply load them again at other positions again. 
Tip
: Be aware that during saving the setting "Connect curve length with object length" is saved as well and
applied during loading. 
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Soft movement
Normally, a hard, unnatural pan results after points are set. 

This option makes sure that the progression of these movements is executed softer and more naturally.
However, you should note that it can happen that a pan slightly exceeds the frame
 border. 

Delete keyframe
Select the keyframe to be deleted by
clicking it. 

This button
 removes the selected keyframe. 

Editing an effects curve in the object
Activate effects curve: For each animated
effects parameter, a curve is created and placed
over the object. Click this button
 to display the effects curve on the object. 

The curve can either be
edited with the
individual curve points
(in "Standard" mouse
mode) or by freely
drawing the effect curve
(in "Curve" mouse
mode). 

New curve points can be added to the curve in "Standard" mode via "Ctrl + Shift" and clicking; existing
ones can be deleted in the same way. Every curve point can be moved with the mouse horizontally and
vertically. 
Note
: The buttons for activating effects curves are first displayed once the first keyframe has been placed. 

Effects curves - Additional functions

 The context menu
 can also be opened via the small arrow beside the effects indicator. 
Delete effects
: Removes the selected effect completely. 
Delete effects curve
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: Removes the effects curve to be created again. 
Copy effects curve: The effects curve is copied to the clipboard
 to be used at other positions. 
Insert effects curve
: A previously copied effects curve can be inserted elsewhere with this function at any time. This may be
in the same object or in another object. 
Note: If you would like to insert the curve into a longer or shorter object, then think about setting the
option "Connect curve length with object length" correctly before copying
. 
Connect curve length with object length: If this option is set, then changes to object length will affect
the effects curve accordingly.
In practice, this behavior is needed rarely, for example if objects are stretched or compressed. The
option is deactivated by default for this reason. 
Load effects curve: A previously saved effects curve may be loaded via this menu
 item. This is useful, for example, if you have added your own default animations. 
Caution!
 The current effects curve will be overwritten as another one is loaded. 
Save effects curves
: Effects curves can be saved as a separate file. This is useful, for example, if you want to add your own
default animations and simply load them again at other positions again. 
Tip
: Be aware that during saving the setting "Connect curve length with object length" is saved as well and
applied during loading. 
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Delete keyframe
Select the keyframe to be deleted by
clicking it. 

This button
 removes the selected keyframe. 

Editing an effects curve in the object
Activate effects curve: For each animated
effects parameter, a curve is created and placed
over the object. Click this button
 to display the effects curve on the object. 

The curve can either be
edited with the
individual curve points
(in "Standard" mouse
mode) or by freely
drawing the effect curve
(in "Curve" mouse
mode). 

New curve points can be added to the curve in "Standard" mode via "Ctrl + Shift" and clicking; existing
ones can be deleted in the same way. Every curve point can be moved with the mouse horizontally and
vertically. 
Note
: The buttons for activating effects curves are first displayed once the first keyframe has been placed. 

Effects curves - Additional functions

 The context menu
 can also be opened via the small arrow beside the effects indicator. 
Delete effects
: Removes the selected effect completely. 
Delete effects curve
: Removes the effects curve to be created again. 
Copy effects curve: The effects curve is copied to the clipboard
 to be used at other positions. 
Insert effects curve
: A previously copied effects curve can be inserted elsewhere with this function at any time. This may be
in the same object or in another object. 
Note: If you would like to insert the curve into a longer or shorter object, then think about setting the
option "Connect curve length with object length" correctly before copying
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. 
Connect curve length with object length: If this option is set, then changes to object length will affect
the effects curve accordingly.
In practice, this behavior is needed rarely, for example if objects are stretched or compressed. The
option is deactivated by default for this reason. 
Load effects curve: A previously saved effects curve may be loaded via this menu
 item. This is useful, for example, if you have added your own default animations. 
Caution!
 The current effects curve will be overwritten as another one is loaded. 
Save effects curves
: Effects curves can be saved as a separate file. This is useful, for example, if you want to add your own
default animations and simply load them again at other positions again. 
Tip
: Be aware that during saving the setting "Connect curve length with object length" is saved as well and
applied during loading. 
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Editing an effects curve in the object
Activate effects curve: For each animated
effects parameter, a curve is created and placed
over the object. Click this button
 to display the effects curve on the object. 

The curve can either be
edited with the
individual curve points
(in "Standard" mouse
mode) or by freely
drawing the effect curve
(in "Curve" mouse
mode). 

New curve points can be added to the curve in "Standard" mode via "Ctrl + Shift" and clicking; existing
ones can be deleted in the same way. Every curve point can be moved with the mouse horizontally and
vertically. 
Note
: The buttons for activating effects curves are first displayed once the first keyframe has been placed. 

Effects curves - Additional functions

 The context menu
 can also be opened via the small arrow beside the effects indicator. 
Delete effects
: Removes the selected effect completely. 
Delete effects curve
: Removes the effects curve to be created again. 
Copy effects curve: The effects curve is copied to the clipboard
 to be used at other positions. 
Insert effects curve
: A previously copied effects curve can be inserted elsewhere with this function at any time. This may be
in the same object or in another object. 
Note: If you would like to insert the curve into a longer or shorter object, then think about setting the
option "Connect curve length with object length" correctly before copying
. 
Connect curve length with object length: If this option is set, then changes to object length will affect
the effects curve accordingly.
In practice, this behavior is needed rarely, for example if objects are stretched or compressed. The
option is deactivated by default for this reason. 
Load effects curve: A previously saved effects curve may be loaded via this menu
 item. This is useful, for example, if you have added your own default animations. 
Caution!
 The current effects curve will be overwritten as another one is loaded. 
Save effects curves
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: Effects curves can be saved as a separate file. This is useful, for example, if you want to add your own
default animations and simply load them again at other positions again. 
Tip
: Be aware that during saving the setting "Connect curve length with object length" is saved as well and
applied during loading. 
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Effects curves - Additional functions

 The context menu
 can also be opened via the small arrow beside the effects indicator. 
Delete effects
: Removes the selected effect completely. 
Delete effects curve
: Removes the effects curve to be created again. 
Copy effects curve: The effects curve is copied to the clipboard
 to be used at other positions. 
Insert effects curve
: A previously copied effects curve can be inserted elsewhere with this function at any time. This may be
in the same object or in another object. 
Note: If you would like to insert the curve into a longer or shorter object, then think about setting the
option "Connect curve length with object length" correctly before copying
. 
Connect curve length with object length: If this option is set, then changes to object length will affect
the effects curve accordingly.
In practice, this behavior is needed rarely, for example if objects are stretched or compressed. The
option is deactivated by default for this reason. 
Load effects curve: A previously saved effects curve may be loaded via this menu
 item. This is useful, for example, if you have added your own default animations. 
Caution!
 The current effects curve will be overwritten as another one is loaded. 
Save effects curves
: Effects curves can be saved as a separate file. This is useful, for example, if you want to add your own
default animations and simply load them again at other positions again. 
Tip
: Be aware that during saving the setting "Connect curve length with object length" is saved as well and
applied during loading. 
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Add sound
 In principle, any track in MAGIX Movie
 Edit Pro 16 can be used as a sound track. There are no specific track types. But it is easier not to mix
object types within one track. 
In this chapter
Load and edit audio files
Import audio CD
MAGIX Soundtrack Maker
Tempo and beat recognition (Plus version)
Adding a sound track using MIDI songs
Synthesizer
Mixer
Audio effects
5.1 Surround
Scrubbing
Mix down of audio objects
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Load and edit audio files
 All importable audio
 files can be accessed from the Media Pool and previewed (as sound) by a click on the file name. All files
can be dragged into the arranger window. 
Tracks from audio CDs can be also placed into the arrangement via drag & drop. 
Edits, fine positioning, volume adjustment, fading in and out, are all processed using the object tab
directly in the arranger. 
Various effect curves may be selected for audio tracks, dynamically controlling selectable effects, volume
or stereo panorama. More information about this can be found in the chapter "Animate objects", section
"Effect curves for the audio track". 

Page 356



Import audio CD
 The steps are similar to transferring wave
 files into an arrangement: 

 Insert an audio CD into the CD/DVD drive of the PC.
 Go to your CD/DVD drive in the Media Pool. The individual CD titles appear in the file list.
 A single mouse click starts the playback of the CD title for prelistening.
 Drag & drop the CD title into a track in the current arrangement and the song will be grabbed

and copied to the hard drive. The files will be saved in the "Import" directory ("Program settings
-> Folders")

 The audio object appears in the track and can be played back or edited immediately.
A special program is used for digitally importing the audio data from the CD/DVD drive. Some drives do
not support this mode (an error message will be displayed) or support will only be of low quality (the
audio objects will contain crackling). 
If this method does not yield a satisfactory result, you can open the CD manager via the menu
 command "File -> Read tracks from audio CD". This option opens the CD manager where you can
select tracks from audio CDs and import them into the arrangement. You can also select the drive if you
have more than one and adjust the import settings. 
If this is also unsuccessful, you can also play the CDs using the drive and record them with the sound
card. More can be found in the "Recording audio CDs"
 section. 
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CD Manager
 This option opens the CD Manager where you can select tracks from audio
 CDs and import them into the arrangement. You can also select and configure the CD-R if you have
more than one drive. 
The CD Manager lets you import audio data using most CD and DVD drives. You may have to contact
your technical support to find out which drive is suitable. Data is imported digitally. Audio tracks are
imported into the arrangement as WAV files and saved in the Import directory. (Program settings ->
Folders
). 
To import audio tracks you should proceed as follows: 

 Select the desired CD-R drive if you have installed more than one drive.
 Click on the "Track list" button.
 Select the desired title from the track list (using the key combination Shift or Alt and the cursor

keys).
 Click on "Copy selected track(s)."
 The audio material is now copied from the CD drive onto hard disk. The progress is displayed.
 Close the track and drive lists. In your arrangement there are now one or several new objects

that contain audio material of the disc.
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Drive list dialog
 Tracklist: This button opens the track list dialog
 for copying one or multiple tracks. 
Configuration: This button
 opens the configuration dialog where you can make various special settings, SCSI IDs, etc. 
Reset:
 Restores the default settings of the drive. 
Add drive:
 Creates a new drive entry in the list, which you may wish to adjust. 
Delete drive: 
Deletes a selected drive from the list. 
Save setup:
 Saves the current drive list and all configuration data in a *.cfg file. 
Load setup:
 Loads the current drive list and all configuration data from a *.cfg file. 
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The tracklist dialog
 Copy selected track(s): This button starts audio
 copy. A new object is created for every track in the arrangement and the corresponding track marker is
created. 
Play:
 Starts the audio playback of the first selected track on the list (for testing). 
Stop:
 Stops playback. 
Pause: Stops playback so as to start it later from the same position using the "Resume" button
. 
Resume:
 Resumes playback if it had been paused before. 
Select all tracks:
 All audio tracks are selected, for instance, to copy the entire CD. Track markers can also be made using
Shift or Alt pressed together with the arrow keys. Multiple tracks can be selected by pressing "Ctrl +
mouse click". 
Deselect all tracks:
 All markers are reset. 
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The CD-ROM configuration dialog
 Drive name:
 Lets you edit the name of the drive in the list. This is useful if you create more than one entry accessing
the same physical drive. 
Host adapter number:
 Lets you specify the number of your SCSI adapter - normally "0". 
SCSI-ID:
 Lets you set the ID of your CD-ROM drive. Be sure to set the correct ID; there is no error checking! 
SCSI-LUN:
 Select the SCSI-LUN parameter, normally "0". 
Alias:
 Lets you select the manufacturer type of your CD-ROM drive. 
Normal copy mode: Copies the audio data without any software
 correction. 
Sector synchronization copy mode:
 Copies the audio data using a correction algorithm. This is especially useful, since many CD drives have
problems finding an exact position again and gaps can occur. 
Burst copy mode:
 Optimizes the speed of the copy process; no software corrections made. 
Sectors per cycle:
 Defines the number of audio sectors that should be read from the audio CD in a read cycle. The higher
the number of sectors, the faster the copying process. Many SCSI systems have problems with more
than 27 sectors. 
Sync sectors:
 Sets the number of audio sectors that will be used for software correction. A higher number results in a
better synchronization but also in a slower copying process. 
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Scanning CD tracks with the recording dialog
 Some CD-ROM drives do not support this mode (trying digital extraction results in an error message),
or they only support it with difficulty (results in audio objects with crackling noise, skips, etc.). In this
case, the CD may be "scanned" by recording it into the computer. When recording the CD to the
computer, the CD titles are simply played back from the CD-ROM drive and are re-recorded as .WAV
by the sound card. Before recording a CD to your computer, change the program settings in the"File ->
Audio/Video options" menu. To ensure easy recording of the CD titles via the "Recording" dialog
, the audio output on the CD-ROM drive must also be connected with the sound card input. This
connection is usually already set up on modern multimedia PCs. If not, this is easily done by installing a
cable inside the computer case. 
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MAGIX Soundtrack Maker
 The MAGIX Soundtrack Maker adds atmosphere. Music tracks corresponding to the specified mood
are generated automatically. Even mood changes are possible. 
Open the MAGIX Soundtrack Maker using the Edit > Assistants menu
. The work is split into 3 steps. 
Then close the dialog
 by clicking on "Apply". If you click on "Cancel", the dialog will be closed and all changes will be
discarded. 

Select music style

 First, choose the musical style you want. The option "Apply only between start and end marker" lets you
limit the length of the background music you want to create. You can also set the start and end markers
with the left and right mouse button
 while MAGIX Soundtrack Maker is open. 

Set mood change

 You can also select a mood from the list. 
Preview:
 Here you can preview your selected emotion. 
Position: With the position slider you can go to a certain position to set the emotions at a certain
position. Instead, you can also move the start marker with the left mouse button
. The preview will be displayed in the video monitor. 
Insert emotion: This button
 inserts the emotion at the current position. MAGIX Soundtrack Maker will then suggest a new position
for the next emotion by adjusting the position slider. Of course, you can also position it elsewhere and
insert additional moods. 
Delete emotion:
 Deletes the current emotion. 

Generate background music

 One click on "Create soundtrack" creates a new soundtrack. 
"Progress" shows the current status. 
Variations
 If you don't like the background music created, you can create variations. 
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You can do this for the entire background music as well as for individual emotions: 
 If you want to vary the entire background music, simply click on "Create variations".
 If you only want this to apply to a certain emotion, you should first go to it with the position slider

in the dialog (or the start marker on the main screen). Then activate the option "Vary only
selected emotions". Now click "Create variations".
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Tempo and beat recognition (Plus version)

 The Tempo and beat recognition in MAGIX Movie
 Edit Pro 16 is a special tool for videoclips. It analyzes the rhythm of a musical piece. The basis for this
analysis is the rhythm speed, measured in BPM (Beats Per Minute). 
After determining the BPM value of the song, the song will be subdivided into short passages of equal
length. The individual objects having the duration of exactly one bar at first stay grouped, so as not to
accidentally "rearrange" the song. (Of course, if you like you can do just that! To do so click on
"ungroup". 
When editing only the resulting object edges are important. Because all objects can always latch to each
other on their edges, videos can be arranged to transition exactly to the beat of the music: The points
along the track where videos lock together lie exactly on the bars of the music. 
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Prerequisites for using the beat recognition assistant
  Songs must be longer than 15 seconds
 Songs must be "rhythmic" (i.e. they can be danced to)
 Songs must be in stereo format
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Preparation - Setting the start marker and object end
 Before opening the Auto Remix Assistant, you should set the start marker at the position in the song
object in the arranger where you want detection to start. If the song contains a long intro
 without beats, set the start marker after the intro. As a rule of thumb, the Auto Remix Assistant should
always be "fed" dance music. 

 The start marker should be set before a quarter note beat or, better still, briefly before a beat at
the start of a bar.

 If the start marker lies before the song object, the object is examined from the beginning. 
 If detection is not performed by the end of the song, the object can be shortened accordingly

with the object handle at the end of the object. 
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Automatic Tempo Recognition
 When the Auto Remix Assistant is launched, the selected song object is analyzed and played back. A
metronome begins to click according to the result and lines visualize the positions of the quarter notes
found in the wave
-shaped display. 
The following cases are differentiated: 

 Position of the start of a measure (the one): red line.
 Position of the other quarter notes (the two, three, and four): green lines.
 Reliably recognized positions: thick lines.
 Unreliably recognized positions: thin lines.
 When tapped, blue lines appear.

If the tact and tempo information is already present, points are indicated above the display at the
appropriate positions. The metronome volume can be regulated below and to the left of the wave-shaped
display. To the right, the BPM value is indicated. If a valid BPM value was found, it is displayed in
green. 
If the metronome clicks in time with the music, the measure start is correct. If not, you can correct the
tempo manually. 

Page 368



Setting the manual and and Onbeat/Offbeat 
If the result is incorrect, you can help the Auto Remix Assistant with a few mouse clicks on the correction
buttons. 
There are two possibilities: 
On the one hand, the "Tempo correction" list offers alternative BPM numbers which could also fit with
the music. The adjustable BPM values are detected automatically ? the total BPM can therefore deviate
from song to song. 
For more difficult audio material, we recommend using the "Tapping input" mode. Either the "T" key must
be pressed or the "Tap tempo" button must be clicked with the mouse in time with the music. With
repeated tapping of the tempo correction button
, one should keep an eye on the color in the BPM display. In the "unlocked" condition (red), the tapping
is not in time with the music. One should tap until the "locked" condition is displayed. After a short time,
you will hear if the result is correct via the metronome. 
Subsequently, offbeat correction takes place as required. If the detected quarter note beats lie around the
length of an eighth note (transferred behind the real positions of the quarter note beats), one or more
alternatives can be selected from the onbeat/offbeat correction list. 
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Determining the start of a measure
 Next, the starting point of the measure is corrected. The beat at the start of the measure must always
agree with the high tone of the metronome and/or the red line in the wave
-shaped display. 
Corrections can be made by tapping; If the start of the measure can be be heard, tap with the mouse or
press the "T" key. Alternatively, you can also select how many quarter notes the "one" is to be pushed to
back. 
If the starting marker was set briefly before the first beat of a measure, this correction is not necessary. 
Note: With all corrections, the metronome and visualization react to the lines in the wave
-shaped display only after a short delay. 
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Using BPM and beat detection
 Now you may select one of the actions to be adapted to the arrangement song (or vice versa) or cut up
the songs at the ends of a measure. 

Save only Tempo & Beat information 
Only wave file
 data is stored. This makes sense if some manual post-correction is required for determining beat/tempo. 
When the data is stored, tempo & beat regulation can be released for future tempo adjustments or to
create object remixes. 

Tempo adjustment 

Setting the object tempo to the arrangement tempo
 This fits the object length to the existing arrangement. Three different procedures are possible:
timestretching, resampling, or audio
 quantization. 

 Timestretching keeps the pitch of the song constant, but sometimes the sound quality can suffer. 
 Resampling changes the pitch (similar to changing the speed of a record player), and retains the

sound quality of the song as much as is possible. 
 During audio quantization, the audio file takes the tempo adjustments into consideration as if the

first remix object (see below) were created and combined immediately into a new audio file. If
the recognition is uncertain, extreme tempo fluctuation may result. It is particularly important to
set the starting marker so that the tempo is recognized definitely. The advantage of audio
quantization is that small tempo fluctuations in the music balance out. The start of the measure
always agrees with the start of the arrangement measure and never plays out of time.

Setting the arrangement tempo to the object tempo 
The arrangement adopts the detected BPM value. If you would like to use the cut-up song as the basis
for a new composition (e.g. for remixes), then this option should be active. 

Creating remix objects
 The song is cut by beat into individual objects. Some applications may include: 

 To produce loops from complete songs which can then be used with other material. Most
importantly, not all remix objects are suitable as loops. Ideally, less complex material should be
used, e.g. drums from an intro.

 To remix songs, thus changing the sequence of the objects, cutting or doubling beats or to enrich
the song with other loops or synth objects. 

 To mix two songs: If percussion and tempo fit perfectly, can you blend the songs without "side
effects"?

This option can be activated later from the "Object" menu
, provided that the tempo data is stored. 
The "Audio quantization" option:
 Audio quantization fits new objects exactly in time with the arrangement. 
With homemade music, tempo fluctuations are common, and therefore different measure lengths may
result. Nevertheless, so that the objects fit into the rigid timing pattern of the VIPs, the time processor is
activated automatically and object timestretching is used to correct the different lengths. 
Setting resampling for small corrections:
 If the necessary corrections are very small, better quality resampling can be used instead of
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timestretching. Afterwards, you should not change the master tempo any longer, since definite pitch
changes may arise. 
Remix objects in "Loop" mode:
 New objects are set in "Loop" mode. When extending the object with the right object mouse handle, the
original length of the object is played again and again. 
Setting the arrangement tempo to the object tempo:
 (see above) 
Note
: Time correction assigned to objects can be subsequently cancelled if the time processor is called up and
edited ("Timestretch/Resample object", or double click on the object to open the FX racks associated
with the time processor). 
Cancel: The dialog
 is closed. 
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Adding a sound track using MIDI songs
 A few words about MIDI: MIDI files do not contain the actual sounds like wave
 files, only the note control information. This data is interpreted to effect playback by the synthesizer chip
on the sound card. This has several advantages: 

 MIDI files need a lot less memory than wave files, so more MIDI files will fit on a CD-ROM.
 MIDI files can be adapted to any beat (BPM) without affecting the sound; only the playback

tempo needs to be changed.
 MIDI files are very easy to transpose to another pitch; a section in a song does not have to be

saved in several different keys. The version in C major is sufficient, and it can then be transposed
to any key by simply clicking with the right mouse button.

The disadvantage of MIDI files: The sound is not true audio. The audio is only produced when the
synthesizer chip on the sound card plays it back. As a result, high-quality sound cards or external
synthesizers will sound completely different and better than standard sound cards, depending upon the
settings for playback "voices". Therefore, it is definitely worth using a good sound card or external MIDI
synthesizer with MAGIX Movie
 Edit Pro 16! 

Arranging MIDI files
 Integrating MIDI files in an arrangement: 
Search for a directory containing MIDI files using the Media Pool located at the left edge of the screen.
Click on a file, and it will be played back immediately. Now drag the desired file into the arrangement to
finish the process. 
An object will appear which displays the MIDI notes as dots. The high notes are dots in the upper
section, and the lower notes are the dots further down in the lower section. You can even see the velocity
of the notes. The louder the note is played, the brighter it appears on the screen. 
MIDI objects may be arranged, the volume may be modified (middle handle) or fades (in or out) may be
added (top right and left handles) in the same way as audio, video, or synthesizer objects. The "element
bar" lets you "open" an entire track instantly from a MIDI loop. If a MIDI file seems to be empty, check
the MIDI replay device in the "Playback parameters" window ("P" key or menu
 "File -> Settings -> Playback parameters"). Your sound card driver or your MIDI interface must be set
correctly to hear MIDI! 

MIDI interface and external sound generator
 Of course, MIDI objects can also be played back over a MIDI interface into external synthesizers,
sound modules, etc. Start by setting FX to 1.0. The timing between MIDI and audio can be balanced
later if you notice a delay between the two. This is important for very slow arrangements, since the
sample rate on the sound card is not entirely. The MIDI drivers can be set in the "Playback parameters"
window ("P" key or menu "File -> Settings -> Playback parameters"). 

Convert MIDI files to audio files
 Before exporting (as a video, for example) an arrangement, all MIDI objects must be converted into
audio objects first, since these contain only pure control information for the sound reproduction before
they are exported. 
First, connect the MIDI synthesizer (usually the sound card) output to the sound card input. Now the
MIDI file can be played back and simultaneously recorded as an audio file using the record function. The
result is an audio
 file that can be processed and exported together with other multimedia files. 
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Synthesizer
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Creating synth objects
 The software synthesizer is to be found in a special file that is configured onto the hard disk during
installation. To open it, press the Synth-Button
 in the MediaPool File manager. 
The symbols for all the available synthesizer Plug-Ins are now displayed in the file list. 
Any plug-in can be pulled into the arrangement by means of drag & drop. A synth object appears on the
relevant track and the operating console of the plug-in
 is opened. Synth objects are programmed with the help of the operating console. 
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Programming the synth object
 Depending on the plug-in
, various functions to create and control sound can be applied via the operating console. 
To monitor programming, playback can be started and stopped at any time with the space bar while the
operating console is open. 
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Arranging the synth object
 Once you have finished programming the melodies or rhythms of the synth object, you can close the
operating console and arrange the synth objects on the tracks. They can be stretched or compressed,
faded in and out, turned down or up, etc. with the help of handles
: These steps are the same for all objects. 
The operating console of every synth object can be reopened at a later stage by double clicking or via
the synth button if you would like to reprogram the object. In addition, you can drag as many other synth
objects of the same software
 synthesizer as you like onto the tracks and program them separately. 
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Effects and mix down of synth objects
 Just like audio
 objects, synth objects can be edited with any available master effect. Please read the chapter on "Audio
effects" for more information. 
In the real-time mixer, it is possible to exactly adjust the level of every synth track. 
The mix down function mixes all tracks, including the synth objects, into one file so that tracks and
computing power for new objects are released. 
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Atmos
 Atmos is a synthesizer which can be used to easily create realistic nature sounds in no time. From
thunder and lightning to animal sounds and traffic
 noise, Atmos helps you design natural-sounding atmospheric noises for your projects. 

 In the upper border window, select the top category "Scenario". You can select a desired nature
sounds category (for example, "Thunder and Lightning").

 In the middle of the window, a collection of control elements appears for designing the desired
"Ambience". Each element has its own description (e.g. "Thunder") and two faders, i.e. "Volume"
and "Intensity". The "volume" control adjusts the loudness portion of the element. The "Intensity" 
fader controls the behavior of the sound, depending on controller element. For example, with
"Thunder", you can set how often thunder and lightning should sound; with "Rain", the strength of
the rain can be regulated (if moved to the far left, light rain can be heard, while if moved to the far
right, a downpour with loud splashing noises is audible).

 At the bottom right border you will find a master volume fader with which the master volume of
the synthesizer can be set. Furthermore, the "Randomize" setting is also located here. This way
you can change the settings of the control elements by yourself.
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Drum & Bass machine 2.0
 The Drum & Bass machine is a dual synthesizer, uniting both distinct styles of drum'n'bass in one piece
of equipment to produce fast beat crashes and rumbling bass lines. With the Drum & Bass machine you
need no special skills to create authentic sounds for your drum'n'bass songs. 
A tip: The typical speed for Drum'n'Bass is usually around 160-180 BPM. The Drum & Bass machine
also fits in perfectly with other music styles, e.g. bigbeat (120 BPM) or trip hop (80-90 BPM). 

Setup

 The top half of the synthesizer controls the rhythm section, the bottom half controls the bass section.
Between the two, on the left side you will see a symbol where both sections can be turned on and off
individually. You can turn off the bass section, for example, so that you take only the drum section break
beat into the arrangement. The MAGIX Movie
 Edit Pro 16 arrangement mix will then only include the drum section in the mix file. 
The volume control is on the right border, controlling the volume for both sections. The play and stop
buttons allow you to listen to your drum'n'bass creations up front in MAGIX Movie Edit Pro 16. 
The "Drum'n'Bass" label covers a menu containing functions to load and save drum'n'bass patterns (Load
machine state/Save machine state), and functions to delete or generate patterns (Clear all/Random all).
The submenu
 "Velocity presets" contains some help functions for programming of the velocity row. 

The rhythm section (top half)
 You can easily create complex and authentic jungle break beat sounds. In a professional recording
studio, jungle break beats are created by dividing any given drum loop into several small "bits" and
putting them back together in a different order. This lengthy process is significantly simplified by the Drum
& Bass machine. You just have to design your own new play sequence. 
You set up the new sequence in the top ("steps") row. The blue cells indicate the individual sections
("notes") for the subdivision of the loop. 
A left mouse click on one of the blue cells allows you to select one of six possible symbols. Each symbol
represents a different note or other way of playing the note. Every time you click on one of the blue cells,
the next symbol is chosen. 
Rely on your own intuition and creativity when programming your beats. It is not absolutely necessary to
know the exact meaning of each individual symbol in order to create cool and authentic beats. 
Summary symbol description: 
1: 
Play drum loop from beginning 
2: 
Play drum loop from the second note 
3: 
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Play drum loop from the third note 
4: 
Play drum loop from the fourth note 
Backward symbol:
 Play backwards from this point 
Stop symbol:
 Stops play 
The right mouse button allows you to delete the step cells individually. The "Clear" button
 on the right deletes all step cells; the drum loop is played in its original sequence. The "Random rhythm"
button generates a random sequence. You can then alter the rhythm as you wish. 
By clicking on the blue field in the bottom part of the rhythm section you open a pop-up menu
 where you can select the drum loop sound. If you select a different drum loop, it will be loaded and
played as programmed by you. 
In the "Flame" row you can set the note to be played twice quickly in succession instead of only once,
allowing you to program rolls and fill-ins. 
The "Velocity" row allows you to set intensity values between 0 and 16 with the mouse (left mouse click
increases value, right mouse click decreases value). Use the three buttons under the "Velocity" row to
determine how these values will affect the sound of your loop. If you select "Volume", the velocity value
alters the volume for this cell (16 = loud, 0 = quiet). If you select "Filter", the velocity value alters the filter
strength for this cell (16 = sharp, 0 = muffled). The "None" button
 blocks use of the velocity values. 

The bass section (bottom half)
 The bass section allows you to create the right bass lines for your rhythm quickly. As in the rhythm row,
there are two-step rows. 

 With the first "Notes" row, you determine the sequence of the notes, i.e. the sound sequence. 
 By clicking on a cell with the left mouse button, you open a pop-up window, where you can

select the notes. 
 By clicking with the right mouse button, you delete a cell. 
 If you click on an empty cell with the right mouse button, you will see a "Stop" symbol. This

function is similar to that in the rhythm section, i.e. it stops the bass sound at this point.
 In the "Octave" row you can determine the bass octave sound. Octave 1 creates a deep tone,

Octave 3 a high tone. You can only set the octave values if there is a note in the row above.
 As in the rhythm section, there are also buttons for "Clear", "Random notes", and a red selection 

field at the top border of the bass section. The red selection field allows you to set the bass
sound.

 Underneath the step rows, you will also find two sliding controls for sound adjustment. You can
use the "Vibrato" control to make the bass tone "swing" at its pitch. If the control is pushed all the
way to the right, the swing will be stronger; all the way to the left will have no effect on the pitch.

 With the "Delay" controller you can set a time for the sound to completely fade out. All the way
to the right makes the sound fade out quickly (after approx. ¼ second); all the way to the left
means ongoing sound.
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Setup

 The top half of the synthesizer controls the rhythm section, the bottom half controls the bass section.
Between the two, on the left side you will see a symbol where both sections can be turned on and off
individually. You can turn off the bass section, for example, so that you take only the drum section break
beat into the arrangement. The MAGIX Movie
 Edit Pro 16 arrangement mix will then only include the drum section in the mix file. 
The volume control is on the right border, controlling the volume for both sections. The play and stop
buttons allow you to listen to your drum'n'bass creations up front in MAGIX Movie Edit Pro 16. 
The "Drum'n'Bass" label covers a menu containing functions to load and save drum'n'bass patterns (Load
machine state/Save machine state), and functions to delete or generate patterns (Clear all/Random all).
The submenu
 "Velocity presets" contains some help functions for programming of the velocity row. 

The rhythm section (top half)
 You can easily create complex and authentic jungle break beat sounds. In a professional recording
studio, jungle break beats are created by dividing any given drum loop into several small "bits" and
putting them back together in a different order. This lengthy process is significantly simplified by the Drum
& Bass machine. You just have to design your own new play sequence. 
You set up the new sequence in the top ("steps") row. The blue cells indicate the individual sections
("notes") for the subdivision of the loop. 
A left mouse click on one of the blue cells allows you to select one of six possible symbols. Each symbol
represents a different note or other way of playing the note. Every time you click on one of the blue cells,
the next symbol is chosen. 
Rely on your own intuition and creativity when programming your beats. It is not absolutely necessary to
know the exact meaning of each individual symbol in order to create cool and authentic beats. 
Summary symbol description: 
1: 
Play drum loop from beginning 
2: 
Play drum loop from the second note 
3: 
Play drum loop from the third note 
4: 
Play drum loop from the fourth note 
Backward symbol:
 Play backwards from this point 
Stop symbol:
 Stops play 
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The right mouse button allows you to delete the step cells individually. The "Clear" button
 on the right deletes all step cells; the drum loop is played in its original sequence. The "Random rhythm"
button generates a random sequence. You can then alter the rhythm as you wish. 
By clicking on the blue field in the bottom part of the rhythm section you open a pop-up menu
 where you can select the drum loop sound. If you select a different drum loop, it will be loaded and
played as programmed by you. 
In the "Flame" row you can set the note to be played twice quickly in succession instead of only once,
allowing you to program rolls and fill-ins. 
The "Velocity" row allows you to set intensity values between 0 and 16 with the mouse (left mouse click
increases value, right mouse click decreases value). Use the three buttons under the "Velocity" row to
determine how these values will affect the sound of your loop. If you select "Volume", the velocity value
alters the volume for this cell (16 = loud, 0 = quiet). If you select "Filter", the velocity value alters the filter
strength for this cell (16 = sharp, 0 = muffled). The "None" button
 blocks use of the velocity values. 

The bass section (bottom half)
 The bass section allows you to create the right bass lines for your rhythm quickly. As in the rhythm row,
there are two-step rows. 

 With the first "Notes" row, you determine the sequence of the notes, i.e. the sound sequence. 
 By clicking on a cell with the left mouse button, you open a pop-up window, where you can

select the notes. 
 By clicking with the right mouse button, you delete a cell. 
 If you click on an empty cell with the right mouse button, you will see a "Stop" symbol. This

function is similar to that in the rhythm section, i.e. it stops the bass sound at this point.
 In the "Octave" row you can determine the bass octave sound. Octave 1 creates a deep tone,

Octave 3 a high tone. You can only set the octave values if there is a note in the row above.
 As in the rhythm section, there are also buttons for "Clear", "Random notes", and a red selection 

field at the top border of the bass section. The red selection field allows you to set the bass
sound.

 Underneath the step rows, you will also find two sliding controls for sound adjustment. You can
use the "Vibrato" control to make the bass tone "swing" at its pitch. If the control is pushed all the
way to the right, the swing will be stronger; all the way to the left will have no effect on the pitch.

 With the "Delay" controller you can set a time for the sound to completely fade out. All the way
to the right makes the sound fade out quickly (after approx. ¼ second); all the way to the left
means ongoing sound.
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The rhythm section (top half)
 You can easily create complex and authentic jungle break beat sounds. In a professional recording
studio, jungle break beats are created by dividing any given drum loop into several small "bits" and
putting them back together in a different order. This lengthy process is significantly simplified by the Drum
& Bass machine. You just have to design your own new play sequence. 
You set up the new sequence in the top ("steps") row. The blue cells indicate the individual sections
("notes") for the subdivision of the loop. 
A left mouse click on one of the blue cells allows you to select one of six possible symbols. Each symbol
represents a different note or other way of playing the note. Every time you click on one of the blue cells,
the next symbol is chosen. 
Rely on your own intuition and creativity when programming your beats. It is not absolutely necessary to
know the exact meaning of each individual symbol in order to create cool and authentic beats. 
Summary symbol description: 
1: 
Play drum loop from beginning 
2: 
Play drum loop from the second note 
3: 
Play drum loop from the third note 
4: 
Play drum loop from the fourth note 
Backward symbol:
 Play backwards from this point 
Stop symbol:
 Stops play 
The right mouse button allows you to delete the step cells individually. The "Clear" button
 on the right deletes all step cells; the drum loop is played in its original sequence. The "Random rhythm"
button generates a random sequence. You can then alter the rhythm as you wish. 
By clicking on the blue field in the bottom part of the rhythm section you open a pop-up menu
 where you can select the drum loop sound. If you select a different drum loop, it will be loaded and
played as programmed by you. 
In the "Flame" row you can set the note to be played twice quickly in succession instead of only once,
allowing you to program rolls and fill-ins. 
The "Velocity" row allows you to set intensity values between 0 and 16 with the mouse (left mouse click
increases value, right mouse click decreases value). Use the three buttons under the "Velocity" row to
determine how these values will affect the sound of your loop. If you select "Volume", the velocity value
alters the volume for this cell (16 = loud, 0 = quiet). If you select "Filter", the velocity value alters the filter
strength for this cell (16 = sharp, 0 = muffled). The "None" button
 blocks use of the velocity values. 

The bass section (bottom half)
 The bass section allows you to create the right bass lines for your rhythm quickly. As in the rhythm row,
there are two-step rows. 

 With the first "Notes" row, you determine the sequence of the notes, i.e. the sound sequence. 
 By clicking on a cell with the left mouse button, you open a pop-up window, where you can

select the notes. 
 By clicking with the right mouse button, you delete a cell. 
 If you click on an empty cell with the right mouse button, you will see a "Stop" symbol. This

function is similar to that in the rhythm section, i.e. it stops the bass sound at this point.
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 In the "Octave" row you can determine the bass octave sound. Octave 1 creates a deep tone,
Octave 3 a high tone. You can only set the octave values if there is a note in the row above.

 As in the rhythm section, there are also buttons for "Clear", "Random notes", and a red selection 
field at the top border of the bass section. The red selection field allows you to set the bass
sound.

 Underneath the step rows, you will also find two sliding controls for sound adjustment. You can
use the "Vibrato" control to make the bass tone "swing" at its pitch. If the control is pushed all the
way to the right, the swing will be stronger; all the way to the left will have no effect on the pitch.

 With the "Delay" controller you can set a time for the sound to completely fade out. All the way
to the right makes the sound fade out quickly (after approx. ¼ second); all the way to the left
means ongoing sound.
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The bass section (bottom half)
 The bass section allows you to create the right bass lines for your rhythm quickly. As in the rhythm row,
there are two-step rows. 

 With the first "Notes" row, you determine the sequence of the notes, i.e. the sound sequence. 
 By clicking on a cell with the left mouse button, you open a pop-up window, where you can

select the notes. 
 By clicking with the right mouse button, you delete a cell. 
 If you click on an empty cell with the right mouse button, you will see a "Stop" symbol. This

function is similar to that in the rhythm section, i.e. it stops the bass sound at this point.
 In the "Octave" row you can determine the bass octave sound. Octave 1 creates a deep tone,

Octave 3 a high tone. You can only set the octave values if there is a note in the row above.
 As in the rhythm section, there are also buttons for "Clear", "Random notes", and a red selection 

field at the top border of the bass section. The red selection field allows you to set the bass
sound.

 Underneath the step rows, you will also find two sliding controls for sound adjustment. You can
use the "Vibrato" control to make the bass tone "swing" at its pitch. If the control is pushed all the
way to the right, the swing will be stronger; all the way to the left will have no effect on the pitch.

 With the "Delay" controller you can set a time for the sound to completely fade out. All the way
to the right makes the sound fade out quickly (after approx. ¼ second); all the way to the left
means ongoing sound.
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Mixer

 MAGIX Movie Edit Pro 16 includes a real-time mixer with a master effects section that professionally
mixes all the tracks within an arrangement. The mixer can be opened by pressing the "M" key or
accessed via the toolbar
 in the main window ("View -> Mixer"). 
In this chapter
Mixer tracks
FX tracks (effect tracks)
Master track (Plus version)
Volume and panorama automation
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Mixer tracks
 Each track has its own volume or brightness fader. This fader also affects added MIDI
 objects. 

The stereo position for each audio
 track is defined with the Pan controls. 

The "Solo" button switches a track to solo mode, i.e. all other tracks are muted. The "Mute" button
 mutes a track. 
Double clicking any of the controls resets them to their default passive setting (no boost or cut in level),
and no processor output will be required. 
Track effects
 Besides audio effects in the object (audio cleaning, reverb/echo, timestretch/resample, Surround, etc.), a
separate track effects rack with equalizer, reverb/echo, compressor as well as plug-ins can be used in
each mixer track. 

The plug-ins are loaded via the plug-ins slot. 

You can open the track audio effects rack with the FX
button. 

A light blue track FX button indicates that effects are active in the track. Please read the chapter "Audio
Effects
" for functionality and handling of the individual audio effects. 
DirectX audio plug-ins 
The MAGIX Movie
 Edit Pro 16 supports DirectX audio plug-Ins. These are usually effects modules such as reverb,
equalizer, etc. 
The DirectX system must be installed on your PC prior to using the DirectX plug-Ins ? a manual
installation is only required on rare occasions. Generally, DirectX is already available through the
Windows installation. If your PC does not have the DirectX System installed or if it is out of date, you
can find a DirectX installer on the MAGIX Movie Edit Pro 16 disc. Of course, DirectX plug-ins have to
be installed first, depending on the plug-in
 used. 

Two so-called "slots" for track effects are located in the
channel strip of the mixer for the corresponding track,
plus in the FX tracks. 

 Clicking on the small triangle will let you select an effect from the list. Select "No effect" to remove a
plug-in from the slot. A left click temporarily disables the plug-in. Active plug-ins are displayed in light
blue. Right clicking on the slot opens the settings dialog of the plug-in
. 
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FX tracks (effect tracks)
Two FX send controllers (FX1 and FX2) are located
below the plug-in
 slots. 

You can determine the volume at which you want the signal to be routed to the two available FX tracks. 
An FX track is a complete, additional mixer track which provides a complete track FX rack and two
plug-in slots for use as a send effect. 
A send effect differs from a
normal effect found in the
track (insert) insofar as it
can edit the signals from
multiple tracks or objects
simultaneously. 
A send effect roughly
corresponds to the scheme
of a parallel switch, while
an insert on a track is like a
series switch. 
A special feature offered by
MAGIX Movie Edit Pro
16 is that audio
 objects can also send
directly to the FX track. 
The FX are usually hidden in the mixer. They will be displayed as soon as one of the FX send controllers
is used. 
In the first FX track, the reverb function is activated as standard, since it is the most important application
of the send effects. 
The volume controllers regulate the volume of the FX track and correspond with the old AUX return
controller. "Mute" is used to switch the FX portion on and off. "Solo" enables you to single out FX
individual tracks. The track's peak meters which send to the FX track are displayed in grey. 
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Master track (Plus version)
 The FX button and the plug-in slots function exactly like in the tracks. The FX button will open the
master audio effects rack. The complete mixer settings including the FX tracks can be reset with the "
Reset
" button. 
MAGIX Mastering Suite: Opens the MAGIX Mastering Suite
. 
5.1 Surround: This button switches the mixer to "Surround
" mode. 
Both faders control the total volume. 

Link button
: If you deactivate the link button, you can control
the volume of the right and left channels
individually. 
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Volume and panorama automation
 You can automate the volume and panorama curves on a mixer track. This means you can record this
movement of the track volume faders and panorama controls while playing the movie
. This way, for instance, you can simulate the movement of a sound source and volume adjustment from
left to right instantly during playback. 

As long as the "Auto" button
 in a track is active, all movements of the volume and
panorama controller are recorded. 

The automation is displayed as a curve in the arranger and can be edited later with the mouse. 
Unlike the automation curve of the mixer, the dynamic effects are track-dependent, i.e. regardless of the
objects contained in the track. 
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Audio effects
 For more information about this, see the section entitled "Audio effects" in the chapter "Effects and titles
" 
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5.1 Surround
 MAGIX Movie
 Edit Pro 16 supports playback and export in real 5.1 Surround. 
In this chapter
Requirements
Importing and exporting surround audio files
The mixer in Surround mode
5.1 Surround Editor
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Requirements
 You will require a sound card or a sound chip which is integrated into the computer's motherboard
 with six individual outputs to playback the individual channels: 

 front left (L) / right (R)
 centre (C) / subwoofer (LFE)
 back left (Ls) / right (Rs)

Surround playback is possible with all audio driver models (see Playback settings), (Wave
, DirectSound, ASIO). 
DirectSound 
is supported by most of the standard sound cards. 
Wave drivers
 are similarly supported by many standard sound cards; however, individual sound cards (for example,
Soundblaster) require access to DirectSound. 
Note: 24-bit Surround playback is often not possible, therefore please select 16-bit output. 
For Surround output with ASIO 
drivers, you will require a 6-channel-capable ASIO driver (e.g. MAGIX Low Latency). Older
multi-channel audio cards that activate their stereo output couples via multiple separate drivers are not
suitable. 
Output of the six output signals is achieved in all driver models in the output channels in the same
(standardized) order: 
Channels 1/2: L-R
 Channels 3/4: C-LFE
 Channels 5/6: Ls-Rs
 When using WAV
 or ASIO drivers, the loudspeaker settings normally have to be changed to 5.1 playback in the control
panel. 
In order to do this you have to start the Control Panel for "Sounds and audio devices" and select
"Loudspeaker settings", "Advanced", "5.1 Surround loudspeakers". 
On most systems the program does this automatically while using DirectSound. 
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Importing and exporting surround audio files

 Import
 When importing MPEG2 files with Dolby Digital sound (for example, VOB files from DVDs or
DVB-TV recordings) you can choose from two different application cases: 

 Mixdown: The surround sound is displayed as an audio object under the video object, playback
of the surround track is reduced and recalculated to stereo playback. Use this option if you don't
wish to edit the surround sound, but rather wish to export it. You can also use it if you think that
a stereo export is enough to meet your requirements.

For the import of surround sound as a mixdown the free activation of the Dolby Digital stereo codec is
required. 

 Surround mix: The individual surround channel pairs (L-R, C LFE, Ls-Rs) are split into three
audio tracks as separate objects and the mixer is then set to Surround Mode (only in MAGIX 
Movie Edit Pro 16 Plus, optional fee-based activation of the Dolby Digital surround codec would
be required). In this mode you can adjust the surround mix.

In MAGIX Movie Edit Pro 16 the import of Dolby Digital surround is always executed as a mixdown. 
MAGIX Movie Edit Pro 16 Plus can also import interleaved wave
 files (multi-channel wave files), multi-channel Windows Media Audio and MP3surround files. A
surround mix is always created. 
Note: The surround channels of AVCHD
 video streams are not importet, in this case only a stereo signal is used. 

Export
 Surround mix exports can occur in any one of the following formats: 

 6-channel PCM files (interleaved wave)
 Windows Media files (as a Surround soundtrack of a Windows Media Video or WMV-HD

disc)
 MPEG-2 files with Dolby Digital sound track (requires activation of the Dolby Digital codec)

The files created are fully compatible
 with the normal file formats, this means that they can also be played on computers incapable of playing
Surround (in normal stereo). 
The export is performed via the same menu commands (e.g. "File -> Export movie -> Audio
 as wave") like the normal stereo export. You will then be asked if the export should be in stereo or
Surround format. 
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Import
 When importing MPEG2 files with Dolby Digital sound (for example, VOB files from DVDs or
DVB-TV recordings) you can choose from two different application cases: 

 Mixdown: The surround sound is displayed as an audio object under the video object, playback
of the surround track is reduced and recalculated to stereo playback. Use this option if you don't
wish to edit the surround sound, but rather wish to export it. You can also use it if you think that
a stereo export is enough to meet your requirements.

For the import of surround sound as a mixdown the free activation of the Dolby Digital stereo codec is
required. 

 Surround mix: The individual surround channel pairs (L-R, C LFE, Ls-Rs) are split into three
audio tracks as separate objects and the mixer is then set to Surround Mode (only in MAGIX 
Movie Edit Pro 16 Plus, optional fee-based activation of the Dolby Digital surround codec would
be required). In this mode you can adjust the surround mix.

In MAGIX Movie Edit Pro 16 the import of Dolby Digital surround is always executed as a mixdown. 
MAGIX Movie Edit Pro 16 Plus can also import interleaved wave
 files (multi-channel wave files), multi-channel Windows Media Audio and MP3surround files. A
surround mix is always created. 
Note: The surround channels of AVCHD
 video streams are not importet, in this case only a stereo signal is used. 

Export
 Surround mix exports can occur in any one of the following formats: 

 6-channel PCM files (interleaved wave)
 Windows Media files (as a Surround soundtrack of a Windows Media Video or WMV-HD

disc)
 MPEG-2 files with Dolby Digital sound track (requires activation of the Dolby Digital codec)

The files created are fully compatible
 with the normal file formats, this means that they can also be played on computers incapable of playing
Surround (in normal stereo). 
The export is performed via the same menu commands (e.g. "File -> Export movie -> Audio
 as wave") like the normal stereo export. You will then be asked if the export should be in stereo or
Surround format. 
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Export
 Surround mix exports can occur in any one of the following formats: 

 6-channel PCM files (interleaved wave)
 Windows Media files (as a Surround soundtrack of a Windows Media Video or WMV-HD

disc)
 MPEG-2 files with Dolby Digital sound track (requires activation of the Dolby Digital codec)

The files created are fully compatible
 with the normal file formats, this means that they can also be played on computers incapable of playing
Surround (in normal stereo). 
The export is performed via the same menu commands (e.g. "File -> Export movie -> Audio
 as wave") like the normal stereo export. You will then be asked if the export should be in stereo or
Surround format. 
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Export Dolby Digital Surround via Smart Encoding
 You can also burn material to be exported with surround sound again without the need for the Dolby
Digital codec (in MAGIX Movie Edit Pro 16 or MAGIX Movie Edit Pro 16 Plus without Dolby Digital
encoder activation) to DVD or export the corresponding MPEG files while keeping 5.1 Surround Sound.
To do so, use the "Smart Rendering" option which transfers the unprocessed parts of the output material
without renewed encoding. Read more on this in the MPEG Encoder Settings annexe, General Settings
 section. 
The import has to be executed as a mixdown, the audio material cannot be changed (no fades, no audio
cleaning, no volume adjustment). Harder steps, for example, for removing commercials are allowed, they
may not happen precisely according to the frame
, but at the GOP (group of pictures) borders. 
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The mixer in Surround mode

 To activate Surround playback, open the mixer (M key) and click on "5.1 Surround" button
 in the master. 
In the master, six peak meters for the individual channels are provided. The normal panorama button
 turns into a representative display of the Surround editor (see below), which can be opened by clicking
on the display. 
The Surround sound editor is also available to the effects tracks. For example, you can send the original
track to the front L/R speakers, the FX track however will remain at the rear L/R speakers
. 
The master volume is applied to all channels, here the left controller influences channels L and Ls, the
right controller; channels R and Rs and the middle value of both controller; the channels C and LFE. 
The master plug-ins are only applied to the front channels. 
The full effects palette of the mastering effects rack in MAGIX Mastering Suite is not available in 5.1
Surround mode, but rather only the compressor and the parametric equalizer (from the Mastering Suite)
are provided. The settings of these effects have the same effect on all six channels. 
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5.1 Surround Editor

 The selected mixer track's 5.1 Surround editor allows you to arrange the audio
 signal of a track (displayed as two red sound sources) in stereo space. The signal is dispersed to the 5
(blue) loudspeakers which represent the individual Surround channels. 
There are 6 channels: 
L:
 front left 
R:
 front right 
C: 
center 
Ls: 
back left/left Surround 
Rs:
 back right / right Surround 
LFE subbass (Low Frequency E
ffect) channel 
Dispersing the signal to the 5 loudspeakers occurs after the sound source emits a sound field
 of a certain level (displayed as red circles). The further away a loudspeaker's source is, the lesser its
share of the corresponding loudspeaker channel. The position of the loudspeaker can be moved with the
mouse. 
The subbass share (LFE)
 is set directly from the corresponding value table. It can also be changed by dragging the mouse. 
There are various modes in which you can use the source signal: 

 Mono: The (stereo) source signal is seen as mono material, the left and right channels are mixed
together and arranged together. The original stereo information is lost here.

 Stereo 1: Similar to mono mode insofar as the left and right channels are moved together, but
only a portion of the left source is audible in the loudspeakers L and Ls and only a portion of the
right source in the right channels R and Rs. The stereo information remains as intact as possible.

 Stereo 2: The left and right channels can be moved individually. The distance between the left
and right source is retained when you move the left source. You can move an individual source
by holding down the "Alt" key.

 Center/LFE: Only the left channel is arranged. In return, the LFE share is drawn solely from the

Page 400



right channel. This mode is only important for importing Surround material.
"Width" 
determines the level of the sound field of an individual source. 
Automation:
 Panning of the sound source on the loudspeaker can be automated to simulate movements in the room. 
For this to happen "Automation"
 must be activated. There are two methods to create automations: record and draw. 
To record
 (when automation is on), the sound source is moved between the loudspeakers during playback. When
recording the automation, the "Record" check box lights up red. 
The draw function is an alternative to drawing out complex movements. When drawing in active mode, all
panning movements are transmitted to the time interval between the start and end marker (when the
mouse button
 is held). You can thus draw the entire movement curve for the selected time range. 
"Reset"
 deletes surround automation from the track. 
There is no automation of the parameters for width and LFE, of the distance between the left and right
source in "Stereo 2" mode, or of the loudspeaker positions. 
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Scrubbing
 Scrubbing originates from a time when tape machines still dominated. The function is suitable for quickly
previewing individual passages of a film or piece of music. 
This was technically implemented in these devices by keeping the tape head on the tape itself, but the
motor doesn't drive the tape rolls in this case. Instead the tape is "manually" set to the desired position. In
this way, positions where a cut should be made, for example, can be set fairly precisely. The
disadvantage of this method is that the pitch changes proportionate to the playback speed - like when a
record is played too quickly or too slowly. 
Scrubbing in MAGIX Movie
 Edit Pro 16 certainly behaves a little differently than its analog predecessor; instead, it plays short
samples of the material at the original speed. 
Note: In order to preview individual audio objects, use the "Preview
" mouse mode. 

Scrubbing: Activate
Scrubbing can be activated via the 
menu beside the speaker button
 on the upper edge of the arrangement
window. 

Scrubbing: Modes
 No scrubbing
: Scrubbing is inactive. If the playback marker is set or moved, then sound will not be played. 
Scrubbing (1 frame)
: Scrubbing is active and samples are only 1 (video) frame in length. The speed is 25 fps, i.e. 1/25
second. This mode is suitable for positioning the playback marker exactly. 
Scrubbing (long)
: Scrubbing is active, the sample length amounts to approx. 0.5 seconds. In this mode, locating specific
events is particularly easy. 
Play 1x during scrubbing
: If this option is active, the current position will be played one time. If it is inactive, then it will be
repeated. 

Scrubbing: Apply
 If a scrub mode is selected, then you can simply set the playback marker with the mouse at a location on
the timeline. Hold down the mouse button
 and move the playback marker to different locations in the arrangement. 

Scrubbing also functions via the keyboard. Using the jog and shuttle wheels in the video monitor also
enables scrubbing, even for different hardware
 controllers, which makes the program feel just like an analog video editing system! 
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Mix down of audio objects
 If the arranger becomes too full to manage, the system is out of RAM, or you just want to "summarize"
your production, use the mix down function to convert the entire audio arrangement into a single audio
file. Just click on the mix down button in the button bar or select the function from the "Processing" menu
. 
You can choose a name and a destination for storing the mix down object. The default directory is "My
audio/video". 
Storage of the audio arrangement will take up a little more space on your hard-drive, but it requires less
RAM for playback than an unmixed entire arrangement. 
Note: The mix down effect optimizes the volume automatically. Even if the mix down function is used
various times, you will not lose audio
 quality. 
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Managing video projects
In this chapter
Backup copy
Load backup project...
Clean-up wizard
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Backup copy
 Files must be saved to be able to be easily retrieved in case of a hard drive crash or some other error. 
In this section:
Copy movie/project and media to folder
Burn project/film and media onto CD/DVD
Restore disc project from (S)VCD/video DVD

Copy movie/project and media to folder
 This menu option allows you to put a complete MAGIX Movie
 Edit Pro 16 arrangement, including all applied multimedia files, into one folder. This is especially useful if
you want to reuse or archive such an arrangement later on, or if the files are located on multiple storage
devices (CDs, DVDs, etc) so that you continually have to change them during loading. Effects files used
are also saved in a folder together with the other files. 
If you select the option, "Copy disc project, movies, and media into folder", all movies in the current
disc project
, including all of the related media, are put together and copied into the chosen folder. 
Hint: MAGIX Movie Edit Pro 16 also features DV logging. You no longer need to save large DV-AVI
and audio
 files, since MAGIX Movie Edit Pro 16 saves the position of this material on the DV tape and imports
missing files automatically when reloading the DV tape. 
A dialog
 opens where you can specify the path and name of the video. 
Shortcuts: 
Copy movie and media into folder Shift + R 
Copy project and media into folder... Ctrl + Q 

Burn project/film and media onto CD/DVD
 Use this option to burn the film as well as all associated files to disc. To do so, you must have a burner
installed on your computer and a blank CD must be inserted. 
If you choose the option "Burn project
 and media", the current project and all of the associated media files are grouped together and burned
onto disc. 
Even larger projects can be burned straight to disc. The project, if necessary, will be split up and burned
automatically to multiple discs. A restore
 program which is burned to the first disc of this type of backup guarantees that the backup can be
restored without any problems. 
Keyboard shortcut: Ctrl + Shift + R 

Restore disc project from (S)VCD/video DVD

Page 405



 With this menu command, you can restore a project backup that has been saved to a CD/DVD. The
disc has to be burned with the option "Add project backup" (see "Burn disc dialog options"
). 
You can select which movies on the disc should be restored by selecting them in the list. You will also
enter the folder where the project should be saved. As subfolder "Backupxx" will be created for every
restored project and all of the project files from the disc will be saved there. All restored movies will be
loaded into MAGIX Movie
 Edit Pro 16 for editing. 
If you select the option "Restore image files only"
, only the original image files contained on the disc are restored. 
Keyboard shortcut: Ctrl + Alt + R 

Load backup project...
 This option loads an automatically created slideshow backup. This type of automatic backup gets the file
extension MV_ (underscore). This command is only intended for use in emergencies, for example, if you
unintentionally saved your change and wish to return to the previous version of the movie
. 
Keyboard shortcut: Alt + O 
Tip:
 Under "File -> Settings -> Program...", you can determine how often an automatic backup will be
created in the "System" tab under "Automatic backup". 

Clean-up wizard
 The clean-up wizard helps you delete projects from your hard drive, including all media files. Use this
function to free up disk space for future projects. 
Caution
: If the files you used in the slideshow have also been used in other slideshows (like trailers, opening
music, etc.), then you should make backup copies of these files beforehand. 
Shortcut: Ctrl + Alt + G 

Page 406



Delete specific files
 Choose this option if you would like to select certain files for deletion. In the file selection dialog, you can
select the desired files. In the next step, the clean-up wizard searches for other files which belong to your
selection. Using this method, you can delete an entire movie with all of its accompanying media, help,
project, and backup files. Before they are deleted, you will receive relevant information in a dialog
 and a confirmation request. 

Search and delete superfluous files
 Choose this option if you would like to find unnecessary files or free up some space on your hard drive.
The clean-up wizard automatically looks for extraneous files created during use of MAGIX Movie Edit
Pro 16. Before they are deleted, you receive relevant information in a dialog
 and a confirmation request. 

Advanced
 "Advanced" lets you set which files and folders should be included in the cleaning process. 
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Load backup project...
 This option loads an automatically created slideshow backup. This type of automatic backup gets the file
extension MV_ (underscore). This command is only intended for use in emergencies, for example, if you
unintentionally saved your change and wish to return to the previous version of the movie
. 
Keyboard shortcut: Alt + O 
Tip:
 Under "File -> Settings -> Program...", you can determine how often an automatic backup will be
created in the "System" tab under "Automatic backup". 

Clean-up wizard
 The clean-up wizard helps you delete projects from your hard drive, including all media files. Use this
function to free up disk space for future projects. 
Caution
: If the files you used in the slideshow have also been used in other slideshows (like trailers, opening
music, etc.), then you should make backup copies of these files beforehand. 
Shortcut: Ctrl + Alt + G 

Delete specific files
 Choose this option if you would like to select certain files for deletion. In the file selection dialog, you can
select the desired files. In the next step, the clean-up wizard searches for other files which belong to your
selection. Using this method, you can delete an entire movie with all of its accompanying media, help,
project, and backup files. Before they are deleted, you will receive relevant information in a dialog
 and a confirmation request. 

Search and delete superfluous files
 Choose this option if you would like to find unnecessary files or free up some space on your hard drive.
The clean-up wizard automatically looks for extraneous files created during use of MAGIX Movie Edit
Pro 16. Before they are deleted, you receive relevant information in a dialog
 and a confirmation request. 

Advanced
 "Advanced" lets you set which files and folders should be included in the cleaning process. 
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Clean-up wizard
 The clean-up wizard helps you delete projects from your hard drive, including all media files. Use this
function to free up disk space for future projects. 
Caution
: If the files you used in the slideshow have also been used in other slideshows (like trailers, opening
music, etc.), then you should make backup copies of these files beforehand. 
Shortcut: Ctrl + Alt + G 

Delete specific files
 Choose this option if you would like to select certain files for deletion. In the file selection dialog, you can
select the desired files. In the next step, the clean-up wizard searches for other files which belong to your
selection. Using this method, you can delete an entire movie with all of its accompanying media, help,
project, and backup files. Before they are deleted, you will receive relevant information in a dialog
 and a confirmation request. 

Search and delete superfluous files
 Choose this option if you would like to find unnecessary files or free up some space on your hard drive.
The clean-up wizard automatically looks for extraneous files created during use of MAGIX Movie Edit
Pro 16. Before they are deleted, you receive relevant information in a dialog
 and a confirmation request. 

Advanced
 "Advanced" lets you set which files and folders should be included in the cleaning process. 
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Options for using the final
movie
In this chapter
Create playable disc
Export movie
Export audio/video
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Create playable disc
 MAGIX Movie Edit Pro 16 allows discs to be burned for playback on conventional playback devices
(e.g. DVD players, Blu-ray players). For more information, please see "Burning discs
". 
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Export movie
 You can export your movie
 in various video formats. The options available vary according to the selected format. 
Presets
: These are the typical settings for the selected format and the most important applications. 

You can save your personal settings by pressing the
"Save" button, or remove them from the list by
pressing the "Delete" button
. 

Export settings: You can set up the general export parameters like resolution, page proportions and
frame rate in the dialogs. Select the most frequently used values from the list fields; to set your own values
click on the "..." button. The "Advanced" button opens the specific settings for the selected video format.
"File" allows you to export your file to a different folder than the one specified as the preset. With "
Overwrite file automatically
", you can perform multiple exports from the same file. 
Other
: Under "Other" you also have the option of switching off your computer automatically after long encoding
processes and limiting the export to the selected area (start to end marker). 
Output after export: Some formats allow special playback options (e.g. DV-AVI on the camera or
WMV
 export with output via Bluetooth to your mobile phone). 
In this section:
Video as AVI
Video as DV-AVI
Video as MPEG video
MAGIX video export
Video als Quicktime Movie
Uncompressed movie
Video as MotionJPEG AVI
Movie as sequence of individual pictures
Windows Media Export
Video as RealMedia video
Exporting as Flash
Video as MPEG-4 video
Audio as MP3
Audio as WAV
Export as transition...
Single frame as BMP
Single frame as JPG
Animated GIF
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Video as AVI
 When exporting to AVI video you can set and configure the size and frame rate of the AVI video and
the compression codec for audio (audio compression) and video. Please also observe the general
information on AVI video formats
. 
Keyboard shortcut: Alt + A 
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Video as DV-AVI
 This option exports the video as a DV encoded AVI. You will be asked for which video standard you
want to export DV data. PAL (Europe)
 or NTSC (USA)? The arrangement can be easily transferred to the Digicam via the FireWire interface. 
The window will provide further information on all available options. You can access it via the button "
Advanced..." in the "Export" dialog
. 
Keyboard shortcut: Alt + B 
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Video as MPEG video
 MPEG stands for "Motion Picture Experts Group" and is a high-performance compression format for
audio
 and video files. 
Details on the settings of the MPEG encoder can be found in the "MPEG encoder settings" appendix. 
Keyboard shortcut: Alt + C 

Page 415



MAGIX video export
 Exports the movie in MAGIX video format. This format is used for video recording by MAGIX video
software
 and is optimized for digitally edited high-quality video material. 
Keyboard shortcut: Alt + D 

Page 416



Video als Quicktime Movie
 Exports the movie in QuickTime movie format. This enables streaming playback of audio
 and video files over the Internet. 
As with RealMedia export, appropriate adjustments can also be made for video site, frame rate, and
codec settings. However, the export dialog
 does not permit you to add commentary to the video. 
For QuickTime files (*.mov
) you have to install the QuickTime library. 
Keyboard shortcut: Ctrl + E 

Page 417



Uncompressed movie
 When exporting an uncompressed AVI video file, you can adjust the size and frame
 rate of the AVI video you wish to create. 
Warning
: This will create very large files! 
Keyboard shortcut: Alt + U 
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Video as MotionJPEG AVI
 Opens the export dialog for AVI
 video in Motion JPEG format. This format is supported by digital picture frames, for example. 
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Movie as sequence of individual pictures
 This option exports the video as a sequence of single frames in bitmap format. This means that for every
video frame, a graphic file will be created. The image count can be determined in the export dialog
 under "Frame rate". 
Keyboard shortcut: Alt + V 
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Windows Media Export
 Exports the arrangement in Windows Media format. This is a universal audio/video format from
Microsoft. The setting options in the Advanced dialog
 are correspondingly complex. 

Manual configuration

 Audio/Video codec:
 Various codecs corresponding to the many versions of Windows Media (7, 8, 9) are possible. If
playback compatibility problems arise, try an older codec with a lower version number. 
Bit rate mode: Constant and variable bit rate modes are possible; however, most devices and streaming
applications require a constant bit rate. For VBR two-pass modes, the movie
 is compressed in two passes for optimal use of the bandwidth required for highly-compressed movies on
the Internet. 
Bit rate/quality/audio format: 
The bit rate substantially determines the display and audio quality. The higher this is, the better your
videos will look and the larger the files and the required encoding time will be. For variable bit rates, the
bit rate is adapted dynamically to the requirements of the corresponding picture or sound material. Here,
either the quality value of between 1-100 can be set or, for two-pass encoding, an average or maximum
bit rate. For audio, the bit rate is set additionally by the audio format. 
Import from system profile (export type): For the most used methods (other than for playback on
mobile devices; for this you should use the supplied presets), e.g. Internet streaming, Microsoft provides
a diverse selection of system profiles. If you have the Windows Media Encoder 9 installed (available
from Microsoft as a free download), then you can edit the profiles or create your own. These can be
loaded by pressing the "Import from profile file" button
. 
Go to Clip info to insert title, author name, copyright
 details, and a description. 
Keyboard shortcut: Alt + F 
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Video as RealMedia video
 Exports the movie
 in RealMedia movie format. 
RealMedia enables streaming playback of video files via the Internet. This has a very high compression
rate, but the quality is noticeably reduced. After choosing a name for your file, you can specify the bit rate
of the transmission speed (modem, ISDN, etc.) at which the audio
 file should still be playable without any errors. 
There are many options for embedding meta information for this format. 
The advanced video options allow you to select the number of frames per second ("fps"), the lower the
value, the less data is transferred and the lower the picture quality. 
The following settings can be accessed via the "Advanced..." button
. 
Audio/Video settings
: Here you can select presets for the quality of audio or video material. 
Clip information
: You can enter the author, video's name, and so on, which appear in the Real player during playback. 
Clip meta information
: You can enter keywords for search engines here. When the RealVideo clip is uploaded to a homepage,
search engines will find it using these keywords. This search engine indexing can also be switched off. 
Preprocessing: Of special interest here is the "Two-pass encoding" field
, since this can be used to enhance the quality of the video. The video is compressed into two runs in
order to optimize the bandwidth. You can also select various filters. 
Video size
: Select between video sizes of 160 x 120 and 720 x 576 pixels. 
Profile
: You can select at which bandwidth the video should be created, i.e. over which data connection it will
be played in real time ("streamed"). The settings selected here may limit other selection options, since files
for 28k modems cannot be created to be played at high quality. 
Keyboard shortcut: Alt + G 
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Exporting as Flash
 Export of FLV files has been replaced by the more powerful H 264 export. Flash plug-ins of the new
generations to playback MP4 files with H.264 material instead of FLV files.
You can select a preset labeled as "Flash Player" or click on "Advanced" and activate the "Export as
website" entry forMPEG 4 export
. This will automatically create an HTML page and a SWF file with Flash Player in addition to the
exported file. 
When applying manual settings, AVC H.264 format with AAC sound is recommended. In order to be
able to play back the file in a browser, the exported MP4 file, the SWF file and the HTML file must be in
the same folder. The browser needs an installed Flash plug-in
 (version 9.0.115.0 or higher is recommended). 

Page 423



Video as MPEG-4 video
 Hint: In order to use the MPEG-4 video export feature, you will have to activate this function first
. 
MPEG-4 is the most advanced video format available at the moment. Unlike others, it can provide
high-quality pictures at the same file size. 
Behind MPEG-4, you'll find a highly complex "academic" standard that operates and is supported
variably according to make. To go into detail on these differences and parameters would be beyond the
scope of this documentation. For this reason, indications, along with the operational manual of your
device, are given that should help create executable MPEG-4 files. For more experimental users, the
complete setup options of the MPEG-4 codec can be found behind the "Advanced settings..." buttons. 
Video/Audio: 
The MPEG-4 format and the advanced AVC format are also available but have, as of yet, only been
used in a few devices. MPEG4 video can be combined with AAC or AMR sound, the latter mostly in
conjunction with mobile phones. The combination ACC/AAC doesn't appear very often (Apple iPod
Video), ACC with AMR in contrast, not at all. 
Multiplexer: Here you can find teh so-called container formats and special options for Apple iPod and
Sony PSP. MPEG-4 is usually used as an output format
, mobile phones mostly use 3GPP. 
Keyboard shortcut: Alt + K 
Note: To import and export AVC and MPEG-4 files, the MEPG-4 codec must first be activated. A
dialog will open if the codec is required. Files with a horizontal resolution of more than 768 pixels can
only be loaded in MAGIX Movie
 Edit Pro 16 Plus. 
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Audio as MP3
 MAGIX Movie Edit Pro 16 supplies an optional MP3 Encoder for especially fast and good-sounding
conversions into the popular MP3 audio
 format. 
Warning:
 In order to use the MP3 export function, Windows Meida Player 10 or higher has to be installed to your
system. 
Hint: The MP3 Encoder cannot be used as a codec for the audio track of AVI
 audio files. 
Transmission format
 Here you can specify how you wish to send the audio file to the mobile device. Read more on this under
Transferring files. 
Options
 In the "Options" section you can set the format and the compression of the audio file. 
Bit rate:
 The "Bit rate" selection specifies the level of compression: The higher the bit rate, the higher the quality of
the exported audio file. On the other hand, the bit rate determines the final file size: The smaller the bit
rate, the smaller the files. 
Mono/Stereo/5.1 Surround
: Most mobile devices have only one loudspeaker. To save on memory, you can export in mono as well.
In 5.1 Surround Mode (see Mixer in Surround Mode) you can also export in MP3surround. 
Normalize:
 This function should always be activated. It guarantees that the music is not too loud/overmodulated or
too quiet. 
Keyboard shortcut: Alt + M 
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Audio as WAV
 The soundtrack of the movie is exported as a WAV audio
 file. 
Keyboard shortcut: Alt + H 
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Export as transition...
 Please see "Creating custom alpha transitions
" 
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Single frame as BMP
 Exports the image
 at the position of the start marker and displayed on the video screen as a BMP file. 
Keyboard shortcut: Alt + M 
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Single frame as JPG
 Exports the picture located at the current start marker and displayed in the video monitor as a JPG file. 
Keyboard shortcut: Alt + N 
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Animated GIF
 The video will be exported as an animated GIF file (also called "AniGIF). This file format is supported
by many mobile phones. 

Page 430



Export audio/video

 This window lets you transfer your finished video to external devices. Besides the camcorder options for
digital camcorders (DV/HDV) and VHS recorders for playing analog video, many options for further
players such as mobile video players, SmartPhones, PDAs or games consoles are also included. These
are explained in the section "Exporting to mobile devices
". 
In this chapter
Video playback via TV output
Playing videos on digital devices
Export DV/HDV
DV export settings
Export to mobile devices
Transfer with Bluetooth
Transfer via infrared
My device is not in the list, what should I do?

Video playback via TV output
 Video or graphics cards with TV outputs allow you to transfer videos directly to external analog video
recorders. The arrangement must be displayed in fullscreen mode and recorded by the external device.
Make sure that the TV output in the Windows Control Panel (in "Display") is active. 
Warning: For many graphic cards, the TV output can only be activated when a television or video
recorder is connected before
 turning on the computer! 
For the best video monitor quality via TV output, select "Overlay" mode. When in doubt, make sure that
"Overlay" mode is selected as the video mode in the program settings ("File -> Program settings ->
Display options"). 
You can play the video directly from the arrangement. Errors may result if the processor is overloaded by
real-time calculations of video effects and transitions. 
If direct playback doesn't work without errors, open the menu
 item "Output video" and select "VCR -> Render and output in fullscreen". All tracks and effects are then
combined as a single file. The file will be played back after this analysis. 
If you would like to play a finished movie several times, export it as an AVI
 file and reload it into a new movie! It should then be possible to play the file directly without constant
rendering. 
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Video playback via TV output
 Video or graphics cards with TV outputs allow you to transfer videos directly to external analog video
recorders. The arrangement must be displayed in fullscreen mode and recorded by the external device.
Make sure that the TV output in the Windows Control Panel (in "Display") is active. 
Warning: For many graphic cards, the TV output can only be activated when a television or video
recorder is connected before
 turning on the computer! 
For the best video monitor quality via TV output, select "Overlay" mode. When in doubt, make sure that
"Overlay" mode is selected as the video mode in the program settings ("File -> Program settings ->
Display options"). 
You can play the video directly from the arrangement. Errors may result if the processor is overloaded by
real-time calculations of video effects and transitions. 
If direct playback doesn't work without errors, open the menu
 item "Output video" and select "VCR -> Render and output in fullscreen". All tracks and effects are then
combined as a single file. The file will be played back after this analysis. 
If you would like to play a finished movie several times, export it as an AVI
 file and reload it into a new movie! It should then be possible to play the file directly without constant
rendering. 
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Playing videos on digital devices
 The digital output always consists of two processes: 

1. Exporting, i.e. compiling all tracks, video, music, effects, transitions, and titles into one single
video file. This video file is created in the format required by the target device and then
temporarily saved to your computer's hard disk.

2. Output: In this case the created video file is transferred to the mobile device or to the camera.
The data is either written to the device via FireWire as a removable device if connected to the
USB port or transferred by Bluetooth or infrared.

Both processes are normally performed together. However, you can only export vie "File -> Export 
movie" or export via the option "Output file" in the dialog "Output audio/video
". 
The Settings button opens the "Export" dialog 
of the file format for your selected device. 
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Export DV/HDV
 For digital output, please select "File -> Export audio/video", and then select Camcorder in the device
menu. For DV cameras, you can select the device DV camera for HDV camcorders HDV1 or HDV2
. 
"Settings" opens the respective export settings dialog (DV-AVI export for DV camcorders; MPEG
export for HDV camcorders). For most applications, you should use the settings defined here. 
Advanced takes you to the DV export settings
. 
Now connect your camera and follow the displayed instructions. 

If you want to play a rendered movie
 on DV, then there's no need to render it again. Simply activate the "Play own DV file" option and select
your DV video from the "My Audio/Video" directory. 
Tip:
 Digital cameras that can record in digital via a PC connection are usually more expensive. You may be
able to reduce your purchase costs considerably by buying a digital camera that cannot transfer digitally
and then have it activated by a camera specialist. You should inquire about this option before buying
one. 
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DV export settings

 PAL/NTSC:
 The PAL format is used in Europe, and the US and Japan use NTSC. This option usually does not
require changing. 
Render changed parts...: Non-edited original files are simply copied into a completed DV AVI
. Normally, you have to decompress the DV data, add the set effects calculations, and recompress it. If
no effects processing is pending, then these steps may not be necessary. This option can be permanently
activated. 
Use references to original material...: 
Unedited original files are exported directly to the device. Effects are rendered in real time. Use this
option for finished movies without edits and effects, since real-time effects processing of DV data causes
high processor loads that often result in output errors. 
Transfer DV back to device after export...: Deactivate this option if you are only rendering your
movie but do not want to export it. You can export your movie later by clicking "Export own DV file"
from the "Export" dialog
. 
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Export to mobile devices
 Most devices require certain format settings (file format, resolution, bit rate, picture repeat rate, etc.) to
be able to play a video. 
The menu
 is divided into various device classes (mobile phones, organizers and PDAs, games consoles, and video
players) to make it easier to select your device. The last three selections are saved as favorites in the top
part of the device list if you have more than one device or want to present your movies to your friends. 
If your device is listed here, you won't have to worry about the format settings, because the necessary
settings of the export dialog are automatically customized to the target device. Simply select your device,
and then click the "OK" button
 - that's all. 
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Transfer with Bluetooth
 Warning! The procedure described here refers to Windows XP with Service Pack 2! 
Dialogs may be different depending on the Bluetooth driver and operating system version, or their order
may vary (e.g. for password allocation) when transferring to your mobile phone. However, the process is
usually similar if other drivers are used. Read more on this in the help file or the corresponding chapters
of your operating system's manual and Bluetooth adapter. 

 If you own a Bluetooth device, you can export the movie straight to your device. To do so, your
device and your PC must both have Bluetooth interfaces. If your system has a Bluetooth device,
you can activate the "Transfer via Bluetooth" option.

 After converting the movie into the desired format, the Bluetooth file transfer assistant opens.
 The first time you try to transfer files to your device via Bluetooth, you have to specify your

device as the receiver in the dialog by clicking on "Search...", selecting your device and then
pressing "OK". The name of your device in the Bluetooth network is specified in the Bluetooth
settings of the device. Check your device manual for this. Select your device and confirm your
choice by pressing "OK".

 Now enter a password of your choice, which you will later have to confirm on your device and
click on the "Continue" button in the assistant. Since connections between multiple Bluetooth
devices can be set up simultaneously in a room, the password serves to identify certain
connections as well as to safeguard your data.

The order may be the other way around, depending on the Bluetooth device driver, i.e. the mobile phone
will request a password which must be confirmed on your PC. It's important that you use the same
password in each case. 

 You may be asked once again to enter the file name and path of the movie. In this case, we
recommend using a folder that you will be able to find again quickly to export the file (e.g. "...My
Files/My Videos").

 Click the "Scan..." button, open the set up folder, and select your video file by double clicking it.
Now, in the wizard, click the "Continue" button.

 Next, you may have to activate the reception of files on the device and re-enter the password.
Afterwards, the transfer of the videos will begin automatically.

 Once the transfer has been completed successfully, "1 new message" will display on your device.
Read more on how to save and play videos in the corresponding device manual.

Warning!
 We only recommend activating data reception via Bluetooth on your device once this function is actually
required, e.g. for transferring files. Once you have completed the uploading process, you should
deactivate Bluetooth again, since permanently activated Bluetooth reception constitutes a security risk! 
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Transfer via infrared
 For devices with infrared interfaces, the transmission of movies works similarly to using the Bluetooth
transfer method. To do this, your PC and your device have to have infrared interfaces. Many notebooks
are already fitted with such IrDA interfaces. 

 Before starting the export, an infrared connection must already be established between the
computer and the device. Activate the infrared interface on your device and establish the
connection to your computer. You can check if a connection has been established via a
corresponding symbol in the task bar. More information on this can be found in the Windows
help under the keyword "Wireless connection".

 Note: Some devices deactivate the infrared interface when no data is exchanged after a
certain amount of time. In this case, you can search for the exported movie in the Media
Pool again, reactivate the infrared interface of your device, open the context menu of the
file, and then send the video to your device again by clicking "Transfer".

 Open the "Export" dialog via the export button, and under "Play after export", select the option
"Export with infrared". Confirm with "OK". A window will now be displayed which informs you
of the current status of the transmission.

 Once the transfer has been completed successfully, "1 new message" will display on your device.
Read more on how to save and play videos in the corresponding device manual.
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My device is not in the list, what should I do?
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Update devices online
 The assortment of playback devices is constantly changing. Every day, new devices or versions are
coming onto the market. The list of supported devices may therefore not be up-to-date and may not (yet)
contain your specific device. MAGIX continuously maintains updated preset lists for the available
devices, and these can be downloaded by pressing the update button
. Internet access is necessary. 
The command "Download presets for new device" in the "Help" menu opens a website containing an
up-to-date list of all supported devices and device versions. Just search for the desired device and click
the corresponding link. The settings for the device will be downloaded and made available to you in
MAGIX Movie
 Edit Pro 16. 
Warning
: Some browsers display a warning if you try to download an executable file (.exe). You can ignore this
warning. 
If your device is not listed on the website, you can report your unsupported device so that it will be
included in later updates. 

Page 440



User-defined:
 If your device does not appear in the list after the online update, you can set up the export settings
manually. No need to worry though; you only have to do it once, since these settings can be saved as a
preset. 
Read the instruction manual of your mobile device
 to find out which file format is required for this. If your device supports multiple formats, then you can
experiment with the formats to get the best results. 
Specify the file format by opening the target device's menu and selecting "User-defined -> Video ->
...Format". If you then click on "Export", you arrive at the Export dialog
 of the selected file format where you can set all the advanced settings. 
For details on these settings, please consult your device manual. Explanations for the file format's
settings can be found in the Overview of the device classes chapter, for the special settings of the
export dialogs see "Export movie
" in the "File menu" chapter. 
Tip:
 If the format settings for your device are not accessible, then you can try out a different device from the
same manufacturer and, using it as a template, make adjustments accordingly. 

If you find settings you like, we recommend saving these as a
preset for further use. 
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Overview of the device classes
 This chapter explains the various supported device classes and which peculiarities should be noted when
manually setting the export format. 

Quick overview of the device types*
Example devices MPEG-4 profiles (audio + video formats

within MPEG-4 container format)
iPod & PSP AVC (video) + AAC (audio) 
Mobile phones 3GP (video) + AMR or AAC (audio) 

Additional video formats
Symbian mobile
phones 

MPEG-4 

Video players DivX / XviD 
PDAs,
PocketPCs 

WMV9 

*No guarantee taken for correctness of information 
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Mobile phones
 This refers to multimedia mobile phones and SmartPhones. 
File format: For SmartPhones running the Symbian operating system, you should ideally use the Real
format for maximum compatibility, since RealPlayer is integrated into the system. Many mobile phones
also play MPEG
-4. It's important in this case that the correct container format (for mobile phones, usually 3GPP) is set up
("Video as MPEG-4 video export") 
Resolution
: The resolution corresponds to the display size of your mobile phone in pixels. Standard resolutions are
128 x 96 pixels (sub QCIF), 176 x 144 pixels (QCIF), 300 x 180 pixels, and 320 x 240 pixels
(SmartPhones). You can find out the resolution of your mobile phone from its documentation. Many
mobile phones require the precise setting in order to play back videos. If the aspect ratio does not
correspond to the display resolution (300 x 180 corresponds to 5:3 instead of 4:3), then black bars are
added. For broad displays (optimized for 16:9) we recommend the video effects Aspect ratio 16:9
(anamorph/letterbox). 
Frame rate
: Picture repeat rate, i. e. the number of frames per second (fps). For mobile phones this is usually
reduced from 25fps to around 10 or 15fps in order to save memory space and because mobile phone
processors are not powerful enough. If you don't have to save on memory, select the largest frame rate
possible (see device manual) because at low frame rates the video can be very jerky. 
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Organizers and PDAs
 Under "Organizers and PDAs", Pocket PCs and similar devices are listed. 
File format
: For Pocket PCs, you should ideally use Windows Media Video format for maximum compatibility,
since it usually only runs on modified Windows Operating Systems (Windows Mobile), and the Windows
Media Player is integrated in the operating system. 
Resolution: The resolution corresponds to the display size of the PDA, mostly 320 x 240 pixels. You
can find out the resolution of your PDA from its documentation. A PDA can also play back at higher
resolutions than those set; mostly, however, the CPU
 is usually not able to handle this as it must scale the picture before output, which can cause errors. 
Frame rate: Picture repeat rate, i. e. the number of frames per second (fps). If you don't have to save on
memory, use the largest frame
 rate possible (see device manual) because at low frame rates the video can be very jerky. 

Page 444



Games consoles
 Some portable games consoles (Sony PSP, Nintendo Wii) can also play videos. The consoles are
extremely particular with regard to file format settings, and they sometimes use their own file format
variations. 
Warning
: Do not change the presets! 
MAGIX tries to supply presets for all games consoles with video functions on the market, but you may
have to update your device list. 
Warning: Sony PSP and Apple iPod video only play movies when they are copied with a specific name
into a pre-defined target folder. Always copy movies for these devices from the export dialog
 along with the corresponding presets (at the top of the "Preset" list and at the bottom beside "Play after
export"). 
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Video players
 Video players are considered to be video devices if they have been developed especially for mobile
video playback. They usually have relatively large displays and their own hard disk
 or a very large flash card memory (in GB). 
File format: Mostly DivX AVI or WMV (Windows Media Video) are used. While WMV is its own
format, AVI is a so-called container format. This means that the actual file format is set via the medium's 
codec
. 
In addition to the AVI format, you will also have to set up a codec that your mobile device supports
when exporting AVI files. 
A much-used codec for AVI is the DivX codec. This is supported by a large number of portable video
players. Specific standards have been set up between the codec manufacturer DivX and the device
manufacturers (profiles) that a certified DivX device has to fulfill. 
Unlike Windows Media or MPEG4, a separate audio codec (ACM codec) is required for the sound in
order to encode the sound track in the same high compression at acceptable quality. Select the codec
you wish to use for the sound under Audio compression. MP3
 56kBps is used as a preset. For improved sound quality, you should read your device manual to find out
which sound formats AVI audio still supports and, if required, install further ACM codecs from the
Internet. 
The DivX codec can be downloaded from www.divx.com.
 Resolution
: Video players can handle almost every resolution up to TV resolution (720x576), as most models can
display your video picture in TV resolution via an analog TV output. For the optimum picture quality on
the device display (if you do not wish to use the TV output) use the resolution that the device can
display. 
Frame rate
: Picture repeat rate, i. e. the number of frames per second (fps). This isn't problematic, since the frame
rate of the output material is used. 
Warning: Sony PSP and Apple iPod video only play movies when they are copied with a specific name
into a pre-defined target folder. Always copy movies for these devices from the export dialog
 along with the corresponding presets (at the top of the "Preset" list and at the bottom beside "Play after
export"). 
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Burn discs
Switch to the "Burn" screen first by pressing the 
button
 indicated. 

You can burn your movies (including a selection menu
) onto CD, DVD, Blu-ray Disc, or upload them to MAGIX Online Album. 
All movies loaded into the project are taken into account. If you want to take out some of the movies that
are loaded, then you will have to switch back to the "Edit" screen and delete some of them from the
project. To do so, switch to the corresponding movie, open the "File" menu and select "Manage movies
-> Remove movie
" 
Note
: At a screen resolution of 1280 x 1024, the program display changes. This makes the program more
manageable and easier to use. The work steps remain the same despite the different display. 
In this chapter
Preview and editing
Menu
Templates
Edit disc menu
Burn dialog for DVD player
Create PC show
Create webDVD
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Preview and editing
 MAGIX Movie Edit Pro 16 provides two different modes for designing and previewing the disc menu
. 

The preview mode is mainly intended to behave
like a DVD player or Blu-ray player for checking
the disc menu under realistic conditions. 
Only templates may be used; more detailed editing
of the disc menu is not possible at this time. 
During editing, you may adjust many features of
the disc menu. There are many templates available
for this that may be changed flexibly once loaded. 

Remote control
 The virtual remote control is an important helper when it comes to checking how the disc will perform
later. 
When you later insert the CD or DVD with your disc project into your player, this remote control will
control the preview picture just like a "real" remote control controls the picture on a monitor or TV. The
DVD menu navigation can now be initiated with the arrow keys or the "OK" button
. Activated buttons are highlighted. 

The number keys select the corresponding entry
on the menu page. All menu entries are marked
with a corresponding number. Within a chapter
menu, playback is started from the particular scene
. In the movie
 menu, the corresponding chapter menu (if
available) is changed or movie playback is
started. 
Navigation keys:
 These help you move from one section to the next
in the menu of the CD/DVD being burned. You
can switch between individual entries and confirm
the switch by pressing "OK". The remote control
works just like the remote control for your home
DVD player. 
Skip/Move forward/back
: This allows you to skip to the next or previous
scene while playing back your movie. In the menu,
you can skip forward or back from one menu
page to another. 

Play: Starts the first entry in the menu. In case both the scene menus and chapter menus are available
(see menu mode), the scene menu will be displayed first. Press the play button
 again to start playback at the beginning of the first scene of the first chapter. 
Pressing stop
 halts playback. 
Disc
 switches to the first page of the film menu. 
Sub switches into the chapter menu
 (if available) of the currently selected film. 
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Menu
 MAGIX Movie Edit Pro 16 can add graphical selection menus to your movies. The menu
 is also burned to CD/DVD and appears when inserted into your player. Just like with a purchased
DVD, you can easily select your movies with the help of preview pictures, or access particular chapters
within a movie. 
This sort of menu is available for the following disc types
: 

 Blu-ray Disc
 DVD
 Mini DVD
 Super Video CD (SVCD)
 Video CD (VCD)
 WMV HD disc (Plus version only)
 AVCHD disc (Plus version only)
 Multi disc (Plus version only)

VCD, SVCD, and AVCHD disc are only possible as static menus. 
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Templates
 Below the preview monitor and the editing elements you will find templates for DVD menus and layouts. 

To the left you will find a tree structure that makes it easier to select the template type. Now you can
select using two buttons in the tree structure, whether you want to select templates in the "16:9" or the
"4:3" (default) format. Every menu
 template is high resolution. Under "4:3" the following are available: 

 Animated DVD: These templates contain background and introductory videos as well as music.
The control elements are displayed in various states. The templates can only be used for mini
DVDs and DVDs. If you burn a VCD or SVCD, still pictures and control elements will be
shown, but music will not be audible.

 Static (DVD, VCD, SVCD): Here you will find templates equally suitable for use with DVDs
and SVCDs. They consist of normal background pictures and tools

 Unique: These templates adjust to your disc project, i.e. the videos and scenes you use are
integrated directly into the menu.

 TV showtime DVD: With these templates your pictures will not be displayed in the movie menu
as small preview pictures, but rather as fullscreen preview pictures for every menu page. With the
"Skip" button on your remote control you can present the chapters with the help of the preview
pictures, like in a slideshow ? with the option of being able to start the movie at any time from the
current preview picture. These templates are intended for DVDs.

Note:
 For these menus the "Movie and chapter menu" mode in the menu design must remain active. 

 HD (DVD, WMV HD): These templates contain super-sharp, high-res background images that
are particularly noticeable on HD TV devices.

Under 16:9 additionally: 
 HD animated (DVD, WMV, HD, mini HD DVD): These templates contain super-sharp,

high-res background images that are particularly noticeable on HD TV devices and are
additionally animated.

If you selected a specific type of menu template, you can use the horizontal scroll bar to view all the
templates. There are lots of options when using the templates: 

 If you wish to apply a template to all menu pages, click on "Complete" in the template bar and
double-click on the template of your choice. The complete template will then be applied.

 You can also combine the various elements of the individual templates. If, for example, you wish
to combine the text format of a template with the background of another one, first double-click
on the template with the text of your choice. Then click on the tab "Text". There you can select
the desired template for the text.

You can load the
template (or individual
template elements) for
the current menu
(movie or chapter) as
well as for all menus. 

Note: Some menu templates include intro
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 videos with a smooth transition to the menu page! 
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Edit disc menu
 The preview pictures and the menu
 title can be moved freely in the preview monitor. The menu may be edited very flexibly. 

Activate the "Edit" button
 to do this. 

In this section:
Load on-disc editing project from disc
Edit menu elements
Navigation
Disc options
Design page
Design button
Menu entry properties
OnDisc Editing
Burning assistant
Memory
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Load on-disc editing project from disc
Use this button to load the DVD-/+RW in your drive for
on-disc editing. For more information on this, consult the 
On-disc editing
 section. 

Edit menu elements
 Hold down the left mouse key and drag text boxes or graphical elements to the desired position. You
can adjust the size by dragging out the corners and edges of the frame
. 
During project
 editing, you can undo the last changes you made. This way it's no problem if you want to experiment
with critical operations. If you don't like the results, then you can always revert to the previous state by
using "Undo". 
Keyboard shortcut: Ctrl + Z 
The "Redo" function undoes the previous "Undo" function. 
Keyboard shortcut: Ctrl + Y 

Set ratio: Avoid distortions by using this button to set the
page proportions of the menu
 elements. 
Group
: Menu elements, including the description text and number,
can be moved or scaled in size. 
Fade in TV display area in the preview monitor: This
option displays the image borders of the television
 as lines in the preview monitor. 

Grid: You can precisely align the frame positions with one
another using the grid button. A dialog
 can be opened to set the grid more exactly using the
small arrow next to the button. 
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Navigation
 All movies are listed as first entries.

The corresponding menu level is
the film menu.

 All scenes are listed as second
entries to the right. The
corresponding menu level is the 
chapter menu.

Removing the red check deactivates the
corresponding entry in the photo menu. The
scenes are shown of course, but they are
not selectable directly in the menu. 

 If you click a film entry, then the film
menu will open in the preview.

 If you click one of the chapters
listed, then the chapter menu will
open in the preview.
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Disc options
 You may deactivate the menus entirely or customize them here. 
Intro video: You can use this button to load videos to be used as introductions to your DVD or mini
DVD. The *.avi, *.mpg, *.mxv, *.vob formats are supported. The intro is played immediately after the
DVD has been inserted into the player. The DVD menu
 will then appear. 

Menu intro 
You can use this button to load videos into the preview monitor to be used as introductions to your DVD
or miniDVD. The following formats are supported: "*.avi", "*.mpg", "*.mxv", "*.vob". The intro is played
immediately after the DVD has been inserted into the player. The DVD menu
 will then appear. 
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Film menu & chapter menu
 The disc menu
 essentially consists of two layers: 
Film menu: The upper layer includes the film menu, which is only used if a project
 contains multiple movies. 
Chapter menu: This is the lowest layer of the disc menu, which assumes the chapter markers in a movie
as menu entries. More information about this is available in "Chapter markers
". 
Note
: A chapter menu cannot contain more than 99 entries. If your movie has more chapters, then you can
either burn it without a chapter menu or split it into multiple parts. 

Note on SVCD compatibility
 Some DVD players may have difficulty playing created SVCDs (despite fault-free burning) if the disc
contains a project
 burned in "Chapter and photo menus" mode and contains several slideshows and/or a large number of
photos. These compatibility problems can be avoided by: 

 Using menu mode 1 or 2 for SVCD,
 Only adding a single movie to the disc, or 
 Turning off the PBC (playback control) function, i. e. the menu navigation of the DVD player.

 Preview pictures: Shows/hides the preview pictures in the disc menu
. 
Numbering:
 The numbers beside the menu entries can be selected directly using the remote control, but they might be
disturbing sometimes. Use this option to show/hide them. 
Frame:
 A frame borders the preview pictures. If you think it gets in the way, then you can easily remove it using
this option. 
In the Arranger: Clicking this button
 opens the Arranger to edit animated menus. 

Create your own menu background
Every menu
 background can be created new from scratch
or edited. 

A click on this button
 switches to the "Edit" interface and loads the selected menu background as video. Here you can change
and design the background as you please. The created film must be saved and then applied as a menu
background. 
Tip: If you would like to design a menu
 background yourself from scratch, first press Ctrl + A to select all objects, and then Del, to delete them. 
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Design page
 Background graphic: You have three options in this case. You can either set a certain "color value" for
the background. Or, you can select an image file from your hard drive. You can also select a certain
frame from a video in your project
. 
Plus version only!
 New menu
 pages may also be added or irrelevant pages may be removed. 

Adds a new menu page. 

Removes the selected menu page. 
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Design button
 MAGIX Movie Edit Pro 16 enables simple editing of any menu entry. They will appear in the disc menu
 as buttons with preview images. 
Plus version only!
 New menu
 entries may also be added or irrelevant pages may be removed. 

Adds a new menu entry. 

Removes the selected menu entry. 

Tip: If you would simply like to deactivate unused menu
 entries, this may be done via the navigation. 
Note: The chapter menu is formed via chapter markers
 and can be influenced in detail with these. 

Pressing this button or double-clicking the menu
entries allows menu entries you have created to be
edited. The dialog with the properties of the menu
entries
 will open. 

Edit in MAGIX Xtreme Photo
Designer: These buttons open MAGIX
Xtreme Photo Designer for further editing
of your background pictures or the
selected menu
 elements. 
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Jump to linked page
To test the targets of menu entries, select the
desired menu entry and click the button
. 
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Menu entry properties
 Double-clicking the preview picture or a menu
 entry opens an editor for you to adjust the preview picture or menu entry. 
Menu entry
: Specify the menu page that should be opened when this menu entry is selected. 
Preview image
: Select a suitable preview picture here. 

Menu text
 In the text input field, you can enter any text to match the chosen menu
 entry. 

Set the vertical direction of the text (upwards, centered or
downward). 

Set the horizontal direction of the text (left, centered or
right). 

Font size:
 Set the height of the text in pixels. 
Font color:
 Define the foreground color of the text. 
Font:
 Set which font and which style (bold, italic, etc.) should be used. 
Shadow:
 Set the color and size of the shadow that will appear underneath the text. 
3D effect:
 If you would like to make your text appear three-dimensional, you can set the width, height, and color of
the 3D effect. 
Apply to all: Except for the text, all settings are applied to all entries in the current menu
. 

Menu image
 Use frame from movie: Use the fader
 to set which frame should be used in the video as a preview picture. The numerical input fields are sorted
as follows: Hours:Minutes:Seconds:Frames. 
Use different graphic: You can also load your own bitmap images to be used as menu
 pictures. 
Hint: It may be the case that there are no menu pictures in some menu templates, so changing the menu
 picture won't have any noticeable effect. 

Actions at the end of the movie (only in the film menu)
 You can enter which action should be carried out once the film has finished playing. You have the choice
of: 

 Stop playback
 Jumping to the video menu or photo menu
 Jump to chapter menu
 Jump to next movie
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 Play film as an endless loop

 Edit your own menu entries
 There is another view in this dialog to edit menu entries you have created. Menu links can be edited
here. This makes it possible to link a menu entry with a certain action, menu page, or a certain position in
the movie
. 
No link
: The menu element cannot be selected and has no function other than to display menu text. 
Link to page in current menu
: Jumps to a menu page in the current movie or chapter menu in the current film. 
Link to another menu
: Opens another movie or chapter menu. 
Link to chapter in a movie
: If this option is selected, enter a film and chapter marker where playback should start. 
Note
: For DVDs, only chapters within the current movie may be jumped to. 
Link to film start: The movie
 will play back from the start. 
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OnDisc Editing
 OnDisc editing lets you burn more movies onto disc at a later stage and customize the menu
 accordingly. It's also possible to just rework the menu. 
In order to use OnDisc editing, the "Prepare disc for OnDisc editing" option has to be activated. You can
find this option in the Burn options of the "Burn" dialog
. 

To put a movie onto DVD, first
load the movie and then switch to
the "Burn" screen. Insert your
DVD+/-RW and press "Load
project
". 

MAGIX Movie Edit Pro 16 will ask you if you wish to add the loaded movies to the disc. If you answer
"Yes", the entries will be added to the existing menu. 
It is not 
possible to edit movies you have already burned onto disc later in the "Burn" window (to do this, please
use the "Restore backup" function). You can only change the menu. 
In addition to normal menu design possibilities (see Burn 
window) you can hide entire movies in OnDisc editing mode, e.g. to replace them with an entirely
reworked version. 
Select a movie in the navigation
structure and press the "Del" key.
To display the movie again, press
"Shift + Del"
. 
Important: Deleting certain parts of your DVD-/+RW is not possible. Every new version of the menu
will be burned additionally to the disc. Accordingly, the remaining disc space decreases the more changes
you make. Deleting movies from your DVD is also not possible. When you remove a movie from the
menu, it will still be played, providing "Actions at the end of the movie" is set up accordingly (see "Menu
entry properties
" in the "Burn" interface). 
With "Burn disc" you can create your "new" disc. Only the new movies and the adjusted menu
 will be encoded and burned to disc. 
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Burning assistant
 Click "Burn" to open the screen where you create DVDs, Blu-ray Discs, or another video medium,
including a menu
. 

Here you can select the type of disc you would like to create. Under "More options" additional disc
options are available to you which aren't used as frequently. 
Note: For each disc format there are different limitations. For example, with many formats animated
menus are not possible or no menus and transitions at all are possible. You can find an overview of these
limitations in the PDF manual or in "Help" under "Appendix: Digital videos and storage media
". 

Memory
VCD (approx. 700 MB) approx. 70 minutes 
SVCD (approx. 700 MB) approx. 30 - 40 minutes 
DVD (approx. 4.7 GB) approx. 2 hours 
Mini-DVD (approx. 700 MB) approx. 20 minutes 
Blu-ray Disc (approx. 25
GB/single-layer or 50
GB/dual-layer) 

approx. 4.5 hours 

Especially with the MPEG
-2 encoder which is used for SVCDs, DVDs, and mini-DVDs (i.e. on CD-ROMs written in DVD file
format), it can be difficult to supply reliable information relating to the required memory. If the "Variable
bit rate" of the MPEG-2 encoder is activated, encoding will occur according to the movements in the
picture. The required memory depends on the film material; an action film would need more memory than
a drama, for instance. 
If you cannot save your disc project
 on a blank CD, you will have to divide it up into different sections. 
A movie
, for example, can be burned onto 3 SVCDs by creating three different projects: Start, middle, and end
are added and burned sequentially. 
Further information on MPEG compression and formats can be found in the chapter "Video and data
formats
" of the PDF manual. 
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Memory
VCD (approx. 700 MB) approx. 70 minutes 
SVCD (approx. 700 MB) approx. 30 - 40 minutes 
DVD (approx. 4.7 GB) approx. 2 hours 
Mini-DVD (approx. 700 MB) approx. 20 minutes 
Blu-ray Disc (approx. 25
GB/single-layer or 50
GB/dual-layer) 

approx. 4.5 hours 

Especially with the MPEG
-2 encoder which is used for SVCDs, DVDs, and mini-DVDs (i.e. on CD-ROMs written in DVD file
format), it can be difficult to supply reliable information relating to the required memory. If the "Variable
bit rate" of the MPEG-2 encoder is activated, encoding will occur according to the movements in the
picture. The required memory depends on the film material; an action film would need more memory than
a drama, for instance. 
If you cannot save your disc project
 on a blank CD, you will have to divide it up into different sections. 
A movie
, for example, can be burned onto 3 SVCDs by creating three different projects: Start, middle, and end
are added and burned sequentially. 
Further information on MPEG compression and formats can be found in the chapter "Video and data
formats
" of the PDF manual. 
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Test series with variable encoder settings
 If you would like to know how much memory you will require for various encoder settings, then you
should run some simulations before burning. 
To avoid wasting blank CDs while testing, you should activate the "Simulate first" option. 
Then create, for example, a short (ca. 5 min.) disc project
 and simulate burning in multiple cycles with various settings. 
After every simulation you can access the MPEG-1 or MPEG-2 file on the hard disk
 to check how large the file has become. 
You will discover how much disc space your disc project will require from the simulation results. The
memory requirements of a 5-minute disc project would have to be multiplied by 20 in order to estimate
the space required for a 100-minute movie. You should also add buffer for the selection menu.

 Separate project onto multiple discs
 Automatically: If the disc project requires more memory than is available on the CD or DVD, a dialog
will appear before burning asking whether the disc project
 should be automatically segmented for multiple discs. Confirm this by clicking "Yes". The disc project
will then be automatically divided into individual disc projects and burned sequentially onto multiple discs.
This is the easiest method since everything is automatic, and all you have to do is insert a new blank CD
when required. 
Manual
 Case 1:
 If several movies do not fit onto a single disc... 
In this case, switch back to the "Record" screen and delete as many movies as is needed until the
remaining movies fit onto the disc. You can create a new disc project and load and burn the other movies
afterwards. 
Case 2: 
When a long film doesn't fit onto a disc... 
In this case, the movie
 has to be split into two or more parts that will be burned separately onto disc. 

 Switch back to the "Edit" view and place the start marker to the position at which you wish to
divide the movie. In the "Edit" menu, select "Cut -> Separate movie".


 All passages behind the start

marker will be removed from the
movie and made into a smaller
movie. Both movies can be
moved using the "Select to edit"
menu in the arranger. Save both
of them separately to your hard
disk ("Save movie" menu option,
for example, as "Part 1" and
"Part 2").

 Remove one of the two movies (for example, "Part 2") from the disc project ("Manage movies
-> Remove movie" menu option).

 Switch to the "Burn" interface and burn the first film ("Part 1") to CD or DVD.
 Create a new disc project ("New" button), switch to the "Record" view and load it into the

second film ("Part 2").
 Switch to the "Burn" interface and burn the second movie to CD or DVD.
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 Burn dialog for DVD player
 Select your burner, the type of disc, the encoder settings, etc. For video CDs this is MPEG
-1; for Mini DVDs, Super Video CDs and DVD, use MPEG-2. Blu-ray Disc uses MPEG-2, and higher
bit rates are applied in order to reach the higher HD resolutions. 

Steps for burning DVDs, etc.
1.  Set up burner and burn speed: If you have multiple burners installed, you can select which

device you wish to use in this menu.
2. Encoder settings: Use the "Encoder" button to access the selection dialog where you can

specify the properties of the MPEG encoder (memory requirements, quality and duration of the
MPEG conversion).

2. The "Advanced" button opens the "Advanced settings" dialog. Here you can adjust all the fine
settings of the MPEG encoder.

Burning disc/starting video encoding: "Burn disc": This starts the disc burning process. Every time
you burn and every time a simulation is carried out, the disc project is encoded (for VCDs with
MPEG-1, with SVCD, DVD and mini-DVD with MPEG-2). You have the option of choosing a storage
location for the MPEG file on the hard disk. Please note that the MPEG file is not deleted from the hard
disk after the burn process has finished. Depending on the length of the project, encoding and burning
may take some time. The time required can be seen in the dialog
. 

Creating an ISO image
 The simplest way to create an ISO image is to select "Image recorder" under "Burner". When starting
the "Burning process", you have to specify a name for the image
 file you wish to create. 
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Burn dialog for DVD player
 Select your burner, the type of disc, the encoder settings, etc. For video CDs this is MPEG
-1; for Mini DVDs, Super Video CDs and DVD, use MPEG-2. Blu-ray Disc uses MPEG-2, and higher
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the "Burning process", you have to specify a name for the image
 file you wish to create. 
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Options
 Simulate first:
 If you are not sure about the write speed or memory requirements of the selected disc, you can simulate
the write process before burning. 
Add project backup:
 Use this option to add additional project data to the CD/DVD together with the selected video format.
You can then load the disc project from the finished disc to re-edit it and create a changed version. 
Activate buffer underrun protection: 
Many burners support techniques that prevent "buffer underrun". Use this option to activate this
protective feature and burn your files at higher speeds (without risking making a coaster out of your blank
disc). 
Completely format DVD/CD-RW media: 
This option reformats the RW media and deletes all existing file material. 
Prepare disc for OnDisc editing: With a DVD±RW, it is possible to add more slideshows to the disc,
or to edit the menu at a later date. The disc has to be burned with the option "Prepare disc for OnDisc
editing"
 activated. 
Shutdown computer after burning:
 Activate this option to automatically turn off the computer after encoding and burning has been
completed. You could, for instance, start the encoding and burning process in the evening, and then you
don't have to wait for the process to finish to switch off your computer. 
Activate the burner's defect management option:
 If a certain section of the disc is defective, then this will be recognized by the burner and labeled as such.
No content will be saved there as a result. 
Burn standard video DVD onto same disc: On a WMV
 HD disc you can use this option burn an additional normal DVD video onto disc. This ensures that your
discs can also be played back on standalone DVD players. See Multi disc. 
CD/DVD title: This is the title of the DVD as displayed as disc name on the PC. The disc project
 name is displayed here by default. 
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Encoder settings

Use the "Encoder" button to
access the selection dialog
where you can specify the
properties of the MPEG
 encoder (memory
requirements, quality, and
duration of the MPEG
conversion). 
Preset:
 Additional settings for the
selected disc type. 

Longplay video
DVD

DVD with extra-long play time. The bit rate is
reduced, causing a compromise in quality. 

Longplay music
DVD

DVD with extra-long play time for music. The
bit rate for the soundtrack remains at the highest
quality level. 

Standard DVD Normal DVD 
Widescreen DVD Normal DVD in 16:9 widescreen format 
Bit rate: The bit rate determines the memory requirement of the completed video. The higher the bit
rate, the larger the file, and the shorter the maximum play time of the movie
 that fits on a disc. 
Adjust bit rate:
 The expected file size of the finished video is estimated, depending on the set bit rate. If the movie does
not fit onto the disc, then the bit rate is corrected accordingly. 
Quality:
 Determines the quality of the encoding process. The higher the quality, the better the finished video will
look, but encoding will take considerably longer. 
Smart rendering: Smart Rendering considerably reduces the encoding effort for MPEG files. During
production of MPEG files, only those parts of the movie that were changed in the program (e.g. by video
cleaning or effects) are re-encoded. Please note: The MPEG files contained in the movie must have the
same format, i.e. the bit rates (variable or constant), audio formats, image
 resolutions, and video formats must match. 
Anti-flicker filter:
 This option should only be activated for playback on a TV screen to reduce line flickering. 
To return to the standard settings please use the "Reset" button
. 
The "Advanced" button opens the "Enhanced parameters" dialog. Here you can adjust all the fine settings
of the MPEG encoder. Please also read the addendum MPEG Encoder Settings
. 
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Create PC show
Click this button
 and a presentation optimized for your PC will be created. 

First, enter a path where the PC show will be found again later, and click "OK". 
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Create webDVD
You can create an online presentation which can be
uploaded to MAGIX Online Album and opened there. To
do this, you must first register on MAGIX Online Album. 

First, create and save the online presentation on your computer, and then it can be uploaded. Indicate a
location to save the file. Usually the suggested folder does not need to be changed. 
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Batch conversion
 Batch conversion makes it is possible to convert multiple video files, movies, objects, or whole projects
into another format in just one step. 

Open batch conversion
 Batch conversion can be opened using different presets. A pre-selection appears only if you have loaded
a film or a project
. 
The following scenarios exist: 

 Batch conversion has been opened from the context menu in the Media Pool: The file selected in
the Media Pool beforehand will be transferred to the task list and can be converted to the
available formats. In case of projects which contain multiple movies, all movies will appear as
individual tasks.

 Only one empty movie is open: A dialog opens additionally for batch conversion, in which video
files that have to be converted to other formats can be selected and loaded.

 A movie with video material and more than one object in the first track is opened. A dialog
opens, in which you can select which tasks should be created for batch conversion.
o All scenes in the movie: All objects present in the 1st track will be used as starting points

for the video files to be exported. An application for this could be that all scene beginnings of
a movie should be exported as bitmap files or a backup for a movie is to be created as
individual scenes.

o Multiple movies: The opened movie will be exported as a whole video. Additional movies
can be added to the list in the dialog.

 Multiple movies with video material are open: The opened movie will be exported as a complete
video. This is especially useful for large projects with a lot of individual movies, eliminating the
need to export each one individually.

 Administration
 Save and load your settings here. These include the list of files to be exported and the export settings
and names of all entries. 
Caution! Batch conversion references the projects, movies, and the objects contained therein directly.
Keep in mind that when converting entire movies, the source material must also be available. During
conversion of individual objects from movies, you have to make sure that the movie
 file has not been changed between loading and saving. 

Queued entries for batch conversion
 This is the list of all objects that have to be converted into the indicated format. Each task can have its
own export settings. 
Add files (not during conversion of individual objects from movies)
: Manually add files, including video files and projects. 
Remove selected
: The marked tasks will be removed from the list. 
Duplicate selected
: If you would like to export tasks in multiple formats, you can simply mark and duplicate them and assign
individual export settings to them. 
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Format settings for the selected conversion
process
 These are settings for the currently selected tasks, and multiple tasks can be given a setting
simultaneously. Select one or more tasks from the task list. 
Note on format setting for multiple tasks:
 If one of the marked tasks already has an individual setting, its will be lost after another format is
selected. To prevent this, remove the selection for each task using Ctrl + mouse-click. 
Set the target format in the flip menu. Windows Media Video format (*.wmv
) is the default. 
Advanced settings: This opens the dialog for the advanced format settings. This corresponds to the
dialog for normal video export of a movie
. 
Tip:
 If you give several tasks the same file name, the files created will be documented intelligently. For
example, you can easily convert and simultaneously line up multiple movies that belong together
thematically. 

Shut down PC automatically after successful
export
 This option is especially useful when you export long movies and are using an especially high-quality and
resource-demanding export format. You can leave the computer to work on the individual tasks and after
finishing them it will turn itself off. 

Start batch conversion
 Click on "Start conversion" to start the process. After ending conversion processes, a list of all export
processes with a message informing of its success will appear. 
Hint: During batch conversion, messages that appear during normal file import will be for the most part
suppressed. This is to enable the smoothest conversion of all tasks. Therefore, please make sure that all
files to be converted or the project
 can be easily loaded before starting a batch conversion. 
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Open batch conversion
 Batch conversion can be opened using different presets. A pre-selection appears only if you have loaded
a film or a project
. 
The following scenarios exist: 

 Batch conversion has been opened from the context menu in the Media Pool: The file selected in
the Media Pool beforehand will be transferred to the task list and can be converted to the
available formats. In case of projects which contain multiple movies, all movies will appear as
individual tasks.

 Only one empty movie is open: A dialog opens additionally for batch conversion, in which video
files that have to be converted to other formats can be selected and loaded.

 A movie with video material and more than one object in the first track is opened. A dialog
opens, in which you can select which tasks should be created for batch conversion.
o All scenes in the movie: All objects present in the 1st track will be used as starting points

for the video files to be exported. An application for this could be that all scene beginnings of
a movie should be exported as bitmap files or a backup for a movie is to be created as
individual scenes.

o Multiple movies: The opened movie will be exported as a whole video. Additional movies
can be added to the list in the dialog.

 Multiple movies with video material are open: The opened movie will be exported as a complete
video. This is especially useful for large projects with a lot of individual movies, eliminating the
need to export each one individually.

 Administration
 Save and load your settings here. These include the list of files to be exported and the export settings
and names of all entries. 
Caution! Batch conversion references the projects, movies, and the objects contained therein directly.
Keep in mind that when converting entire movies, the source material must also be available. During
conversion of individual objects from movies, you have to make sure that the movie
 file has not been changed between loading and saving. 

Queued entries for batch conversion
 This is the list of all objects that have to be converted into the indicated format. Each task can have its
own export settings. 
Add files (not during conversion of individual objects from movies)
: Manually add files, including video files and projects. 
Remove selected
: The marked tasks will be removed from the list. 
Duplicate selected
: If you would like to export tasks in multiple formats, you can simply mark and duplicate them and assign
individual export settings to them. 

Format settings for the selected conversion
process
 These are settings for the currently selected tasks, and multiple tasks can be given a setting
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simultaneously. Select one or more tasks from the task list. 
Note on format setting for multiple tasks:
 If one of the marked tasks already has an individual setting, its will be lost after another format is
selected. To prevent this, remove the selection for each task using Ctrl + mouse-click. 
Set the target format in the flip menu. Windows Media Video format (*.wmv
) is the default. 
Advanced settings: This opens the dialog for the advanced format settings. This corresponds to the
dialog for normal video export of a movie
. 
Tip:
 If you give several tasks the same file name, the files created will be documented intelligently. For
example, you can easily convert and simultaneously line up multiple movies that belong together
thematically. 

Shut down PC automatically after successful
export
 This option is especially useful when you export long movies and are using an especially high-quality and
resource-demanding export format. You can leave the computer to work on the individual tasks and after
finishing them it will turn itself off. 

Start batch conversion
 Click on "Start conversion" to start the process. After ending conversion processes, a list of all export
processes with a message informing of its success will appear. 
Hint: During batch conversion, messages that appear during normal file import will be for the most part
suppressed. This is to enable the smoothest conversion of all tasks. Therefore, please make sure that all
files to be converted or the project
 can be easily loaded before starting a batch conversion. 
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Administration
 Save and load your settings here. These include the list of files to be exported and the export settings
and names of all entries. 
Caution! Batch conversion references the projects, movies, and the objects contained therein directly.
Keep in mind that when converting entire movies, the source material must also be available. During
conversion of individual objects from movies, you have to make sure that the movie
 file has not been changed between loading and saving. 

Queued entries for batch conversion
 This is the list of all objects that have to be converted into the indicated format. Each task can have its
own export settings. 
Add files (not during conversion of individual objects from movies)
: Manually add files, including video files and projects. 
Remove selected
: The marked tasks will be removed from the list. 
Duplicate selected
: If you would like to export tasks in multiple formats, you can simply mark and duplicate them and assign
individual export settings to them. 

Format settings for the selected conversion
process
 These are settings for the currently selected tasks, and multiple tasks can be given a setting
simultaneously. Select one or more tasks from the task list. 
Note on format setting for multiple tasks:
 If one of the marked tasks already has an individual setting, its will be lost after another format is
selected. To prevent this, remove the selection for each task using Ctrl + mouse-click. 
Set the target format in the flip menu. Windows Media Video format (*.wmv
) is the default. 
Advanced settings: This opens the dialog for the advanced format settings. This corresponds to the
dialog for normal video export of a movie
. 
Tip:
 If you give several tasks the same file name, the files created will be documented intelligently. For
example, you can easily convert and simultaneously line up multiple movies that belong together
thematically. 

Shut down PC automatically after successful
export
 This option is especially useful when you export long movies and are using an especially high-quality and
resource-demanding export format. You can leave the computer to work on the individual tasks and after
finishing them it will turn itself off. 

Start batch conversion
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 Click on "Start conversion" to start the process. After ending conversion processes, a list of all export
processes with a message informing of its success will appear. 
Hint: During batch conversion, messages that appear during normal file import will be for the most part
suppressed. This is to enable the smoothest conversion of all tasks. Therefore, please make sure that all
files to be converted or the project
 can be easily loaded before starting a batch conversion. 
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Queued entries for batch conversion
 This is the list of all objects that have to be converted into the indicated format. Each task can have its
own export settings. 
Add files (not during conversion of individual objects from movies)
: Manually add files, including video files and projects. 
Remove selected
: The marked tasks will be removed from the list. 
Duplicate selected
: If you would like to export tasks in multiple formats, you can simply mark and duplicate them and assign
individual export settings to them. 

Format settings for the selected conversion
process
 These are settings for the currently selected tasks, and multiple tasks can be given a setting
simultaneously. Select one or more tasks from the task list. 
Note on format setting for multiple tasks:
 If one of the marked tasks already has an individual setting, its will be lost after another format is
selected. To prevent this, remove the selection for each task using Ctrl + mouse-click. 
Set the target format in the flip menu. Windows Media Video format (*.wmv
) is the default. 
Advanced settings: This opens the dialog for the advanced format settings. This corresponds to the
dialog for normal video export of a movie
. 
Tip:
 If you give several tasks the same file name, the files created will be documented intelligently. For
example, you can easily convert and simultaneously line up multiple movies that belong together
thematically. 

Shut down PC automatically after successful
export
 This option is especially useful when you export long movies and are using an especially high-quality and
resource-demanding export format. You can leave the computer to work on the individual tasks and after
finishing them it will turn itself off. 

Start batch conversion
 Click on "Start conversion" to start the process. After ending conversion processes, a list of all export
processes with a message informing of its success will appear. 
Hint: During batch conversion, messages that appear during normal file import will be for the most part
suppressed. This is to enable the smoothest conversion of all tasks. Therefore, please make sure that all
files to be converted or the project
 can be easily loaded before starting a batch conversion. 
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Format settings for the selected conversion
process
 These are settings for the currently selected tasks, and multiple tasks can be given a setting
simultaneously. Select one or more tasks from the task list. 
Note on format setting for multiple tasks:
 If one of the marked tasks already has an individual setting, its will be lost after another format is
selected. To prevent this, remove the selection for each task using Ctrl + mouse-click. 
Set the target format in the flip menu. Windows Media Video format (*.wmv
) is the default. 
Advanced settings: This opens the dialog for the advanced format settings. This corresponds to the
dialog for normal video export of a movie
. 
Tip:
 If you give several tasks the same file name, the files created will be documented intelligently. For
example, you can easily convert and simultaneously line up multiple movies that belong together
thematically. 

Shut down PC automatically after successful
export
 This option is especially useful when you export long movies and are using an especially high-quality and
resource-demanding export format. You can leave the computer to work on the individual tasks and after
finishing them it will turn itself off. 

Start batch conversion
 Click on "Start conversion" to start the process. After ending conversion processes, a list of all export
processes with a message informing of its success will appear. 
Hint: During batch conversion, messages that appear during normal file import will be for the most part
suppressed. This is to enable the smoothest conversion of all tasks. Therefore, please make sure that all
files to be converted or the project
 can be easily loaded before starting a batch conversion. 
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Shut down PC automatically after successful
export
 This option is especially useful when you export long movies and are using an especially high-quality and
resource-demanding export format. You can leave the computer to work on the individual tasks and after
finishing them it will turn itself off. 

Start batch conversion
 Click on "Start conversion" to start the process. After ending conversion processes, a list of all export
processes with a message informing of its success will appear. 
Hint: During batch conversion, messages that appear during normal file import will be for the most part
suppressed. This is to enable the smoothest conversion of all tasks. Therefore, please make sure that all
files to be converted or the project
 can be easily loaded before starting a batch conversion. 
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Start batch conversion
 Click on "Start conversion" to start the process. After ending conversion processes, a list of all export
processes with a message informing of its success will appear. 
Hint: During batch conversion, messages that appear during normal file import will be for the most part
suppressed. This is to enable the smoothest conversion of all tasks. Therefore, please make sure that all
files to be converted or the project
 can be easily loaded before starting a batch conversion. 
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Menus
 Certain menu
 items are not available on the "Record" and "Burn" screens. The menu reference describes the full menu
as found on the "Edit" screen. 
In this chapter
File menu
Edit menu
Effects (FX)
Windows menu
Online menu
Tasks menu
Help menu
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File menu
In this chapter
New project
Load project
Save project
Save project as...
Manage movies
Export movie
Record audio / images / video
Import Audio CD track(s)
Scan image
Output audio/video
Burn CD/DVD
Internet
Backup copy
Load backup project
Clean-up wizard
Settings
Exit
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New project
Creates a new MAGIX Movie Edit Pro 16 project. A dialog
with settings for a new disc project or a new film
 opens to get started. 

Keyboard shortcut: Shift + N 
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Load project
Use this option to load a movie into your disc project
. Please note that all media files associated with it must be
accessible. MAGIX Movie Edit Pro 16 will search for all used
sounds and video files in the folders in which they were located
when the movie was saved. 

Keyboard shortcut: Ctrl + O 
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Save project
The current disc project is saved with the name displayed in the
project window. If you have not yet specified a name for your
project, a dialog
 will open asking you to do so. 

Keyboard shortcut: Shift + S 
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Save project as...
 A dialog
 opens where you can specify the path and name of the video for saving. 
Keyboard shortcut: Shift + O 

Page 487



Manage movies
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New movie
 Use this option to create a new movie for your recordings and imported files. Since a film is normally
already opened, you will have to decide whether the movie should be inserted into the existing project
 or if a new project should be created. 
Keyboard shortcut: Ctrl + Alt + N 
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Delete movie
 This option lets you remove the current movie from the project
. However, it is still available on the hard drive and can be loaded again at any time. 
Shortcut: Shift + F4 

Attach movie
 Using this function you can attach a movie to an opened one. This is then attached to the end of the
movie and automatically takes on the original movie
's settings. 

Rename movie
 You can enter a new name for your movie
 here. 
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Attach movie
 Using this function you can attach a movie to an opened one. This is then attached to the end of the
movie and automatically takes on the original movie
's settings. 

Rename movie
 You can enter a new name for your movie
 here. 
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Import movie file
 Use this option to load a movie into your disc project
. Please note that all media files associated with it must be accessible. MAGIX Movie Edit Pro 16 will
search for all used sounds and video files in the folders in which they were located when the move was
saved. 

The "Select movie for editing" button
 lets you switch between movies. 
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Export movie file
 A dialog will open in which a file name for the film to be exported has to be entered. The movie
 can then be imported again into other projects. 
Note
: The movie file (*.mvd) contains all information about the used media files, cuts, effects, and titles, but
not the picture and sound material itself. This is found in the recorded or imported media files that remain
unchanged during the entire MAGIX Movie Edit Pro 16 editing process. To save the full movie into a
dedicated directory, e.g. to continue editing on a different PC, please use the function "Copy movie and
media into directory". 
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Export movie
 This provides all export formats supported by MAGIX Movie Edit Pro 16 that aren't covered by
burning. Refer to "Exporting
" for more information. 
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Record audio / images / video
A
selec
tion
wind
ow
will
open
for
you
to
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reco
rding
type.
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"Rec
ord" 
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n
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trans
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Keyboard shortcut: G 
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Import Audio CD track(s)
 You can simply import a CD track as a regular file from the Media Pool via drag & drop. If this simple
method doesn't work for some reason, then you can use the menu command to open the CD manager to
select tracks from an audio CD and load them into the arrangement. More about this can be found in the
section "Importing Audio CDs" in the Audio chapter
. 
Keyboard shortcut: C 
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Scan image

 Select scanner
 The twain interface connects MAGIX Movie
 Edit Pro 16 with almost all current scanners or digital cameras. Proceed as follows if working with the
twain interface for the first time: 

1. Install the twain software for the device. 
2. Restart your computer. 
3. Start MAGIX Movie Edit Pro 16. 
4. Click on "File -> Twain scanner -> Select source", if the scanner works with 32-bit software. 
5. In the dialog field click on the device you want to work with. This step will no longer be

necessary if you continue using the same device.
Keyboard shortcut: Alt + Q 

Start the scanning process
 The scan window of your scan software will appear. Specify the resolution and color depth in this
window. Once the scan process is finished, the twain software will normally switch off by itself ? the
scanned image file will be added to MAGIX Movie Edit Pro 16 automatically. If the twain dialog
 remains open, you will be able to scan multiple images in succession. 
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Select scanner
 The twain interface connects MAGIX Movie
 Edit Pro 16 with almost all current scanners or digital cameras. Proceed as follows if working with the
twain interface for the first time: 

1. Install the twain software for the device. 
2. Restart your computer. 
3. Start MAGIX Movie Edit Pro 16. 
4. Click on "File -> Twain scanner -> Select source", if the scanner works with 32-bit software. 
5. In the dialog field click on the device you want to work with. This step will no longer be

necessary if you continue using the same device.
Keyboard shortcut: Alt + Q 

Start the scanning process
 The scan window of your scan software will appear. Specify the resolution and color depth in this
window. Once the scan process is finished, the twain software will normally switch off by itself ? the
scanned image file will be added to MAGIX Movie Edit Pro 16 automatically. If the twain dialog
 remains open, you will be able to scan multiple images in succession. 
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Start the scanning process
 The scan window of your scan software will appear. Specify the resolution and color depth in this
window. Once the scan process is finished, the twain software will normally switch off by itself ? the
scanned image file will be added to MAGIX Movie Edit Pro 16 automatically. If the twain dialog
 remains open, you will be able to scan multiple images in succession. 
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Output audio/video
 This command opens the dialog for exporting the completed video or its audio
 track to analog or digital video recorders/camcorders or various mobile devices such as smartphones,
PDAs, video players, or games consoles. 
Please read the chapter "Output audio/video
". 
Keyboard shortcut: H 
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Burn CD/DVD
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Manually compile files
 Opens the MAGIX Speed burnR burning application for burning movies or other files onto CD/DVD.
The files are selected by simply dragging & dropping them into the MAGIX Speed burnR explorer.
Further information can be found in the MAGIX Speed burnR help
 file. 
Keyboard shortcut: Alt + Shift + R 
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Copy CD/DVD direct
 The dialog
 provides several options for creating a copy: 

 Copy: Here you can directly copy a non copy-protected CD or DVD. 
 Shrink: Compresses a DVD to the size of a regular single layer DVD+/-R/RW. All files of the

original DVD have to be on the hard drive.
 Analog copy: Copies your video onto a disc via analog recording.

More on this in the chapter about the "Record" dialog. 
Keyboard shortcut: Alt + Shift + D 
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Burn an already created (S)VCD/Video DVD
 All necessary files, menus, and encoded video files needed to burn a CD/DVD will be temporarily
stored on your hard drive. After your disc is burned, these are not automatically deleted. Using "Disc
image
" multi-copy, you can uses these images to burn as many discs as you would like without having to
encode the files again. 
In the dialog
, choose the image you want. All necessary files are then transferred to the MAGIX Speed burnR
burning tool. 
For more information on using MAGIX Speed burnR, read the program's help file. 
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Internet
 This is a list of menu entries regarding all of the services that are available directly from within MAGIX
Movie
 Edit Pro 16. 
In this section:
MAGIX Online Album/MAGIX Online Print Service/Catooh
Export to magix.info
Online login details
MAGIX Community
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MAGIX Online Album/MAGIX Online Print Service/Catooh
 For MAGIX Online World please read menu
 item Online! 

Export to magix.info
 This command allows you to export your movie
 to magix.info. 
First, export your project in one of the following formats: asf, mov, mpg, mpeg, mp4, wmv, 3gp, or avi
. Next, access "File -> Internet -> magix.info -> Present videos on magix.info" to reach a page where
you can upload your video. You may need to register with magix.info. 
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Export to magix.info
 This command allows you to export your movie
 to magix.info. 
First, export your project in one of the following formats: asf, mov, mpg, mpeg, mp4, wmv, 3gp, or avi
. Next, access "File -> Internet -> magix.info -> Present videos on magix.info" to reach a page where
you can upload your video. You may need to register with magix.info. 
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Online login details
 In this dialog
, you can save your login information (login and password) for MAGIX Online Album and all other
MAGIX Online World as well as for Catooh, making it unnecessary to login each time you access
MAGIX Online World. 
The saved data are valid for all other MAGIX programs for the corresponding computer user. 
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MAGIX Community
 This is a direct connection between MAGIX and different communities like YouTubeTM or VimeoTM

. 
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Upload current movie as video
 Uploads the current film to the selected portal or to the selected community. Enter the data for video into
the fields provided, so that the search function for this portal can also find this video. 
MAGIX Movie Edit Pro 16 partially uses the H.264 format for this, which is a component of the MPEG
-4 codec. Since Flash supports this format directly and most communities and portals use the format, the
film does not need to be re-rendered on the corresponding server. This avoids loss of quality. 
When HD material is uploaded, a resolution of 720p
 is used for the HD format. 

Upload all selected media in Media Pool
 Uploads the media selected in the Media Pool to the corresponding portal or the selective community. 
Note: To import and export AVC and MPEG-4 files, the MEPG-4 codec must first be activated. A
dialog will open if the codec is required. Files with a horizontal resolution of more than 768 pixels can
only be loaded in MAGIX Movie
 Edit Pro 16 Plus. 
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Backup copy
 Files must be saved to be able to be easily retrieved in case of a hard drive crash or some other error. 
For detailed information, read the Backup section in the "Video project management"
 chapter. 
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Load backup project
 This option loads an automatically created slideshow backup. This type of automatic backup gets the file
extension MV_ (underscore). This command is only intended for use in emergencies, for example, if you
unintentionally saved your change and wish to return to the previous version of the movie
. 
Keyboard shortcut: Alt + O 
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Clean-up wizard
 The clean-up wizard helps you delete projects from your hard drive, including all media files. Use this
function to free up disk space for future projects. 
Caution
: If the files you used in the slideshow have also been used in other slideshows (like trailers, opening
music, etc.), then you should make backup copies of these files beforehand. 
Shortcut: Ctrl + Alt + G 
For detailed information, read the clean-up wizard section in the "Video project management"
 chapter. 
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Settings
In this section:
Movie settings
Program settings
Edit Keyboard shortcut
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Movie settings
 Opens the movie settings of the currently selected movie
. 
Keyboard shortcut: E 
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Program settings
Opens the program settings
. 

Keyboard shortcut: Y 
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Edit Keyboard shortcut
 This menu entry opens a dialog for editing the keyboard shortcuts. This allows you to adjust MAGIX
Movie
 Edit Pro 16 to your own specific needs. 
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Exit
 Closes MAGIX Movie
 Edit Pro 16. 
Keyboard shortcut: Alt + F4 
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Edit menu
In this section:
undo
Restore
Cut objects
Copying objects
Paste objects
Duplicate objects
Delete objects
Select all objects
Cut
Musical editing
Range
Form group
Ungroup objects
Wizards
Mixdown Audio
Audio and video mixdown
Edit snap point
Marker
Move screen view
Multicam
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undo
 During project
 editing, you can undo the last changes you made. This way it's no problem if you want to experiment
with critical operations. If you don't like the results, then you can always revert to the previous state by
using "Undo". 
Keyboard shortcut: Ctrl + Z 
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Restore
 The "Redo" function undoes the previous "Undo" function. 
Keyboard shortcut: Ctrl + Y 
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Cut objects
This function deletes the selected scene (or the selected object
in "Timeline" mode) and copies it to the clipboard. You can
then use the "Paste" command to copy it into any movie
. 

Keyboard shortcut: Ctrl + X 
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Copying objects
This function copies the selected scene (or the selected object
in Timeline mode) to the clipboard. You can then use the
"Paste" command to place it into any movie
. 

Keyboard shortcut: Ctrl + C 
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Paste objects
This command inserts the clipboard
 material (photo or object) at the current position of the start
marker. 

Keyboard shortcut: Ctrl + V 
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Duplicate objects
This command duplicates all selected objects. The copies
appear beside the original and can be placed in the correct
position using drag & drop. 

Keyboard shortcut: Ctrl + D 
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Delete objects
This function deletes the selected scene
 (or the selected object in "Timeline" mode). 

Keyboard shortcut: Del 
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Select all objects
All objects in the arrangement will be selected. 

Keyboard shortcut: Ctrl + A 

Cut

 Split scene
 This command cuts a scene
 at the point where the playback marker is positioned. This way, two free-standing objects are created. 
Keyboard shortcut: T 
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Cut

 Split scene
 This command cuts a scene
 at the point where the playback marker is positioned. This way, two free-standing objects are created. 
Keyboard shortcut: T 
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Split scene
 This command cuts a scene
 at the point where the playback marker is positioned. This way, two free-standing objects are created. 
Keyboard shortcut: T 
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Delete scene start
 This command cuts a scene
 at the point where the start marker is positioned, and deletes all material that precedes the start position
simultaneously. 
Shortcut key: Shift + T 
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Delete scene end
 This command cuts a scene
 at the point where the start marker is positioned, and deletes all material behind the start position
simultaneously. 
Shortcut: Shift + Z 

Remove scene
 If you want to cut a scene out of a movie
 retroactively, this option automatically moves all objects, titles, and transitions on all tracks forwards so
that no gaps result. 
Objects on other tracks which project
 into the area of the selected scene will not be moved automatically; they will remain at the current
position. 
Keyboard shortcut: Ctrl + Del 

Split movie
 This command splits a movie at the point where the playback marker is positioned, making two separate
movies. The part before the playback marker will remain in the arranger. The remaining part will be
erased from the current arranger and turned into a new movie, which can be found in the "Window" menu
. 
Keyboard shortcut: Alt + T 
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Remove scene
 If you want to cut a scene out of a movie
 retroactively, this option automatically moves all objects, titles, and transitions on all tracks forwards so
that no gaps result. 
Objects on other tracks which project
 into the area of the selected scene will not be moved automatically; they will remain at the current
position. 
Keyboard shortcut: Ctrl + Del 

Split movie
 This command splits a movie at the point where the playback marker is positioned, making two separate
movies. The part before the playback marker will remain in the arranger. The remaining part will be
erased from the current arranger and turned into a new movie, which can be found in the "Window" menu
. 
Keyboard shortcut: Alt + T 
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Split movie
 This command splits a movie at the point where the playback marker is positioned, making two separate
movies. The part before the playback marker will remain in the arranger. The remaining part will be
erased from the current arranger and turned into a new movie, which can be found in the "Window" menu
. 
Keyboard shortcut: Alt + T 
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Musical editing
 If your background music is edited using the beat recognition assistant
, you can automatically adapt your cuts to the tempo with this option. All hard cuts (no crossfaded
objects) are shifted across the musical quarter note positions. 
Keyboard shortcut: Ctrl + Shift + U 
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Range
 MAGIX Movie Edit Pro 16 provides object-based functions as well as "band-oriented" editing
functions. These always refer to the whole project
 from the first to the last track as well as to the area between the start and end marker. 

Cut out
 The section between the in and out points is cut from the current arrangement and placed on the 
clipboard
. This section can then be reinserted elsewhere. 
Keyboard shortcut: Ctrl + Alt + X 

Copy
 The section between the in and out points is copied from the current arrangement to the clipboard
. This section can then be reinserted elsewhere. 
Keyboard shortcut: Ctrl + Alt + C 

Delete
 The section between the in and out points is deleted from the current arrangement and not copied to the 
clipboard
. 
Keyboard shortcut: Ctrl + Del 

Insert
 The contents of the clipboard
 are inserted at the current arrangement's position of the in point. 
Keyboard shortcut: Ctrl + Alt + V 

Extract
 The section between the in and out points is preserved, and all of the material in front and behind it are
deleted. Use this option to isolate a specific part of an arrangement for further individual editing. 
Keyboard shortcut: Ctrl + Alt + P 
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Cut out
 The section between the in and out points is cut from the current arrangement and placed on the 
clipboard
. This section can then be reinserted elsewhere. 
Keyboard shortcut: Ctrl + Alt + X 

Copy
 The section between the in and out points is copied from the current arrangement to the clipboard
. This section can then be reinserted elsewhere. 
Keyboard shortcut: Ctrl + Alt + C 

Delete
 The section between the in and out points is deleted from the current arrangement and not copied to the 
clipboard
. 
Keyboard shortcut: Ctrl + Del 

Insert
 The contents of the clipboard
 are inserted at the current arrangement's position of the in point. 
Keyboard shortcut: Ctrl + Alt + V 

Extract
 The section between the in and out points is preserved, and all of the material in front and behind it are
deleted. Use this option to isolate a specific part of an arrangement for further individual editing. 
Keyboard shortcut: Ctrl + Alt + P 
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Copy
 The section between the in and out points is copied from the current arrangement to the clipboard
. This section can then be reinserted elsewhere. 
Keyboard shortcut: Ctrl + Alt + C 

Delete
 The section between the in and out points is deleted from the current arrangement and not copied to the 
clipboard
. 
Keyboard shortcut: Ctrl + Del 

Insert
 The contents of the clipboard
 are inserted at the current arrangement's position of the in point. 
Keyboard shortcut: Ctrl + Alt + V 

Extract
 The section between the in and out points is preserved, and all of the material in front and behind it are
deleted. Use this option to isolate a specific part of an arrangement for further individual editing. 
Keyboard shortcut: Ctrl + Alt + P 
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Delete
 The section between the in and out points is deleted from the current arrangement and not copied to the 
clipboard
. 
Keyboard shortcut: Ctrl + Del 

Insert
 The contents of the clipboard
 are inserted at the current arrangement's position of the in point. 
Keyboard shortcut: Ctrl + Alt + V 

Extract
 The section between the in and out points is preserved, and all of the material in front and behind it are
deleted. Use this option to isolate a specific part of an arrangement for further individual editing. 
Keyboard shortcut: Ctrl + Alt + P 
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Insert
 The contents of the clipboard
 are inserted at the current arrangement's position of the in point. 
Keyboard shortcut: Ctrl + Alt + V 

Extract
 The section between the in and out points is preserved, and all of the material in front and behind it are
deleted. Use this option to isolate a specific part of an arrangement for further individual editing. 
Keyboard shortcut: Ctrl + Alt + P 
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Extract
 The section between the in and out points is preserved, and all of the material in front and behind it are
deleted. Use this option to isolate a specific part of an arrangement for further individual editing. 
Keyboard shortcut: Ctrl + Alt + P 
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Form group
Orders all selected objects into groups. As soon as an object
from the group is selected, all other objects in the group will be
highlighted as well so that you can work on them collectively. 

Keyboard shortcut: Ctrl + L 
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Ungroup objects
This turns all selected objects into free-standing objects
again. 

Keyboard shortcut: Ctrl + M 
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Wizards
In this section:
Slideshow Maker
Soundtrack Maker
Travel route animation
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Slideshow Maker
 Opens the Slideshow Maker
 Keyboard shortcut: Ctrl + Shift + M 
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Soundtrack Maker
 This command opens MAGIX Soundtrack Maker
. 
Keyboard shortcut: W 
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Travel route animation
 This menu
 entry opens the separate Travel route animation program. This enables simple creation of animated travel
routes with the help of online maps. 
Note: In order to be able to use current map data, maps are fetched by Travel route animation directly
from the Internet. This requires an active Internet connection.
More information about the program is available in the help file, which can be opened by pressing the
"F1" key. 
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Mixdown Audio
 This option joins all audio
 objects in one audio file. The sound material will only occupy one track of the arranger and will hardly
affect the RAM, but it will occupy approximately 10 MB (in stereo) on the hard drive. This will give you
more control over the arranger and more space for additional objects. 
MAGIX Movie Edit Pro 16 automatically normalizes the audio file, i.e. the loudest part of the wave
 audio object is identical with the highest figure of the 16-bit resolution ceiling. This guarantees the same
sound quality, even if you repeat the mix down procedure or you combine the mix down file with other
wave audio objects again and again. 
The mix function is very helpful if you want to go on using the mixdown object. For the final AVI or
WAV (or any other multi-media) file, which is designed for burning a CD or for use on other PCs, use
the "Export arrangement" submenu options from the file menu
 instead of the mixdown function. 
Tip:
 Instead of using the mixdown function, you can use the various options of th submenu "Export movie" in
the File menu to create a final final *.avi or *.wav (or any other multimedia) file. 
Keyboard shortcut: Shift + M 
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Audio and video mixdown
 In addition to the "Mix down audio" function (see above), all video objects including effects, fades, and
edits in a single MAGIX video file. If this overloads your CPU
, try closing some other programs. 
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Edit snap point
 If the position of objects, object borders, markers, or the playback marker is changed with the mouse,
these will automatically spring to certain "key positions" if you get close enough to them. This functions as
a "notch", i.e. even objects in a higher zoomed resolution can be precisely positioned, without any gaps,
which you wouldn't normally see in that resolution. Normally, all object borders and all markers lock to
one another. 

 Per object, one additional snap point can now be placed within an object to mark positions
where other objects should snap to. This is helpful if you want to show a title at a certain spot in a
video object, for example.

 To set a snap point, select an object and place the playback marker at the position where you
would like the snap point to be.

 Next, use "Set snap point" to set the point. Likewise, "Delete snap point" removes a snap
point. As soon as you select the option "Set snap point" at another position it will be moved
automatically.

 "Delete all snap points" deletes all snap points for all objects.
Keyboard shortcut: Alt + Shift + P 
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Marker
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Set project marker
 This option sets a project marker at the current playback position. More information about project
markers is available in the chapter "Markers" under "Set project marker
". 
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Delete project marker
 Deletes the selected project marker. Project markers can be deleted and renamed via the context menu
. 

Set chapter marker
Sets a chapter marker at the position of the playback marker.
This creates a chapter entry in the disc menu, in case you are
planning to burn the movie
 to CD/DVD. 

You can rename your chapter markers by right clicking and selecting "Rename". The name then appears
in the chapter menu
. 
Shortcut: Shift + Enter 
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Automatic chapter markers
 Automatically sets chapter markers in the arrangement based on certain rules. These chapter markers
determine the chapters in your DVD menu
. This function is useful if you want to burn your recording onto disc right away. 
There are a few options for automatic chapter generation: 
At the beginning of the movie: 
The movie contains only one chapter 
At the object starts in a track...:
 Every object in a track creates a chapter. Track 1 is preset. 
At the position of existing title objects:
 Subtitles, for instance as faded-in subheadings, give the position of the chapter markers. 
Provide interval (in minutes)/provide quantity:
 If the chapters are separated without any particular method and are just needed for quicker navigation,
you can also insert chapter markers in pre-defined intervals or as a pre-defined number of chapter
markers. 
Titling the chapter markers:
 To title the chapter markers, you can use a user-defined name with consecutive numbers or the object
name or text from the text objects. 
Optionally, you can delete existing chapter markers and confine the automatic chapter marker function to
the area between the start and end markers. 
Keyboard shortcut: Alt + Shift + Enter 
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Delete (all) chapter markers
 Deletes one or all chapter markers. This removes chapter entries from the disc menu
. Read more in "Burn screen". 
Keyboard shortcut: Ctrl + Enter / Alt + Ctrl + Enter 

Marker -> Set range start/end
 Sets a range start/end marker at the position of the playback marker. 
Keyboard shortcut: I/O 

Marker -> Jump to range start/end
 Sets the playback marker at the position of the range start/end. 
Shortcut: Shift + I/O 

Marker -> Reset selected range
 Deletes the range start and the range end. 
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Marker -> Set range start/end
 Sets a range start/end marker at the position of the playback marker. 
Keyboard shortcut: I/O 

Marker -> Jump to range start/end
 Sets the playback marker at the position of the range start/end. 
Shortcut: Shift + I/O 

Marker -> Reset selected range
 Deletes the range start and the range end. 
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Move screen view
 Using these commands, a viewable portion together with the start marker will be moved in the timeline.
You can quickly skip between different markers (skip, chapter, scene
, ad-marker) and object edges. 
Keyboard shortcut: See "Keyboard shortcuts", "Arranger".

 Multicam
 This command switches to Multicam mode
. 
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Multicam
 This command switches to Multicam mode
. 
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Effects (FX)
In this chapter
Master effects
Video object effects
Audio object effects
Title Effects
Design elements
Effects library
Synthesizer
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Master effects
 This menu item accesses the movie's effects settings
. The settings made in this case will affect the entire film. 
Shortcut: Ctrl + B 
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Video object effects
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Scene recognition
 Calls up the automatic scene
 recognition, which "cuts up" longer videos into scenes for storage in the "Takes" directory. 
Keyboard shortcut: Shift + Z 
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Bildstabilisierung
 Opens the "Motion stabilizer" dialog for you to correct shaky footage. Please read the chapter "Motion
stabilizer
". 
Keyboard shortcut: Shift + K 
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Searching for and removing ads (only in Plus version)
 Opens the dialog for searching and removing advertising
. 
Keyboard shortcut: Shift + C 
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Edit in external editor
 Graphic files (BMPs or JPEGs) from the arranger can be post-edited in an external graphics program.
The selected image file is loaded automatically and, once editing has been completed, is used in the
MAGIX Movie Edit Pro 16 instead of the original material. For this, MAGIX Movie
 Edit Pro 16 offers the high-performance photo editing program MAGIX Xtreme Photo Designer. 
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Save photos with effects
 This allows you to save photos used in the movie
 and add the object effects used in MAGIX Movie Edit Pro 16 (e.g. StoryMaker) to the photo. 
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Create panorama...
 Opens the dialog
 for setting a panorama. Place as many photos in the correct order as you like, and align brightness and
color settings to get the best results. You should make sure that the photos harmonize at the transitions. 
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Video effects
 These are the various effects which can be applied to videos and stills. The effects can be set after an
object is selected in the respective effects dialog which appears. For more information, see the "Video
effects in the Media Pool
" chapter. 
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Video effect templates
 This features general templates that can be added to the video objects via drag & drop and several
video mix effects that can be quickly and easily applied, e.g. bluescreen. 

Movement effects
 These are movement effects you can use to animate the frame by using zoom or camera movements. For
more information, go to the "Effects and titles" chapter in "Movement effects in Media Pool
". 
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Movement effect templates
 These are templates for movement effects. These can be added from the Media Pool into the
arrangement by double-clicking or via drag & drop. 
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Section
 Places video objects in a particular part of the screen. Please read the "Video effects" chapter for more
details. 
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Background design
 Select a color, a picture, or any video on your hard disk
 which you would like to serve as the background for the photo displayed. This function is especially
useful when photos have black bars around them, or if they are reduced in size. 
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Reset background
 Resets the background design
 settings to default settings. 
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Set as background
 Uses the selected photo or video as the background. 

Load video effects
 This command lets you load a saved effects combination for the currently selected object. If you have
selected multiple objects, then the effects combination for each object will be applied. 
Shortcut: Alt + Shift + O 

Save video effects
 This command lets you save the current effects combination for each object separately. 
Shortcut: Alt + Shift + S 

Reset video effects
 This option allows you to deactivate all currently used effects entirely if you want to undo the changes. 
Shortcut: Alt + Shift + C 
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Load video effects
 This command lets you load a saved effects combination for the currently selected object. If you have
selected multiple objects, then the effects combination for each object will be applied. 
Shortcut: Alt + Shift + O 

Save video effects
 This command lets you save the current effects combination for each object separately. 
Shortcut: Alt + Shift + S 

Reset video effects
 This option allows you to deactivate all currently used effects entirely if you want to undo the changes. 
Shortcut: Alt + Shift + C 
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Save video effects
 This command lets you save the current effects combination for each object separately. 
Shortcut: Alt + Shift + S 

Reset video effects
 This option allows you to deactivate all currently used effects entirely if you want to undo the changes. 
Shortcut: Alt + Shift + C 
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Reset video effects
 This option allows you to deactivate all currently used effects entirely if you want to undo the changes. 
Shortcut: Alt + Shift + C 
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Copy video effects
 Effects settings for an object can be copied to the clipboard to add
 them to other objects. 
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Insert video effects
 Video effects can be added from other objects to the one selected. The settings must be copied to the
clipboard
 beforehand to do so. 
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Apply video effects to all
 The current effects settings will be applied to all scenes and photos in your movie
. 
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Apply video effects to all of the following
 The current effects settings will be applied to all scenes and photos in your movie
 which lie behind the selected object. 
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Audio object effects
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Normalize
 The "Normalize audio
" function increases the level of the audio object to the maximum possible without overmodulating the
material. To do this, the largest signal peak in the audio material and the level of the object are detected
so that this point corresponds exactly to 0dB (full modulation). 
Keyboard shortcut: Shift + N 
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Reduce volume
 Please see "Reducing volume" in the audio
 effects chapter. 
Keyboard shortcut: Alt + Shift + L 
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Set volume
 This function, located in both the effects menu and the context menu, controls the sound volume for
individual objects, just like the object handles
 in the arranger. 
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Audio cleaning
 Please see "Audio cleaning" in the "Audio
 effects" chapter 
Keyboard shortcut: Shift + W 
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Echo/Hall
 Please see "Reverb/Echo" in the chapter "Audio
 effects". 
Keyboard shortcut: Shift + H 
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Timestretch/Resample
 Read more about this in "Timestretch/Resample
". 
Keyboard shortcut: Shift + Q 
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Load audio effects
 This command lets you load a saved effects combination for the currently selected object. If you have
selected multiple objects, then the effects combination for each objects will be applied. 
Keyboard shortcut: Ctrl + Alt + O 
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Save audio effects
 This command lets you save the current effects combination for each object separately. 
Keyboard shortcut: Ctrl + Alt + S 
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Reset audio effects
 This option allows you to deactivate all currently used effects entirely if you want to undo the changes. 
Keyboard shortcut: Ctrl + Alt + K 
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BPM Wizard
 Please see "BPM wizard" in the chapter "Audio".
 Keyboard shortcut: Shift + E 
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Volume curve
 The most important object effects curve, allowing the volume to be immediately accessible. Volume is
also located in the Media Pool under "Effects -> Audio
 effects -> General", and can also be animated there. 
Keyboard shortcut: Alt + X 
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Title Effects

 Title Editor
Opens the title editor
 for the selected photo, video, or title object. 

Keyboard shortcut: Ctrl + T 
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Load Title Effects
 You can store the current preset effects combination for each title object separately and later apply them
to other title objects if they have worked satisfactorily. 
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Save Title Effects
 You can store the current preset effects combination for each title object separately and apply it later to
other title objects. 
Keyboard shortcut: Alt + T 

Design elements
 Multi picture-in-picture: These are various effects presets for image
 stacking. 
Collages
: These work similarly to normal picture-in-picture effects, but more objects are used. Depending on the
collage, arrange the selected objects one after the other and drag the collage onto the first object. 
Portrait effects
: Select individual effects which are especially suited to vertically formatted photos. 
Image objects
: These are various image objects like black bars, thought bubbles for cartoons, etc. 
Intros/Outros
: These are beginning and end scenes for films with various themes. 
Visuals
: Graphical displays of any played sounds which can be combined with other video material. 
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Effects library
 Using these menu choices, you can control the corresponding directories in the Media Pool
. 

Synthesizer
 Synthesizers in MAGIX Movie
 Edit Pro 16 can be loaded as individual objects. This is less of an effect than a technical means of
producing your own sound effects. More information is available in "Synthesizers". 
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Windows menu
In this section:
Cut Trimmer
Object trimmer
Mixer
Master audio effect rack
Mastering Suite
Program monitor
Media Pool
Project
Reset window arrangement
Display settings
Show movie overview
Optimize movie view
Zoom horizontal
Zoom vertical
Close all movies
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Cut Trimmer
 Shows or hides the "Cut trimmer" window. This allows you to make fine adjustments to the position of
the selected video or image objects and their handles
 ? as well as the transition characteristics (transition type, length). Please read the "Fine adjustment of
video ("Trimming")" chapter for more details. 
Keyboard shortcut: N 
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Object trimmer
 Shows or hides the "Cut trimmer" window. Opens up the video trimmer to help you fine tune the position
and the handles
 of a video object. Please read the "Fine adjustment of video ("Trimming")" chapter for more details. 
Shortcuts: Q 
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Mixer
This option allows you to display or conceal the real-time
mixer. You will find further information, especially with regard
to the integration of effects plug-ins, in the chapter "Mixer". 

Keyboard shortcut: M 
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Master audio effect rack
 Opens or closes the master effects rack; you can also use the "Master FX" button
 in the mixer window for this. 
Keyboard shortcut: B 
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Mastering Suite
 This opens the Mastering Suite
. 

Program monitor
 Opens and closes the video window. If the standard layout is chosen the Mediapool can be shown in a
freely scalable and moveable window. 
Keyboard shortcut: V 
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Program monitor
 Opens and closes the video window. If the standard layout is chosen the Mediapool can be shown in a
freely scalable and moveable window. 
Keyboard shortcut: V 
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Media Pool
 This option can be used to conceal the Media Pool or make it visible again. 
Keyboard shortcut: F 

Project
 Shows/Hides the arranger 
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Reset window arrangement
 This option resets the window arrangement to its default state. 
Shortcut key: F9 
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Display settings
 See program settings -> "Display presets
" in the PDF manual. 
Shortcut: Alt + Shift + V 
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Show movie overview
 With this option, you can display an overview of the entire arrangement on the video screen. It is
particularly suitable for long and complex arrangements to prevent you from losing track. You can view
the whole movie
 and you are, despite this, able to access the object you're looking for in a split second ? you can zoom in
directly on the video monitor or move around the clip displayed in the arranger. 
Shortcut: Shift + A 
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Optimize movie view
The zoom level is set to 100% so that you can see every
object and the entire film. 

The start and end markers are set to the beginning or end so that the entire movie
 can be played. 
Shortcut: Shift + B 
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Zoom horizontal
 Here you will find a range of functions for altering the visible time axis section. 
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Zoom vertical
 The number of simultaneously visible tracks can be changed here. The more tracks are visible, the
smaller they will appear. 

Close all movies
 Closes all opened movies. 
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Online menu
 This is a list of menu entries regarding all of the services that are available directly from within MAGIX
Movie
 Edit Pro 16. 
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Tasks menu
 In this menu
 you will find direct solution and short video explanations on how to perform tasks in different topics. Not
only will you find step-by-step instructions for sound and pictures here, but you also find quick access to
many of functions. 
If you click on an entry with a camera symbol, then you will open a short tutorial video which displays a
solution. Entries without camera symbols offer a solution to the problem immediately. 
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Help menu
In this section:
Help
Content
Context help
Quickstart/Recording/Editing/Burning and exporting tutorial video
Ask questions online in the Knowledge Community
Find knowledge & workshops
Online tutorials
Get in contact with other users
About MAGIX Movie Edit Pro 16
Register online
Online update
Download presets for new device
Download video effects plug-ins
Display tool tips
Reset program settings to default...
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Help
 This command is available for almost every feature of the program, and it opens the "Help" file for the
corresponding topic. Use this command to get help on any of MAGIX Movie
 Edit Pro 16's functions. 
Keyboard shortcut: F1 
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Content
 Use the command "Content" in the "Help" menu
 to open the start page of the help file. You can read through the help file step-by-step and jump to
specific sections via the tree structure on the right hand side. 
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Context help
By choosing the context help entry from the "Help" menu, or by
clicking on the button in the top toolbar
, the mouse cursor will turn into an arrow with a question mark. 

Then, when you click on any button
 of the main screen, program help describing the control element in question will open. 
Shortcut key: Alt + F1 
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Quickstart/Recording/Editing/Burning and exporting
tutorial video 
Displays tutorial videos on different video editing topics in MAGIX Movie
 Edit Pro 16. 
Tip
: If you are using MAGIX Movie Edit Pro 16 for the first time, we recommend you view the tutorial
videos first. They will give you a quick introduction to the most important topics. 

Ask questions online in the Knowledge Community
 Ask magix.info a question. 

Find knowledge & workshops
 Have a look at the newest workshops at magix.info and read useful tips from other MAGIX Movie
 Edit Pro 16 users. 
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Ask questions online in the Knowledge Community
 Ask magix.info a question. 

Find knowledge & workshops
 Have a look at the newest workshops at magix.info and read useful tips from other MAGIX Movie
 Edit Pro 16 users. 
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Online tutorials
 Interesting tutorials and useful tips for working with MAGIX Movie Edit Pro 16 can be found on the
MAGIX website. 
An online connection is required. 

Get in contact with other users
 MAGIX Screenshare allows you to transfer the contents of your screen to other users (Screen transfer
as guest) or view the screens of other users (Screen transfer as host). 
To transfer the contents of your monitor to another user, select the menu item "Transfer screen as host
". The MAGIX Screenshare start screen will appear. Now click "Start session". 
Note
: Clicking your name allows you to change it as it appears in the session. In the start screen, you can also
set if you would like to view the guest's screen as the host via the "Settings" tab under "Options". 

Two windows will open. A large one which
shows other screen contents as required, and a
smaller one which displays your session ID.
Provide this number to all users who would
like to view your screen. 

Note
: The session ID changes with every new session. 
If you would like to receive another user's screen contents, you will require the session ID. Select the
menu item "Transfer screen as guest". In the dialog
 that opens, enter the session ID you received and click "Start session". 
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About MAGIX Movie Edit Pro 16
 Displays copyright info and version number of MAGIX Movie
 Edit Pro 16. 
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Register online
 This option opens the MAGIX homepage for online registration where you can register yourself as a
MAGIX user. 
Registration grants you access to the MAGIX support website
 (see support) where various program updates and help programs can be downloaded. 
With the registration form supplied (start menu under "MAGIX Movie
 Edit Pro 16 -> Service and support -> Register") you can register via post or fax. Simply print it out, fill
it in, and send it off! 
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Online update
 Connects directly to the MAGIX online update page where you can get the latest version of your
program. 

Download presets for new device
 It's possible that your device will not be supported for import or export of video material by MAGIX 
Movie
 Edit Pro 16. 
The command "Download presets for new device" in the "Help" menu
 opens a website containing an up-to-date list of all supported devices and device versions. Just search
for the desired device and click the corresponding link. The settings for the device will be downloaded
and made available to you in MAGIX Movie Edit Pro 16. 
Warning
: Some browsers display a warning if you try to download an executable file (.exe). You can ignore this
warning. 
If your device is not listed on the website, you can report your unsupported device so that it will be
included in later updates. 

Download video effects plug-ins
 This command lets you download new video effects plug-ins
. 
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Display tool tips
 Tooltips are small information windows that open up automatically if the mouse pointer stops briefly on
a button or some other area. They provide information about the function of the button
. These information boxes can be switched on or off with this option. 
Keyboard shortcut: Ctrl + Shift + F1 

Reset program settings to default...
 Use this function to reset all program settings you made in MAGIX Movie
 Edit Pro 16 to their original settings. 
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Reset program settings to default...
 Use this function to reset all program settings you made in MAGIX Movie
 Edit Pro 16 to their original settings. 
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Context menu (right click)
 Context menu
 can be reached by right clicking on a selected object. It offers functions which are available and can be
expected in the given context. 
In this section:
Video objects
Image objects
Transitions
Audio objects
Text objects
MAGIX 3D Maker objects
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Video objects
In this section:
Create frame table (new)
Scene recognition
Bildstabilisierung
Searching for and removing ads (only in Plus version)
Cut Trimmer
Object trimmer
Audio/Video Offset
Edit snap point
Create still frame
Audio cleaning
Motion
Section
Attach to picture position in the video
Interpolation for interlace material
Anti-flicker filter
Border cropping adjustment:
Background design
Video effects
Copying objects
Cut objects
Delete objects
Add time code
Object properties
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Create frame table (new)
 Sometimes, rebuilding a frame table can get rid of problems in certain MPEG files. For example, such
problems can be present if the navigation (positioning of the playback marker, transport) is bumpy or
doesn't function at all.
Normally, when loading MPEG video, a frame table is not created in order to speed up the loading
process. If you do create one anyway, MPEG files are normally noticeably faster and easier to edit. 
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Scene recognition
 Calls up the automatic scene
 recognition, which "cuts up" longer videos into scenes for storage in the "Takes" directory. 
Keyboard shortcut: Shift + Z 
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Bildstabilisierung
 Opens the "Motion stabilizer" dialog for you to correct shaky footage. Please read the chapter "Motion
stabilizer
". 
Keyboard shortcut: Shift + K 
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Searching for and removing ads (only in Plus version)
 Opens the dialog for searching and removing advertising
. 
Keyboard shortcut: Shift + C 

Page 630



Cut Trimmer
 Shows or hides the "Cut trimmer" window. This allows you to make fine adjustments to the position of
the selected video or image objects and their handles
 ? as well as the transition characteristics (transition type, length). Please read the "Fine adjustment of
video ("Trimming")" chapter for more details. 
Keyboard shortcut: N 
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Object trimmer
 Shows or hides the "Cut trimmer" window. Opens up the video trimmer to help you fine tune the position
and the handles
 of a video object. Please read the "Fine adjustment of video ("Trimming")" chapter for more details. 
Shortcuts: Q 
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Audio/Video Offset

 You can use this dialog to balance the sound & image time differences. A positive value shifts the audio
 material back, a negative value moves it forwards. 
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Edit snap point
 If the position of objects, object borders, markers, or the playback marker is changed with the mouse,
these will automatically spring to certain "key positions" if you get close enough to them. This functions as
a "notch", i.e. even objects in a higher zoomed resolution can be precisely positioned, without any gaps,
which you wouldn't normally see in that resolution. Normally, all object borders and all markers lock to
one another. 

 Per object, one additional snap point can now be placed within an object to mark positions
where other objects should snap to. This is helpful if you want to show a title at a certain spot in a
video object, for example.

 To set a snap point, select an object and place the playback marker at the position where you
would like the snap point to be.

 Next, use "Set snap point" to set the point. Likewise, "Delete snap point" removes a snap
point. As soon as you select the option "Set snap point" at another position it will be moved
automatically.

 "Delete all snap points" deletes all snap points for all objects.
Keyboard shortcut: Alt + Shift + P 
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Create still frame
 MAGIX Movie Edit Pro 16 can create a still frame
 of an object at the position of the start marker. 
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Audio cleaning
 Please see "Audio cleaning" in the "Audio
 effects" chapter 
Keyboard shortcut: Shift + W 
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Motion
 Lets you move video objects on the screen. See "Movement" in the "Video effects" chapter. 
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Section
 Places video objects in a particular part of the screen. Please read the "Video effects" chapter for more
details. 
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Attach to picture position in the video
 This can be used to attach the current video, image, or (3D) text object to a movement path in another
video object. Read more about this in the chapter "Magnetic objects
". 
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Interpolation for interlace material
 Choose this option to remove interlace artifacts from your video image
. If, for instance, you extract freeze frames from a video, ridge structures appear in sequences which
feature movement. 
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Anti-flicker filter
 Choose this option for still pictures with detailed structures and high contrast. This filter reduces line
flickering during TV playback. 
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Border cropping adjustment:
 Select this option if the edges are cropped during playback on your television. Values stored in "Movie
effects settings" ("Effects" menu
) will be applied. 
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Background design
 Select a color, a picture, or any video on your hard disk
 which you would like to serve as the background for the photo displayed. This function is especially
useful when photos have black bars around them, or if they are reduced in size. 
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Video effects
 The entries for this submenu
 are directly available in the Media Pool. 

In this section:
Load video effects
Save video effects
Reset video effects
Copy video effects
Insert video effects
Apply video effects to all
Apply video effects to all of the following

Load video effects
 This command lets you load a saved effects combination for the currently selected object. If you have
selected multiple objects, then the effects combination for each object will be applied. 
Shortcut: Alt + Shift + O 

Save video effects
 This command lets you save the current effects combination for each object separately. 
Shortcut: Alt + Shift + S 

Reset video effects
 This option allows you to deactivate all currently used effects entirely if you want to undo the changes. 
Shortcut: Alt + Shift + C 
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Load video effects
 This command lets you load a saved effects combination for the currently selected object. If you have
selected multiple objects, then the effects combination for each object will be applied. 
Shortcut: Alt + Shift + O 

Save video effects
 This command lets you save the current effects combination for each object separately. 
Shortcut: Alt + Shift + S 

Reset video effects
 This option allows you to deactivate all currently used effects entirely if you want to undo the changes. 
Shortcut: Alt + Shift + C 
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Save video effects
 This command lets you save the current effects combination for each object separately. 
Shortcut: Alt + Shift + S 

Reset video effects
 This option allows you to deactivate all currently used effects entirely if you want to undo the changes. 
Shortcut: Alt + Shift + C 

Page 646



Reset video effects
 This option allows you to deactivate all currently used effects entirely if you want to undo the changes. 
Shortcut: Alt + Shift + C 
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Copy video effects
 Effects settings for an object can be copied to the clipboard to add
 them to other objects. 
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Insert video effects
 Video effects can be added from other objects to the one selected. The settings must be copied to the
clipboard
 beforehand to do so. 

Page 649



Apply video effects to all
 The current effects settings will be applied to all scenes and photos in your movie
. 
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Apply video effects to all of the following
 The current effects settings will be applied to all scenes and photos in your movie
 which lie behind the selected object. 
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Copying objects
This function copies the selected scene (or the selected object
in Timeline mode) to the clipboard. You can then use the
"Paste" command to place it into any movie
. 

Keyboard shortcut: Ctrl + C 
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Cut objects
This function deletes the selected scene (or the selected object
in "Timeline" mode) and copies it to the clipboard. You can
then use the "Paste" command to copy it into any movie
. 

Keyboard shortcut: Ctrl + X 
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Delete objects
This function deletes the selected scene
 (or the selected object in "Timeline" mode). 

Keyboard shortcut: Del 
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Add time code
 MAGIX Movie Edit Pro 16 can add a time or date ("timecode") to the picture material. To add a
timecode, right click on the video object and choose the "Fade in date as title" option from the context
menu
. 

 If you're using a DV-AVI file (a digital recording from a camcorder, for instance), then the
recording date will be used from the selected section.

 If you're using a different file, the creation date will be used as the timecode.
The title editor is then opened in order to customize the entry. 
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Object properties
 This function displays all of the information about the currently selected objects such as file name,
position on the hard drive, tempo, etc. The object editor also defines the foreground and background
color of every object in the arrangement. Depending on the type of object, the elements displayed will
vary. 
General information
 The name of the selected object and the fore/background color for the object in unselected status can be
changed here. Additional information is also displayed about which file the selected object points to. 
Interlace/Deinterlace
 (only for video objects) 
The tab "Interlace/Deinterlace" lets you specify the interlace editing of the video material. 
Interlace properties: Normally, MAGIX Movie
 Edit Pro 16 automatically makes suitable settings for this; however, if the video material is faulty, you
may have to make some adjustments yourself. If playback of the exported movie is very jittery or if
flickering occurs, or if some effects do not look how they should, you can reverse the source material
frames. 
Deinterlace options: Normally, the setting "Automatic interlace processing
" does not have to be changed. The frames are processed separately and passed to the encoder when
exported. If necessary, MAGIX Movie Edit Pro 16 will perform high-quality interlacing. If "No interlace
processing" is set, then it is assumed that the source material contains full frames. 
For more information on interlacing, please see "Interlace
". 
Tempo/Pitch (audio
 objects only) 
If there is information about the tempo, then the tempo can be doubled or halved here. The tempo can be
detected using Tempo and beat recognition
. 
Keyboard shortcut: Ctrl + E 
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Image objects
In this section:
Create frame table (new)
Scene recognition
Edit snap point
Change photo length
Edit in MAGIX Xtreme Photo Designer
Save photos with effects
Create panorama...
Motion
Section
Attach to picture position in the video
Cut automatically to fit screen
Anti-flicker filter
Border cropping adjustment:
Background design
Export to MAGIX Online Album
Export to MAGIX Online Print Service
Video effects
Copying objects
Cut objects
Delete objects
Object properties
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Create frame table (new)
 Sometimes, rebuilding a frame table can get rid of problems in certain MPEG files. For example, such
problems can be present if the navigation (positioning of the playback marker, transport) is bumpy or
doesn't function at all.
Normally, when loading MPEG video, a frame table is not created in order to speed up the loading
process. If you do create one anyway, MPEG files are normally noticeably faster and easier to edit. 
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Scene recognition
 Calls up the automatic scene
 recognition, which "cuts up" longer videos into scenes for storage in the "Takes" directory. 
Keyboard shortcut: Shift + Z 

Page 659



Edit snap point
 If the position of objects, object borders, markers, or the playback marker is changed with the mouse,
these will automatically spring to certain "key positions" if you get close enough to them. This functions as
a "notch", i.e. even objects in a higher zoomed resolution can be precisely positioned, without any gaps,
which you wouldn't normally see in that resolution. Normally, all object borders and all markers lock to
one another. 

 Per object, one additional snap point can now be placed within an object to mark positions
where other objects should snap to. This is helpful if you want to show a title at a certain spot in a
video object, for example.

 To set a snap point, select an object and place the playback marker at the position where you
would like the snap point to be.

 Next, use "Set snap point" to set the point. Likewise, "Delete snap point" removes a snap
point. As soon as you select the option "Set snap point" at another position it will be moved
automatically.

 "Delete all snap points" deletes all snap points for all objects.
Keyboard shortcut: Alt + Shift + P 
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Change photo length
 This dialog
 gives exact values regarding the display duration for the selected photo. You may select multiple photos
beforehand to change their display duration at once. 
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Edit in MAGIX Xtreme Photo Designer
 Graphics files (BMPs or JPEGs) can be edited in MAGIX Xtreme Photo Designer. The selected image
file is loaded automatically and, once editing has been completed, is used in the MAGIX Movie
 Edit Pro 16 instead of the original material. 
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Save photos with effects
 This allows you to save photos used in the movie
 and add the object effects used in MAGIX Movie Edit Pro 16 (e.g. StoryMaker) to the photo. 
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Create panorama...
 Opens the dialog
 for setting a panorama. Place as many photos in the correct order as you like, and align brightness and
color settings to get the best results. You should make sure that the photos harmonize at the transitions. 
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Motion
 Lets you move video objects on the screen. See "Movement" in the "Video effects" chapter. 
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Section
 Places video objects in a particular part of the screen. Please read the "Video effects" chapter for more
details. 
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Attach to picture position in the video
 This can be used to attach the current video, image, or (3D) text object to a movement path in another
video object. Read more about this in the chapter "Magnetic objects
". 
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Cut automatically to fit screen
 This function ensures that images don't have black edges (in case they don't fit into the given format). 
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Anti-flicker filter
 Choose this option for still pictures with detailed structures and high contrast. This filter reduces line
flickering during TV playback. 
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Border cropping adjustment:
 Select this option if the edges are cropped during playback on your television. Values stored in "Movie
effects settings" ("Effects" menu
) will be applied. 
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Background design
 Select a color, a picture, or any video on your hard disk
 which you would like to serve as the background for the photo displayed. This function is especially
useful when photos have black bars around them, or if they are reduced in size. 
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Export to MAGIX Online Album
 Log in to the MAGIX Online Album service and load images and music into the album to share them
with your friends and acquaintances in the Internet. The assistant will lead you step-by-step through the
uploading process. After the process is finished, you can access your updated MAGIX Online Album. 
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Export to MAGIX Online Print Service
 Use MAGIX Online Print Service to order high-quality photo prints or fantastic printed photo gifts of
your valuable digital photos simply with one click. 
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Video effects
 The entries for this submenu
 are directly available in the Media Pool. 

In this section:
Load video effects
Save video effects
Reset video effects
Copy video effects
Insert video effects
Apply video effects to all
Apply video effects to all of the following

Load video effects
 This command lets you load a saved effects combination for the currently selected object. If you have
selected multiple objects, then the effects combination for each object will be applied. 
Shortcut: Alt + Shift + O 

Save video effects
 This command lets you save the current effects combination for each object separately. 
Shortcut: Alt + Shift + S 

Reset video effects
 This option allows you to deactivate all currently used effects entirely if you want to undo the changes. 
Shortcut: Alt + Shift + C 
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Load video effects
 This command lets you load a saved effects combination for the currently selected object. If you have
selected multiple objects, then the effects combination for each object will be applied. 
Shortcut: Alt + Shift + O 

Save video effects
 This command lets you save the current effects combination for each object separately. 
Shortcut: Alt + Shift + S 

Reset video effects
 This option allows you to deactivate all currently used effects entirely if you want to undo the changes. 
Shortcut: Alt + Shift + C 
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Save video effects
 This command lets you save the current effects combination for each object separately. 
Shortcut: Alt + Shift + S 

Reset video effects
 This option allows you to deactivate all currently used effects entirely if you want to undo the changes. 
Shortcut: Alt + Shift + C 
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Reset video effects
 This option allows you to deactivate all currently used effects entirely if you want to undo the changes. 
Shortcut: Alt + Shift + C 

Page 677



Copy video effects
 Effects settings for an object can be copied to the clipboard to add
 them to other objects. 
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Insert video effects
 Video effects can be added from other objects to the one selected. The settings must be copied to the
clipboard
 beforehand to do so. 
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Apply video effects to all
 The current effects settings will be applied to all scenes and photos in your movie
. 
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Apply video effects to all of the following
 The current effects settings will be applied to all scenes and photos in your movie
 which lie behind the selected object. 
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Copying objects
This function copies the selected scene (or the selected object
in Timeline mode) to the clipboard. You can then use the
"Paste" command to place it into any movie
. 

Keyboard shortcut: Ctrl + C 
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Cut objects
This function deletes the selected scene (or the selected object
in "Timeline" mode) and copies it to the clipboard. You can
then use the "Paste" command to copy it into any movie
. 

Keyboard shortcut: Ctrl + X 
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Delete objects
This function deletes the selected scene
 (or the selected object in "Timeline" mode). 

Keyboard shortcut: Del 
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Object properties
 This function displays all of the information about the currently selected objects such as file name,
position on the hard drive, tempo, etc. The object editor also defines the foreground and background
color of every object in the arrangement. Depending on the type of object, the elements displayed will
vary. 
General information
 The name of the selected object and the fore/background color for the object in unselected status can be
changed here. Additional information is also displayed about which file the selected object points to. 
Interlace/Deinterlace
 (only for video objects) 
The tab "Interlace/Deinterlace" lets you specify the interlace editing of the video material. 
Interlace properties: Normally, MAGIX Movie
 Edit Pro 16 automatically makes suitable settings for this; however, if the video material is faulty, you
may have to make some adjustments yourself. If playback of the exported movie is very jittery or if
flickering occurs, or if some effects do not look how they should, you can reverse the source material
frames. 
Deinterlace options: Normally, the setting "Automatic interlace processing
" does not have to be changed. The frames are processed separately and passed to the encoder when
exported. If necessary, MAGIX Movie Edit Pro 16 will perform high-quality interlacing. If "No interlace
processing" is set, then it is assumed that the source material contains full frames. 
For more information on interlacing, please see "Interlace
". 
Tempo/Pitch (audio
 objects only) 
If there is information about the tempo, then the tempo can be doubled or halved here. The tempo can be
detected using Tempo and beat recognition
. 
Keyboard shortcut: Ctrl + E 
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Transitions
In this section:
Cut Trimmer
Settings...
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Cut Trimmer
 Shows or hides the "Cut trimmer" window. This allows you to make fine adjustments to the position of
the selected video or image objects and their handles
 ? as well as the transition characteristics (transition type, length). Please read the "Fine adjustment of
video ("Trimming")" chapter for more details. 
Keyboard shortcut: N 
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Settings...
 A dialog
 with the settings for the corresponding transition will be displayed. Depending on the transition, different
settings are available. 
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Audio objects
In this section:
Create wave form
Normalize
Reduce volume
Set volume
Audio/Video Offset
Edit snap point
Audio cleaning
Echo/Hall
Timestretch/Resample
Load audio effects
Save audio effects
Reset audio effects
Copying objects
Cut objects
Delete objects
BPM Wizard
Volume curve
Audio effects curves
Snap to other audio objects
Split stereo objects into mono objects
Display track curves
Reset track curves
Export to MAGIX Online Album
Object properties
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Create wave form
 In most cases, the waveform display of an audio
 file will not be required. However, if you require this, e.g. to navigate while cutting video, a waveform
display can be produced manually via this function. 
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Normalize
 The "Normalize audio
" function increases the level of the audio object to the maximum possible without overmodulating the
material. To do this, the largest signal peak in the audio material and the level of the object are detected
so that this point corresponds exactly to 0dB (full modulation). 
Keyboard shortcut: Shift + N 
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Reduce volume
 Please see "Reducing volume" in the audio
 effects chapter. 
Keyboard shortcut: Alt + Shift + L 
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Set volume
 This function, located in both the effects menu and the context menu, controls the sound volume for
individual objects, just like the object handles
 in the arranger. 
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Audio/Video Offset

 You can use this dialog to balance the sound & image time differences. A positive value shifts the audio
 material back, a negative value moves it forwards. 
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Edit snap point
 If the position of objects, object borders, markers, or the playback marker is changed with the mouse,
these will automatically spring to certain "key positions" if you get close enough to them. This functions as
a "notch", i.e. even objects in a higher zoomed resolution can be precisely positioned, without any gaps,
which you wouldn't normally see in that resolution. Normally, all object borders and all markers lock to
one another. 

 Per object, one additional snap point can now be placed within an object to mark positions
where other objects should snap to. This is helpful if you want to show a title at a certain spot in a
video object, for example.

 To set a snap point, select an object and place the playback marker at the position where you
would like the snap point to be.

 Next, use "Set snap point" to set the point. Likewise, "Delete snap point" removes a snap
point. As soon as you select the option "Set snap point" at another position it will be moved
automatically.

 "Delete all snap points" deletes all snap points for all objects.
Keyboard shortcut: Alt + Shift + P 
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Audio cleaning
 Please see "Audio cleaning" in the "Audio
 effects" chapter 
Keyboard shortcut: Shift + W 
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Echo/Hall
 Please see "Reverb/Echo" in the chapter "Audio
 effects". 
Keyboard shortcut: Shift + H 
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Timestretch/Resample
 Read more about this in "Timestretch/Resample
". 
Keyboard shortcut: Shift + Q 
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Load audio effects
 This command lets you load a saved effects combination for the currently selected object. If you have
selected multiple objects, then the effects combination for each objects will be applied. 
Keyboard shortcut: Ctrl + Alt + O 
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Save audio effects
 This command lets you save the current effects combination for each object separately. 
Keyboard shortcut: Ctrl + Alt + S 
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Reset audio effects
 This option allows you to deactivate all currently used effects entirely if you want to undo the changes. 
Keyboard shortcut: Ctrl + Alt + K 

Page 701



Copying objects
This function copies the selected scene (or the selected object
in Timeline mode) to the clipboard. You can then use the
"Paste" command to place it into any movie
. 

Keyboard shortcut: Ctrl + C 
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Cut objects
This function deletes the selected scene (or the selected object
in "Timeline" mode) and copies it to the clipboard. You can
then use the "Paste" command to copy it into any movie
. 

Keyboard shortcut: Ctrl + X 
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Delete objects
This function deletes the selected scene
 (or the selected object in "Timeline" mode). 

Keyboard shortcut: Del 
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BPM Wizard
 Please see "BPM wizard" in the chapter "Audio".
 Keyboard shortcut: Shift + E 
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Volume curve
 The most important object effects curve, allowing the volume to be immediately accessible. Volume is
also located in the Media Pool under "Effects -> Audio
 effects -> General", and can also be animated there. 
Keyboard shortcut: Alt + X 
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Audio effects curves
 This feature provides direct access to diverse object effects, and these can be automated using a curve.
All of the audio effects listed here are found in the Media Pool under "Effects -> Audio
 effects -> General". 
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Snap to other audio objects
 Video objects grouped with audio
 objects can be used to synchronize recordings from different camera perspectives. 
For more information, please see the topic "Synchronize video objects using the audio track". 
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Split stereo objects into mono objects
 An audio
 object in stereo format can be split into two mono objects very easily using this function. The original
track will then feature the audio object with the left channel, and an automatically added track will feature
the object with the right channel. 
This is useful if the channels were switched by accident during recording, i.e. due to incorrect cabling. In
this case, simply open the mixer and set the pan setting to the correct position for each channel. 
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Display track curves
 The most recently selected track curve is displayed on the object for editing. Use of a curve causes the
parameters set in the mixer to be disregarded. 
Note: The track curves of audio objects can be animated in the same way as video effects. Read more
about this in the chapter "Animating objects
". 
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Reset track curves
 All track curves can be reset with this function. The settings made in the mixer will be applied to the
track again. 
Caution!
 Before applying this function, make sure none of the track curves will be need in the future. 

Page 711



Export to MAGIX Online Album
 Log in to the MAGIX Online Album service and load images and music into the album to share them
with your friends and acquaintances in the Internet. The assistant will lead you step-by-step through the
uploading process. After the process is finished, you can access your updated MAGIX Online Album. 

Page 712



Object properties
 This function displays all of the information about the currently selected objects such as file name,
position on the hard drive, tempo, etc. The object editor also defines the foreground and background
color of every object in the arrangement. Depending on the type of object, the elements displayed will
vary. 
General information
 The name of the selected object and the fore/background color for the object in unselected status can be
changed here. Additional information is also displayed about which file the selected object points to. 
Interlace/Deinterlace
 (only for video objects) 
The tab "Interlace/Deinterlace" lets you specify the interlace editing of the video material. 
Interlace properties: Normally, MAGIX Movie
 Edit Pro 16 automatically makes suitable settings for this; however, if the video material is faulty, you
may have to make some adjustments yourself. If playback of the exported movie is very jittery or if
flickering occurs, or if some effects do not look how they should, you can reverse the source material
frames. 
Deinterlace options: Normally, the setting "Automatic interlace processing
" does not have to be changed. The frames are processed separately and passed to the encoder when
exported. If necessary, MAGIX Movie Edit Pro 16 will perform high-quality interlacing. If "No interlace
processing" is set, then it is assumed that the source material contains full frames. 
For more information on interlacing, please see "Interlace
". 
Tempo/Pitch (audio
 objects only) 
If there is information about the tempo, then the tempo can be doubled or halved here. The tempo can be
detected using Tempo and beat recognition
. 
Keyboard shortcut: Ctrl + E 
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Text objects
In this section:
Title Editor
Disable effects
Edit snap point
Load title template
Save as title template
Save as special effect
Convert to 3D title
Attach to picture position in the video
Border cropping adjustment:
Copying objects
Cut objects
Delete objects
Object properties

Title Editor
Opens the title editor
 for the selected photo, video, or title object. 

Keyboard shortcut: Ctrl + T 
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Disable effects
 All effects applied to the text will be deactivated. 
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Edit snap point
 If the position of objects, object borders, markers, or the playback marker is changed with the mouse,
these will automatically spring to certain "key positions" if you get close enough to them. This functions as
a "notch", i.e. even objects in a higher zoomed resolution can be precisely positioned, without any gaps,
which you wouldn't normally see in that resolution. Normally, all object borders and all markers lock to
one another. 

 Per object, one additional snap point can now be placed within an object to mark positions
where other objects should snap to. This is helpful if you want to show a title at a certain spot in a
video object, for example.

 To set a snap point, select an object and place the playback marker at the position where you
would like the snap point to be.

 Next, use "Set snap point" to set the point. Likewise, "Delete snap point" removes a snap
point. As soon as you select the option "Set snap point" at another position it will be moved
automatically.

 "Delete all snap points" deletes all snap points for all objects.
Keyboard shortcut: Alt + Shift + P 
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Load title template
 A dialog
 for loading a title template will open. 
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Save as title template
 This allows you to create your own templates using your title creations. The function "Load title
template" enables these templates to be used again quickly. 
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Save as special effect
 This function saves the title with all objects that have been grouped
 with the title object. This enables you to create title templates that contain all required overlay objects. 
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Convert to 3D title
 The title object will now be turned into a MAGIX 3D Maker object, and a limited version of MAGIX
3D Maker will open. 
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Attach to picture position in the video
 This can be used to attach the current video, image, or (3D) text object to a movement path in another
video object. Read more about this in the chapter "Magnetic objects
". 
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Border cropping adjustment:
 Select this option if the edges are cropped during playback on your television. Values stored in "Movie
effects settings" ("Effects" menu
) will be applied. 
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Copying objects
This function copies the selected scene (or the selected object
in Timeline mode) to the clipboard. You can then use the
"Paste" command to place it into any movie
. 

Keyboard shortcut: Ctrl + C 
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Cut objects
This function deletes the selected scene (or the selected object
in "Timeline" mode) and copies it to the clipboard. You can
then use the "Paste" command to copy it into any movie
. 

Keyboard shortcut: Ctrl + X 
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Delete objects
This function deletes the selected scene
 (or the selected object in "Timeline" mode). 

Keyboard shortcut: Del 
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Object properties
 This function displays all of the information about the currently selected objects such as file name,
position on the hard drive, tempo, etc. The object editor also defines the foreground and background
color of every object in the arrangement. Depending on the type of object, the elements displayed will
vary. 
General information
 The name of the selected object and the fore/background color for the object in unselected status can be
changed here. Additional information is also displayed about which file the selected object points to. 
Interlace/Deinterlace
 (only for video objects) 
The tab "Interlace/Deinterlace" lets you specify the interlace editing of the video material. 
Interlace properties: Normally, MAGIX Movie
 Edit Pro 16 automatically makes suitable settings for this; however, if the video material is faulty, you
may have to make some adjustments yourself. If playback of the exported movie is very jittery or if
flickering occurs, or if some effects do not look how they should, you can reverse the source material
frames. 
Deinterlace options: Normally, the setting "Automatic interlace processing
" does not have to be changed. The frames are processed separately and passed to the encoder when
exported. If necessary, MAGIX Movie Edit Pro 16 will perform high-quality interlacing. If "No interlace
processing" is set, then it is assumed that the source material contains full frames. 
For more information on interlacing, please see "Interlace
". 
Tempo/Pitch (audio
 objects only) 
If there is information about the tempo, then the tempo can be doubled or halved here. The tempo can be
detected using Tempo and beat recognition
. 
Keyboard shortcut: Ctrl + E 
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MAGIX 3D Maker objects
In this section:
Edit settings...
Edit snap point
Create still frame
Audio cleaning
Motion
Section
Attach to picture position in the video
Interpolation for interlace material
Anti-flicker filter
Border cropping adjustment:
Background design
Video effects
Copying objects
Cut objects
Delete objects
Add time code
Object properties
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Edit settings...
 A limited MAGIX 3D Maker version is opened to edit the selected object. 
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Edit snap point
 If the position of objects, object borders, markers, or the playback marker is changed with the mouse,
these will automatically spring to certain "key positions" if you get close enough to them. This functions as
a "notch", i.e. even objects in a higher zoomed resolution can be precisely positioned, without any gaps,
which you wouldn't normally see in that resolution. Normally, all object borders and all markers lock to
one another. 

 Per object, one additional snap point can now be placed within an object to mark positions
where other objects should snap to. This is helpful if you want to show a title at a certain spot in a
video object, for example.

 To set a snap point, select an object and place the playback marker at the position where you
would like the snap point to be.

 Next, use "Set snap point" to set the point. Likewise, "Delete snap point" removes a snap
point. As soon as you select the option "Set snap point" at another position it will be moved
automatically.

 "Delete all snap points" deletes all snap points for all objects.
Keyboard shortcut: Alt + Shift + P 
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Create still frame
 MAGIX Movie Edit Pro 16 can create a still frame
 of an object at the position of the start marker. 
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Audio cleaning
 Please see "Audio cleaning" in the "Audio
 effects" chapter 
Keyboard shortcut: Shift + W 
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Motion
 Lets you move video objects on the screen. See "Movement" in the "Video effects" chapter. 
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Section
 Places video objects in a particular part of the screen. Please read the "Video effects" chapter for more
details. 
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Attach to picture position in the video
 This can be used to attach the current video, image, or (3D) text object to a movement path in another
video object. Read more about this in the chapter "Magnetic objects
". 
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Interpolation for interlace material
 Choose this option to remove interlace artifacts from your video image
. If, for instance, you extract freeze frames from a video, ridge structures appear in sequences which
feature movement. 
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Anti-flicker filter
 Choose this option for still pictures with detailed structures and high contrast. This filter reduces line
flickering during TV playback. 
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Border cropping adjustment:
 Select this option if the edges are cropped during playback on your television. Values stored in "Movie
effects settings" ("Effects" menu
) will be applied. 
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Background design
 Select a color, a picture, or any video on your hard disk
 which you would like to serve as the background for the photo displayed. This function is especially
useful when photos have black bars around them, or if they are reduced in size. 
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Video effects
 The entries for this submenu
 are directly available in the Media Pool. 

In this section:
Load video effects
Save video effects
Reset video effects
Copy video effects
Insert video effects
Apply video effects to all
Apply video effects to all of the following

Load video effects
 This command lets you load a saved effects combination for the currently selected object. If you have
selected multiple objects, then the effects combination for each object will be applied. 
Shortcut: Alt + Shift + O 

Save video effects
 This command lets you save the current effects combination for each object separately. 
Shortcut: Alt + Shift + S 

Reset video effects
 This option allows you to deactivate all currently used effects entirely if you want to undo the changes. 
Shortcut: Alt + Shift + C 
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Load video effects
 This command lets you load a saved effects combination for the currently selected object. If you have
selected multiple objects, then the effects combination for each object will be applied. 
Shortcut: Alt + Shift + O 

Save video effects
 This command lets you save the current effects combination for each object separately. 
Shortcut: Alt + Shift + S 

Reset video effects
 This option allows you to deactivate all currently used effects entirely if you want to undo the changes. 
Shortcut: Alt + Shift + C 
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Save video effects
 This command lets you save the current effects combination for each object separately. 
Shortcut: Alt + Shift + S 

Reset video effects
 This option allows you to deactivate all currently used effects entirely if you want to undo the changes. 
Shortcut: Alt + Shift + C 
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Reset video effects
 This option allows you to deactivate all currently used effects entirely if you want to undo the changes. 
Shortcut: Alt + Shift + C 
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Copy video effects
 Effects settings for an object can be copied to the clipboard to add
 them to other objects. 
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Insert video effects
 Video effects can be added from other objects to the one selected. The settings must be copied to the
clipboard
 beforehand to do so. 
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Apply video effects to all
 The current effects settings will be applied to all scenes and photos in your movie
. 
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Apply video effects to all of the following
 The current effects settings will be applied to all scenes and photos in your movie
 which lie behind the selected object. 
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Copying objects
This function copies the selected scene (or the selected object
in Timeline mode) to the clipboard. You can then use the
"Paste" command to place it into any movie
. 

Keyboard shortcut: Ctrl + C 
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Cut objects
This function deletes the selected scene (or the selected object
in "Timeline" mode) and copies it to the clipboard. You can
then use the "Paste" command to copy it into any movie
. 

Keyboard shortcut: Ctrl + X 
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Delete objects
This function deletes the selected scene
 (or the selected object in "Timeline" mode). 

Keyboard shortcut: Del 
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Add time code
 MAGIX Movie Edit Pro 16 can add a time or date ("timecode") to the picture material. To add a
timecode, right click on the video object and choose the "Fade in date as title" option from the context
menu
. 

 If you're using a DV-AVI file (a digital recording from a camcorder, for instance), then the
recording date will be used from the selected section.

 If you're using a different file, the creation date will be used as the timecode.
The title editor is then opened in order to customize the entry. 
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Object properties
 This function displays all of the information about the currently selected objects such as file name,
position on the hard drive, tempo, etc. The object editor also defines the foreground and background
color of every object in the arrangement. Depending on the type of object, the elements displayed will
vary. 
General information
 The name of the selected object and the fore/background color for the object in unselected status can be
changed here. Additional information is also displayed about which file the selected object points to. 
Interlace/Deinterlace
 (only for video objects) 
The tab "Interlace/Deinterlace" lets you specify the interlace editing of the video material. 
Interlace properties: Normally, MAGIX Movie
 Edit Pro 16 automatically makes suitable settings for this; however, if the video material is faulty, you
may have to make some adjustments yourself. If playback of the exported movie is very jittery or if
flickering occurs, or if some effects do not look how they should, you can reverse the source material
frames. 
Deinterlace options: Normally, the setting "Automatic interlace processing
" does not have to be changed. The frames are processed separately and passed to the encoder when
exported. If necessary, MAGIX Movie Edit Pro 16 will perform high-quality interlacing. If "No interlace
processing" is set, then it is assumed that the source material contains full frames. 
For more information on interlacing, please see "Interlace
". 
Tempo/Pitch (audio
 objects only) 
If there is information about the tempo, then the tempo can be doubled or halved here. The tempo can be
detected using Tempo and beat recognition
. 
Keyboard shortcut: Ctrl + E 
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Program settings
All basic settings for MAGIX Movie
 Edit Pro 16 are made in this window. This allows you to
influence the settings in MAGIX Movie Edit Pro 16 in detail. 

Keyboard shortcut: P 
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Play

 Audio playback
 Driver selection WAV/Direct Sound: Here you can specify whether you wish to use the standard
Windows driver for the sound card or the DirectSound driver. DirectSound has the advantage that the
sound output (for all modern sound cards or onboard sound chips) can also be used by other programs
open simultaneously. WAV drivers are recommended if the CPU
 load is higher, as the larger buffers allow better handling of the load peaks (otherwise this would cause
crackling). 
Output device: Use this option to specify which sound card plays the wave
 audio objects. This is especially important if you have multiple sound cards installed on your computer,
e.g. "onboard sound" as well as an additional sound card. 
Audio buffer: In order to allow smooth playback of a complex arrangement, MAGIX Movie
 Edit Pro 16 creates a RAM data buffer into which the current data is loaded. Therefore it is not the
entire arrangement that is pre-processed; far more, processing occurs step-by-step. 
Multi-track audio buffer/preview audio buffer: 
Here you can specify the size of the buffer that should be used for playback of the entire arrangement or
for previewing waves in the file manager. 
Number of buffers: Here you can specify how many buffers you want to us. More buffers increase the
safety for crackle-free playback of the arrangement, but also increase the memory requirement. If played
via Direct Sound (see Settings in the "Playback parameter" dialog
), only one buffer is automatically used. 
Note:
 If response and loading times are too slow, reduce the buffer size; otherwise increase the buffer size if
the audio playback is choppy or if real-time errors occur. As error-free playback is usually more
important than fast reaction times, the buffer size should be raised to 16384 or 32768 if dropouts occur.
The possible number of buffer updates is between 2 an 10. 
Write realtime audio to wave file:
 If this option is activated, the entire soundtrack can be mixed live and recorded simultaneously. During
playback, for example, you can therefore control mixer fades and effects live. All realtime activities are
recorded and saved in a separate WAV file. 
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MIDI playback
 With MIDI device you can specify which soundcard or which MIDI interface should be used for MIDI
playback. 

Video playback parameters
 Video cache size:
 The video cache ensures a smooth on-screen playback of files and effects by preloading them. The ideal
setting depends on your system. It is best to experiment to see what results in the best playback
performance. 

Arranger
 Autoscroll during playback:
 If autoscroll is activated, the screen view automatically shifts when the playback cursor reaches the right
edge of the screen, which is particularly useful for longer arrangements. You may select the size of the
scrolling steps from either "Fast" (whole pages) or "Slow" (half pages). 
Warning:
 Scrolling requires constant recalculation of the screen view, which may lead to interrupted playback if
the amount of system RAM is too low. If this does happen, then you should deactivate autoscroll. 
Display: Displaying objects in timeline mode allows your to simplify the performance enhancement. You
can decide whether to display preview frames for video objects across the entire object, or just for the
first and last frames. For audio objects you can hide the wave form display. This is particularly
recommended for MPEG
 data streams. 
Update in background:
 The update if the object display after move and zoom operations in the arranger is performed in the
background in order to let you work smoothly. 
Image playback: Resizing high-quality image material: You can use this feature to improve the quality
when resizing, particularly downsizing to less than half of the original size as in picture-in-picture effects.
This also requires more CPU
 power. 
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Directory settings

 Set the paths where 
 the projects are saved
 imported and exported data and recordings are stored
 exported (Export) and imported (Import) files and recordings (Recordings) and virtual VCR

recordings (TV recordings) are stored
 temporary files are stored (which are needed for regular operation)
 the EXE files for external audio and the image editor are located, which can be started via the

context or effects menu (PLUS version only)
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Video/Audio
 In this tab you will find all settings concerning video and audio
 files. 

Video standard
 PAL is used in Europe, the US and Japan use NTSC. 

Movie display
 The resolutions that can be set here concern only the picture display in the Arranger. If playback
becomes jerky, we recommend entering a lower value. The quality of exported videos is not influenced
by this. 
Automatic interlace processing: MAGIX Movie Edit Pro 16 normally detects whether the loaded video
files were recorded with the interlace or progressive processes automatically, and half-image format is
detected for interlaced movies. In case automatic detection fails, you can deactivate it here and set the 
object properties
 of video objects to the correct process. 

Video options
 Extract sound from video: If a video file contains video and audio data the audio track of the video
will also be imported if this option is activated. It will be displayed as an audio object in the arrangement
below the video object. Both are automatically grouped together. If the audio track has to be edited or
replaced later, you first have to ungroup it ("Ungroup" button in the tool bar or via the "Edit" menu
). 
Allow user-defined names for sound extracted from VOBs:
 Specifies whether a warning will be displayed for each imported file during VOB import
(VTS_01_1.vob) allowing you to enter a name for your movie (check box "checked") or whether you
would like an automatically generated name to be assigned (check box "unchecked"). 
Automatically copy exported material to clipboard: This option is particularly useful when used with
other programs, such as Microsoft Powerpoint. If activated, a multimedia file you have just created is
immediately copied to the clipboard
 and can be used in other applications. For instance, you can insert it into an opened MS Powerpoint
template by pressing "Ctrl + V". 
Adjust 4:3 aspect ratio to screen:
 This option automatically customizes photos that have an approximate 4:3 aspect ratio to the television's
4:3 picture. The pictures are therefore easily stretched or compressed. This inevitably brings about
distortions in the picture. If this option is deactivated, black bars appear to the sides. 
Automatically preview exported clips
: This option starts the clip immediately after exporting for verification. 
Automatically load/save picture effects from JPX file
: If you have edited pictures using another MAGIX program (e.g. MAGIX Digital Photo Maker), then a
.jpx description file is saved along with the image which contains information about effects editing and
texts. This option adds that information into your editing process. 
Use picture effects when exporting to MAGIX Online Services
: If this option is selected, all the picture effects are included with the sent file. 
Hardware acceleration for 3D effects: Here you can (de)activate hardware acceleration of your
graphics card for 3D effects. You can find more information about this topic in the 3D fades
 chapter. 
Automatically create frametable during importing: Sometimes, rebuilding a frame table can get rid of
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problems in certain MPEG files. For example, such problems can be present if the navigation (positioning
of the playback marker, transport) is bumpy or doesn't function at all.
Normally, when loading MPEG video, a frame table is not created in order to speed up the loading
process. If you do create one anyway, MPEG files are normally noticeably faster and easier to edit. 
Reduce bitmap resolution for preview:
 The resolution of image files is reduced during playback to decrease required memory. This requires less
computing power than playback in full resolution; full resolution is always calculated during export. 
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System

 Dialogs: In its newly installed state, MAGIX Movie Edit Pro 16 displays a number of security queries
in various parts of the program. Each one can be switched off by clicking the small box at the bottom that
says "Don't show this message again". To display these warning messages select the Reactivate dialogs
 option. 
Import formats: You can unselect file formats that you never use, and these will no longer be imported.
Please keep in mind that for some file types (AVI, WMA) several import modules exist, and MAGIX
Movie Edit Pro 16 uses the fastest one in each case. If you experience problems during the import of
certain files, you can experiment with deactivation of certain import modules, forcing the program to use
the slower, but more compatible
 import module. 
Start file preview for...:
 Unselects automatic file preview start for Media Pool files and certain file types. 
Still frame duration:
 Specifies how long a still frame will be shown normally during BMP or JPEG file import. For single
frame sequence import select the duration of 1 frame. 
Save interval:
 The interval at which autosave projects will be periodically saved. 
Layout: Determines whether MAGIX Movie Edit Pro 16 should start with the Import or the Edit
 interface. 
Automatic preview during transition switch:
 Ifthis option is activated a short preview of the transition effect will be quickly played between two
photos when you select a new transition. 
Use Title Editor with high resolution as default:
 The Title Editor is used in high resolution by default. The representation of titles is improved, but this also
results in a longer loading time for movies. 
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Display templates

 These presets provide a collection of useful configurations for display on the monitor. On systems with
only a single connected monitor, only the first two are practical. The presets are explained on the right
side of the dialog
. All window properties of the arranger, program monitor, etc. can still be changed manually after the
application of a preset. 
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Display options

 Video output to DV device
 Video output on a DV device: This option displays your arranger view on your TV via your DV
camera. This is useful if your graphics card doesn't have a TV output. However, since your PC must then
compress the video signal in real time in DV-AVI
 format and in addition to processing all real-time effects, so you need to have a powerful PC for
jitter-free playback. Even if your computer is not particularly powerful, you can still use this function to
see how your video looks on your TV screen, since the analog video output signal of a good DV camera
is better than the TV output of an average graphics card. 

Playback in the Arranger/Preview and playback in video
recorder
 You can set the playback mode separately for the arranger (including all preview windows and effect
dialogs), and the preview monitors during recording and in the video recorder. 

Video mode
 Standard playback (video for windows):
 This is the standard mode that functions on all systems. 
Direct 3D (hardware mixer):
 This mode provides an extreme increase in speed by letting the mixing, many effects, and various
transitions be calculated directly on the graphics card. Depending on the graphics card, performance can
increase by 300%. The graphics card will not be used during export. 
Note: To use this mode the graphics card must posses at least 128 MB own memory. You will need to
install Direct 3D 9 or higher, and the graphics card driver must support "High Level Pixel Shader
Language 2.0". MAGIX Movie
 Edit Pro 16 checks the corresponding properties when this mode is selected, and switches it off if
necessary. 
Standard mode (overlay mixer): In this mode you can use a hardware-like de-interlacing for the
output on your PC screen or progressive scan-capable projector. Playback of recordings with interlace
 turns out much better. 
Alternative mode (video mixing renderer 9): This mode uses the hardware de-interlacing function of
modern graphics cards together with DirectX 9. Make sure that you are using the most recent version of
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your graphics card driver, which must be compatible
 with DirectX 9 to function properly. This mode works better than the standard mode (overlay mixer)
only for a few graphics card models. 

Image formation in Vertical Blank Intervals (VBI)
 The image
 formation takes place in the vertical blank intervals of the monitor signal (or the connected TV signal).
This helps avoid image interruptions. Warning: Because of the necessary waiting time on the next VBI,
this process adds significant computation time! 
You can deactivate this option for digital displays such as TFT monitors. In "Overlay" mode, image
 formation occurs exclusively via VBI. 

Acceleration for high-resolution MPEG2 files
 This option can be selected only in the "Hardware acceleration (Direct 3D)" video mode and indicates
that videos in MPEG
-2 format will be processed directly from the graphics card GPU. Depending on the graphics card
performance, an improvement of up to 300% can be achieved! 

De-interlacing
 In the DirectShow modes "Overlay mixer" and "Video mixing renderer 9", you can activate hardware
de-interlacing with your graphics card. For general information on de-interlacing and the options
"Top/Bottom field first", please read the corresponding article "De-interlacing
". 
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Problems and solutions
In this chapter
File will not load
Choppy or uneven playback
Problems and Remedies regarding the Auto Remix Assistant
Activation problems
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File will not load
 If files cannot be loaded, this means that the format is either no supported by MAGIX Movie Edit Pro
16 and the corresponding codec must first be activated. Read the section "Import formats" or "Activate
additional functions
". 
In case of AVI files, it is possible that the necessary codec in not installed. For more, please refer to "
General tips for AVI videos
" in the appendix "Digital video and storage devices". 
Tip
: To find out which codecs are used in the movie file, different help programs are available. An example
for this is "GSpot" or "AVIcodec". 
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Choppy or uneven playback
 Don't panic if the picture on your screen is choppy or uneven. The finished product will look perfect and
play smoothly. Don't forget that MAGIX Movie
 Edit Pro 16 calculates all effects in real time. This lets you see for yourself what sort of influence each of
the effects will have on your video footage. Some effects make even today's high-performance PCs work
quite hard, and often, a steady, continuous video stream is simply not possible on your PC. The final
product, free from previous choppiness, is only available after rendering it to DVD or exporting it. For
that reason, you should first edit the movie in its raw version without effects. The preview generally
delivers a steady picture, allowing you to work quickly and quietly. Towards the end, you can add effects
to your movies to give them a special touch of Hollywood! 
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Problems and Remedies regarding the Auto
Remix Assistant
 Problem: 
The playback stutters, the metronome is suspended, the computer is overloaded... (on older computers.) 
Remedy: We recommend changing to wave drivers ("P" key, "Playback parameter" dialog
) instead of DirectSound. 
Problem: 
The metronome does not work and there are no lines on the the wave-shaped display. 
Probable cause:
 The material does not contain beats or the song contains a passage without beats. 
Remedy: 
The song should be limited in such a way that only rhythmic passages are contained. 
Possible 2nd reason:
 Inaccurate tapping or a false BPM value has been entered. 
Remedy: 
Try the tempo correction buttons or tap until the "locked" condition is attained. 
Problem: The metronome sounds inaccurately or is jerky, the lines in the wave
-shaped display are irregular and thinly drawn. 
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Activation problems 
Problem:
 The entered code is incorrect (telephone activation) 
Make sure your entry is correct; in most cases a typo is to blame.
If the code is entered correctly, dial the number of our Call Center. Our coworkers will gladly help you. 
The MAGIX website won't open
 Check your Internet connection; you may have to use manual dial-up. 
The form for ordering via post/fax won't open

  Check that an adequate text editing program is installed and activated (for example, MS Word).
I still haven't received an email with the activation code

  Check that your inbox isn't full.
 Have a look in your spam folder.

You can always send questions via email to our support whenever you like. Please have the following
information at hand so that we can assist you as quickly and as specifically as possible. 

 Complete product name
 Exact version number (to be found in the about box in the "About" menu item of the "Help"

menu)
 Encoder/Decoder name
 Your user code (accessible via the "Activate via post/fax" dialog)

Problem: I installed my MAGIX program onto my new computer or built a new hard disk
 (sound card, memory...) into my old computer. Now my activation code is no longer accepted. 
Activation is linked to a specific computer. Changes to the computer's hardware, for example, integrating
a larger hard disk can lead to the computer no longer being recognized as the one for which the activation
code has been calculated. This will most likely happen if you install MAGIX Movie Edit Pro 16 on a new
computer. If this is the case, simply request a new activation code. Since you're already registered as a
MAGIX customer, you won't have to pay for another activation.
Online: When registering on the MAGIX website use your existing MAGIX login details.
Post/fax:
 Print out the order form again and send it to the address or fax number stated. 
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Online functions
In this chapter
Integrated browser
MAGIX News Center
Online
Embed Flash videos into your own web page
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Integrated browser
 The integrated browser offers many useful functions that help you collect material for using in your
project
. All kinds of media can be collected ? images, videos, sound or simply text can be all integrated using the
built-in browser with great results. 
Tip: You must have an Internet connection to use the full range of options offered by the integrated
browser
. 

Open browser
The integrated browser is opened by
clicking on the "Internet media" button
 in the Media Pool (see Media). 

Navigation in the browser
One page back:
 Switches to the previous page. 
One page forward: Switches back to the page before the
"One page back" button
 was pressed. 
Stop:
 Stops loading the selected page. 
Reload:
 The current page will be reloaded. 
Home:
 Returns to the home page. 

In the address header, next to the navigation buttons, you can simply enter an Internet address like http://
www.magix.com. Press the enter button
 and the corresponding page will be loaded. 

Loading Internet media
 The buttons described here are used to collect and load media directly from the Internet into the current
film. The corresponding functions can be found in the context menu of the browser
. 

Save selected text: The selected text will be saved. It can
then be edited using the title editor
. 
Start screen capture: Opens the capture dialog
 for starting screen capture. 
Download selected images:
 The selected images will be saved to your computer. 
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Import screen capture of the opened Internet page:
The loaded Internet page will be saved as an image
 file. 
Start audio recording:
 A dialog for audio recording opens. 
Hint:
 For recording from the Internet, it is important that the
sound card is selected as the sound source. 

Accept media after download
 This option makes sure that the downloaded media are loaded into the current movie
 right away. 

Define the path for saving Internet media.
 To define the path for saving Internet media, simply click on the folder symbol and navigate to the
desired folder. Confirm your selection with OK. 
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Open browser
The integrated browser is opened by
clicking on the "Internet media" button
 in the Media Pool (see Media). 

Navigation in the browser
One page back:
 Switches to the previous page. 
One page forward: Switches back to the page before the
"One page back" button
 was pressed. 
Stop:
 Stops loading the selected page. 
Reload:
 The current page will be reloaded. 
Home:
 Returns to the home page. 

In the address header, next to the navigation buttons, you can simply enter an Internet address like http://
www.magix.com. Press the enter button
 and the corresponding page will be loaded. 

Loading Internet media
 The buttons described here are used to collect and load media directly from the Internet into the current
film. The corresponding functions can be found in the context menu of the browser
. 

Save selected text: The selected text will be saved. It can
then be edited using the title editor
. 
Start screen capture: Opens the capture dialog
 for starting screen capture. 
Download selected images:
 The selected images will be saved to your computer. 
Import screen capture of the opened Internet page:
The loaded Internet page will be saved as an image
 file. 
Start audio recording:
 A dialog for audio recording opens. 
Hint:
 For recording from the Internet, it is important that the
sound card is selected as the sound source. 

Accept media after download
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 This option makes sure that the downloaded media are loaded into the current movie
 right away. 

Define the path for saving Internet media.
 To define the path for saving Internet media, simply click on the folder symbol and navigate to the
desired folder. Confirm your selection with OK. 
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Navigation in the browser
One page back:
 Switches to the previous page. 
One page forward: Switches back to the page before the
"One page back" button
 was pressed. 
Stop:
 Stops loading the selected page. 
Reload:
 The current page will be reloaded. 
Home:
 Returns to the home page. 

In the address header, next to the navigation buttons, you can simply enter an Internet address like http://
www.magix.com. Press the enter button
 and the corresponding page will be loaded. 

Loading Internet media
 The buttons described here are used to collect and load media directly from the Internet into the current
film. The corresponding functions can be found in the context menu of the browser
. 

Save selected text: The selected text will be saved. It can
then be edited using the title editor
. 
Start screen capture: Opens the capture dialog
 for starting screen capture. 
Download selected images:
 The selected images will be saved to your computer. 
Import screen capture of the opened Internet page:
The loaded Internet page will be saved as an image
 file. 
Start audio recording:
 A dialog for audio recording opens. 
Hint:
 For recording from the Internet, it is important that the
sound card is selected as the sound source. 

Accept media after download
 This option makes sure that the downloaded media are loaded into the current movie
 right away. 

Define the path for saving Internet media.
 To define the path for saving Internet media, simply click on the folder symbol and navigate to the
desired folder. Confirm your selection with OK. 
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Loading Internet media
 The buttons described here are used to collect and load media directly from the Internet into the current
film. The corresponding functions can be found in the context menu of the browser
. 

Save selected text: The selected text will be saved. It can
then be edited using the title editor
. 
Start screen capture: Opens the capture dialog
 for starting screen capture. 
Download selected images:
 The selected images will be saved to your computer. 
Import screen capture of the opened Internet page:
The loaded Internet page will be saved as an image
 file. 
Start audio recording:
 A dialog for audio recording opens. 
Hint:
 For recording from the Internet, it is important that the
sound card is selected as the sound source. 

Accept media after download
 This option makes sure that the downloaded media are loaded into the current movie
 right away. 

Define the path for saving Internet media.
 To define the path for saving Internet media, simply click on the folder symbol and navigate to the
desired folder. Confirm your selection with OK. 
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Define the path for saving Internet media.
 To define the path for saving Internet media, simply click on the folder symbol and navigate to the
desired folder. Confirm your selection with OK. 
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MAGIX News Center
MAGIX can supply you with all of the latest information about
your software
. In the MAGIX News Center, you will find all of the links to
current online tutorials as well as tips & tricks on individual
topics or software application examples. 

You will also be informed of the availability of brand new updates and patches for your program as well
as special offers, contests, and surveys. 
The news is split into three color-coded sections: 

 Green for practical tips & tricks for your software
 Yellow reports the availability of new patches and updates for your product
 Red for special offers, contests, and surveys
 And if there are no new messages, then the button will be grey

All available information is shown as soon as you click on MAGIX News Center. If you click on one of
the news items you will be forwarded to the corresponding website. 
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Online
 MAGIX Online World offers a wide range of online services for digital photography, video, music,
media backup/security, and connecting desktop PCs with mobile handsets and the web. 
For more information, please go to the menu
 Online > MAGIX Online World overview or surf to the MAGIX Online World website. 
In this section:
Catooh – the Online Content Library
MAGIX Online Album
MAGIX Online Print Service
magix.info
More online services
MAGIX Screenshare
Online login details
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Catooh – the Online Content Library
 Catooh provides you with high-quality photos, videos, and music for every theme, expanded by
intelligent iContent with professional Soundpools, DVD menu templates, and brilliant MAGIX
ShowMaker styles to help you make your photo, video, and music projects reality. All of this is available
directly from your MAGIX software
. 
Just choose "Online" from the menu "Catooh" to set up an Internet connection. 
Browse through the thematically sorted categories or view the results directly by entering a keyword.
After downloading, you can drag the objects from the Media Pool directly into your arrangement. 
Tip: Read the introduction online
! 

Import media backup
 iContent (for example, 3D transitions) which you buy and download from Catooh is stored directly in
your central My files\MAGIX Downloads\Backup directory. If you have downloaded these files from
other MAGIX programs, then you can use the command "Import media backup" to make them
accessible for use in MAGIX Movie
 Edit Pro 16. 
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MAGIX Online Album
 Impress your friends and family in minutes with your own photos and videos as your own your personal
photo & video website: http
://first_name.last_name.magix.net. 
MAGIX Online Album lets you put your favorite photos online directly from within MAGIX products
like MAGIX Movie
 Edit Pro 16, or mobile phones with built-in cameras, and then send a link to them to your friends via
email. All photos are immediately available from anywhere in the world on a professionally-designed
photo website, in well-organized photo galleries, as full-screen slideshows, or in the form of a personal
photo e-card. 

 Personalized album website in many designs,
 unique Internet address (URL),
 upload your pictures directly from a camera phone, send the link, and share the picture with other

camera phone users,
 full-screen online slideshows with fade effects and music,
 send individual designer e-cards with your own photos,
 Share your photos with friends, including address management and password protection for

private albums.
MAGIX Online Album is available in three versions, of which the smallest (the FREE album with 500
MB webspace for your photos) is entirely free. 
The larger versions (CLASSIC or PREMIUM) are available for a monthly charge, but also come with
many handy features, such as a faster website, 2 GB or 5 GB storage space, more website designs or
access by mobile phone/PDA. More information about prices and features is available at 
http://www.magix-photos.com
. 
Upload images from slideshow

1.  Select still image and place the start marker at the position of the image which you want to
upload from your slideshow.

2. Then, select "Online -> MAGIX Online Album -> Load image from slideshows" in the menu. 
In order to upload photos to your MAGIX Online Album, simply log in using your email address.
Naturally, access is protected via your personal password. If you still don't have a password, click on "
Register now
". 
Using your MAGIX Online Media Manager
, you can quickly manage your photo website, upload photos and music, create new albums, add designs
and text, and much more. 
Using "Upload movie as video
" you can present your slideshow with fades, music, and all other effects as a playable video in the
Internet. 

1. Design your slideshow.
2. Save your movies, and then under "<Service_name_OFA>" select "Online -> Upload slideshow

as video". 
Now you just have to follow the instructions on the screen to finish the upload process. 
Upload slideshow as audio
: With this option, you can present only the audio of your slideshow in your online album. 

1. Design your slideshow.
2. Save your movies, and then under "<Service_name_OFA>" select "Online -> Upload audio

from slideshow". 
Now you just have to follow the instructions on the screen to finish the upload process. 
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The following options are also available: 
Send e-cards and photo emails
 Send your photos as unique ecards with great designs or as a photo email to your friends and family. 
Order photo prints and gifts
 Order paper prints or great photo gifts from MAGIX Online Album and have them delivered directly to
your home, or pick them up from a photo lab in your area. Delivery time is usually just 2 - 3 days. More
about MAGIX Online Print Service
 You can also read the FAQ (frequently asked questions) on the Internet.
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MAGIX Online Print Service
 MAGIX Online Print Service lets you order paper prints and photo gifts (t-shirts, mugs, etc.) directly
from within MAGIX programs such as MAGIX Movie Edit Pro 16 or via www
.magix.com. Upload your photos with a click and have the developed photos delivered to your home
within days. 

Order photo prints and gifts
 Order real paper prints or great photo gifts straight from your MAGIX Online Album and have them
delivered directly to your home or pick them up (no shipping costs) from your nearest photo developer. 
Delivery usually takes 2 - 3 days. 
More about MAGIX Online Print Service

  Order your valuable digital photos in impressive quality on premium photo paper from a digital
photo printing specialist 

 Brilliant prints on premium photo paper in all formats
 Impressive picture quality; true-to-color for up to 100 years
 Huge selection of great photo gifts (t-shirts, mugs, calendars, and much more)
 Includes MAGIX Photo Manager for conveniently ordering your photos
 Real prints and great photo gifts of your digital pictures ? it's that easy

1. Select photos
 Take your time and select your favorite photos from the program and optimize them for best results.
Remove redeye, enhance colors and contrast, and much more. All offline and on your PC! 
Then simply select MAGIX Online Print Service from the "Online" menu
 and "Send selected". 

2. Select format and quantity
 Now select the desired number and the image
 format (e.g. 10x15) or photo gift (mug, t-shirt). Do you have a voucher? Then click on "Use voucher"
and enter your voucher code. 

3. Specify zoom
 One great option is the crop function for your prints. To use it click on the button
 "Edit photo". Here you can set the format (small 2:3 or digital 3:4) you would like for your photos. 
You can see how your photo prints will look in the preview window. Using the selection frame
 you can crop your photos individually. 

4. Submit order
 Once you have made all your settings click on the "Submit order" button
. Now all you have to do is enter your details and the type of delivery. Your order will now be
dispatched online. 
You will now receive an order confirmation by email including a link where you can find up-to-date
information about your order anytime. 
Delivery straight to your doorstep
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 Have your prints and photo gifts conveniently delivered straight to your doorstep or pick them up from a
photo retailer close to you to save postage. Orders usually take 2-3 days. 
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magix.info
 Share your knowledge & get answers
 This MAGIX service offers you and the MAGIX Community at large a central platform for exchanging
knowledge, photos, videos, and music, for discussing and evaluating, for communicating with one
another, for presenting yourself, and networking with other members. 

You will find the sections "Questions & Answers", "Show & Discuss", "Online Training", and "Chat"
where you can play an active or passive role in the MAGIX Community. For this there's not only the 
www.magix.info
 portal, but magix.info directly in your product. 
Ask questions online
 If you have questions or problems with your MAGIX program or you're looking for tips & tricks
concerning multimedia, then you're at the right place. 
Display all questions & answers...
 Use the questions which other community members have asked and the collective knowledge of the
answers to improve your own working methods, to solve problems, and to get to know the details of
MAGIX Movie
 Edit Pro 16. 
Launch the online training center
 Learn not only theoretically, but also practically what the program is capable of: "learning by doing",
quickly and uncomplicated. 
Let your friends view the contents of your MAGIX.info screen over the Internet on their PCs.
 Ideal for viewing photos and videos together or for receiving support for questions arising during your
creative workflow while using the program (a licensed client will be installed for this purpose). 
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More online services
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MAGIX Website Maker
 Not only is Internet surfing easy! Thanks to MAGIX Website Maker creating websites also becomes
child's play! 
This service offers:

  Your desired domain (www.desiredname.com) and a subdomain (http
://your-name.magix.net/website).

 250 MB memory space with 5 email accounts, 1 GB each.
 Website Maker with website templates, intros. Also animations, text effects, form and design

objects, picture and graphic templates, and buttons. And everything without any ad banners!
 Photo (*.jpeg), video (*.wmv) & music (*.mp3) options.
 Additional software: MAGIX web mail for managing your email inbox. 

MAGIX Website Maker offers 3 months of free, non-binding service. This way, you have enough time
to find out everything about MAGIX Website Maker and all existing possibilities for editing and
managing your homepage. 
MAGIX Website Maker offers everything for the perfect Flash® website:

  Design templates: Numerous high-quality website templates in the latest professional Flash®

design with pre-finished, customizable subpages, start pages, profile pages, photo pages, video
pages, and much more. 

 Text & text effects: Freely positionable text fields with fantastic fonts and animated text effects
can be added and individually formatted with ease. 

 Multimedia content: Select your favorite photos, spectacular slideshows, videos and an online
video player with your own background music, or integrate it all as an online music player with
playlists.

 Decorative elements: Attractive design objects, plenty of vector shapes, background images,
buttons, and much more offer more possibilities for designing unique websites than ever.

 Animation objects: Large selection of dynamic, impressive animation objects for breathtaking,
moving websites.

 Links: Easily add links to your own or external websites. 
 Top extras: Enhance your website with a visitor counter, guest book, contact form, and many

other useful extras.
Export function
: Conveniently add individual components of your website (e.g. video player, slideshow, online music
player) or even the entire website to external sites as an embedded website. 
Proceed as follows:
 After registering your desired domain, you can start creating your website right away. 

1. First, select a design for your website in MAGIX Website Maker
2. If you would like to place an intro (start animation) at the start of your domain, select your intro

as a next step.
3. Now you can replace the mock text with your own text as you see fit. All free-standing elements

on all webpages can also be moved as you please. To do so, click to select the element and
move it using your mouse.

4. Once everything is just how you want it, you can put your page online, so that your domain can
be accessed. 

MAGIX Blog Service
 With MAGIX Blog Service, YOU make the news! Share your thoughts, experiences, and news with a
worldwide audience in no time using your own interactive online multimedia journal. Invite family, friends,
and acquaintances to join in and enter their comments! A free MAGIX Online Album belongs to the
MAGIX Blog Service so that you always have full control over your contributions. 
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You can also read the FAQ (frequently asked questions) on the Internet.
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MAGIX Podcast Service
 Podcasts are quickly becoming the medium of choice, since everyone who can record audio
 files (music, readings, radio plays, and news) and put them online can now also offer them as podcasts. 
Since podcasts are not webstreams (like webradio), but are rather offered as downloads, radio stations,
newspapers, and magazine companies often use them to provide their broadcasts as repeats in podcast
form. New releases from record labels and, most of all, ones from purely Internet-based labels can also
be listened to as podcasts. 
Check out the podcast directory that MAGIX has compiled: Audio recordings for every area of interest
in many languages are available as a one-time trial or as a subscription. 
More about this topic can be found under MAGIX Podcast Service. 
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<Service_name_MMS>
 No wishes remain unfulfilled with this service! 
Manage music online: The soundtrack of your life with you all of the time! MAGIX makes all of your
favorite songs available to you all of the time ? forget carrying your record boxes. Simply upload songs,
manage them online, and play them with an integrated MP3
 player. Wherever you go, your music is already there! 
Buy music
: A musical shopping experience, around the clock: Download hits, oldies, and rarities comfortably from
home and enjoy them anywhere. The free MAGIX Music Manager gives you an overview of all of your
music and devices. Select songs with the original cover art from an especially large offer of high-quality
MP3 songs! 
Download music samples
: Complete your own multimedia projects with high-quality sounds and styles from professionals! No
matter whether you want loops, sounds, and instrumental parts for your arrangements, or a great voice
for one of your own guitar recordings ? you're guaranteed to find the right sounds. New content every
month ? excellent templates for individual ringtones with MAGIX Ringtone Maker. 
Listen to podcasts online
: The MAGIX Podcast Service automatically provides acoustic variation at home, on the go, or on
mobile devices. Whether pirate stations, the storytelling hour, or a cookery show. Simply choose the
station you want! You can use MAGIX music programs like MAGIX MP3 Maker to comfortably
subscribe to, download, manage, and burn podcasts from all over the world. 
Download sound templates for your own ringtones
: Ringtones not only let you show others who you are, but what you like: In the MAGIX Online Content
Library, you can download professional sound templates for your own creations, individually edit them,
then transfer them directly to your mobile. You're guaranteed to be the only one with these ringtones! 
Create ringtones with your mobile
: A music studio in your pocket ? MAGIX Mobile Music Maker turns your mobile into a DJ booth!
Compose and remix ringtones easier than ever before: Select the style, add effects, mix down, and your
unique ringtone is finished! Groove together now in multi-player mode via Bluetooth! 
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MAGIX Screenshare
 This function makes it possible for you to offer assistance to other users directly via the Internet, or to
get help from others. To do this you have to register MAGIX Movie
 Edit Pro 16 first. 
Hint:
 To inform the screensharing guests of exactly what is being shown, it is also a good idea to telephone or
chat simultaneously. 

Register as host for a screen transfer
1.  If you want to start a screenshare instance yourself, then you have to register as a host first. To

do this open the menu "Online" and then select "Screen transfer as host...".
2. In the dialog you can enter a name for the screen session. Your user account name is used here

by default.
3. Now click on "start session". A small window will now open in the bottom right corner which

displays the status of your screen session. A number will also be displayed (session ID) which
serves as a password for your guests. 

4. Start the screenshare instance.

 Register as guest of a screen session
1.  You have to register as a guest to view a screensharing instance. To do this open the menu

"Online" and then select "Screen transfer as guest...".
2. Enter the password you received from your host (8-digit session ID).
3. Now click on "start session". A window will open displaying a smaller version of your host's

screen.

Page 788



Online login details
 In this dialog
, you can save your login information (login and password) for MAGIX Online Album and all other
MAGIX Online World as well as for Catooh, making it unnecessary to login each time you access
MAGIX Online World. 
The saved data are valid for all other MAGIX programs for the corresponding computer user. 
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Embed Flash videos into your own web page
 To do this, you will need a basic knowledge of HTML pages and all technical requirements for
uploading your files to your web page. 
Tip: If you do not have HTML skills, we recommend using MAGIX Online Album
. Without any previous knowledge, you can present videos, photos and music on your own web page ?
all completely for free. Videos from MAGIX Online Album can also be embedded in other websites as
well. 
Please note that a Flash video cannot be directly embedded into an HTML page like a picture in JPEG
format. For a Flash video, you will need a Flash player embedded in the website to play back your
video.

MAGIX offers you a download package with some Flash player goodies. It can be downloaded here
. 
The package contains the following files: 

 standalone_omk.swf - the Flash player
 demo.html - a sample website, which demonstrated how the player can be used
 demo.flv - a demo video, which will be played by the Flash player on the demo website

To reach your target quickly, simply adjust the demo website to your own requirements and replace the
demo video with your own. At the end, upload all three files to your website. 
If you need more information about the website's HTML code, we recommend that you read an
explanation of HTML documentation to better understand the structure and functions of HTML. 
If you understand HTML code, you will find another explanation of various parameters using which you
can influence the appearance and function of the Flash player. 
url The path to the video which is to be played back. 
preview The path to an image

 in JPEG format. It is displayed as a preview in stopped
state before the video is played back. 

sound The sound contained in the video will be played back if
this parameter is "true". 

loop The video will be automatically played back from the
start after reaching the end if this parameter is "true". 

tooltip Changing the position of the position cursor will display
a tooltip with position information if this parameter is
"true". 

swfborder A limiting line will be drawn around the player if this
parameter is true. 

autoplay The video will be played back automatically when the
page or the player are loaded. 
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Keyboard shortcuts
In this chapter
Playback functions
Arranger view
Move view
Transport control in Media pool
Mouse modes
"File" menu
Edit menu
Effects menu
Window menu
Help
Edit keyboard shortcut
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Playback functions
Start/Stop Space bar 
Transport buttons J / K / L 
In/Out points for punch recording I/O 
Stop (playback marker is stopped at
the current position) 

K 

Restart beginning at playback marker Backwards 
Playback marker back to the
beginning 

Home 

Playback marker to end End 
1 frame
 back 

Left arrow 

1 frame forward Right arrow 
5 frames back Ctrl + left arrow 
5 frames forward Ctrl + right arrow 
Fast forward Shift + right arrow 
Fast rewind Shift + left arrow 
Set project
 marker 

Shift + 1/2/3 
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Arranger view
Zoom in Ctrl + up cursor key 
Zoom out Ctrl + down cursor key 
Full screen playback Alt + Enter 
Movie
 overview 

Shift + A 

Optimize view Shift + B 
Zoom 1 frame
 / 5 frames 

Ctrl + 1/2 

Zoom 1s / 5s / 1min/ 10min Ctrl + 3/4/5/6 
Zoom between red area markers Ctrl + 7 
Entire movie Ctrl + 8 
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Move view
To next object edge Ctrl + 0 
To previous object edge Ctrl + 9 
To movie
 start 

Home 

To movie end End 
To beginning of section Ctrl + Home 
To end of section Ctrl + End 
Page to right/left PgDn/PgUp 
Grid unit right/left Ctrl + PgUp/PgDn 
To project
 markers 1-10 

1/2/3/4/5/6/7/8/9/0 

To next/ 
previous project marker 

Ctrl + Shift + PgDn/PgUp 

To next/ 
previous scene
 marker 

Shift + PgDn/PgUp 

To next/ 
previous chapter marker 

Alt + PgDn/PgUp 

To next/previous ad marker Ctrl + Shift + W 
Ctrl + Alt + W 

Scroll to left/right marker Alt + Home/Alt + End 
To next/previous empty section Shift + 4/Shift + 5 
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Transport control in Media pool
Set InPoint I 
Set OutPoint O 
Go to InPoint Shift + I 
Go to OutPoint Shift + O 
Play from InPoint to OutPoint Ctrl + K 
Save Take Shift + T 
Apply range to movie Ctrl + P 
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Mouse modes
Intelligent mouse mode Alt + 1 
Mouse mode for individual objects Alt + 2 
Curve mouse mode Alt + 3 
Object stretch mouse mode Alt + 4 
Preview audio
 objects 

Alt + 5 

Scrub mouse mode Alt + 6 
Context help Alt + 7 
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"File" menu
New movie Ctrl + N 
Open movie Shift + O 
Save movie Ctrl + S 
Save movie as Shift + S 
Close movie Ctrl + F4 
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Load/Save project
Load project Ctrl+Shift+O 
Save project Ctrl+?+S 
Save project as... Ctrl + Shift + D 
Clean-up wizard Ctrl + Alt + G 
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Export movie
Export as AVI Alt + A 
Export as DV AVI Alt + B 
Export movie as an MPEG Alt + C 
Video as MAGIX video Alt + D 
Video as QuickTime Movie Alt + E 
Windows Media Export Alt + F11 
Real Media export Show quantization grid Alt

+ G 
Video as MPEG 4 video... Alt + K 
Audio as WAV Alt + H 
Uncompressed movie Alt + U 
Movie as sequence of individual pictures Alt + V 
Single frame
 as BMP file 

Alt + M 

Single frame as JPEG Alt + N 
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Internet

Send movie
 as email 

Shift + U 

Internet connection Ctrl + W 

Burn CD/DVD Alt + Shift + R 

Audio
 / Video recording 

G 

Audio recording R 
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Twain scanner
Select Source Alt + Q 
Scan Alt + Shift + Q 

Read tracks from audio
 CD 

C 

Play Audio/Video H 
Slideshow Maker Ctrl + Shift + M 
Soundtrack Maker W 

Backup copy
Copy movie
 and media into folder 

Shift + R 

Copy project
, movie, and media into folder 

Ctrl + Q 

Burn movie and media to CD/DVD Ctrl + Shift + R 
Burn project, all movies, and media Ctrl + Shift + Q 
Restore disc project
 from (S)VCD/video DVD 

Ctrl + Shift + P 

Load backup film Alt + O 
Slideshow Maker Ctrl + Shift + M 
MAGIX Soundtrack Maker W 
Movie properties E 
Program settings Y 
Exit Alt + F4 
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Edit menu
Undo Ctrl + Z 
Restore Ctrl + Y 
Cut objects Ctrl + X 
Copy objects Ctrl + C 
Paste objects Ctrl + V 
Duplicate objects Ctrl + D 
Deleting objects Del 
Select all objects Ctrl + A 
Cut
Split scene T 
Delete scene start D 
Delete scene end U 
Remove scene Ctrl + Delete 
Split movie Alt + W 
Adjust music to section Ctrl + Shift + U 
Edit range
Cut section Ctrl + Alt + X 
Copy section Ctrl + Alt + C 
Delete range Ctrl + Delete 
Insert section Ctrl + Alt + V 
Extract section Ctrl + Alt + P 
Group objects Ctrl + L 
Ungroup objects Ctrl + M 
Mix audio Shift + M 
Set snap point Shift + Alt + P 
Set project
 marker 

Shift + 1/2/3/4/5/6/7/8/9/0 

Set chapter markers Shift + Enter 
Set chapter markers automatically Alt + Shift + Enter 
Delete chapter markers Ctrl + Enter 
Delete all chapter markers Alt + Ctrl + Enter 
Move view see "Move view"
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Effects menu
Master effects Ctrl + B 

Video object effects
Scene
 recognition 

Shift + Z 

Image
 stabilization 

Shift + K 

Find and remove ads Shift + C 
Edit bitmap externally Alt + P 
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Movement
Pan left -> right Ctrl + Shift + A 
Pan right -> left Ctrl + Shift + B 
Pan up -> down Ctrl + Shift + Y 
Pan down -> up Ctrl + Shift + Z 
Zoom out Ctrl + Shift + X 
Zoom in Ctrl + Shift + F 
Restore
 movement 

Ctrl + Shift + G 
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Cropping
Zoom 2 Ctrl + Alt + 4 
Zoom 3 Ctrl + Alt + 5 
Free zoom selection Ctrl + Alt + 6 
Fix picture proportions Ctrl + Alt + 7 
Restore
 selection 

Ctrl + Alt + 8 

Load movie
 effects 

Ctrl + Shift + O 

Save movie effects Ctrl + Shift + S 
Restore movie effects Shift + C 
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Audio object effects
Normalize Shift + N 
Automatic track damping Shift + L 
Audio
 Cleaning 

Shift + W 

Echo/Hall Shift + H 
Timestretch/Resample Shift + Q 
Surround Editor Ctrl + Shift + N 
Load/Save settings Ctrl + Alt + Shift + J/K 
Load audio effects Ctrl + Alt + O 
Save audio effects Ctrl + Alt + S 
Restore
 audio effects 

Shift + Alt + K 

Tempo Recognition Wizard Shift + E 
Externally edit Wave Alt + Z 
Volume curve Alt + X 
Object properties Ctrl + E 

Page 806



Window menu
Edit trimmer N 
Object trimmer Q 
Mixer M 
Master audio
 effects rack 

B 

Video monitor V 
Media Pool F 
Reset window arrangement F9 
Display settings Alt + Shift + V 
Switch to next window Tab 
Film overview Shift + A 
Optimize view Shift + B 
Zoom horizontally/vertically see "Arranger view

" 
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Help
Help F1 
Context help Alt + F1 
Show tool tips Ctrl + Shift + F1 
System information Ctrl + I 
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Edit keyboard shortcut
 In this dialog you can specify keyboard shortcuts for all menu function of MAGIX Movie
 Edit Pro 16. This allows you to adapt existing shortcuts to your requirements or to add new ones. 
The settings are automatically saved in a file upon closing the program, i.e. they will be available the next
time the program is used. 
The display of the entire menu tree is the key function of MAGIX Movie
 Edit Pro 16. 

Add keyboard shortcut
 To add a keyboard shortcut, proceed as follows: 

 Look for the required menu point and select it with a simple mouse click. Under "Current menu
point" the currently selected menu point will be displayed.

 Then, click on the "New keyboard shortcut" field.
 Type in the keyboard shortcut. You can also use combinations of any key with "Shift", "Alt", and

"Ctrl".
 Then click on "Assign shortcut". If the shortcut should already have been assigned a

corresponding warning will be displayed.
Note! Please do not use the space bar, "Esc", or "Insert" key ("0" in the number block), since the
functions of these keys are permanently assigned in MAGIX Movie
 Edit Pro 16 and can not be changed. 

Keyboard shortcut list
 Reset:
 Activates all preset shortcuts again. 
Load:
 Previously saved shortcuts are loaded and activated again. 
Tip: MAGIX Movie
 Edit Pro 16 offers additional presets for those switching over from other programs. This significantly
simplifies getting used to MAGIX Movie Edit Pro 16! 
Note! 
The current settings will be overwritten during loading! Save your current keyboard shortcuts in advance
if you would like to keep them. 
Save:
 The current keyboard shortcuts can be saved after naming the file appropriately. 
List: This button opens a window where a complete list of current keyboard shortcuts appears. The
included "Copy" button can be used to copy this list to the Windows clipboard
 and then edit and print it using a text editor. 
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Activate additional functions
 You can activate encoders/decoders for various file formats as required. The corresponding activation 
dialog will appear automatically when the codec is used for the first time, e.g. when a DVD is burned and
the MPEG
-2 codec is used. 
Why does it have to be "activated"?
 To import (decode) or export (encode) certain video and audio formats, you will require a specific
codec. MAGIX Movie Edit Pro 16 will ask you if you want to activate the codec as soon as you need it.
The integration of decoders and encoders from third parties into programs usually costs money. These
codecs are integrated via additional, voluntary activation in MAGIX programs which, according to usage
and degree of prevalence, can be free or fee-based for special high-quality codecs. This way, MAGIX
can continue to be able to provide you with optimum value for money for your software
. 
In this chapter
Free activation (MPEG-2, MPEG-4, Dolby Digital 2.0 & 5.1)
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Free activation (MPEG-2, MPEG-4, Dolby
Digital 2.0 & 5.1)
 To be able to use MPEG-2, MPEG-4, the Dolby Digital stereo import
, and Dolby Digital 5.1, you will have to activate the codec for free. 
Activation can be done online via telephone or via post/fax. The quickest and easiest way to order an
activation code is via the Internet. 
Order activation code online
 Click on "Order online..." (Field 1). MAGIX Movie
 Edit Pro 16 will automatically contact the MAGIX server and load the corresponding codec. 
Note
: Activation of the codec checks the registration data as required. Activation of the codec only functions if
your version of the program has already been registered in your name. If you haven't registered MAGIX
Movie Edit Pro 16, then you can do this at any time. 
If your computer has no Internet access, you have the following options for activation: 
Order activation code in MAGIX Service Center
 Use this option to conduct activation from a different computer which has Internet access. 
Order activation code via post/fax
 After clicking on "Order via post/fax" (field 2), your user code will appear. This automatically assigns
your personal activation code to your PC. Click on "Continue to order form" to transfer your user code
automatically to the post/fax form. Now send the completed form as a print out to the address/fax no.
mentioned. Your activation code will be sent to you in just a few days via post or fax. It can also be sent
by mail if an email address is stated. 
Enter activation code
 After receiving your personal activation code use the export or burn function to reopen the activation 
dialog for the corresponding file format. Type or copy the activation code into the input field in the dialog
and click on "Activate..."
. 
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Annex: Digital Video and Data
Storage
In this chapter
Video Editing on the PC
MPEG Compression
General notes on AVI videos
Overview of the different disc types
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Video Editing on the PC
 Digital video processing with the PC is comparable to audio
 processing. The analog medium that is video must first be digitized before it can be processed by the
computer. 
Digital video processing functions quite similar to recording via a sound card. The signal flow is measured
in very short, regular intervals, and the values resulting from it can then be processed by the computer.
The accuracy of each individual measurement results in the resolution, and the frequency of the
measurements results in the frame rate. The more precise and frequent the signal is measured, the higher
the quality of the digitized video, but also the higher demands on the capture performance and the
required storage space. The Windows standard format for video files is AVI
 (audio and video Interleaved). 
Digitizing video adopts either the camera or the graphics card, a TV card (e.g. Miro PCTV), or a video
card (e.g. Fast AV Master). However, video handling makes much higher demands upon the hardware if
good image quality is required. In order to be able to reasonably process video files on today's PCs, they
must be compressed. Digital audio
, on the other hand only uses compression for saving storage space. 
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MPEG Compression
 MPEG means "Moving Picture Experts Group" and defines a workgroup which cooperates with the
International Standards Organization (ISO) as well as the international Electro Technical Commission
(ETC) to develop standards for video and audio
 coding. 
Generally, the graphic data rate of the digital video standard is 167 megabits per second, which, when
not compressed, requires a far higher storage capacity than a DVD can offer. A one-sided DVD 5 with
4.7 GB storage capacity is enough for 4 Minutes. For this reason, the available pictorial material must be
effectively compressed ? a function which is achieved with the MPEG procedure. 
This procedure is based on the simple fact that up to 96% of digital video data consists of repetition and
can be compressed without visible degradation of the pictorial quality. 
Each MPEG compression is, however, a data reduction and as such connected with information loss. If
the video consists of very extensive details, or if the content changes very fast, then the picture may blur
(dependent on the strength of the compression and the quality of the encoder). 
Errors can also result from so-called compression artifacts such as small color defects or images that are
too dark. 
At average compression rates under 3 megabits per second it is probable that you will notice reduced
quality. At rates around 6 megabit per second the degradation in quality becomes almost invisible. 

General notes on AVI videos
 The AVI format (Audio Video Interleaved) isn't actually a proper video format! Rather, it is a so-called
"container", where the conventions for transferring audio and video files to the program are only loosely
defined. The codec (coder/dec
oder) actually defines what storage format is used. A codec compresses audio/video data into its own
unique format which can only be read by the codec itself and is decoded when the film is played. 
In concrete terms, a computer-generated AVI file can only
 be loaded by and played on a different computer if the same codec is installed on it. 
Many codecs (e.g. Intel Indeo®

 video) have now become standard components of the Windows™ installation. Others like the popular
DivX codec are not standard. If you are generating an AVI file for future play on another computer using
one of these codecs, you should first install this codec on the other PC. The best method available is to
copy the codec installer to your export directory and burn it every time you create a video disc
(slideshow disc) for play on computers. 
You may encounter some problems when using older video editing cards with codecs which only function
with the card's hardware. Such AVIs can only
 be used on the computer which was used to create them. Try to avoid using this kind of codec. 
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Overview of the different disc types
 MAGIX Movie Edit Pro 16 contains many disc types
 depending on whether you want to burn a movie or slideshow and which disc type you are using (CD or
DVD), or the type of playback device or quality required. 
The table below will explain which disc types can be best employed in different cases, the differences in
quality, and how much storage space each format requires. 
For further information please read the chapters on the individual disc types
. 
Disc
type

Media Menu Quality ca. length Suitable
for

Playback
on

VCD CD Yes * approx. 70
minutes 

Movie DVD
player on
TV 

S-VCD CD Yes ** ca. 30-70
minutes 

Movie
photos 

DVD
player on
TV 

DVD DVD Yes,
advance
d 

*** approx. 2
hours 

Movie
photos 

DVD
player on
TV 

miniDV
D

CD Yes *** ca. 20
minutes 

Movie
photos 

DVD
player on
TV 

JPEG
DISC 

CD
DVD 

No **** Depends on
original
images and
DVD
player* 

Photos DVD
player on
TV
without
sound,
effects or
transitions
 

Slidesho
w 

CD
DVD 

No **** Depending
on original
images and
DVD
player 

17
photos 

Every PC
with some
effects, 
or as a
backup 

WMV
HD 

CD
DVD 

Yes **** 3 hours /
DVD 
30 min
/CD 

Movie
photos 

PC from
Windows
Media
Player 9
format 

Multi
Disc 

CD
DVD 

Yes **** 45 min/
DVD 
7min/CD 

Movie
photos 

PC from
Windows
Media 9
format +
DVD
player 

* The display duration for some DVD players may be set in this menu. The number of photos that can be
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burned onto a CD or DVD depends on the sizes of the picture files. 
You can also use the menu templates from the category "TV Showtime DVD" for the disc types mini
DVD and DVD. Each picture of a slideshow is then displayed in fullscreen on its own menu
 page without having to playback the slideshow. 
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Digital Versatile Disc (DVD)

 Quality
 The exceptional color quality, image
 definition, and contrast of the DVD format are all well known. 
A resolution of 720 x 576 (PAL) and coded using MPEG
-2, 25 pictures per second produces very good results. The quantity of data is approx. 5 times as much
as a VCD. 

DVD size
 DVDs look similar to CDs. The only visible difference is that double-sided DVDs have no label.
Otherwise, both formats have the same dimensions. 

 Diameter: 12 cm, like a normal CD (there are also DVDs with a diameter of only 8 cm) 
 Thickness: 1.2 mm, just like a normal CD

DVD media (overview)
 The DVD does not differ outwardly from a conventional CD-ROM. Higher memory density (up to 17
GB as opposed to 650-780 megabytes) results from the fact that information is stored more densely
(double-capacity) and that up to four layers can be used. In order to be able to read the information, a
special laser with modified wavelength is required. Therefore, DVDs cannot be read using conventional
CD-ROM drives. 

Writable disc formats
 The recordable DVD market is split for the time being into three types: DVD-RAM, DVD+RW and
DVD-RW. 
DVD-R: Once-only writable medium. The DVD-R can be specified with the file structures of DVD
Video, DVD Audio
, or DVD-ROM. 
DVD+RW
: Re-recordable DVDs can be created using +RW drives and can be read by almost any commercial
DVD-ROM or DVD player. The companies involved are mainly Philips, Sony, HEWLETT PACKARD
(as well as Ricoh, Yamaha, and Mitsubishi). 
DVD-RW: Writable and erasable DVD technology is promoted by Pioneer and Sharp. This format was
developed by the Pioneer company and should be compatible
 with existing DVD players. 
DVD-RAM:
 This standard is not recommended due to small storage capacity and incompatibility with DVD players. 
Note: MAGIX Movie
 Edit Pro 16 supports DVD -R, DVD+R, DVD +RW, DVD -RW, but not DVD-RAM! 
Blank discs:
 Single-sided recordable blanks with a capacity of 4.7 GB and a playback time of approx. 2 hours serve
as storage media for all DVD burning formats at present. 

Copy Protection
 Macrovision (APS): The movie
 industry claims that even DVD-ROM drives and decoders or diagram cards with composite outputs or
s-video outputs must support the Macrovision analog copy protection (APS). Only some older DVD
players do not possess APS. 
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APS adds additional signals to a DVD's stored graphical data. The data is almost unchanged. These
supplementary signals disturb the synchronization and the automatic recording regulation of most video
recorders to prevent recording of the video. They are not noticeable on the television or the monitor,
however. 
Content Scrambling System (CSS): CSS prevents saving and duplication of DVD video tracks to
hard disk. The VOB streams of DVDs without CSS can otherwise (like other video files) be loaded via
the Import Video button
 There are further types of copy protection besides APS and CSS which ensure that retail DVDs cannot
be copied without distortion 
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Blu-ray Disc
 Alongside HD-DVD, the Blu-ray Disc is viewed as the successor to DVDs and offers especially high
storage capacity of up to 27 GB as a single-layer disc (double-layer up to 54 GB) with very few write
errors. 
The term Blu-ray Disc comes from the blue color of the laser. Because a color cannot be registered as a
trademark, the letter "e" was removed from the word "blue". 
The high storage capacity of the Blu-ray Disc suits high definition videos and slideshows in high quality
perfectly, since these are characterized by large file sizes (depending on material approximately 40
MB/sec) and very high memory use. 
Hint:
 A corresponding device is required for viewing Blu-ray Discs. To fully enjoy the benefits of high
definition video, you should also use an HD-enabled TV. 
Companies that were involved in developing Blu-ray technology have united themselves into the Blu-ray
Disc Association (BDA). 
Blu-ray Discs come in three varieties:

  Only readable BD ROM (comparable to DVD video),
 rewritable BD-RE (comparable to DVD±RW or DVD RAM), 
 and as a disc that can be written to only once BD-R (comparable to DVD±R).
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AVCHD disc
 Use this command to create a high-resolution video. You can even burn Blu-ray (BD-R/RE) blanks as
well as conventional DVD±R/RWs. In contrast to Blu-ray Discs, MPEG-4/AVC codec is applied as the
video format, which requires less memory at a comparable image quality. There is no disc menu on
AVCHD
 discs. 
Tip
: To fully enjoy the benefits of high definition video, you should also use an HD-enabled TV. 
Compatibility
 AVCHD disc on Blu-ray: Since this is a BD-conformant format, the disc created can be played back
in any conventional Blu-ray player. Playback problems can almost always be traced to incompatibilities
between Blu-ray blanks and Blu-ray players. In this case, consult the instructions for your Blu-ray player
or ask the manufacturer which blanks are compatible
 with the device. 
AVCHD disc on DVD: The DVDs created with AVCHD video are not supported by all Blu-ray
players. The behavior of the devices is quite different. Normal DVD players cannot replay AVCHD
 discs, since the AVC format is not supported. 
Note: To import and export AVC and MPEG-4 files, the MEPG-4 codec must first be activated. A
dialog will open if the codec is required. Files with a horizontal resolution of more than 768 pixels can
only be loaded in MAGIX Movie
 Edit Pro 16 Plus. 
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Super Video CD (SVCD)
 The Super Video CD (SVCD) is a technological advancement of the video CD. SVCDs are also like
VCD-specified CD-ROMs which can be played using either a Super Video CD player (connected to
the television), or directly with the CD-ROM drive of a computer. Many DVD players can also play
SVCDs. MPEG
-2 and the increase of the data transfer rate makes it hard to tell videos from videos in DVD quality
apart. 
Resolution: SVCDs use the better MPEG-2 encoder in a standardized resolution of 480 x 576 (PAL).
The MPEG-2 format offers a maximum resolution of up to 720 x 576 points and improved compression
methods characterized by excellent image
 definition and homogenity. 
Hard disk capacity: An average 90-minute movie
 must be spread across 3 CDs. On one SVCD you can get about 30 minutes of good-quality movie. 
Encoder setting:
 Compared to the VCD with 1.3, the data transfer rate is doubled to 2.6 Mbit/s. 
MPEG-2 format introduces the so-called variable bit rate (VBR). In contrast to the constant bit rate
(CBR) of the MPEG-1 encoders, this encoder has the option of using more bits for movement-intensive
sections, as well as saving bits if picture content remains the same. 
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Video CD (VCD)
 Video CDs are specific CD-ROMs for storing videos in certain forms. Compression takes place using
the MPEG
-1 codec. VCDs can be played on either a video CD player attached to a television or directly via the
computer's CD-ROM drive. Most DVD players can play VCDs. 
Resolution: 
VCDs can play movies with a maximum resolution of 352 x 288 pixels (PAL) or 352 x 240 (NTSC) at
25 pictures per second. The resolution of a VHS cassette offers for instance 300 x 360 pixels. More
important than the resolution is the use of a good MPEG-1 encoder. Since video images constantly
change, errors cannot always be perceived by the viewer. 
Hard disk capacity:
 A VCD can store about 70 minutes of video. A typical motion picture must therefore be stored on two
VCDs. In order to get as much video data on a normal CD as possible, one must forego correction
information on VCD/SVCD formats within the individual sectors (sub-ranges) of a CD. You can
therefore fit 720 MB of video data on a 650 MB blank CD. Due to improved burning and scanning
technology it is now possible to burn up to 985 MB video data on a 99min blank CD. 
Encoder settings: Normally the video CD data is played at a data rate of 1150 kBits video and 224
kBits audio. By increasing the video bit rate to 3000kBits you can get the same resolution and an
better-quality audio bit rate. Movement artifacts disappear almost completely at approx. 2000 kBits with
the picture appearing a little less sharp. This pre-supposes, however, that the player can also play back
such a bit rate. The fact that many DVD players can handle an increased data rate is due to well written
player software
. 
Experiment with higher data rates:
 If you do not need the full running time of the VCD, then you can experiment with space to improve the
quality of the video! 
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miniDVD
 The miniDVD is nothing more than the DVD data format burned onto a CD-ROM. Thus the MPEG-2
encoder and all other specifications of the DVD data format are used, and only the data carriers are
different. Because the CD-ROM can only save about a sixth of the quantity of data a DVD can hold, the
capacity of a miniDVD is accordingly limited to approx. 20 minutes of movie
. 
MiniDVDs are particularly suitable for playing on the computer. For stand-alone devices they must be
tested on an individual basis as to whether the device can handle the DVD format on a CD-ROM. 
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JPEG disc
 The "JPEG disc" is a special case for slideshows. No video file is created to be burned, but rather
every photo in the disc project
 is exported individually with effects and burned to CD or DVD. Many modern DVD players can play
JPEG files directly. 
If a project
 contains several slideshows, a subfolder will be created for each one, and the corresponding images will
be placed into each one. This means that there are no menus, no sound, no animated effects or transitions
? although it does offer the best possible quality available for playback on TV. This means that there are
no menus, sounds, animated effects or transitions, it does, however, offer the best possible quality
available for TV playback. 
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Slideshow disc
All slideshow image and audio
 files will be burned onto CD or DVD, together with
any effect settings and the MAGIX Media Manager
CDR player program. 
A MAGIX Media Manager CD is designed especially
for photo projects (slideshows). The original photos
are burned onto CD; 

Ideal for backing up valuable recordings. During playback on your PC, the highest possible picture
quality is made possible. The following photo effects can be played by Media Manager. 

 Brightness, contrast, gamma
 Cropping and rotation
 Title text (without text effects)

If your project
 uses more effects, they won't be visible on the Media Manager CD. A VCD or DVD is more suitable
for such projects. 
The MAGIX Media Manager CDR ensures that the CD-ROM can be played back on any Windows
PC regardless of the software
 installed. The disc will automatically begin playing the slideshow after the CD-ROM has been inserted
into the drive, provided the auto-play feature is enabled on your PC. To enable the auto-play feature on
your PC, select the "Auto Insert Notification" option for your CD-ROM drive from the Windows
Control Panel. 
If deactivated, you can also start your CD-ROM slideshow manually: 

1. Place your home-burned CD-ROM into your CD-ROM drive.
2. Open Explorer and click on the drive letter of the CD-ROM drive (usually D:\).
3. Double-click "MediaManager.exe" to start the MAGIX Media Manager CDR.
4. In the Explorer window of MAGIX Media Manager CDR, open the slideshow playlist file ending

with *.PLR and start the slideshow.
Additional information can be found in the help feature of MAGIX Media Manager CDR (F1 key). 
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WMV HD (Windows Media High Definition Disc)
 WMV WMV HD (Windows Media High Definition Disc) is a type of disc optimized for playback of
slideshows on PC. The movies are converted into high-resolution Windows Media 9 format and a menu
 is added, like with DVDs. You must have Windows Media Player 9 or higher installed on your PC. 
Video encoding will be preset for HDTV resolution (1280 x 720, also known as "720p"). To select
different resolutions, click on the button
 "Encoder settings" and in "Presets" choose the following: 

 Standard PAL (720x576) or NTSC (720 x 480)
 Standard PC resolutions (1024 x 768 or 1280 x 1024)
 HDTV 720p (1280x720) or 1080i (1920x1080)
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Multi Disc
 A multidisc is a combination of different disc formats on one DVD. It consists of 3 parts and offers the
following advantages: 

 Maximum quality when played on a PC with WMV HD (Windows Media High Definition Disc)
 Fully compatible with DVD players due to a DVD part (Digital Versatile Disc)
 Greatest possible safety as a data backup of the project is added (burn option).
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Backup disc
 Use this option to compile all movies in the current disc project
, including all connected media and burn them to disc. 
Even larger projects can be burned straight to disc. The project, if necessary, will be split up and burned
automatically to multiple discs. A restore
 program which is burned to the first disc of such a backup, guarantees easy re-recording of the backup. 
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MPEG-4 encoder settings
 Behind MPEG
-4, you'll find a highly complex "academic" standard that operates and is supported variably according to
make. 
Tip: First, check if there is a suitable preset in the export dialog
 for your purposes. Before changes are made in "Advanced settings", the effects and interplay of the
different parameters should be familiar. 
The "Advanced settings" are divided into "Video", "Audio
", and "Multiplexer". 
Under "Video", there is a choice between "MPEG-4" (H.263) and "AVC/H.264
". Depending on the purpose of application of the material to be exported, both of these encoder settings
can be selected for compressing the video material. It is important in this case to know how the material
will be played back. 
Under "Audio", there is a choice between "AMR" and "AC
". The AMR format is more suitable for mobile devices that don't necessarily require high playback
quality. ACC is more flexible, on the other hand, but it is supported by fewer mobiel devices. 
For material that is not exactly specific, encoder qualities recommend AVC image
 and AAC sound, since these encoders are equally suitable for all source material. 
The option "Export as website" also creates an HTML page in an integrated Flash player that can play
back the video created. Read the topic "Embed Flash videos into your own web site
". 
In this chapter
MPEG-4
AVC / H.264
AMR
AAC
Multiplexer
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MPEG-4
 The MPEG
-4 (H.263) codec is especially useful for video material with little or only slower movements. 
In this section:
Generic
Bit rate control
Pixel aspect ratio
GOP structure
Input info
Statistics
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Generic

 MPEG-4 preset
 Different presets located within the encoder. 
(A)SP@L0-L5
: (Advanced) Simple Profile in Level 0-5 
(Q)CIF (Common Intermediate Format): CIF is a video format produced as soon as 1990 with the
video compression format H.261. At that time, the format was used for video telephone conferences.
The "Q" in QCIF stands for "Quarter", and since resolution is halved in terms of height and width
compared to CIF, the entire size is only a quarter of CIF.
QCIF was popular with mobile telephone manufacturers, since the resolution of 176 x 144 pixels was
sensible for the first affordable SmartPhones (144 x 176). 
(Half)D1: D1 corresponds with MPEG
-2 DVD. HalfD1 has exactly half of the entire number of pixels, meaning that the pixel number of the
height and weight is 2/3 of D1. 
720p: 
Video stream with a resolution of 1280 x 720p (progressive). 
Apple iPod: Apple iPod-compatible
 stream. 
Sony PSP
: Sony PSP-compatibler stream. 

Profile/Level
 So that profile and level are conformant with the other settings, pay attention to the minimum and
maximum values in the following tables. 
Note!
 In case the settings are not included in this information, problems playing back the encoded videos can
lead to problems. 

Table 1: The levels of the MPEG
-4 simple profile (SP) 
Level Typical

visual
session
size 

Max.
number
of
objects 

Maximum
number
objects per
type 

Max.
unique
quant.
tables 

Max. VMV
buffer size 
(MB) 

L0 QCIF 1 1 x simple 1 198 
L1 QCIF 4 4 x simple 1 198 
L2 CIF 4 4 x simple 1 792 
L3 CIF 4 4 x simple 1 792 

Continuation of table 1 
Level Max.

VCV
buffer size
(MB) 

VCV
decoder
rate
(MB/s) 

Max. total
VBV
buffer size 
(units of
16384
bits) 

Max. VOL
VBV
buffer size 
(units of
16384
bits) 

Max.
video
packet
length
(bits) 

Max.
bitrate
(kbit/s) 
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L0 99 1485 10 10 2048 64 
L1 99 1485 10 10 2048 64 
L2 396 5940 40 40 4096 128 
L3 396 11880 40 40 8192 384 

Table 2: The levels of the MPEG-4 advanced simple profile (ASP) 
Level Typical

visual
session
size 

Max.
number
of
objects 

Max.
number 
per type 

Max.
unique
quant.
tables 

Max.
VMV
buffer
size
(MB) 

Max.
VCV
buffer
size
(MB) 

VCV
decoder
rate
(MB/s) 

L0 176x144 1 1x AS or
simple 

1 297 99 2970 

L1 176x144 4 4x AS or
simple 

1 297 99 2970 

L2 352x288 4 4x AS or
simple 

1 1188 396 5940 

L3 352x288 4 4x AS or
simple 

1 1188 396 11880 

L4 352x576 4 4x AS or
simple 

1 2376 792 23760 

L5 720x576 4 4x AS or
simple 

1 4860 1620 48600 

Continuation of table 2 
Level Max.

percentage
of intra
MBs with
AC
prediction
in VCV
buffer 

Max total
VBV
buffer size
(units of
16384
bits) 

Max. VOL
VBV
buffer size
(units of
16384
bits) 

Max.
video
packet
length 
(bits) 

Max.
bitrate
(kbit/s) 

L0 100 10 10 2048 128 
L1 100 10 10 2048 128 
L2 100 40 40 4096 384 
L3 100 40 40 4096 768 
L4 50 80 80 8192 3000 
L5 25 112 112 16384 8000 

Picture type
 "Picture type" specifies which parts of a frame
 should be used as the basis for the encoding: 

 Frame: A frame is a single image from a video sequence, also called a full image.
 Field: A half-image, two of which combine to produce a frame. Read more about this explanation

regarding "Interlace".
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 Field order
 Note: This parameter is only available if the setting "Field
" is selected for "Picture type". 
In case of interlaced streams, the half-image sequence is set. Read more about this explanation regarding
"Interlace
". 

Pulldown
 Note: This parameter is only available if the setting "Frame
" or "MBAFF" (only for AVC/H.264)" is selected for "Picture type". 
In normal cases, an image
 playback rate of 24 (or 23.976) frames per second is use; the NTSC system however requires 30 (or
29.97) frames/s, and there is a special algorithm for converting the video's frame rate. For compilations
or test purposes, switch this option to "No". In normal cases, the setting can be set to "Auto". 

Slice count
 A frame
 can be divided into multiple slices for encoding. Specify the maximum number of slices are permitted. If
set to "0", then the number will be determined automatically. 
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Bit rate control
 The bit rate indicates how much data per second is saved in the video (playback speed). This makes the
bit rate the deciding parameter for the video to be encoded. 

Mode
  Constant bit rate: The constant bit rate should only be used if the device used to play the video

supports constant bit rates.
 Variable bit rate: The bit rate varies. For faster movements in the video, the bit rate increases,

and for still images or slow pans, a lower bit rate is sufficient for creating the video in constant
quality.

 Constant quality: Similar to the "Variable bit rate" mode, the bit rate varies according to the
video material. The quality depends on the selected profile and can be changed.

 Constant quantizer: In this mode, a fixed colour quantization is used for the macro blocks.
Under Advanced settings, a value between 1 and 32 can be set independent of the respective 
frame (I-Frame, P-Frame, or B-Frame). The higher the value, the stronger the quantization: small
values produce qualitatively high-quality images and the data rate increases, and larger values
produce a reduction in data, but the quality suffers.

 Bit rate (Bits/s)
  In "Constant bit rate" mode: Exactly those values entered are applied to be able to calculate

the size of the video precisely. 
 In "Variable bit rate" mode: The values entered here are applied to the video as an average as a

guideline. The size of the video to be exported can only be approximated.

 Max. rate
 This is the maximum bit rate that should be present in the video stream, i.e. maximum number of bits that
may be transferred to the decoder. 
Note
: This option is only available in "Variable bit rate" mode. 

VBV buf. size
 VBV is the abbreviation for "Video rate buffer verifier d
efinition" and the size of the buffer (storage area) that is applied to the encoding. 
The larger the buffer is, the better the results will be, but the processing will also take much longer. The
smaller the buffer is, the more parallel processing can take place at the same time in RAM. 
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Pixel aspect ratio
 Specifies the page ratio of the individual image
 points (pixels). 
Meaning
: Different television norms and the standard pixel ratio. Select a setting and the results are displayed as
"X" and "Y". 
X/Y
: The actual pixel ratio. If under "Meaning" the setting "Custom" is selected, then a custom ratio can be
set. 
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GOP structure

 Max key interval
 Determines the maximum GOP
 length. High values mean improved compression. Lower values create stronger security protection and
enable improved access to individual frames for processing the video. 

B-frames count
 The number of B-Frames
. Several applications, e.g. video conferences, require a setting of "0" for this, i.e. no B-Frames, in order
to enable the shortest possible reaction times for transfer. 

Scene change detection
 If this option is activated the scenes will be detected during encoding, thus allowing you to insert an I
frame after a scene
 change. 
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Input info
 Information about the incoming video stream is displayed here during live recordings. 

Page 838



Statistics
 Information about the encoder activity is displayed here during live recordings. 
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AVC / H.264
 The H.264/AVC codec is suitable for all types of material; however, it requires relatively higher CPU
 power for later decoding. 
In the advanced encoder settings of the AVC encoder the "Generic" options in "Main Settings" are mainly
interesting. 
The AVC preset and video format can be adjusted here. For instance, if DVD quality is desired you
should select "DVD". The video format should be selected specific to the country so that the material can
be played on the devices most commonly available in these countries. For instance, you should select
PAL for Germany, SECAM for France and NTSC for the US. 
In this section:
Generic
Bit rate control
Aspect ratio
GOP structure
Input info
Statistics
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Generic

 AVC preset
 This is where the actual video stream that will be exported is selected. 

 Baseline: According to ISO/ICE 11172-1/2 standard
 CIF: Corresponds with MPEG-1 VideoCD
 Main: Corresponds with ISO/ICE 13818-1/2 standard
 SVCD: Corresponds with MPEG-2 Super VideoCD
 D1: Corresponds with MPEG-2 DVD
 High: HIGH profile 1920x1080i
 DVD: DVD video
 HD DVD: HD DVD video
 Blu-ray: Blu-ray Disc
 Blu-ray HD: Blu-ray Disc in high definition
 Sony PSP: Sony PSP-compatible format
 HD 1280 x 720p: High profile with a resolution 1280x720p (progressive)
 HD 1440 x 1080i: High profile with a resolution of 1440 x 1080i (interlaced)
 Apple iPod: Apple iPod-compatible stream.

 Video format
 Specifies where the video to be exported should be. The encoder optimizes video material for the
selected mode of playback. 

 Auto: The format from the MAGIX Movie Edit Pro 16 project.
PAL: Phase Alternating Line, or PAL
, is a process for color transmission for analog TV that is primarily used in Europe, but also in Australia,
South America, and many African and Asian countries. 

 The image repetition rate for PAL is 25 Hz.
NTSC: NTSC stands for "National Television Systems C
ommittee". This is a US institution that defined the first color carrier system for TV which is now used in
most of America and some East Asian countries. 

 The image repetition rate for NTSC is 29.97 Hz.
 SECAM: SECAM is a TV norm in France and eastern Europe for transferring analog color

video signal.
 MAC: The MAC process (Multiplexed Analogue Components) involves TV norms developed

for satellite TV. They have also been developed for an HDTV standard (HD-MAC).
 Unspecified: This setting does not make any special optimization.

Tip: The best results are achieved with the setting "Auto", since this automatically uses the project settings
as a basis by MAGIX Movie
 Edit Pro 16. 

Profiles
 Defines which profile is applied in the AVC/H.264 stream. 

 Baseline profile: The basis of applications with limited computing performance, especially for
video conferences or videos on mobile telephones.

 Main profile: This profile was originally intended for the broadcast industry and for backup
purposes. The process has however retreated somewhat from use, since "High Profile" has been
developed for these purposes.

 High profile: This profile is used for broadcast and backup applications, and it is also used

Page 841



sometimes in the HDTV industry (High Definition Television). For example, this profile for
HD-DVD and Blu-ray Discs.

 Level
 H.264 defines different levels. The higher the level, the larger the video's bit rate. In this table, you can
see the maximum permitted values for the respective level in relation to the selected profile. 
Level Max.

macro
blocks per
seconds 

Max. image
size in
macro
blocks 

Max. video
bit rate
(VCL) for
baseline and
main profile 

Max. video
bit
rate (VCL)
for high
profile 

Examples
(Resolution /
image rate in Hz) 

1 1485 99 64 80 128 x 96/30.9 
1.1 3000 396 192 240 176 x 144/30.3 
1.2 6000 396 384 480 320 x 240/10 
1.3 11880 396 768 960 320 x 240/36 
2 11880 396 2 Mbit/s 2.5 Mbit/s 320 x 240/36 
2.1 19800 792 4 Mbit/s 5 Mbit/s 352 x 480/30 
2.2 20250 1620 4 Mbit/s 5 Mbit/s 352 x 576/25.6 
3 40500 1620 10 Mbit/s 12.5

Mbit/s 
720 x 480/30 

3.1 108000 3600 14 Mbit/s 17.5
Mbit/s 

1280 x 720/30 

3.2 216000 5120 20 Mbit/s 25 Mbit/s 1280 x
1024/42.2 

4 245760 8192 20 Mbit/s 25 Mbit/s 1920 x
1080/30.1 
2048 x 1024/30 

4.1 245760 8192 50 Mbit/s 62.5
Mbit/s 

1920 x
1080/30.1 
2048 x 1024/30 

4.2 522240 8704 50 Mbit/s 62.5
Mbit/s 

1920 x 1080/64 
2048 x 1024/60 

5 589824 22080 135 Mbit/s 168.75
Mbit/s 

1920*1080/72.3 
2048 x
1080/67.8 
2560 x
1920/30.7 

5.1 983040 36864 240 Mbit/s 300 Mbit/s 1920 x
1080/120.5 
4096 x 2048/30 

The setting "Level auto" specifies the encoder levels automatically, among other things for the resolution
of the video format specified under "AVC preset" and the set profile bit rate. If a level is manually set in
this case, then other parameter values may not exceed the permitted maximum values. 

Picture type
 "Picture type" specifies which parts of a frame
 should be used as the basis for the encoding: 
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 Frame: A frame is a single image from a video sequence, also called a full image.
 Field: A half-image, two of which combine to produce a frame. Read more about this explanation

regarding "Interlace".
 MBAFF (macro block adaptive frame field): A macro block consists of 16 x 16 pixels. The

encoder creates a "frame field" on this basis for encoding.

 Field order
 Note: This parameter is only available if the setting "Field
" is selected for "Picture type". 
In case of interlaced streams, the half-image sequence is set. Read more about this explanation regarding
"Interlace
". 

Pulldown
 Note: This parameter is only available if the setting "Frame
" or "MBAFF" (only for AVC/H.264)" is selected for "Picture type". 
In normal cases, an image
 playback rate of 24 (or 23.976) frames per second is use; the NTSC system however requires 30 (or
29.97) frames/s, and there is a special algorithm for converting the video's frame rate. For compilations
or test purposes, switch this option to "No". In normal cases, the setting can be set to "Auto". 

Slice count
 A frame
 can be divided into multiple slices for encoding. Specify the maximum number of slices are permitted. If
set to "0", then the number will be determined automatically. 
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Bit rate control
 The bit rate indicates how much data per second is saved in the video (playback speed). This makes the
bit rate the deciding parameter for the video to be encoded. 

Mode
  Constant bit rate: The constant bit rate should only be used if the device used to play the video

supports constant bit rates.
 Constant quantizer: 
 Variable bit rate: The bit rate varies. For faster movements in the video, the bit rate increases,

and for still images or slow pans, a lower bit rate is sufficient for creating the video in constant
quality.

 Pass
  Single pass: The encoder process takes place without prior analysis. This requires the least

amount of time, however quality suffers.
 Multi-pass analysis: The first encoding is carried out at the same time as the analysis for the

second encoding is calculated.
 Multi-pass encode: The first encoding is carried out at the same time as the analysis for the

second encoding is calculated and updated. This produces the best results, but the process
requires the most time.

 Bit rate (Bits/s)
  In "Constant bit rate" mode: Exactly those values entered are applied to be able to calculate

the size of the video precisely. 
 In "Variable bit rate" mode: The values entered here are applied to the video as an average as a

guideline. The size of the video to be exported can only be approximated.

 HSS rate
 This is the maximum bit rate that should be present in the video stream, i.e. maximum number of bits that
may be transferred to the decoder. 
Note
: This option is only available in "Variable bit rate" mode. 

CPB size
 This sets the size of the "coded picture buffer" in bits. This is the buffer where the encoding is carried out.
The larger the buffer is, the better the results will be, but the processing will also take much longer. 

Init delay (90 kHz)
 Image and sound offset
 is compensated as per the source material. 
Tip: Detects asynchronicity that should be compensated directly in MAGIX Movie
 Edit Pro 16. 

Dest delay (90 kHz)
 Certain mobile playback devices create an offset of image
 and sound during playback, even if material is exactly synchronous. This option ensures that the device
offsets the image for the value entered to counteract asynchronicity. 
Example of calculation
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 Suppose a device creates an offset of 13 ms, then the following calculation must be made: 

Note: Only positive offsets are compensated, i.e. image
 comes after the matching sound. 
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Aspect ratio
 In the film industry, this is an indictation of the ratio between width and height of a rectangle, monitor, or
screen. 
There are 3 different sizes available: 

 Picture Aspect Ratio (also Display Aspect Ratio, DAR): This indicates the desired aspect
ratio of the video to be exported. Here are some examples of typical aspect ratios: at home 4:3,
16:9 (typical for TV sets) or 16:10 (widescreen-flatscreens, widescreen notebooks), 3:2 for
35mm films and photos. In cinemas you mostly find 1.85:1.

 Pixel Aspect Ratio (PAR, pixel aspect ratio: Indicates the aspect ratio of individual pixels.
The majority of computer monitors have quadratic pixels (PAR=1:1), for analog television
monitors (PAL at 4:3) 128:117.

 Sample Aspect Ratio (SAR, also Storage Aspect Ratio): Aspect ratio of the saved
resolution (number of pixels), e.g. 720:576 at PAL. It also calculates picture aspect ratio and
pixel aspect ratio: SAR = DAR / PAR.

Note
: In the standard case, the "Aspect ratio" remains set the way it is. You should only change the settings if
the resulting video is exported distorted or stretched or if you need to correct the video because it is in
the wrong aspect ratio. 
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GOP structure

 Max GOP length
 Determines the maximum GOP
 length. High values mean improved compression. Lower values create stronger security protection and
enable improved access to individual frames for processing the video. 

Max b-frames count
 The maximum number of b-frames
. Several cases of application, e.g. video conferences require "no b-frames" in order to achieve the
shortest possible reaction times during transfer. 

Scene change detection
 If this option is activated the scenes will be detected during encoding, thus allowing you to insert an I
frame after a scene
 change. 
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Input info
 Information about the incoming video stream is displayed here during live recordings. 
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Statistics
 Information about the encoder activity is displayed here during live recordings. 
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AMR
 AMR involves a parametric codec with different data rates between 4.75 and 12.2 kbit/s. The
12.2-kbit/s settings throughly corresponds with the GSM-EFR codec in terms of algorithm and audio
 quality. 
This audio format is used by mobile telephones for transferring the conversation and is optimized for
encoding conversation (voices). Low bit rates provide compensation for mobile phones in case of
transfer errors, i.e. bad reception. Depending on the signal strength, the compression increases or
decreases to enable the best possible quality for a conversation. The AMR sound, on the other hand,
encodes a fixed sample rate of 8,000 Hz compared to AAC sound. 
The advanced AMR audio menu
 includes the following settings options: 
The bit rate can be set between 4.75 and 12.2kbit/s. The higher the bit rate, the greater the file size and
the higher level of audio quality. The standard settings provide a bit rate of 7.4 kbit/s. The highest bit rate
for this format is more suited for transferring conversations. 

Page 850



AAC
 The AAC audio was developed by MPEG
, the Moving Picture Experts Group (Dolby, Fraunhofer Institut für Integrierte Schaltungen in Erlangen,
AT&T, Nokia, Sony) as an audio data compression process, that was specified as a further development
of MPEG-2 Multichannel in the MPEG-2 standard. 
It's also a further development of MPEG-2 audio. This format is equally suitable for encoding general
audio information and not especially optimized for certain types of audio material. As with video material,
the audio format should be considered for playback later. 
AAC audio can be encoded with a sample rate of 8,000, 16,000, 24,000, 32,000 or 48,000 Hz and in
mono and stereo sound, respectively. By default, the sound is set to 48,000 Hz stereo. The higher the
sample rate is, the larger the resulting file and higher the audio quality. 
The advanced AAC audio menu
 includes the following settings options: 

 The bit rate can be set between 6 and 512 kbit/s. 160 kbits/s is active by default. The higher the
value is, the larger the resulting file and higher the audio quality. After a certain limit, additional
improvements to audio quality will not be perceived. Bit rates under 64 kb/s are not
recommended.

 As an MPEG version, set MPEG-4 or the older, proven MPEG-2 format.
 For the File Header Type, choose either RAW or ADTS. The "Header" indicates an

explanatory head for the beginning of the file segment, which in fact takes up extra space, but is
required for decoding under circumstances.
o RAW indicates material which does not include a file header in audio format. The audio

material is therefore transferred directly without any special additional information (raw).
o This requires that decoding routines are able to process the material without the explanatory

file header. Especially in case "exotic" sample rates are set, this can lead to problems during
RAW encoding.

o ADTS indicates a file header type which contains information for encoded audio material. In
case of doubt, select this file header type, since fewer problems can be expected in this case.

Object type
: This provides selection between "Main" and "Low complexity". 

 Low complexity: Data is present in a form that hinders different decoding algorithms (noise
replacement), but enables others (temporal adjustment noise formation).

 Main: This sets other focuses in the encoding, and other decoder algorithms can be used.
Note: For example, Apple iPod requires "low complexity encoding". However, you don't need to worry
if you select the right preset for Apple iPod in the export dialog
. 
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Multiplexer
 The multiplexer is a component of the encoder which combines audio
 and video streams. 
In this section:
Output format
ISMA compatible
For Sony PSP
For iPod
Live mode (get times from samples)

Output format
 MPEG-4 file
: This is an MPEG standard (ISO/IEC-14496) with the original goal of supporting devices with less
computing performance. Currently, MPEG-4 has reached a wide bandwidth of application, from HD
video to support for mobile telephones. 
JPEG2000 file: DCI (Digital Cinema Initiative) has been replaced by the JPEG2000 format for
encoding movies. The current distribution and presentation of films has been taken over by digital
projectors that play back high-resolution Mj2 streams in outstanding image
 and sound quality. 
3GPP file: A standard supported by plenty GSM and UMTS mobile telephones. 3GPP is very similar to
the MPEG-4 standard, but also supports formats that are not permitted by MPEG
-4. 

ISMA compatible
 The "Internet Streaming Media Alliance" combines video codec standards (e.g. MPEG) and continuous
transfer within computer networks (e.g. RTP Real-time Transport P
rotocol) to ensure that videos available online can be correctly transferred and played back. 
Note: This option can only be activated, if under "Format" the entry "MPEG
-4 file" has been selected. 

For Sony PSP
 Switch on this option if the video should be played back with the Sony PSP. 
Note: This option can only be activated, if under "Format" the entry "MPEG
-4 file" has been selected. 

For iPod
 Switch on this option, if the video should be played back with the Apple iPod. 
Note: This option can only be activated, if under "Format" the entry "MPEG
-4 file" has been selected. 

Live mode (get times from samples)
 This option is only important for live transfers and is therefore not required in MAGIX Movie
 Edit Pro 16. 
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Appendix: MPEG Encoder
Settings
In this chapter
General settings
Video settings
Advanced video settings
Audio settings
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General settings
 MPEG type:
 Set the output type of the created MPEG file. You can adjust the encoder settings freely (to export your
video in the corresponding format, for instance) for further use in other programs or on your own
website. 
If you open the encoder from a burn dialog, or intend to use the exported material for VCDs, SVCDs or
DVDs, then select the corresponding option. This will adjust the settings of the encoder according to the
standards required for the corresponding discs to be played in a compatible
 player. 
Video format: Automatically specifies the video format, aspect ratio, and frame rate (see video settings
). You can choose between PAL or NTSC. 
Interlace mode: The movie is encoded interlaced (i.e. in two half-screens, so-called fields). This is
essential for later playback on TV screens. If you want to view the exported movie on your PC only and
like a "cinemascope" view, you can also encode by frame (progressively). Some video projectors also
support playback of progressively encoded image material. See Interlace
. 
Bit rate:
 The bit rate determines the memory requirement by the completed video. The amount of data available
can be used differently for different display modes. 20 MB can be 4 seconds of DVD video, or 5
minutes of Internet streaming at the thumbnail size. The quality of an MPEG video is measured by the
width of the created data stream, i.e. the bit rate. This is the amount of transmitted data per time unit and
is indicated in kBit/s or bit per second. 
Quality: Determines the quality of the encoding process, or the quality of the movement
 to be more precise. The higher the quality, the better the finished video will look, but encoding will take
considerably longer. The preset value "10" is a good compromise between speed and quality. 
Smart Rendering: Smart Rendering can considerably reduce the encoding/processing strain of MPEG
files. The production of MPEG files re-encodes only those parts of the movie that were changed in the
program (e.g. by video cleaning or effects). Please note: The MPEG files contained in the movie must
have the same format, i.e. the bit rates (variable or constant), audio
 formats, image resolutions, and video formats must match. 
Quick, GOP-precise copying:
 This special Smart Rendering mode enables MPEG material to be transferred without having to encode
it for the target medium, thereby greatly increasing the encoding speed. The video material cannot appear
to have been altered in any way; only hard cuts (without fades) are permitted. These won't be executed
precisely to the frame, but will rather take place at the next GOP borders. For this reason, cuts should be
set somewhat more generously. 
To burn DVDs in original 5.1 Surround Sound (Dolby Digital Audio) without having to re-encode, this
option has to be activated. 
Allows you to rip the necessary settings from an existing MPEG file. This can be useful if you want to
merge MPEG
 files together without re-rendering via Smart Rendering. 
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Video settings
 Frame rate:
 PAL requires 25 frames/sec, NTSC 29.97 frames/sec. Please note: encoding NTSC material as PAL or
vice versa may be possible; however, it will result in jittery images. 
Aspect ratio: Lets you set the image side or pixel ratio. With MPEG
 2 the image format is displayed as image ratio; correspondingly there is 1:1 (square screen, not
recommended), 4:3 (regular video) an 2.21:1 (cinemascope). This applies irrespectively of the selected
video format. 
With MPEG 1 the pixel format is specified instead. There is 1:1, CIR601 (corresponds to regular video)
for 625 lines = PAL and 525 lines = NTSC and the same in 16:9. When selecting the output format
Video CD the pixel format is automatically adjusted to the selected video format. Use with caution, even
if you only want to export MPEG 1. 
The option Auto is set as default. Here you can adjust the Movie settings
 accordingly. 
Resolution: Width and height of the video corresponds with the settings in the export dialog
. 
GOP structure: Here you can change the settings of the GOP
 sequence, i.e. the number of P frames per I frame within a GOP. Please note that the total length of the
GOP must not exceed 15 frames, which corresponds to the default setting (1 I frame + 4 P frames + 5*2
B frames = 15 frames). 
However, you can reduce the length of the GOP sequence (while compromising the image quality at the
same bit rate). This speeds up the encoding process considerably as the motion estimation while
encoding P and B frames requires high CPU
 performance. The speed of decoding, i.e. playback, is also increased. 
If I frame is set to 1, each frame is an I frame. If the value is set larger, the setting describes the total
length of the GOP. 
Auto GOP: Closed GOPs do not contain relations to frames from subsequent GOPs. MPEGs where all
GOPs are closed, make MPEG editing easier as the I frames only can be edited alone if the GOP is
closed. Auto GOP closes GOPs at scene
 changes, whereby two different and complex procedures ("fast" and "VSCD") are used. 
Bit rate mode
 In "constant bit rate" mode a bit rate that constantly remains the same is used. This option should be
used for Video CDs, as it is only requried here. With a constant bit rate the full power of MPEG
compression can not be used properly as bandwidth for non-moving scenes is lost. 
"Variable bit rate" mode attempts to adjust the available storage space to the requirements of the video
you want to encode. The actual bit rate fluctuates around a mean value. During calm sections of the video
it may drop to a minimum value, if there are movements in the scene
 it may rise to the maximum value. There are two different regulation processes (mode 1 and mode 128). 
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Advanced video settings
 MPEG profile and level: The MPEG-2 standard defines so-called "profiles" and "levels". For creating
SVCDs and DVDs you can use "Main profile and Main level". The high profile adds additional
properties to the data stream like the option to display an image at a reduced resolution for restricted
transmission quality (SNR-scalable profile), or locally scaled, for instance an HDTV
 data stream on a standard TV set. The 4:2:2 profile is used if the image data is to be encoded for
alternative chroma scanning. However, these profiles are supported by very few encoders, and mainly
only for professional use. 
These levels define the restrictions to the image resolution and the maximum data rate. Low level can only
reach a reduced resolution (352x2888 = CIF); high level, or High 1440, enables encoding in HDTV
format. 
Estimate movement: These parameters are controlled via the quality controller (see General Settings). 
Other
 Noise sensitivity:
 This factor defines how sensitive the encoder will react to noise in the source material. If the source
material only contains a little noise (digital recordings, computer animations, or material already de-noised
by video cleaning), then you don't have to change the default value 4, or you can even reduce to increase
the quality further. However, if you want to encode noisy material, then too low of a factor will
considerably increase the encoding time at the cost of quality. For an unedited analog video you can
increase the factor to 8-14. 
Noise reduction
 (click on noise sensitivity): A noise filter is used with adjustable settings from 1-31. 
Advanced parameters
 Additional expert settings are available in the tree to the right of the window. These should only be
changed by experienced users. They have been optimized for general applications to such an extent that
changes are only necessary in exceptional cases. 

Audio settings
 Audio Type: You can use MPEG -1/-2, PCM (WAV), or Dolby® Digital. You can also select "No
audio" in the export dialog
. 
Sample rate:
 You can set a sample rate of 32, 44.1 or 48 kHz for the audio track. VCDs and SVCDs require 44.1
kHz, DVDs require 48 kHz. To reduce the size of audio data it is recommended to lower the bit rate
instead of the sample rate. 
Mode: You can use mono, stereo, joint stereo, or dual channel. If audio type "Dolby®

 Digital" is used, then "5.1 Surround" mode may also be selected. 
 Dual channel enables encoding of two mono tracks (e.g. different language sound tracks) that can

be switched during playback. 
 Joint stereo is an optimized stereo encoder which takes advantage of the fact that the signal of

both stereo channels is largely identical. Use joint stereo if you can only use small audio bit rates,
but still require a stereo signal.

 5.1 Surround is available only for surround projects for burning DVDs. During this process, all 6
surround channels in the audio stream are encoded.

Note! For Surround projects "Dolby®

 Digital" should be selected under "Audio type", and "5.1 Surround" under "Mode". 
Bit rate:
 Here you can set the audio signal bit rate. The higher the bit rate, the better the playback quality. VCD
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requires 224 kBit/s, and for SVCDs and DVDs select a value between 384 kBit/s and 448 kBit/s. 

Dolby® Digital Details
 Hint:
 These functions are available only in the "5.1 Surround" mode. 
Dialog normalization:
 Set the dB level of spoken dialog. This value will be used to adjust the total volume of DVD movies and
different programs that can be received by the DVB. To do this, you must first measure the volume of
spoken dialogs in your movies. The values 1-31 correspond to volume levels of -1 to -31 dB. 
Hint: Use the mixer's peakmeter to set the volume level. This process produces only approximate
results, because the exact measurement requires a mean value and this cannot be easily measured with
MAGIX Movie
 Edit Pro 16. 
The displayed value serves also as a reference value for "Dynamic Range Control". Some areas are
softer so that speech can be made louder, and louder areas will be made softer to avoid
overmodulations. 
Background:
 Action-filled movies have larger volume differences between spoken dialogs and loud scenes (during
explosions, for example). Because of this dialogs are softer than in quieter films which can be modulated
higher. 
Surround mix level / Center mix level: 
These settings lead to an additional damping of the surround channels and the central channel. Usually
both settings are set to -3 dB. 
LFE channel: Switch off the LFE channel (Low Frequency E
ffect), e.g. if you want to eliminate undesirable rumbling sounds in the low frequency range. Normally,
you should leave this option activated. 
LFE filter: The LFE filter is a low pass filter, which lets through only the lowest frequencies. If you are
dubbing a project
 in Samplitude/Sequoia, and have applied the LFE filter, you can switch off this function here, since this
filtering has already been accomplished. 
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 Action-filled movies have larger volume differences between spoken dialogs and loud scenes (during
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dubbing a project
 in Samplitude/Sequoia, and have applied the LFE filter, you can switch off this function here, since this
filtering has already been accomplished. 
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MPEG glossary
In this chapter
Motion estimation
Bit rate
Block
Chroma format
Field
Frame
GOP
I frames
Interlace
P frames and B frames
Prediction
Quantization scaling
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Motion estimation
 Motion estimation is a further element for reducing data used in MPEG
 encoding. 
Motion estimation also occurs in the B and P frames. The image difference that still exist after prediction
are examined. Complex algorithms are used to search for an original occurrence of the macro block in
the reference frame
 of each macro block of the P or B frame (these are units of 2x2 blocks specially combined for this
purpose), which have been moved either by movement or by camera pan. They can then be left out in the
P and B frame. Only the information by how far and to where the macro block has been moved is saved
instead. This vector is called the motion detector. 
In the General encoder settings
, you can specify the quality of the final MPEG video. This factor also influences the time required for
encoding. The longer it takes, the better the quality. 
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Bit rate
 MPEG is a format used for storage and transferring. With older formats (e.g. AVI) you could predict
that 20 seconds of movie
 would result in 20 MB of data. The file size is this a direct measurement of quality. 
This is different for MPEG: The amount of data available can be used differently for different display
modes. 20 MB can be 4 seconds of DVD Video or 5 minutes Internet streaming in thumbnail format.
The quality of an MPEG video is measured by the width of the created data stream, the bit rate. This is
the amount of the transmitted data per time unit; it is stated in kBit/s or bit per second. 
Bits, not bytes are used, since the data word width has to address the transmission restrictions. 
The file size can be calculated from the average bit rate, if its length is known: 
F = (BRV + BRA) * t 
F=File size BRV=

Video bit rate 
BRA=
Audio
 bit rate 

t=Length in s 
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Block
 For almost all image file editing techniques the image is subdivided into 8 x 8 pixel blocks (image points).
This should be noted if you would like to used user-defined image
 resolutions (width/height), and they should always be a multiple of 8. 

Chroma format
 The color value of each image
 point consists of the color values for the primary colors red, green, and blue (RGB), and for traditional
and technical reasons it is transformed into one brightness value (Y = 0.299*R = 0.587*G + 0.114*B)
and two color difference values (U = R - Y, V = G -Y). 
The Y value alone produces the black and white picture. These signal components allow brightness and
color information to be handled separately. The first data reduction occurs when single rows comprising a
picture are read. Because the human eye has a lower color resolution than a brightness resolution, the
color components are recorded only for every other point of a row (4:2:2) for each four pixels grouped
(4:1:0), i.e. color signal under-reading. 
4:2:2
 This corresponds to the established TV standard. One piece of color information is transmitted per row
for two pixels which corresponds to a 2/3 compression of the output data. 
4:1:0 
This is the color coding used for DVDs and most other consumer video applications. For each 4 pixels
grouped together on two rows, one unit of color information is saved. This corresponds to a output data
compression of 1/2. 

Field
 A half-image, i.e. two halves which combine to produce a frame (see de-interlacing
). 

Frame
 A frame is a single image
 from a video sequence which also called a full image. PAL video, for example, contains 25 frames per
second, NTSC 29.97 frames. 
Video recordings, with the exception of computer animations and still frames, don't contain full images.
Instead, they have double numbers of half-images (fields) which are transmitted in an interlaced state.
However, we still refer to frames, since many predecessors of MPEG
 compression are based on such frames. Video editing literature usually refers to frames. 

GOP
 Group of P
ictures: The sequence of I frames and the P and B frames that belong to them. 
e.g. I B B P B B P B B I ... 
(This GOP has a length of 9, with 2 P frames and 2 B frames) 
I frames contain the entire image information of a frame, while P and B have part of the information.
So-called prediction
 and movement approximation are methods used for reduction. 
The combination P B B is called a subgroup. 
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I frames must appear in regular intervals in the data stream for image and sound to be synchronized.
Between the I frames only a limited count of P and B frames is allowed. This explains a few things: Since
P and B frames contain only differential information, these differences will be larger with time, since more
and more changes takes place from frame to frame. A large count does not make much sense, since
GOP has a maximum length of 15 (4P, 2B) in PAL and 18 (5P, 2B) in NTSC. (More than 2 B frames
between P frames is not allowed). 
In a closed GOP, B frames of the last subgroup may contain only backward predictions or references to
the preceding P frame, but no references to the following I frame
, since it belongs to the next GOP. 

I frames
 Intra-frames: In these pictures, the entire image information of a frame is saved and only information from
this frame is used ("intra-frame encoded"). In contrast to the I frame, P and B frames save only the
differences between the current frame, and preceding and/or following frame are also found in MPEG
video (P frame = "predicted frame", B frame = "bidirectional frame", see Prediction
). 
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 Group of P
ictures: The sequence of I frames and the P and B frames that belong to them. 
e.g. I B B P B B P B B I ... 
(This GOP has a length of 9, with 2 P frames and 2 B frames) 
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between P frames is not allowed). 
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In a closed GOP, B frames of the last subgroup may contain only backward predictions or references to
the preceding P frame, but no references to the following I frame
, since it belongs to the next GOP. 

I frames
 Intra-frames: In these pictures, the entire image information of a frame is saved and only information from
this frame is used ("intra-frame encoded"). In contrast to the I frame, P and B frames save only the
differences between the current frame, and preceding and/or following frame are also found in MPEG
video (P frame = "predicted frame", B frame = "bidirectional frame", see Prediction
). 
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However, we still refer to frames, since many predecessors of MPEG
 compression are based on such frames. Video editing literature usually refers to frames. 
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e.g. I B B P B B P B B I ... 
(This GOP has a length of 9, with 2 P frames and 2 B frames) 
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). 
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Frame
 A frame is a single image
 from a video sequence which also called a full image. PAL video, for example, contains 25 frames per
second, NTSC 29.97 frames. 
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Instead, they have double numbers of half-images (fields) which are transmitted in an interlaced state.
However, we still refer to frames, since many predecessors of MPEG
 compression are based on such frames. Video editing literature usually refers to frames. 

GOP
 Group of P
ictures: The sequence of I frames and the P and B frames that belong to them. 
e.g. I B B P B B P B B I ... 
(This GOP has a length of 9, with 2 P frames and 2 B frames) 
I frames contain the entire image information of a frame, while P and B have part of the information.
So-called prediction
 and movement approximation are methods used for reduction. 
The combination P B B is called a subgroup. 
I frames must appear in regular intervals in the data stream for image and sound to be synchronized.
Between the I frames only a limited count of P and B frames is allowed. This explains a few things: Since
P and B frames contain only differential information, these differences will be larger with time, since more
and more changes takes place from frame to frame. A large count does not make much sense, since
GOP has a maximum length of 15 (4P, 2B) in PAL and 18 (5P, 2B) in NTSC. (More than 2 B frames
between P frames is not allowed). 
In a closed GOP, B frames of the last subgroup may contain only backward predictions or references to
the preceding P frame, but no references to the following I frame
, since it belongs to the next GOP. 

I frames
 Intra-frames: In these pictures, the entire image information of a frame is saved and only information from
this frame is used ("intra-frame encoded"). In contrast to the I frame, P and B frames save only the
differences between the current frame, and preceding and/or following frame are also found in MPEG
video (P frame = "predicted frame", B frame = "bidirectional frame", see Prediction
). 
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I frames
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Interlace
 For historical reasons, pictures in a movie are always recorded and transmitted in the form of two fields;
first the lines with even numbers and then those with odd numbers. These fields are alternatively displayed
with double the frame
 rate. The (lazy) eye of the viewer or the processing of the TV tube puts the two frames together to form
one. 

The output image First field Second field 
You normally don't have to worry about field processing. The video material goes through the entire
processing chain as fields and is exported again as fields or burned onto DVD or shown on TV when
played back on a DVD as a full picture. Only in certain rare conditions is it necessary to go deeper into
this process. Two problems can occur: 

1. Interlace artifacts
 To be displayed on a computer monitor (during recording, in your TV/VCR, and in the arranger during
editing), the two fields must be combined to form a full screen. 
These two fields are not the same, since two fields are created during the recording between which a
1/50 of a second gap is evident. Moving objects can therefore produce artifacts on vertical edges. 

Typical interlacing errors 
You can use so-called de-interlacing to avoid this type of artifact. De-interlacing places a picture in
between the two fields (interpolated). If you want to create stationary pictures from movies, then you
should definitely use a de-interlace filter. 
In the system settings ("File" menu -> Program settings) you can set the preview monitor display to use
hardware
 de-interlacing during video recordings for the video recorder and for display in the arranger. 

2. Incorrect field rate
 If you move around the series of fields in a movie data stream, then you will see strong jitter and flicker
effects. Picture objects move in a backward movement ? two steps forwards, one back ? since a
delayed field is shown before the previous one. This can happen in the processing chain if you export
video material improperly with the wrong field order and then import it into different material. We use 
MXV or MPEG
 "Top field first" format for all analog recordings ("odd" in other programs). 
DV-AVI
 on the other hand is saved with "Bottom Field First". 
You can correct the field series for each video object in its object settings. See: "Menu
 -> Effects -> Object properties" 

P frames and B frames
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 P frames save only the difference between the current picture and the preceding I frame
. The "P" comes from the term "prediction" which describes this process. 
B frames save the differences between the current picture and the I or P frame preceding and following.
This includes the information that was the same before and remained the same after the current frame.
Both directions are analyzed (indicates the "B" in the name, i.e. "bidirectional-predicted"). You can read
more under prediction
. 
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Prediction
 Prediction is a method of data reduction used by the MPEG format. The image
 elements already known from the previous or following frames are removed from the data stream. 

How does it work?
 The encoder has a precisely defined GOP, for example IBBPBBPBB. This sequence is transmitted
together with the encoder, which always knows exactly which kind of frame
 comes next. I, P, and B frames are differentiated. 
Hint: When we talk about pictures, we mean frames of the video output, and I, P an dB frames are the
frames of the encoded video. Just as in movement approximation, blocks (8x8 pixels) are united into
macroblocks (16x16 pixels) during prediction. 
The first frame is always the I frame. It is completely encoded from the first picture. Afterwards, the 4th
picture is analyzed for the creation of the first P frame. (As already said, the encoder, and later the
decoder, will know that two B frames belong between them.) This image will also be completely
encoded, and afterwards all macroblocks that haven't changed in comparison to the I frame will be
deleted. They will be replaced by corresponding references for the decoder that tell it "you already know
what should be shown here, and you can get it from the last I frame". 
Now, the 2nd will be completely encoded, and all macroblocks identical to the first I frame and the
following P frame will be removed. References to previous frames are called backward predictions,
and references to following frames are called forward predictions
. The third picture will be edited in exactly the same fashion. 
The fourth picture we have already explained, and now we need the next P frame, or picture number 7.
Pictures 5 and 6 are B frames again, which are compared to P frames to both sides of them (picture 4
and 7); these are followed by the last two B frames. These have a special place, since in closed GOPs,
they may contain only backward predictions
, and no references to the next I frame, because it belongs to the next GOP. 
Something else: Since the decoder is no prophet, the P frames are always transmitted before the B
frames! The GOP explained above will be encoded and transmitted in the order it is written. 
Original
GOP 

I0 B01 B02 P01 B11 B12 P02 B21 B22 I1

Data
stream 

I0 P01 B01 B02 P02 B11 B12 B21 B22 I1

 ... 
for closed GOPs 

I0 P01 B01 B02 P02 B11 B12 I1 B21 B22 P
11

... 

For open GOPs 

Due to this nested structure, it is easy to see that during direct editing of MPEG material, complicated
computations have to take place! These are made easier using a frame table
. A frame table contains a list, where the information of every frame in the data stream is found,
identifying the type of frame it is. 
Using Movement prediction
 P and B frames are likewise reduced. 

Quantization scaling
 The single pictures in MPEG are saved using a compression method comparable to JPEG with bitmaps
and associated with quality loss. For this single images are divided into 8 x 8 blocks
. 
Each one of these blocks is then transformed into an 8 x 8 matrix (a table with rows and columns) using
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a DCT (discreet cosinus transformation) mathematical method. Each of these values is produced using all
64 individual pixels of the block, but the values in the matrix are ordered in such a way that the image
 information is ordered according to its importance. 
This matrix will then be multiplied by another matrix, i.e. the quantization matrix
. Exactly how and why this matrix must be created is the biggest secret of encoder programmers, since
this determines the quality of the whole encoding process. What is known is that the result should contain
as many zeros as possible! These zeros correspond to the "unimportant" image elements mentioned and
will not be transmitted in the data stream. 
Depending on the encoder parameters regarding the target bit rate, fewer or more values of the matrix
will be declared unimportant by dividing the quantization matrix by the quantization scaling factor
. Since only whole numbers are used, a division can produce a zero is the remainder is discarded. 
This factor is also a direct measure of the sought image
 quality of the MPEG data stream, since the "Q" in "Q" factor stands for quantization and quality. 
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If you still have questions...
In this chapter
Task assistant
Online lexicon
Program help
PDF manual

Task assistant
 The task assistant is your information center. It helps you complete your tasks and provides support at
every step. Not only will you find clear videos with step-by-step instructions, but you'll also find quick
access to a lot of functions. 
The task assistant chapters can be found in the "Tasks" menu
. 

Online lexicon
 In the D:Magazine from MAGIX we explain everything you ever needed to know about digital media.
From Active-X to Zooming, it's all there. 
You'll be able to find the lexicon at the following Internet address:
http://site.magix.net/index.php?id=16113/
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Program help
 The program's help file contains hints on how to use the program and additional information. Many
important terms are indicated in the text in italics and an explanation of them can be reached by clicking
on them. 
Homepage: The main help page can be accessed via the "Help -> Contents" menu
 point. 
Context help
: Press the "F1" key at any point in the opened program and help will open with the matching help topic
(context help). 
Search function
: To find out information on specific words, use the search function. Enter either the individual word or
use logical operators (OR, AND, NEAR) to refine your search if you have several search words. 

 "OR" (between two words): All topics which contain both words or one of the words will be
listed.

 "AND" (between two words): Only those topics will be listed which contain both words.
 "NEAR" (between two words): Only those topics will be listed which contain both words. A

maximum of six other words may be added between the search terms.
 "NOT"" (before a word): Topics which contain this word will not be listed.

Print: Use the help program's print function to make a printout of individual topics or entire sections. For
help cases which may take a long time, this can be more practical than switching between the help
window and the program. The print button is located at the top of the help window in the toolbar
. 
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PDF manual
 Much like the help feature, the electronic PDF manual contains the entire program documentation. You
can find it under "Start -> Programs -> MAGIX Movie
 Edit Pro 16" in the "Documentation" subfolder. 
Note: To view the PDF file you will need "Foxit Reader" application; you can find it on the MAGIX
Movie
 Edit Pro 16 installation DVD. 
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